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 1 Introduction 
 
 
Welcome to Thermo Scientific TQ Analyst™ software. TQ Analyst is a 
powerful yet versatile software package for developing analytical 
methods for spectroscopic applications, including mid-infrared, near-
infrared, far-infrared, and Raman. The software offers a complete 
selection of qualitative and quantitative analytical techniques, an easy-
to-use graphical interface and a broad range of on-line support. 
 
The Professional Edition contains all of the algorithms that are 
typically used for calculating component concentrations and classifying 
spectra based on a set of standards. You can also set up a method that 
simply measures spectral features and reports the measured values. If 
you purchased TQ Analyst EZ Edition, you have full access to the 
software features for basic experiments, such as quality control and 
quantitative analyses. Once a method is developed, it can easily be run 
from a Thermo Scientific spectral analysis application, such as 
OMNIC® or RESULT™.  
 
With TQ Analyst, you don’t have to be an expert to create accurate 
analytical methods. The software’s Explain help window provides 
information instantly on any feature in the software. Our Help package 
includes tools for basic training in method development and a set of 
example methods. You can also take advantage of the software’s 
“suggest” wizards and performance index to get answers to common 
questions, such as, 
 

What type of analysis will work best for this application? 

How many standards should I use and with what concentrations? 

Which regions of the spectrum will work best for this analysis? 

How many factors should I use for a PLS analysis? 

Will a correction curve improve my results? 
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We’ve eliminated the guesswork from method design. If you’re 
wondering which settings will give you the best answers, ask the 
TQ Analyst wizards for help! 
 
 

TQ Analyst 
Professional Edition 

The Professional Edition of TQ Analyst provides a broad selection of 
quantitative and classification analyses. You can also set up a method 
that simply measures spectral features and reports the measured values. 
Once a method is developed, it can easily be run from a Thermo 
Scientific spectral analysis application, such as OMNIC or RESULT. 
 
You can use the Professional Edition to create the following method 
types. 

For quantitative analysis: 

• Simple Beer’s Law 

• Classical Least Squares (standard version) 

• Stepwise Multiple Linear Regression (SMLR) 

• Partial Least Squares (PLS) 

• Principal Component Regression (PCR) 

For sample classification: 

• Similarity Match 

• Distance Match 

• Discriminant Analysis 

• Search Standards 

• QC Compare search 

For basic measurements: 

• Peak locations 

• Peak heights or areas 
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• Peak ratios 

• Peak width at half maximum 
 
You can also measure random noise in a given region and find where a 
peak is reduced to 1%, 2%, 5% or 10% of its maximum height. 
 
 

TQ Analyst 
EZ Edition 

The EZ Edition of TQ Analyst includes the features you need to create 
and run the common quantitative and classification experiments. You 
can also set up a method that simply measures spectral features and 
reports the measured values. Once a method is developed, it can easily 
be run from a Thermo Scientific spectral analysis application, such as 
OMNIC or RESULT. 
 
You can use the EZ Edition to create the following method types. 
 
For quantitative analysis: 

• Simple Beer’s Law 

• Classical Least Squares (basic version) 
 
For sample classification: 

• Similarity Match 

• Search Standards 

• QC Compare search 
 
For basic measurements:  

• Peak locations 

• Peak heights or areas 

• Peak ratios 

• Peak width at half maximum 



 

4 TQ Analyst User’s Guide Thermo Fisher Scientific 

 
You can also measure random noise in a given region and find where a 
peak is reduced to 1%, 2%, 5% or 10% of its maximum height. 
 

 Note If you purchased the EZ Edition, some of the features described in this 
manual are not available in your software. In some cases a described 
button does not appear in the software. In other cases certain options 
do not appear in the list of available options for a parameter or group. 
Read and follow the instructions for the features that are available.  
 
Here are some other things you should be aware of when using the EZ 
Edition: 

• The toolbar is always displayed when you use the EZ Edition. It 
provides a convenient way to calibrate and run methods and to open 
and close the Explain help window. 

• The full menu bar is available in the EZ Edition. No menu 
commands have been altered or omitted. 

• The choices for quantitative methods available in the EZ Edition are 
limited to Simple Beer’s Law and a simplified version of classical 
least squares. They provide a basic approach to single or multi-
component experiments that are based on peak height or peak area 
measurements.  
 
If each component in your method has an associated spectral peak 
that changes proportionally with concentration, use the Simple 
Beer’s Law analysis type. If some of the component bands overlap, 
choose classical least squares. 

• The classical least squares analysis type available in the EZ Edition 
is somewhat different from the one in the full version of 
TQ Analyst. The full version lets you associate peak heights and 
peak areas as well as larger regions with each component in a 
classical least squares method. The EZ Edition allows you to select 
peak heights and peak areas but not regions. 
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• The Discriminant Analysis and Distance Match classification 
techniques are not available in the EZ Edition of TQ Analyst. 

• The Suggest Analysis Type wizard is not available in the EZ 
Edition. 

 
 

How to use 
this manual 

This manual provides an overview of TQ Analyst software operation. It 
also serves as a training tool for creating quantitative, qualitative 
(classification) and spectral measurement methods.  
 
The contents of the individual chapters are summarized below: 

• The first chapter, “Introduction,” tells you how to get started and 
how to use the software’s extensive on-line help system.  

• Chapter two “Principles of TQ Analyst” explains some basic 
analytical terms and concepts and describes the software’s 
integrated approach for designing analytical experiments.  

• The third chapter, “Using TQ Analyst Software,” explains how to 
interact with the features in the TQ Analyst window.  

• Chapters 4, 5 and 6 provide details about working with method 
and data files, TQ Analyst windows and standards.  

• Chapter 7 covers processing spectral data for all types of analyses. 

• Chapters 8, 9, and 10 take you step-by-step through the process of 
developing methods for quantitative analysis, qualitative analysis 
(classification) and spectral measurement.  

• Chapter 11 explains how to set up sample reports for all types of 
methods and add security features to your method files.  

• Chapter 12 tells how to update the calibration data for quantitative 
and classification methods.  

• Chapter 13 “Method Diagnostics” itemizes the diagnostic routines 
available in TQ Analyst and details their use.  
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• Read chapter 14 “Troubleshooting Tips” for helpful hints when 
operating the software.  

 
At the end of the manual is an index that will help you locate 
information about specific software features. 
 
The manual is intended to be used as a training tool; it is not a 
comprehensive guide to every feature in the software. If you want 
detailed information about a specific software feature, refer to the on-
line help. See the section titled “On-line Help” in this chapter for a 
tour of the software’s extensive help system. 
 
 

Examples used 
in this manual 

Many of the methods and spectra used to create the illustrations in this 
manual are included with the TQ Analyst software. You may wish to 
use these example methods and spectra as you learn about the software. 
The example methods and spectra are contained in method and 
spectral data files in the EXAMPLES directory within the QUANT 
directory. Each example method also comes with a step-by-step tutorial 
and real data that you can work with while following the tutorial 
lessons (see the Example Methods item in the TQ Analyst help menu.) 
 
The example method files are read only. If you want to use one as a 
starting point for a new method, open the example method and save it 
with a new file name. 
 
 

Conventions 
used in this manual 

This manual includes safety precautions and other important 
information presented in the following format: 

 
 Note Notes contain helpful supplementary information.  

 
 Notice Follow instructions labeled “Notice” to avoid damaging the system 

hardware or losing data.  
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  Caution Indicates a hazardous situation which, if not avoided, could result in 

minor or moderate injury.  
 
Any text that you are required to type at the command prompt is 
underlined in this manual.  The Enter key is shown as <Enter>. Here is 
an example: 
 

C:\PROGRAM FILES\THERMO SCIENTIFIC\ 
TQ ANALYST\TQA.EXE

 
 <Enter> 

Words or phrases that appear in italic in this manual are included in 
the glossary. 
 
 

Questions 
or concerns 

In case of emergency, follow the procedures established by your facility. 
If you have questions or concerns about safety or need assistance with 
operation, repairs or replacement parts, you can contact our sales or 
service representative in your area or use the information at the 
beginning of this document to contact us.  
 
 

Learning  
the software 

TQ Analyst software is intended to serve a broad audience of users, 
from the novice chemist to the advanced chemometrician, whose job is 
to create methods for sample analysis. The software’s tabbed layout, 
integrated wizards, context sensitive on-line help and artificial 
intelligence are designed to simplify this task and help ensure quality 
results with little rework.  
 
In all of the software screens, the simplest techniques and algorithms 
are listed first and the software displays only the features that relate to 
the selected algorithm or technique. Thus, the novice user is not 
confused by software features he or she doesn’t want or need and the 
experienced user has instant access to advanced features in the software.  
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In addition to this printed user’s guide, we provide the following 
on-line tools to help you learn how to use the software.  
 
TQ Analyst on-line tour - A quick demonstration of the main features 
in TQ Analyst software.  
 
TQ Analyst example methods - Brief tours of working methods for 
quantitative analysis, sample classification, and spectral measurement 
 
TQ Analyst is a standard Windows® application. The program can be 
installed with or without the training guides, such as the TQ Analyst 
tour and the example methods. 
 
 

Where to start Depending on your knowledge and experience, we recommend the 
following approach to learning the software: 
 
If you . . . Then start with . . . 

are less familiar with  chapters 3 through 6 (or the 
Windows applications TQ Analyst Tour in the Help 
 menu) for an introduction to the 
 software. 

are new to analytical con- chapter 2 “Principles of  
cepts and method design TQ Analyst” for an overview of 
 the methods you can create 

are familiar with Windows  chapter 8, 9 or 10 (or the example 
applications and other  methods in the Help menu) to 
method development software  learn how to create quantitative, 
 qualitative (classification) or 
 spectral measurement methods 
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Customizing 
TQ Analyst 

You can customize the way TQ Analyst displays certain windows and 
dialog boxes by setting options. You can also use options to set 
parameters that apply to all of the TQ Analyst method types, such as 
the algorithm for the performance index.  
 
Use the Options command in the TQ Analyst Edit menu to display 
the options dialog box.  
 

 
 
There are three groups of options you can set: 
 
TQ Analyst options Use the options in this group to define default 

settings for TQ Analyst software and control 
when certain messages and help screens are 
displayed.  

 
Diagnostic options The Diagnostic options allow you to select the 

algorithm TQ Analyst will use to calculate the 
performance index and to indicate whether the 
software should display legends for the 
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diagnostic plots. The Display Legends check box 
allows you to turn off the legends when they 
cover data points that are critical to your 
diagnostic analysis. 

 
General options This large group of options allows you to define 

how TQ Analyst performs many operations, 
including collecting, viewing, processing, 
saving, and printing windows, spectral and 
other data within TQ Analyst software. Many 
of these general options are also available in 
other Thermo Scientific spectral analysis 
software, such as OMNIC or RESULT.  

 
To set the options, click the tab that corresponds with the group of 
options you want to set.  
 
The General tab provides a link to the general options. To see the 
General options, click the General tab and then click the General 
Options button. 
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When you are finished viewing or setting options, click OK to close 
the General Options dialog box. Then click Close to close the 
TQ Analyst Options box. 
 
 

On-line help The TQ Analyst Help package provides many kinds of on-line support, 
including a comprehensive list of Help topics with standard Windows 
search features, plus context-sensitive help and several wizards. We also 
provide an on-line tour of the unique features in TQ Analyst and a set 
of example methods.  
 
This section details the Help features and explains where to find them. 
The Help package can help you quickly learn how to use TQ Analyst 
and take advantage of its powerful features for method development 
and diagnostics. 
 
 

Help menu The Help menu is the last menu in the TQ Analyst menu bar. It lists 
several categories of information that you can select to find the 
information you need. The categories are described in the following 
table. 
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For this information... Choose this category... 
 
List of main Help topics. Also search and 
keyword index. 

TQ Analyst Help 
Topics 

A quick demonstration of the main 
features in TQ Analyst software.  

TQ Analyst Tour 

Brief tours of working methods for 
quantitative analysis, sample classification, 
and spectral measurement. 

Example Methods 

Information on how to reach Thermo 
Fisher Scientific’s hot line for technical 
support. 

Technical Support 

The version number for your TQ Analyst 
software. 

About TQ Analyst 

 

When you choose TQ Analyst Help Topics, a Help window appears 
presenting information about the software.  
 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 13 
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As you request information within Help, the information is presented 
one window at a time. Each window includes all the standard Windows 
Help buttons for finding information.  
 

 
 
The Help window in TQ Analyst works essentially the same as other 
Help software found in Windows applications. If you have not used 
Windows Help before, see your Windows documentation for complete 
information. You can also choose Using Help to see information on 
using the Help features. When you are finished reading help 
information, close the Help window by choosing Exit from the File 
menu. 
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If you choose Find or Index, a search window appears.  
 

 
 
Use the Find window to run a full text search of all the on-line help for 
the word or phrase you enter. The topics that contain the most 
occurrences of the search text will be listed first. The Index search 
window allows you to search the on-line help for all of the topics that 
are associated with the text you enter. 
 
The TQ Analyst Tour and Example Methods present an interactive 
help window. Follow the instructions in the help window to complete 
the tour or view an example method. 
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Context-sensitive help While using TQ Analyst, you won’t waste time searching for 
information about how a software feature works or when it should be 
used. Context-sensitive help lets you see information instantly about 
any feature in the software. Three kinds of context-sensitive help are 
available in TQ Analyst:  F1 Help, Explain Help and How To Help. 
 
 

F1 help For help information about a command in a TQ Analyst menu, use key 
combinations to select the command and then press the F1 key on 
your keyboard. 
 
To open a menu using the keyboard, hold down the Alt key and then 
press the underlined letter in the menu name on the screen. For 
example, to open the File menu, hold down the Alt key and then 
type F.  
 
Use the up and down arrow keys on the keyboard to select a command 
in the open menu. Press the F1 key on the keyboard to display help 
information on the selected command.  
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When you are finished reading the Help information, close the Help 
window by choosing Exit from the File menu. 
 
 

Explain help You can display information about the features in TQ Analyst software 
by opening the Explain help window and then selecting the feature you 
want to read about. To open the Explain help window, click the 
Explain button on the toolbar. 
 

 
 

The Explain help window always contains information about the 
currently selected feature. The feature can be a button, a parameter, or 
a graphical window or plot.  
 
Three characteristics of the feature are typically described in the 
Explain help window:  a definition of the feature, a description of how 
the feature works, and tips on when the feature should be used. The 
illustration below shows the kind of information you can expect to see 
in the Explain help window. 
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To display help information for another feature, simply use the left 
mouse button to click the feature. The information provided in the 
Explain help window is updated each time a new feature is selected. 
The Help window updates without changing the status of the feature 
you clicked.  
 
Keep the Explain window open as you work if you think you may need 
information about other features in a TQ Analyst window. If the 
Explain window is in your way, you can easily move it by clicking and 
dragging its title bar or close it by clicking the Close button in the 
Explain help window. 
 
 

How To help Whenever a new type of window is displayed in TQ Analyst software, a 
help card is available to explain step-by-step how to complete the tasks 
presented in the window. How To help cards are available for the 
following windows: 

• Method windows 
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• Region Selection task window 

• Correction task window 
 
To display the How To help card for a window, click the How To 
button displayed in the window.  
 

 
 
The following illustration shows the How To help card for a method 
window. 
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The help card stays visible until you close it, even while you interact 
with other features in the software. To close a How To help card, click 
the Close button at the top of the How To Help window. 
 

 Note When you install TQ Analyst on your computer, the software is 
configured to display the How To Help window whenever a procedure 
is available for the current task. You can turn this feature on and off 
from the TQ Analyst tab in the Options dialog box (choose Options 
from the Edit menu and then click the TQ Analyst tab).  

 
 

Wizards TQ Analyst offers a number of wizards to help you complete each 
method development task. From choosing the proper settings for 
method parameters to setting up your experimental design, the wizards 
can help make even your first attempt at developing a method a success.  
 
The following table gives brief descriptions of the wizards available in 
TQ Analyst. 
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Location Wizard Function 
 

Description tab Suggest Analysis 
Type 

Recommends a setting for the 
Analysis Type parameter. 

Pathlength tab* Suggest 
Pathlength Type 

Recommends a setting for the 
Pathlength Type parameter. 

Components 
tab* 

Assess Feasibility Determines whether there is 
sufficient variability in the sample 
data that correlates with differences 
in sample composition. (Tells you 
whether your method is feasible.) 

Standards tab* Suggest 
Standards 

Fills in the Standards table with the 
names and concentrations of the 
standards you should prepare and 
collect.  

 Evaluate 
Standards 

Determines whether the standards 
that are listed in the Standards table 
were prepared correctly and 
whether additional standards are 
needed. 

Regions tab Suggest Regions Chooses appropriate spectral regions 
for the analysis. 

*Available for quantitative methods only. 

Continued on next page
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Location Wizard Function 
 
Other tab* Suggest Factors Chooses appropriate factors or 

principal components (PCs) in a 
partial least squares or principal 
component regression method. Use 
the Edit Factors button to view or 
edit the chosen factors or PCs. 

Corrections tab* Suggest 
Corrections 

Determines whether a correction 
curve will improve the accuracy of 
a quantitative method and, if so, 
which settings for the correction 
parameters are appropriate for each 
component. 

*Available for quantitative methods only. 

 

 
To start a wizard, click the appropriate button on the specified tab. For 
example, to start the Regions wizard, click the Suggest Regions button 
on the Regions tab.  
 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 23 

When you start a wizard, an interactive window appears.  
 

 
 
Follow the instructions in the window. When you are finished, click 
the Next button to display the next screen. You can stop the wizard at 
any time by clicking the Cancel button in the interactive window. 
Click the Finished button in the last screen to complete the wizard.  
 
The wizards are intended to be used in the order shown in the table 
above. However, some of the wizards’ recommendations will be limited 
if they can’t access certain information. See the sections on using 
wizards in the individual chapters on creating quantitative and 
classification methods for more details. 
 
The results from the Suggest Analysis Type, Suggest Pathlength Type 
and Suggest Standards wizards will be displayed on the corresponding 
tab. The remaining wizards display their results in a special window or 
tab. The regions that are recommended by the Suggest Regions wizard, 
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for example, are displayed in the Region Selection task window and the 
results from the Assess Feasibility wizard appear on the Feasibility tab. 
 
The wizards use the spectral and other data you provide and their built-
in expertise in multivariate analysis to determine appropriate settings 
for the method parameters or to suggest how you should proceed. You 
may use the wizard’s recommendations, alter them, or overwrite them 
completely. 
 
We suggest using the wizards’ recommended settings as a starting 
point. Then add your knowledge of spectroscopy and the chemical 
system you are measuring to determine the optimum settings. 
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 2 Principles of TQ Analyst 
 
 
 
TQ Analyst is a software package for developing calibrated methods for 
either quantitative analysis or classification of spectral data.  
 
Quantitative methods calculate the concentrations of one or more 
components in a sample mixture. They can tell you how much of a 
component is present in an unknown sample. 
 
Classification methods identify features in a sample spectrum and 
compare them to predefined groups (classes) of spectra. The class that 
provides the closest match is reported along with a measure of 
similarity. Classification methods are typically used for quality control 
analyses and prefilters for quantitative experiments. They can help you 
identify an unknown material or measure its purity. 
 
You can also set up a method that simply measures spectral features 
and reports the measured values. These “measure only” methods can be 
used to determine peak heights or areas, peak ratios, peak locations and 
even the noise in a given spectral region.  
 
TQ Analyst is designed to help you develop successful analytical 
methods quickly and easily. This chapter explains the basic concepts of 
chemical spectroscopy and the quantitative, classification and spectral 
measurement analytical techniques provided in TQ Analyst. If you 
understand these concepts and are familiar with the techniques 
included in TQ Analyst, skip this chapter and review the example 
methods instead. They demonstrate how to create methods using a 
typical data set and explain how to interpret the calibration results. To 
run an example method, choose Example Methods from the 
TQ Analyst Help menu. Then click the method name. 
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Chemical 
spectroscopy 

Spectrometers measure the interaction of radiation with experimental 
samples. They record the frequencies or wavelength at which the sample 
absorbs radiation and the intensities of the absorptions. Frequency, or 
wavelength, and intensity of sample absorption are depicted in a two-
dimensional plot called a spectrum. 
 
Intensity is reported in terms of absorbance, the amount of light 
absorbed by a sample, or by % transmittance, the amount of light 
which passes through it. Percent transmittance is related to absorbance 
through the equation 
 
A = - Log10(%T/100%) 

  where A is absorbance 
 
Frequency is usually reported in terms of wavenumbers (cm-1); 
wavelength is typically reported in nanometers (nm). For this 
discussion, we will use the term “frequency” to refer to either frequency 
or wavelength. 
 
 

 
 

Infrared Spectrum 
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Determining the absorption frequencies allows identification of a 
sample’s chemical makeup, since chemical functional groups are known 
to absorb light at specific frequencies. By comparing the spectrum of 
an unknown sample, such as a polymer film, to the spectra of known 
materials (standards), the spectrometer can quickly find the spectra that 
most closely match the unknown. Identification of what makes up a 
sample is called qualitative analysis. 
 
We may also be interested in finding out how much of a component is 
present in a sample. For example, we may need to know the amount of 
an antioxidant additive that is present in a polymer film.  
 
The intensity of an absorption is related to the concentration of the 
component in the sample. A calibration model relates concentration 
changes to absorbance changes. Using a calibration model, the 
absorbance of an unknown sample can be used to calculate component 
concentration. We refer to the determination of component 
concentrations in a sample mixture as quantitative analysis. 
 
 

Quantitative 
techniques 

We often know the components in a sample mixture but need to find 
their concentrations. We refer to the determination of component 
concentrations in a sample mixture as quantitative analysis.  
 
TQ Analyst provides a wide range of quantitative techniques. All of 
them are based on the following basic premise: 
 

The intensities of the peaks in the absorbance spectrum of a 
sample are directly related to the amount of sample present.  

 
In other words, as the concentrations of the components in a sample 
mixture increase, so do the spectral peaks related to each component. 
This relationship is true at any frequency in the spectrum. 
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The simplest quantitative technique is based on a relationship called 
Beer’s Law (Beer-Lambert-Bougher law). Beer’s law states that not only 
is peak intensity related to sample concentration, but the relationship is 
linear as shown in the following equation:: 
 
 A = a b c 
 

where: A = absorbance measured at a given frequency 

 a = absorptivity of the component at the measured frequency 
(constant for a given component and frequency) 

 b = pathlength of the component 

 c = concentration of the component 
 
 

Calibration  
models 

for quantitative methods 

As we mentioned earlier, the intensity of an absorption is related to the 
concentration of the component in the sample. A calibration model relates 
concentration changes to absorbance changes. Using a calibration 
model, the absorbance of an unknown sample can be used to calculate 
component concentration. 
 
For compounds that do not tend to interact, such as gases, the 
calibration model may consist of a single standard. (For quantitative 
analysis, standards are samples which have known concentrations of 
each component the method will be used to measure.) This works best 
when the concentrations of the component of interest in the unknown 
samples are close to the concentration of the chosen standard.  
 
For liquid and solid samples and gases that vary widely in concentration, 
the calibration model should be based on several standards that contain 
different amounts of the components you want to measure. When 
multiple standards are used to create a calibration model, this group of 
standards are defined as the “calibration set.” The spectra of the standards 
are collected and used to determine the absorbance value of each 
component peak at several different concentrations. 
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Simplest  
calibration model 

In the simplest calibration model, the concentration data and the 
absorbance measurements from the calibration standards allow us to 
generate a plot of absorbance versus concentration for each component to 
be measured. The simplest way to determine absorbance is by 
measuring the height or area of a single peak. The best fit of this data is 
called a “calibration curve,” or “working curve.” 
 
 

 
 

Calibration Curve 
 
 
If you measure the same peak in the spectrum of a sample of unknown 
concentration and compare the measured absorbance to the calibration 
curve, you can determine the concentration of the component in the 
unknown sample. 
 
Assuming that the spectra of the standards and the unknown sample are 
collected at the same pathlength, the equation used to calculate 
component concentration is the equation of a straight line: 
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 A = m • C + b 
 

where: A = absorbance at a given frequency 

 m = slope of the calibration curve 

 C = concentration of the component 

 b = Y-axis intercept of the calibration curve 
 
If we rearrange this equation to solve for sample concentration, C, the 
new equation looks like this: 
 
 C = (A - b) / m 
 
 

Multivariate 
calibration models 

There are many other quantitative techniques besides Beer’s law which 
can be used to generate a calibration model. However, all of the 
quantitative techniques provided in TQ Analyst are based on the same 
basic premise:  that peak intensity is related to concentration. The 
techniques differ only in the way they relate spectral information to 
component concentration. 
 
For multivariate techniques, such as classical least squares, partial least 
squares and multiple linear regression, calibration produces a model 
that is more sophisticated than a simple calibration curve. However, the 
multivariate calibration model serves the same purpose as the 
calibration curve;  relating spectral measurements to component 
concentration. We’ll explain more about multivariate quantitative 
techniques later in this chapter.  
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Choosing a 
calibration technique 

The various techniques available in TQ Analyst for quantifying 
unknown samples using absorption spectroscopy differ mainly in the 
way they relate spectral information to component concentrations. 
 
A list of the calibration techniques available in TQ Analyst software is 
provided below. 

• Simple Beer’s law 

• Classical Least Squares (CLS) 

• Stepwise Multiple Linear Regression (SMLR) 

• Partial Least Squares (PLS), and  

• Principle Component Regression (PCR).  
 
All of these calibration techniques use the spectral and component 
concentration information from the standards to create a calibration 
model. Techniques that are based on simpler calibration models are 
listed first, while those with more complex models appear later in the 
list.  
 
It is best to select the simplest technique that is capable of modeling 
the absorbance versus concentration response of the samples you want to 
analyze. If you’re not sure which technique to use, let the TQ Analyst 
wizard recommend one. You can always switch to another technique 
later if the results from the first attempt are unsatisfactory or try several 
techniques and choose the one that calculates component 
concentrations with the most accuracy. 
 

 Note If you switch the analysis type between two options in the same group, 
for example if you change from Simple Beer’s Law to CLS, the 
information you entered and the settings you chose for the previous 
analysis type will be saved.  
 
The following sections explain each of the calibration techniques 
available in TQ Analyst and suggest applications for their use.  
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Simple Beer’s Law 
calibration technique 

This calibration technique uses the classic Beer-Lambert-Bougher law 
(absorbance increases proportionally with concentration) to create a 
calibration model.  
 
To achieve accurate quantitative results from a Simple Beer’s Law 
method, the following conditions must be met: 

• The spectra of the standards have one unique spectral peak for each 
component you want to measure. (It is best if each component 
produces only one peak in the spectrum.)  

• The component peaks can be calculated using simple peak height or 
peak area measurements. 

• You have at least as many standards as there are components. 

• Each component is included in at least two different standards and 
at two different concentrations.  

• If the samples are mixtures, the standards contain all of the 
components that will be present in the samples. 

 
The software uses the concentration data and the measured absorbance 
values from the standards to create the calibration model. If the 
method is configured to use the default (nonzero) setting for the 
intercept, the calibration model is the best fit straight line between the 
data points in the absorbance versus concentration plot.  
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This simple calibration model is often referred to as a “calibration 
curve,” or “working curve.” A separate calibration curve is created for 
each component. 
 
 

 
 

   Calibration Curve for Component A 
 
 
If you are measuring gas phase components, a single pure standard for 
each component may be sufficient, depending on the calibration range 
you want to model. Molecules in a gas sample, especially molecules 
that contain six or less atoms, are generally far apart and don’t tend to 
interact. 
 
When measuring most solids and liquids, include each component in 
at least two different standards and at two different concentrations. If 
you expect the concentrations of a component in the unknown samples 
to vary over a wide range, you may need additional standards to 
measure that component accurately.  
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It is best if the concentrations of the components in the standards 
“bracket” the concentrations you expect to measure in the unknown 
samples. In other words, the sample with the lowest concentration of a 
given component should not be below the concentration of its lowest 
standard. In the same way, the sample with the highest component 
concentration should not be above its highest standard. If the samples 
are mixtures, the standards should contain all of the components that 
will be present in the samples. 
 
Be sure to include one or two additional standards that can be used to 
validate your calibration model. The concentration of each component 
in the validation standards should fall within the specified analysis 
range.  
 
The Simple Beer’s law calibration model works well for solving basic 
analytical problems in which the following statements are true: 

• Component peaks overlap a little or not at all. 

• Spectral baselines are stable. 

• Relationships between absorbance and concentration are linear or 
nearly linear. 

• There are little or no chemical interactions between components 
(chemical interactions will cause component peaks to shift from 
sample to sample).  

• Sample matrix is well understood (you don’t expect additional 
components to show up in the unknown samples). 

 
Examples of materials which can usually be quantified using a Simple 
Beer’s law method include ethyl alcohol in water and gasoline in oil. 
 
Advantages of Simple Beer’s law methods:

• Mathematics are easy to understand. 

 

• Few standards are required. 
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• Easy to apply knowledge of sample chemistry and experience in 
spectroscopy. 

 
Disadvantages of Simple Beer’s law methods:

• Not effective when component peaks overlap significantly. 

 

Accurate only in the concentration range for which the calibration 
curve is linear. The linear range depends on the material to be 
analyzed as well as the sampling technique, analysis region and the 
type of detector used for the analysis. 

 
 

Classical least squares 
calibration technique 

The Classical Least Squares (CLS)calibration technique expresses 
measured absorbance as the sum of the absorbance contribution from 
each of the components being measured. In other words, the calibration 
model assumes the component absorptions extend beyond a single peak 
and can look at many regions of the spectra to find relationships 
between absorbance and concentration. This kind of model works well 
for differentiating components that produce overlapping bands in the 
spectral data. Mathematically, a CLS analysis is a simultaneous 
equation application of Beer’s Law. 
 
The CLS calibration model can be based on spectral peak height or area 
measurements or the use of many data points in a spectral range. You 
must include at least one peak or region for each component you want 
to measure. Multiple peaks or regions are often used for each 
component. You can also associate more than one component with 
each region. 
 
To achieve accurate quantitative results from a CLS method, the 
following conditions must apply: 

• You can identify at least one analysis region for each component. 

• The method includes at least as many calibration standards as there 
are components being measured. 
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• The concentrations of the components in the standards vary 
independently. (Whenever possible, avoid using serial dilutions of 
one standard to prepare combinations of standards.) 

• There are little or no chemical interactions between components 
(component peaks don’t tend to shift from sample to sample).  

• Sample matrix is well understood (you don’t expect additional 
components to show up unexpectedly in the unknown samples). 

• Relationships between absorbance and concentration are linear or 
nearly linear. 

 
The CLS method type is useful for solving analytical problems that are 
more complex than the problems that can be solved by Simple Beer’s 
Law. For example, you can use a CLS method under the following 
conditions: 

• Component peaks or regions overlap significantly (isolated 
component peaks may or may not exist). 

Spectral baselines are variable. 
 
Examples of materials which can be quantified using a CLS method 
include gases and other samples with little or no intermolecular 
interactions. 
 
Advantages of CLS methods:

• Able to calibrate using component peaks or regions that overlap 
significantly. 

 

• Do not require as many standards as a PLS or PCR analysis. 

• More accurate than Simple Beer’s Law because all of the data 
points in the analysis regions are used. 

 
Disadvantages of CLS methods:

• Cannot handle unexpected impurities. 
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Stepwise Multiple 
Linear Regression 

calibration technique 

Multiple linear regression, also known as Inverse Least Squares or P-
Matrix, is one of the most common modeling approaches for 
quantitative analysis. The stepwise multiple linear regression (SMLR) 
technique expresses concentration as a function of the absorbance at 
multiple frequencies. This is the opposite (inverse) of the classical least 
squares, or K-Matrix, technique where absorbance is a function of 
concentration. Select the SMLR technique when you are interested in 
measuring the concentrations of a few components in a multicomponent 
mixture.  
 
If you use the default settings for the SMLR technique, the software 
selects the analysis regions automatically. TQ Analyst uses a stepwise 
algorithm to select regions for each component. It begins by selecting 
the first region (frequency) for the first component. Additional 
frequencies that provide complementary information may be used to 
achieve the best possible prediction of the standards (the  
second region typically accounts for the sample matrix). When the 
software is finished selecting regions for the first component, it begins 
selecting them for the second component and so on until 
corresponding frequencies have been chosen for all components in the 
method.  
 
You can specify multiple components in an SMLR method. The 
SMLR calibration model can be based on spectral peak heights or the 
average peak height in a region. Multiple peaks or regions are typically 
used for each component (default settings select 3 regions) and more 
than one component can be associated with a region.  
 

 Note The second region may be used as a denominator peak. This can be 
useful for minimizing pathlength differences in the standards and 
samples. See “Setting Up a Denominator Peak or Region for an SMLR 
Method” in the chapter on “Creating a Quantitative Method” for more 
information.  
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The number of regions used is limited by the number of calibration 
standards in the method. We recommend using at least 3 standards for 
each component in an SMLR method. Ideally, the number of 
standards should be 3n + 1, where n is the number of components in 
the method. 
 
You cannot edit the regions in an SMLR method. However, you can 
specify the starting and ending point of the frequency range the 
software will use to find regions and the limits of the first region used 
to measure each component. You can also expand or limit the number 
of regions used to measure each component and specify the widths of 
the regions and the minimum gap between regions.  
 
Keep in mind, however, that a multivariate calibration model such as 
SMLR can become overfit as more regions are added to the model and 
the method’s prediction accuracy may degrade. For example, let’s say 
you are creating a method to analyze a vitamin compound consisting of 
vitamin C, lactose and other materials. As you add regions to the 
method, the calibration model may begin using some spectral features 
of lactose to predict concentrations of vitamin C. If changes occur in 
the lactose content of the samples, the calibration errors may increase. 
This happens because the model is less able to detect and correctly 
identify changes in the spectra which are not related to concentration 
changes in the sample mixture.  
 
Each component is calibrated independently. This is an advantage over 
the CLS technique and is the reason why SMLR can handle 
unexpected changes in the sample mixture. 
 
SMLR works well in the following conditions:  

• You can identify at least one analysis region for each component. 

• There is little or no overlap between component peaks. 

• The components of interest absorb linearly with concentration.  
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• You have at least 3 standards for each component and one 
additional standard (plus validation standards if you use them). 

• Spectral baselines are fairly stable (you can try using mean centering 
or applying a processing operation if they’re not). 

• There are regions that show little or no chemical interactions 
between components (chemical interactions will cause component 
peaks to shift from sample to sample). You can try using wider 
regions to accommodate some shifting of sample peaks.  

 
Since SMLR expresses concentration as a function of the absorbance at 
multiple frequencies, it is not necessary to account for every 
component or interference in the sample mixture. 
 
SMLR may be used to analyze a broad range of sample types, especially 
multicomponent mixtures for which the measured components are 
well defined. If the components of interest dominate the spectral 
variation in the standards, the SMLR technique will work even when 
the sample matrix contains other components that are not well defined.  
 
Because near-infrared peaks are broad, they can appear to overlap. 
SMLR will work with near-infrared spectra as long as there is at least 
one spectral region that varies linearly with concentration for each 
measured component. SMLR has been used extensively in near-
infrared applications but it also works well with other forms of 
spectroscopy.  
 
If the samples contain a few well-defined components and none of the 
components interact or have overlapping peaks or if the samples do not 
absorb linearly with concentration, we recommend trying Beer’s Law 
rather than SMLR for the analysis. If you are not  
satisfied with the results from a Beer’s Law analysis, then try SMLR. If 
the samples and/or the spectral response is complex or if the noise level 
on the spectral data is high, use the PLS or PCR analysis type rather 
than SMLR. 
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Advantages of SMLR methods:

• Can handle unexpected impurities in the samples. 

 

• Don’t require as many standards as a PLS or PCR analysis. 

• Can handle intercorrelations 

• More accurate than Simple Beer’s Law because more of the data 
points in the analysis regions are used.  

 
Disadvantages of SMLR methods:

• Cannot handle component peaks that overlap severely. 

 

• Components must absorb linearly with concentration. 
 
 

Partial least squares 
calibration technique 

Our partial least squares (PLS) calibration technique is based on the 
standard partial least squares (PLS1) algorithm. This is a statistical 
approach to quantitative analysis.  
 
The PLS1 algorithm examines the specified region or regions of the 
calibration spectra to determine which areas varying statistically as a 
function of component concentration. The PLS calibration model is 
developed in one operation using the spectral and concentration 
information from the standards. 
 
To achieve accurate quantitative results from a PLS method, the 
following conditions must apply: 

• You have at least 3 calibration standards for each component being 
measured and one additional standard, plus validation standards if 
you use them. (10n + 1 standards are recommended, where n 
equals the number of components.) 

• The standards are mixtures that contain all of the components that 
you expect to find in the unknown samples. 
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• The concentrations of the components in the standards vary 
independently. (You can’t use serial dilutions of one standard to 
prepare combinations of standards.) 

• The spectral variation present in the standards accurately represents 
the variation expected in the unknown samples. 

 
The PLS method type is useful for solving complex analytical problems 
for which one or more of the following statements may be true: 

• Large number of components. 

• Component peaks or regions overlap severely. 

• Spectral baselines are variable. 

• Chemical interactions between components cause peaks in the 
mixture spectrum to shift or broaden. 

• Sample matrix may not be well understood (unknown materials or 
impurities may crop up in the unknown samples).  

 
Examples of materials which can usually be quantified using a PLS 
method include detergents in water and boron and phosphorus in 
glass. PLS also works nicely for analyzing sample properties rather than 
the concentrations of specific chemicals. For example, you can use PLS 
to look for physical characteristics of the sample, such as color, 
hardness or viscosity, if those characteristics produce a spectral 
response.  
 
Advantages of PLS methods:

• Able to calibrate using component peaks or regions that overlap 
severely. 

 

• Can handle unknown components or impurities that might absorb 
in the analysis regions. 

• More robust than Simple Beer’s Law because all of the data points 
in the analysis regions are used. 
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• User does not need to specify individual regions for each 
component. 

• Software allows you to optimize the number of factors for each 
measured component. 

• Software offers a full suite of diagnostic tools for evaluating PLS 
methods. 

 
Disadvantages of PLS methods:

• Require lots of standards. 

 

• Mathematics are difficult to understand. 
 
 

Principal 
component regression 
calibration technique 

Principal Component Regression (PCR) is another statistical 
quantitative analysis technique. Similar to the partial least squares (PLS) 
analysis, the PCR algorithm examines the specified region or regions of 
the calibration spectra to determine which areas are varying statistically 
as a function of component concentration. 
 
But rather than developing the calibration model in one operation, like 
PLS, PCR calibration is a two-step process. First, the spectral 
information is used to calculate the principal component spectra. 
Then, the principal component spectra and the component 
concentration information are used to create the calibration model. All 
component concentration values are calculated simultaneously. 
 
The same conditions that are needed for a successful PLS analysis are 
also required for PCR. For example, to achieve accurate quantitative 
results from a PCR method the following statements must be true: 

• at least 3 calibration standards for each component being measured 
and one additional standard, plus validation standards, if you use 
them. (10n + 1 standards are recommended, where n equals the 
number of components.) 
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• The standards are mixtures that contain all of the components that 
you expect to find in the unknown samples. 

• The concentrations of the components in the standards vary 
independently. (You can’t use serial dilutions of one standard to 
prepare combinations of standards.) 

 
In general, you should try the PLS analysis type before using PCR. The 
two techniques are similar. However, the PLS calibration model is 
developed in one operation using spectral and concentration 
information from the standards while PCR creates a calibration model 
in two steps. Step 1 uses the spectral data to determine spectral 
variation; step 2 correlates spectral variation with concentration. Since 
the regression step is done after the principle components are selected, 
the principle components aren’t weighted toward producing 
concentration information. Because of this difference, PLS results may 
be more accurate than the results from a PCR analysis.  
 
On the other hand, PCR is a well known and widely understood 
technique for statistical analysis. We included the PCR analysis option 
in our software in case you need to reproduce a PCR method that was 
created in another application or you simply prefer PCR over PLS. 
 
Advantages of PCR methods:

• Able to calibrate using component peaks or regions that overlap 
severely. 

 

• Can handle unknown components or impurities that might absorb 
in the analysis regions. 

• More robust than Simple Beer’s Law because all of the data points 
in the analysis regions are used. 

• User does not need to specify individual regions for each 
component.  
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Disadvantages of PCR methods:

• Require lots of standards. 

 

• Mathematics are difficult to understand. 

• Since the regression step is done after the principle components are 
selected, the principle components aren’t weighted toward 
producing concentration information as they are in a PLS method. 

• TQ Analyst does not offer as many diagnostic routines for PCR as 
it does for PLS. 

 
 

Qualitative 
(classification) 

techniques 

TQ Analyst offers a variety of techniques for comparing and 
identifying unknown samples based on the spectra of known materials. 
These “classification” techniques are all qualitative measurements 
because they can tell you what’s in a sample (or which class it belongs 
to), but not how much of a component the sample contains. Qualitative 
techniques can also tell you how closely a sample matches a group of 
known materials so you can distinguish “good” samples from “bad” 
ones. 
 
TQ Analyst provides the following classification method types: 

• Similarity Match 

• Distance Match 

• Discriminant Analysis 

• Search Standards 

• QC Compare Search 
 
All of the classification methods compare the spectrum of an unknown 
sample with the spectra of one or more groups (classes) of known 
materials (standards). If you want to use one class of standards for the 
comparison, you must create a Similarity Match or Distance Match 
method. When several classes of standards are needed, a Distance 
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Match, Discriminant Analysis, or QC Compare search method should 
be used. If you want to compare the unknown to many kinds of 
materials, a Search Standards method is ideal. 
 
A Search Standards method uses only one standard to define each class 
(TQ Analyst considers each standard as a separate class). Similarity 
Match methods need at least one standard in each class but allow 
multiple standards per class. Distance Match, Discriminant Analysis, 
and QC Compare search methods use statistical algorithms to 
determine similarity and require at least two standards to define each 
class. 
 
The various classification methods also differ in the kind of 
information they provide about an unknown sample. For example, a 
Similarity Match method compares the unknown sample to a single 
class of standards and reports a match value, which is a measure of 
similarity, while a Discriminant Analysis method can compare the 
unknown to several classes and give a “distance from class” value for 
each class. 
 
Classification methods are typically used for quality control analyses 
and prefilters for quantitative experiments. For example, once a sample 
has been “classified,” you can run it through a quantitative method that 
has been optimized for that type of sample.  
 
The classes may be quite different or very similar. For example, you 
may set up a classification method where each class represents a 
material that is different from the other classes. The results can help 
you sort or identify an unknown material. The classes in another 
method may differ only in the concentration of a single component 
and the results can be used to sort materials based on dosage. 
 
The next two sections discuss calibration models for classification 
methods and provide tips on selecting an appropriate classification 
technique. 
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Calibration  
models for classification 

methods 

Classification methods do not build calibration models in the same sense 
that quantitative methods do. However, you must calibrate a 
classification method before the software will allow you to use it to 
analyze a sample. 
Only Discriminant Analysis and Distance Match methods display a 
Calibration Results window. The calibration results show how well the 
method performs by classifying the method standards. This information 
can help you identify standards that may have been assigned to the 
wrong class or standards that are simply too different from the rest of 
the standards in their class. See the item called “Calibration Results for 
Classification Methods” in the TQ Analyst Help Topics for more 
information about calibrating Discriminant Analysis and Distance 
Match methods. 
 
Similarity Match methods also do some calculations during the 
calibration step. Search Standards and QC Compare search methods 
do not require formal calibration. However, even for these methods the 
software uses the “calibration” step to test the method for consistency 
and experimental design. So be sure to click the Calibrate button on 
the TQ Analyst toolbar when you think your classification method is 
ready to be implemented and TQ Analyst will let you know if anything 
looks out of order.  
 
For more information on calibrating a classification method, see the 
section titled “Calibrating the method” in the chapter on “Creating a 
Classification Method” in this document. 
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Choosing a 
classification technique 

There are a number of factors to consider when classifying samples using 
absorption spectroscopy. The most important considerations are the 
number of different materials the algorithm must distinguish, the 
number of standards available to define each known material and the 
quality of the spectral information available for the standards and 
unknown samples. Each of these factors plays an important role in 
helping you determine the proper experimental design. 
 
The first step in classifying samples is to define the analytical problem, 
that is,  
 

How much information do you have about the unknown samples? 
What do you want to compare them to? 
What information is needed from the comparison?  

 
Are you simply trying to verify the purity of a known sample or 
determine whether it is compound a, b, or c or are you trying to 
identify a material that is completely unknown? 
 
TQ Analyst provides the following techniques for sample classification. 
The basic concepts behind these classification techniques are 
summarized below. 
 
If you . . . Then use . . . 

are interested in monitoring the  Similarity Match 
purity of an incoming material or  Distance Match 
the product of some process 

want to screen incoming materials to  Discriminant Analysis 
determine if they are compound a, b, or c Distance Match 
 QC Compare search 

are trying to identify a material that  Search Standards 
you know little or nothing about 
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If you’re not sure which technique to use, let the TQ Analyst wizard 
recommend one. You can always switch to another technique later if 
the results from the first attempt are unsatisfactory or try several 
techniques and choose the one that classifies your samples with the 
most accuracy. 
 
If you switch the analysis type between two options in the same group, 
for example if you change from Similarity Match to Discriminant 
Analysis, the information you entered and the settings you chose for 
the previous analysis type will be saved. 
 
The following sections explain each of the classification techniques 
available in TQ Analyst and suggest applications for their use.  
 
 

Similarity Match 
classification technique 

Similarity Match is a spectral classification technique that indicates 
how closely an unknown material matches a known material. Multiple 
standards may be used to set up a Similarity Match method. The 
software places all of the standards in a single class. Multiple regions of 
the spectrum may be used for the comparison.  
 
Similarity Match methods are typically used to monitor the purity of 
incoming materials. This type of method works well when all of the 
standards represent different lots of the same material. A Similarity 
Match method may also be used to compare a mixture of compounds 
with the spectra of the individual components by using the pure 
component spectra as the method standards. Similarity Match methods 
are also good for prequalifying materials that will be used for 
quantitative measurements. 
 
The Similarity Match algorithm is set up to measure similarity based 
on a residual spectrum. When the method is calibrated, the software 
performs a Gram-Schmidt analysis of the standards. The resulting 
orthogonal model represents the spectral information provided by all of 
the data points in all of the standards. During sample analysis, the 
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software uses the Gram-Schmidt model to remove any spectral 
information represented by the method standards from the spectrum of 
the unknown sample. The result is called a residual spectrum. The 
software then compares the information in the sample spectrum with 
the information in the residual spectrum and calculates a “match 
value.” The match value represents the unexplained variation in the 
spectrum of the unknown sample. See the section on “Similarity 
Match” in Appendix C:  Algorithms Used in TQ Analyst Software” for 
more information. 
 

 Notice The Match Type parameter on the Other tab determines the format for 
reporting the match value. If Match Type is set to “Find Similarities,” 
the match values will be scaled from 0 to 100 where 100 is a perfect 
match (little spectral information in the residual spectrum). If Match 
Type is set to “Find Residual Differences,” the match values will be 
scaled from 100 to 0 where 0 is a perfect match.  
 
By specifying a limit for the match value, you can monitor the quality 
of the samples and flag samples that are below (or above) the specified 
limit. You may also set up a pass/fail indicator on the sample reports. 
See “Preparing a Method for Sample Analysis” at the end of this 
document for information on specifying limits and pass/fail indicators 
for TQ Analyst methods. 
 
 

Distance Match 
classification technique 

The Distance Match classification technique can be used to determine 
how closely an unknown material matches two or more classes of 
known materials by calculating a conformity spectrum for each class and 
measuring its distance from the class average. This technique is 
typically used to screen incoming materials, for example, to determine 
how closely they match compound a, b, or c or to determine “degrees 
of difference” between known and unknown materials. The Distance 
Match technique works well for distinguishing materials that are closely 
related.  
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We recommend using at least five standards to define each class (two 
standards are required in order to perform the variance analysis during 
calibration). Multiple regions of the spectrum may be used for the 
comparison.  
 
During calibration, the software calculates an average spectrum and a 
standard deviation spectrum for each class.  
 
When you use the method to classify the spectrum of an unknown 
sample, the software subtracts the average spectrum from the unknown 
sample spectrum to create a residual spectrum and divides by the 
corresponding standard deviation spectrum to create a conformity 
spectrum for each class. (The subtraction step shows the differences 
between the two spectra; the ratio tells you the significance of that 
difference.) Then it calculates the percentage of frequencies in the 
residual spectrum that exceed the Distance Match threshold in 
standard deviation units (typically 5). The Distance Match threshold is 
located on the Other tab. 
 

 Notice The result of the comparison is called the “match value,” which is an 
indicator of the quality of the match. The match values for Distance 
Match methods will range from 100 to 0, where 0 (percent frequencies 
exceeding the threshold) is a perfect match. s 
 
If one class is defined in the method, the software reports the match 
value for that class. If multiple classes are used, the software reports the 
class name and match value for the specified number of classes. The 
best matched class (the one with the lowest match number) is listed 
first.  
 
By specifying a limit for the match value, you can monitor the quality 
of the samples and flag samples that are below (or above) the specified 
limit. You may also set up a pass/fail indicator on the sample reports. 
See “Preparing a Method for Sample Analysis” at the end of this 
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document for information on specifying limits and pass/fail indicators 
for TQ Analyst methods. 
 
The Distance Match algorithm works well for differentiating materials 
that contain different amounts of the same components. In this type of 
analysis, the spectra of the standards in each class are very similar. The 
main difference may occur only in the intensities of the peaks in a few 
key regions. For example, a lab might set up a Distance Match method 
to check the dosage of drugs used in a double-blinded clinical study to 
confirm that no mix-ups occurred in the packaging. In this case, the 
analyst might set up classes that define different levels of an active 
ingredient, such as salicylic acid. The method could then be used to 
test incoming drugs to see which category they match and to what 
degree. 
 
You can also use Distance Match to detect slight changes in incoming 
raw materials or production samples by comparing them to previous 
samples of the same type. We refer to this procedure as “qualification.” 
It can be an effective technique for statistical quality control. 
 
 

Discriminant  
Analysis classification 

technique 

The Discriminant Analysis classification technique can be used to 
determine the class or classes of known materials which are most similar 
to an unknown material by computing the unknown’s distance from 
each class center in Mahalanobis distance units. The discriminant 
analysis technique is typically used to screen incoming materials to 
determine if they are compound a, b, or c.  
 
The method usually specifies two or more classes of known materials. 
Multiple standards are typically used to describe each class. You can use 
multiple regions of the spectrum for the analysis. 
 
During calibration, the software computes an average spectrum and 
then generates a distribution model by estimating the variance at each 
frequency in the analysis range. You can select whether a unique 
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distribution model is developed for each class or one model is used for 
all classes (see Within Class Variance on the Other tab). If  
one model is used for all classes, the software subtracts the class average 
from each standard and then creates a single variance spectrum using 
information from all of the classes. If you elect to use a unique 
distribution model for each class, the software subtracts the class 
average from each standard and uses only the information from a given 
class to create a unique variance spectrum for that class. This is similar 
to the technique known as SIMCA (Soft Independent Modeling of 
Class Analogies).  
 
In order to calculate the statistics properly, the single model requires at 
least one class that contains two or more standards. If you select the 
option that creates a unique distribution model for each class, every 
class must contain at least two standards. Both models work best with 
several standards per class. 
 
When you use the method to analyze an unknown sample, the software 
performs a principal component analysis on the unknown sample 
spectrum and on the variance spectrum (or spectra) to determine score 
values. The score plots are used to produce Mahalanobis distance values, 
which in turn are used to rank the classes. 
 

 Note The Discriminant Analysis technique uses the spectral information 
from all of the method standards to create the distribution model or 
models. As a result, adding or deleting standards may have a significant 
impact on the method’s calibration model, especially when using the 
pooled distribution model. If you are using a unique distribution 
model for each class, you may add or delete standards from one class 
without affecting the other classes in the method.   
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 Notice The result of a discriminant analysis is the name of the class or classes 
that are most similar to the spectrum of the unknown sample. The 
Mahalanobis distance between the unknown sample and each reported 
class can also be reported. The closer each distance value is to zero, the 
better is the match.   
 
For most experiments, a Discriminant Analysis method will perform 
best when the software creates a unique distribution model for each 
class. However, if you have fewer than five standards to define each 
class and the spectra that make up the various classes are very similar, 
we recommend using a pooled distribution model to differentiate the 
classes.  
 
The Discriminant Analysis technique works well when you are trying 
to analyze samples in which the composition may be very different but 
they all contain a common ingredient. For example, you can use a 
Discriminant Analysis method to analyze street drugs, such as cocaine 
or heroin, that are mixed with various materials. In this case, the 
standards used to define each class all contain the drug of interest but 
the other components in the standards (cutting agents, etc.) are very 
different. Since this kind of experiment guarantees lots of variation in 
the standards, make sure the method is set up to calculate a unique 
distribution model for each class.  
 
 

QC Compare  
search classification 

technique 

The QC Compare search classification technique can be used to verify 
the composition of an unknown material that is known to belong to 
one of several classes. In these applications, the analyst is interested in 
identifying which known material each sample is most like. The 
QC Compare search algorithm compares the intensities at each 
frequency of the unknown sample spectrum with the individual spectra in 
each class in order to find the spectra and class that most closely match 
the unknown.  
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A QC Compare search method must specify at least two classes of 
known materials. Multiple standards may be used to describe each class. 
Multiple regions of the spectrum may be used for the analysis.  
 
The result of a QC Compare search is the single best match from each 
reported class. The classes are listed in order of importance; the class 
that contains the best matched spectrum is listed first.  
 

 Notice The library index number of each reported standard is given as well as a 
match value between 0 and 100. The match value tells you how well 
the standard matches the unknown. A match value of 100 indicates a 
perfect match.   
 

 Note If you are interested in identifying unknown materials by their near-
infrared spectra, we recommend using QC Compare search rather than 
Search Standards because you can use several spectra to define each 
known material the unknown will be compared with.  
 
 

Search Standards 
classification technique 

You can use the Search Standards classification technique to look at a 
wide range of known materials (standards) to determine which of them 
are most similar to an unknown material. The Search Standards 
algorithm compares the intensities at each frequency of the unknown 
sample spectrum with the spectrum of each standard and finds the 
spectra that most closely match the unknown. The Search Standards 
technique is often used to identify a material that is completely 
unknown.  
 
You can use only one standard to describe each known material in a 
Search Standards method. The software considers each standard in the 
method as a separate “class.” The method must specify at least two 
standards; in most cases, many standards are used. Multiple regions of 
the spectrum may be used for the comparison. 
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You may choose between five search algorithms when creating a Search 
Standards method. We recommend using the Correlation search 
algorithm. 
 

 Notice When you use a Search Standards method to analyze the spectrum of 
an unknown sample, the index number and title of each reported 
standard are given as well as a match value between 0 and 100. The 
match value tells you how well the standard matches the unknown. A 
match value of 100 indicates a perfect match.  
 
If you are familiar with Thermo Scientific OMNIC spectral analysis 
software, the Search Standards classification technique is the same as 
the OMNIC Search feature.  
 
 

Spectral 
measurement 

techniques 

You can use TQ Analyst to set up methods that simply measure 
spectral features and report the measured values. These “measure only” 
methods can be used to determine peak heights or areas, peak locations 
and even the noise in a given spectral region.  

 
A spectral measurement method can be configured to do any of the 
following: 

• Measure the height or area of a peak. 

• Measure the ratio of two spectral peaks. 

• Measure the random noise in a given region. 

• Measure the width at half maximum of the largest peak in a region. 

• Locate the largest peak in a specified region. 

• Find where a peak is reduced to 1%, 2%, 5% or 10% of its 
maximum height. 

 
You can specify up to 50 measurements in a spectral measurement 
method.  
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 Note To set up a method that calculates the ratio of two spectral peaks, set 

the TQ Analyst Pathlength option to Peak Ratio. The numerator peak 
must be listed with the other measurements in the Measure Only 
method. The Peak Ratio options let you define the denominator peak. 
See the Explain Help in your TQ Analyst software for more 
information about setting Pathlength options. See the section titles 
“Selecting the Analysis Regions” in this chapter for instructions for 
using the Peak Ratio pathlength option to define a denominator 
peak.  
 
Methods that report peak heights or areas are typically used to 
consistently measure a peak or area in a series of spectra. The 
absorbance values could then be used to plot a calibration curve by 
hand or on a computer that can calculate spectral plots. 
 
An optional linear function can be applied to the absorbance values 
from each measured peak for simple mathematical corrections. Each 
function is defined by its slope and intercept values. If a linear correction 
is specified for a given peak, the corrected absorbance value is reported 
instead of the measured value. 
 
People use methods that measure spectral noise to test spectrometer 
performance or to validate a specific analysis. You can configure a 
method to measure either RMS noise or peak-to-peak noise in a specified 
region. 
 
Some people need to consistently measure the width of a peak in a 
spectral region or simply report the peak’s exact location. These 
measurements are often useful for validation purposes or to detect 
changes in peak shape. Peak width values and peak locations are 
reported in the X-axis unit of the corresponding spectrum. 
 
Others simply want to report the location where a peak is reduced to a 
certain percentage of its maximum value. Percent-of-maximum 
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measurements are typically used for instrument validation. For 
example, you can use them to report the X-axis location where the 
energy in a single-beam spectrum is reduced to a level that is no longer 
useful.  
 
 

Calibration models 
for Measurement 

Only methods 

Measurement methods do not require calibration as no calibration 
model is needed. These methods are intended for measuring or 
reporting information about spectral data, rather than classifying spectra 
or calculating component concentrations. However, TQ Analyst uses 
the “calibration” step to test the method for consistency and 
experimental design. So be sure to click the Calibrate button when you 
think the method is ready to be implemented and TQ Analyst will let 
you know if anything looks out of order.  
 
 

How pathlength 
affects quantitative 

and classification 
techniques 

Sample pathlength, defined as the distance that a beam of incident 
energy travels within a sample, affects both quantitative and qualitative 
(classification) analyses. When analyzing samples that are in the solid 
state, “sample pathlength” is often referred to as “sample thickness.” 
The pathlength of a liquid sample is defined by the distance between 
the internal walls of the holder used to place the liquid in the energy 
beam. 
 

 Note Pathlength is important to a spectral measurement analysis only when 
the measurement data are used for quantitative or classification 
purposes.  
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In our discussions so far, sample pathlength, represented by the term 
“b” in the Beer’s Law equation, was assumed to be constant.  
 
 
 A = a b c 
 

where: A = absorbance measured at a given frequency 

 a = absorptivity of the component at the measured frequency 
(constant for a given component and frequency) 

 b = pathlength of the component 

 c = concentration of the component 
 

Beer’s Law Equation 
 
 
This allowed us to drop the pathlength term from the equation so we 
could focus the discussion on the relationship between absorbance and 
concentration. In reality, sample pathlength isn’t always constant. If 
the pathlengths of the standards and the unknown samples are 
different, the calibration model must account for the differences. This is 
true for any quantitative method.  
 
TQ Analyst provides a number of options for handling variations in 
sample pathlength for quantitative methods. All of these pathlength 
options are described in the sections that follow. 
 
Sample pathlength is important to qualitative (classification) analyses 
for the same reasons. This is especially true for Distance Match and 
Discriminant Analysis methods when the method must discriminate 
between various materials that contain different amounts of a key 
compound. If the pathlengths of the standards and the unknown 
samples are different and component concentrations are not important 
to your classification analysis, the method should include a pathlength 
correction to account for the pathlength differences. For example, if 
you are classifying samples of the same material but with different 
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particle sizes, apply a pathlength correction only if particle size effects 
are not something you want the method to track. A pathlength 
correction may also allow you to tighten class distribution for spectra 
that have significant anomalies, due to scattering or some other 
problem.  
 
The pathlength options that are provided for classification methods 
(Peak Ratio, Multiplicative Signal Correction, and Standard Normal 
Variate) all correct the spectral data rather than the calculated 
concentration values, which would be useless for a classification method 
since no concentration values are reported. See the sections that follow 
for details on the Peak Ratio, Multiplicative Signal Correction and 
Standard Normal Variate pathlength options. 
 
 

Choosing a 
pathlength option 

TQ Analyst provides a range of techniques for handling variations in 
sample pathlength. The following is a complete list of the pathlength 
options available in TQ Analyst software: 

• Constant 

• Known 

• Predict 

• Internal Reference 

• Peak Ratio 

• Multiplicative Signal Correction (MSC) 

• Standard normal variate (SNV) 
 
Detailed descriptions of the pathlength options are provided at the end 
of this section. 
 
The software offers more pathlength options for the multivariate 
quantitative techniques (CLS, SMLR, PLS and PCR) than for Simple 
Beer’s Law because a multivariate calibration model is better able to 
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identify subtle changes in the spectral data that are due to differences in 
sample pathlength. If sample pathlength is unknown or difficult for 
you to measure, a multivariate analysis may be required to accurately 
analyze your samples .  
 
If you are creating a classification method, the software provides the 
pathlength options that rescale the spectrum (or do nothing) rather 
than correct the calculated concentration values, including: 

• Constant 

• Peak Ratio 

• Multiplicative Signal Correction (MSC) 

• Standard Normal Variate (SNV) 
 
Pathlength corrections that operate on the calculated concentration 
values would be useless for a classification method since no 
concentration values are available.  
 

 Note No pathlength options are available for the Search Standards and QC 
Compare search classification techniques.  
 
In most cases, your sampling technique will dictate the correct 
pathlength option (frequently Constant or Known). If the pathlengths 
of your samples aren’t constant or known, we recommend setting the 
pathlength option to “Undecided.” Using this option will allow the 
TQ Analyst Pathlength wizard to recommend a pathlength setting for 
your method.  
 

 Note The Pathlength wizard is available only for quantitative methods.  
 
To use the Pathlength wizard, set the Pathlength Type to “Undecided” 
and then click the Suggest Pathlength Type button on the Pathlength 
tab. Keep in mind, however, that the method must be fairly complete 
before the Pathlength wizard can recommend a pathlength setting. For 
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example, you must define the components, collect and identify the 
standards and select the spectral regions to be used for the analysis before 
the wizard can recommend a pathlength setting.  
 
If you select the Undecided pathlength option and then use the 
Suggest Regions wizard to recommend spectral regions for your 
method, the Regions wizard will recommend a pathlength option as 
part of the region selection process. The Pathlength wizard performs a 
statistical analysis of the spectral data from the standards to find the 
spectral peak or region that correlates best with variations in sample 
pathlength. 
 
You may also try several pathlength types and then choose the one that 
produces the best results. Here are some brief guidelines: 
 
If sample pathlengths are... 

Always the same Constant 

Use this pathlength type... 

Variable and known  Known 
 (or easily measured)  

Variable and unknown  Predict 
 (or not easily measured) Internal Reference 
   MSC 
   SNV 
 
If you are creating a classification method that contains standards 
collected at different pathlengths and you can find a peak that varies 
only with pathlength, use the Peak Ratio pathlength option. The Peak 
Ratio pathlength correction is especially useful for Distance Match and 
Discriminant Analysis methods when the method must discriminate 
between various materials that contain different amounts of a key 
component. Peak Ratio scales the spectrum based on the pathlength 
peak, leaving the concentration differences intact.  
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If the pathlengths of the standards and the unknown samples are 
different but you can’t find a peak that varies only with pathlength, use 
the MSC or SNV pathlength correction.  
 
If the pathlengths of the standards and the unknown samples are all the 
same, use the Constant pathlength option. 
 
The remaining sections of this chapter list the pathlength options 
available in TQ Analyst and explain how they work and when each of 
them should be used.  
 
 

Constant 
pathlength option 

Select the Constant pathlength option only if you can collect the 
spectra of the standards and every unknown sample the method will 
analyze at exactly the same pathlength. You do not need to know the 
pathlength value. It is only important that the pathlengths are all the 
same.  
 
When the pathlengths of the standards and unknown samples are 
exactly the same, the pathlength term “b” can be dropped from the 
Beer’s Law equation, and the analysis focused on the relationship 
between absorbance and concentration. 
 
 
 A = a b c 
 

where: A = absorbance measured at a given frequency 

 a = absorptivity of the component at the measured frequency 
(constant for a given component and frequency) 

 b = pathlength of the component 

 c = concentration of the component 
 

Beer’s Law Equation 
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Select the Constant pathlength type if you are using a sampling 
accessory that has a fixed pathlength, such as a liquid ATR accessory or 
fixed path gas cell. 
 
If you know the exact pathlength of your sampling accessory (some 
accessories have a label that tells you the measured pathlength), we 
recommend using the Known pathlength option even though 
pathlength is constant. Then, if the cell you are using breaks and must 
be replaced, you can enter the pathlength of the new cell and continue 
analyzing samples without rerunning the standards.  
 
The following sampling accessories may have a constant pathlength: 

• Uncalibrated liquid transmission cells. 

• Liquid ATR accessories, such as a Circle cell or Horizontal ATR. 

• Diffuse reflectance accessories. 
 
 

Known 
pathlength option 

Select the known pathlength option if you know or can easily measure 
the pathlengths of the standards and any samples you want to analyze 
with your method. The pathlengths of the standards and the unknown 
samples can be different but the pathlength values must be known.  
 
When the Known pathlength option is selected, you must enter a 
pathlength value for each standard before the method can be calibrated. 
You must also specify the pathlength of every unknown sample that 
you use the method to analyze.  
 
Select the Known pathlength type in the following cases: 

• You are analyzing samples that have different but known 
thicknesses, such as a series of molded polymer films. 

• You will be using a variety of sampling accessories that have a fixed 
pathlength or a pathlength that can be accurately set. 
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• The pathlengths of the standards and samples are the same but the 
pathlength could change, for example if the cell you are using 
breaks and must be replaced. Then you can enter the pathlength of 
the new cell and continue analyzing samples without rerunning the 
standards. 

 
The following types of samples and sampling accessories may have 
measurable pathlength values: 

• Molded polymer films. 

• Variable path gas cells. 

• Variable path liquid cells. 
 
 

Predict 
pathlength option 

If you know or can easily measure the pathlengths of the standards but 
don’t know the pathlengths of the unknown samples, try using the 
Predict pathlength option. Predict uses the pathlength information in 
the calibrated method to predict the pathlength of each unknown 
sample.  
 
The Predict pathlength option works only when there is sufficient 
variation in the calibration model that correlates with differences in 
pathlength. Since pathlength is treated as an additional component to be 
quantified, at least one additional calibration standard is required. 
 
When the Predict pathlength option is selected, you must enter a 
pathlength value for each standard before the method can be calibrated. 
When the method is used to analyze an unknown sample, the software 
uses the calibration model to predict the sample pathlength. The 
predicted pathlength value is used to calculate component 
concentrations in the unknown sample. The sample results will show 
the predicted pathlength value along with the component 
concentrations. 
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People often use the Predict pathlength option when the pathlengths 
of the standards and samples can be measured but the process is time 
consuming or expensive. The pathlengths of films and polymers are 
often calculated this way.  
 

 Note The Predict pathlength option in TQ Analyst is the same as the 
“Internal known” pathlength option in Thermo Scientific QuantIR 
software.  
 
 

Internal Reference 
pathlength option 

(A = b * c)  

The internal reference pathlength option can be used when the 
following conditions apply: 

• You are creating a CLS or Simple Beer’s Law method, 

• The pathlengths of your standards and unknown samples vary, 

• Sample pathlength is difficult or impossible to measure accurately, 

• You can identify a spectral peak or region that varies only with 
pathlength. 

 
The Internal Reference pathlength setting uses a specified peak to 
compensate for differences in sample pathlength. When using the 
internal reference pathlength option, you must specify an absorbance 
peak that is indicative of sample pathlength. This can be a peak from a 
known amount of a component that is added to the calibration standards 
and unknown samples or it can be a peak that is due to the matrix 
material. The selected peak must respond only to pathlength; it cannot 
contain absorptions from other components or impurities in the sample 
mixture. 
 
Examples of sample types whose pathlength values can sometimes be 
determined this way include samples mixed with KBr and pressed into 
a pellet (added pathlength component) and molded polymer films 
(matrix peak). 
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If you need help finding a pathlength peak for a quantitative method, 
let the TQ Analyst wizard find one for you. There are several ways you 
can do this, depending on how far along you are developing your 
method. For example, if you simply want to investigate the Internal 
Reference pathlength option, use the Suggest Pathlength Wizard to 
recommend a pathlength region. The Pathlength wizard performs a 
statistical analysis of the spectral data from the standards to find the 
spectral peak or region that correlates best with variations in sample 
pathlength. 
 
Keep in mind, however, that the method must be fairly complete 
before the Pathlength Wizard can make a recommendation. For 
example, you must define the components, collect and identify the 
standards and select the spectral regions to be used for the analysis before 
the wizard can recommend a pathlength region.  
 
If you leave the Pathlength Type set to Internal Reference and then use 
the Suggest Regions wizard to recommend analysis regions for your 
method, the Regions wizard will recommend a pathlength peak or 
region along with the analysis regions.  
 
We prefer using the Internal Reference pathlength option rather than 
Peak Ratio because it provides information about the measurement 
error. A method based on Peak Ratio, A / b = C, calculates just 
concentration, C. But this calculation is based on the pathlength 
corrected analytical measurement, A / b. The calibrated method cannot 
tell you anything about measurement error because this error is masked 
by ratioing the raw data before presenting it to the method. 
 

 Note If you need to use a pathlength peak to compensate for changing 
pathlengths, use either Internal Reference or Peak Ratio. See the 
section titled “Comparison of Internal Reference and Peak Ratio 
Pathlength Types” in Appendix B for details on how these two 
pathlength options differ.  
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 Note The Internal Reference pathlength option in TQ Analyst is the same as 
the “Internal standard” pathlength option in Thermo Scientific 
QuantIR software.  
 
 

Peak Ratio 
pathlength option 

(A / b = c) 

The Peak Ratio pathlength setting allows you to use a specified peak to 
compensate for differences in sample pathlength. The Peak Ratio 
pathlength type works only when the sample spectra contain a peak 
that varies in proportion to pathlength. This pathlength option works 
for PLS, PCR and SMLR methods. 
 
When using the Peak Ratio pathlength option, you must specify an 
absorbance peak that is indicative of sample pathlength. This can be a 
peak from a known amount of a component that is added to the 
standards and unknown samples or it can be a peak that is due to the 
sample matrix. The selected peak or spectral region must respond only 
to pathlength; it cannot contain absorptions from other components or 
impurities in the sample mixture. 
 
If you need help finding a pathlength peak for a quantitative method, let 
the TQ Analyst wizard find one for you. There are several ways you can 
do this, depending on how far along you are developing your method. 
For example, if you simply want to investigate the Internal Reference 
pathlength option, use the Suggest Pathlength Wizard to recommend a 
pathlength region. The Pathlength wizard performs a statistical analysis 
of the spectral data from the standards to find the spectral peak or region 
that correlates best with variations in pathlength. Keep in mind, 
however, that the method must be fairly complete before the Pathlength 
Wizard can make a recommendation. For example, you must define the 
components, collect and identify the standards and select the spectral 
regions to be used for the analysis before the wizard can recommend a 
pathlength region. If you leave the Pathlength Type set to Peak Ratio 
and then use the Suggest Regions wizard to recommend analysis regions 
for your method, the Regions wizard will recommend a pathlength peak 
or region along with the analysis regions.  
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When the Peak Ratio pathlength option is used, the software divides all 
of the data points in all of the analysis regions for each standard by the 
pathlength reference peak before the method is calibrated. Because the 
correction is applied before calibration, the peak ratio pathlength 
correction is not described by the calibration model. This technique 
tends to mask the measurement error of the raw data and can skew the 
sample results.  
 

 Note If you need to use a pathlength peak to compensate for changing 
pathlengths, use either Internal Reference or Peak Ratio. See the 
section titled “Comparison of Internal Reference and Peak Ratio 
Pathlength Types” in Appendix B for details on how these two 
pathlength options differ.  
 

 Note You can also use the Peak Ratio pathlength type to specify the 
denominator peak in a spectral measurement method when taking the 
ratio of two measured peaks. See the section titled “Selecting the 
Analysis Regions” in the chapter on “Creating a Spectral Measurement 
Method” for instructions.   

 
 

Multiplicative 
Signal Correction 
pathlength option 

The multiplicative signal correction (MSC) pathlength option is useful 
under the following conditions: 

• The pathlengths of your standards and unknown samples vary, 

• Sample pathlength is difficult or impossible to measure accurately, 

• You can’t find a spectral peak or region that varies only with 
pathlength. 

 
The MSC pathlength setting uses a mathematical function to 
compensate for differences in pathlength. MSC works when there is a 
multiplicative contribution to the spectral signal that correlates with 
pathlength. It is assumed that the relationship between pathlength and 
its contribution to the signal absorbance is perfectly linear. MSC is 
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designed to work with spectra that also have a linear response to 
concentration, that is, spectra which are in absorbance, log (1/R) or 
Kubelka-Munk units. 
 
This allows you to analyze samples with different pathlengths when it 
is difficult or impossible to obtain an independent measure of sample 
pathlength. For example, the pathlengths of oils smeared on a metal 
surface can often be calculated this way. The MSC pathlength 
treatment may also be used to compensate for variations in sample 
thickness that are caused by particle size and scattering. These 
variations often occur in diffuse reflectance measurements, especially 
when measured in the near-infrared range.  
 
When the MSC pathlength type is selected, no additional pathlength 
information is required. Pathlength is treated as a multiplicative 
contribution to the spectral signal. The calculated pathlength function 
corrects the multiplicative contribution of the scattering due to 
pathlength. The software applies the same function to the standards 
and the unknown samples.  
 
 

Standard 
Normal Variate 

pathlength option 

The standard normal variate (SNV) pathlength option is useful under 
the following conditions: 

• The effective pathlengths of the standards and unknown samples 
vary, 

• Sample pathlength is difficult or impossible to measure accurately, 

• You can’t find a spectral peak or region that varies only with 
pathlength, 

• Scattering, due to differences in particle size for example, produced 
significant variation in the spectra of your standards. 

 
The SNV pathlength setting scales the spectral data in order to 
compensate for differences in sample pathlength. This allows you to 
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analyze samples with different effective pathlengths when it is difficult 
or impossible to obtain an independent measure of sample pathlength. 
The spectra of the standards and any unknown samples the method is 
used to analyze are all scaled independently.  
 
SNV works when there is a multiplicative contribution to the spectral 
signal, due to scattering or some other effect, that correlates with 
pathlength. It is assumed that the relationship between pathlength and 
its contribution to the signal absorbance is perfectly linear. SNV is 
designed to work with spectra that also have a linear response to 
concentration, that is, spectra which are in absorbance, log (1/R) or 
Kubelka-Munk units. 
 
You can define the region used for the SNV pathlength correction. You 
may want to limit the region used for correcting pathlengths if one or 
both ends of your spectral data tend to be quite noisy. If the noise level 
is fairly even across the spectra of the standards or samples, we 
recommend using the entire spectrum for the pathlength correction 
(default setting). For information on how to define the pathlength 
region for the SNV pathlength type, click the Pathlength tab and select 
the SNV pathlength option. Then click the Explain button on the 
TQ Analyst toolbar to open the Explain help window and click the 
Region for SNV Pathlength feature in the software.  
 
If you are creating an SMLR method, the SNV pathlength region can 
be combined with a quadratic removed baseline type for corrections 
and detrending. The SNV pathlength type removes the effects of 
scattering from the specified region and the quadratic removed baseline 
type removes additional baseline curvature.  
 
The SNV pathlength option allows you to analyze samples with 
different pathlengths when it is difficult or impossible to obtain an 
independent measure of sample pathlength and you cannot find a peak 
or region in the sample spectra that varies only with pathlength. The 
SNV technique may also be used to compensate for variations in 
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sample thickness that are caused by particle size and scattering. For 
example, the near-infrared diffuse reflectance spectra of two ground 
tablets displayed in log (1/R) units can appear quite different even 
though the tablets are made from the same materials. The differences 
are due to scattering effects from variations in particle size. The SNV 
pathlength correction can remove the effects of scattering from the 
spectral data so that chemical differences can be observed.  
 
SNV can also be used to “normalize” spectra in order to minimize the 
effects of scaling and offsets. For example, if you want to use a group of 
spectra of the same material that were measured at different 
pathlengths to define a class in a discriminant analysis method, you can 
use SNV to normalize the spectra so the pathlength variations do not 
contribute to the classification process. 
 
When the SNV pathlength type is selected, no additional pathlength 
information is required during sample analysis. Pathlength is treated as 
a multiplicative contribution to the spectral signal. For each standard 
in the method, the software computes the mean and standard deviation 
of the baseline region. Then, for each point or points in the spectral 
region, it subtracts the mean value and divides by the standard 
deviation. This places all of the standards on the same scale. The SNV 
pathlength correction is automatically applied to any unknown samples 
you use the method to analyze.  
 
The SNV pathlength correction is similar to the Multiplicative Signal 
Correction (MSC) pathlength option. However, MSC calculates an 
ideal spectrum from the calibration standards and uses it to correct the 
data, while the SNV correction removes the effects of scattering by 
normalizing the spectra individually. We recommend using SNV 
instead of MSC if you think the spectra of the unknown samples you 
want to measure may have different scattering characteristics than the 
calibration spectra, or if you are using a classification technique that 
allows multiple classes (for example, Discriminant Analysis, Search 
Standards, or QC Compare search).  
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 Note The Pathlength wizard will not suggest the SNV pathlength option.  
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 3 Using TQ Analyst Software 
 
 
 
Read this chapter to learn about the unique features of your 
TQ Analyst method development software.  
 
The following software features are introduced in this chapter: 

• TQ Analyst main window 

• Menu bar 

• Toolbar 

• Method windows 

• Tabs 

• Scroll bars 

• Action buttons 

• Method parameters 
 
You should understand how to use these features before attempting to 
create methods using TQ Analyst.  
 
 



 

74 TQ Analyst User’s Guide Thermo Fisher Scientific 

TQ Anayst window While you are using TQ Analyst, the TQ Analyst window is displayed 
on the screen. 
 

 
 

              TQ Analyst Window 
 
 
You can maximize, minimize and resize the TQ Analyst window just as 
you can other application windows that run with Microsoft® Windows® 
software. See your Microsoft Windows documentation for information 
on these standard Windows features. 
 
The TQ Analyst window is divided into three distinct parts: the menu 
bar, the toolbar and the method windows. You may also see other types 
of windows, such as task windows and spectral windows. All of these 
features are described in the sections that follow. 
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Menu bar The menu bar contains the TQ Analyst menu names.  

 

 
 
The menus provide useful commands for working with method files and 
spectral data. You will also find a menu of diagnostic commands which 
can be used to evaluate a method as you develop it. 
 
The Help menu allows you to access the software’s extensive on-line 
help system any time you need information. The Help menu provides 
links to a comprehensive list of help topics, organized by tasks, plus a 
tour of the software and a set of example methods. 
 
You can choose commands in TQ Analyst menus just as in other 
Windows applications:  by using the mouse or by typing key 
combinations on the keyboard. The key combinations are shown in the 
menus. 
 
 

Toolbar The toolbar allows you to perform the following operations with the 
current method: 
 

 
 
• The Calibrate button calibrates the method.  

• The Quantify button allows you to use the method to analyze an 
unknown sample spectrum. 

• The Explain button opens the Explain help window for context-
sensitive help with any feature of the software.  

• The Close button closes the active method or other window, such 
as a task window or spectral window. 
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To use a feature on the toolbar, click the appropriate button. 
 
The first time you calibrate a method, the software calculates a 
performance index which appears next to the Close button on the 
toolbar. The performance index is a measure of how accurately a 
calibrated method can quantify or classify the validation standards.  
 
If you change the method and then recalibrate, the toolbar shows the 
performance index from the previous calibration as well as the index 
for the new calibration.  
 

 
 

Since method development is usually an iterative process, this allows 
you to determine whether the changes you make to optimize a method 
actually improve its performance. 
 

 Note Validation standards are required to calculate the performance index. If 
your method has no validation standards, the symbol “N/A,” meaning 
“not available,” is displayed instead of a performance index.  
 
The indicator to the right of the performance index tells whether the 
selected method is calibrated. If the method has never been calibrated, 
the bar is red and the message reads “uncalibrated.” After the first 
calibration, the bar turns green and the “calibrated” message appears.  
 

 
 

If you then change something in the method that affects calibration, 
the calibration indicator turns red, letting you know that the method is 
no longer calibrated. Once you recalibrate, the indicator changes back 
to green. 
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 Note The calibration indicator updates when the method is saved on the 
computer’s hard disk.  
 

Method windows Method windows can be displayed in the main portion of the 
TQ Analyst window. A method window contains all the features needed 
to create methods for sample analysis.  
 
You can have many method windows open at the same time. To make 
an open method window active, choose its name in the Window 
menu. 
 
The main features of a method window include the tabs, scroll bar, 
action buttons and parameters. 
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Tabs The method parameters specify how your method will work. Method 
parameters are grouped by function. Each group of parameters is 
contained on a file card which has a tab that is always visible at the top 
of the method window. To display a group of parameters, click the 
corresponding tab. The file card containing the parameters is brought 
to the front. 
 

 
 
The parameters on a tabbed card work together to specify important 
features of your TQ Analyst methods. For example, the parameters on 
the Standards tab identify the spectral data files which will be used to 
create a method calibration model or classification scheme. 
 
The tabs are arranged in an order that is convenient for creating a 
TQ Analyst method. If you select the tabs in sequence from left to 
right, starting with the Description tab, they will lead you step by step 
through the method development process. 
 
 

Scroll bars A scroll bar will appear along the right side or bottom of the selected 
tab when the tab contains more features than will fit in the window. 
Click the arrow at either end of a scroll bar to move the tab’s contents 
up and down or right and left in order to bring additional features into 
view. You can also operate the scroll bar by clicking and dragging its 
scroll box. 
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Action buttons When you select a tab, one or more buttons may appear below the tab 
name. These buttons, called “action buttons,” allow you to perform 
tasks related to the selected tab. For example, the “Suggest” button 
shown in the previous illustration may be used to help you set the 
Analysis Type parameter on the Description tab. 
 

 
 
 

Method parameters The method parameters specify how the method will work. There are 
several distinct types of parameters, including text boxes, readouts, option 
buttons, check boxes, list boxes, and tables. 
 
Text boxes 
Text boxes allow you to enter information that you want to save with a 
method, such as the method title or the unit used to measure sample 
pathlength. You can also use a text box to specify a value, such as 
pathlength or component concentration. 
 
Text boxes have a white background, which indicates that their 
contents can be changed. 
 

 
 

You can select a text box by using the mouse to click in the box or by 
clicking the window and then pressing the Tab key until the desired 
text box is highlighted. Then type the text you want to enter.  
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Readouts 
A readout displays information or values provided by TQ Analyst, such 
as the version number of a method or the method’s performance index. 
Readout fields have a colored background, which indicates that their 
contents cannot be changed. 
 

 
 

Option buttons 
Some parameters, such as the Analysis Type and Pathlength Type, 
provide a group of option buttons and allow you to select only one of 
the available options.  
 

 
 

You can select an option from a group of option buttons by using the 
mouse to click the corresponding button. If you want to use the 
keyboard to select an option, tab to the option and then press the space 
bar. 
 
Check boxes 
Check boxes allow you to turn parameters on and off.  
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You can operate check boxes using a mouse or the keyboard. To turn a 
check box on or off using a mouse, click the check box. The parameter 
is on when an X appears in the box and off when the box is blank. 
 
To turn a check box on or off from the keyboard, tab to the check box 
and then press the space bar. 
 
List boxes 
List boxes allow you to select an item from a list of available options. 
To see the options in a list box, use the mouse to click the arrow next 
to the list box. Then click an item to select it. 
 

 
 

To select an item in a list box using the keyboard, tab to the list box 
and press Enter. Then use the arrow keys to select an item and press 
Enter again. 
 
Tables 
Tables help you keep data and specifications organized. For example, 
the Standards table identifies the spectral data files which will be used 
to create a calibration model or classification scheme.  
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Tables also allow easy access to the data once it has been entered. 
 

 
 

The fields in a table may be text boxes, list boxes, or buttons. 
 
You can select a text field by using the mouse to click in the field or by 
using the tab or arrow keys on the keyboard. When the field is selected, 
use the keyboard to fill in the text or enter a number. Use the mouse to 
select another cell or press the Enter key on the keyboard to select the 
next cell.  
 
To see the options in a list box that is part of a table, use the mouse to 
click the arrow next to the list box. Then click an item to select it. 
 
To use a button that is part of a table, such as the Display buttons in 
the Standards table, click the button with the mouse. To turn a button 
on and off from the keyboard, tab to the button and press the space 
bar. 
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Task windows Special task windows may be displayed for certain operations. Task 
windows often contain tables and plots of spectral and method data to 
help you make a selection or complete a procedure. For example, the 
Region Selection task window shown in the illustration below allows 
you to choose the limits and baseline of the analysis regions for the 
current method and to specify how the region and baseline will be 
measured. 
 
 

 
 

Example of Task Window 
 
 
Task windows appear on top of the current method window. To close a 
task window, click the Close button on the TQ Analyst toolbar. 
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Spectral windows TQ Analyst allows you to open and display spectral data files and work 
with displayed spectra. A spectral window is opened automatically when 
you open a spectrum or display the selected standards in your method. 
Many of the diagnostic results are also displayed in a spectral window.  
 
The illustration below shows a spectral window with the spectra of 
several standards displayed. 
 
 

 
 

Example of Spectral Window 
 
 
You may have several spectral windows open at the same time. Spectral 
windows appear on top of the current method window. Use the 
Window menu to see the windows that are currently open or to change 
the active window. To close the active spectral window, click the Close 
button on the TQ Analyst toolbar. 
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 4 Managing TQ Analyst Files 
 
 
 
The TQ Analyst File menu commands and toolbar allow you to work 
with method and spectral data files. Read this chapter to learn how to 
use the File menu and toolbar commands to create, open, save, print 
and run methods from TQ Analyst and to save a TQ Analyst spectrum 
in a file on your disk. This chapter also explains how to open and run a 
completed TQ Analyst method from other applications and to move 
method files from one computer to another. 
 
 

Creating a 
new method 

Create a new method when you want to use the software’s default 
settings as a template for the new method.  

 
 Note If you want to create a new method that is based on an existing 

method, use the Open Method command in the File menu. See 
“Opening An Existing Method” in the next section for more 
information.  
 
To create a new method based on the software’s template: 
 
Choose New Method from the File menu. 
 
The method parameters appear in a new method window, which 
automatically becomes the active window. The method file name is 
displayed in the title bar. 
 
A new method must contain valid settings for all of the method 
parameters before it can be calibrated or run. When you create a new 
method, the method parameters are automatically set to their default 
values. You can change any of the parameter settings or use the default 
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settings. See the chapters on creating TQ Analyst methods for more 
information. 
 
As with any software application, be sure to save your work while 
creating a method or editing the method parameters. For information 
on saving a method, see “Saving a Method” or “Saving a method with a 
new file name” in this chapter. 
 

 Note To create a new method by starting with an existing method, use the 
Open Method command in the File menu to open the existing method 
and then choose Save Method As from the File menu to save a copy of 
the method with a different file name.  
 
 

Opening an 
existing method 

Open an existing method when you want to view or edit the method 
or use it as a template for a new method. Many methods can be open at 
the same time. 
 
To open an existing method: 
 
1. Choose the Open Method command from the File menu.  
 
 The Open Method dialog box is displayed. 
 
 
1. Select the file you want to open from the list of available files. 
 
 If the method you want to open is not listed, select a different drive 

or directory from the Drives or Directories list boxes or select 
another file format. When you select a file name, the method’s title 
appears in the Method Title box. 

 
 TQ Analyst allows you to open methods that were saved using 

TQ Analyst (*.QNT) or methods that are in another Thermo 
Scientific format, or “file type,” such as QuantIR or Quick IR®+ 
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(Basic Quant). Both of these applications use the *.QMT and 
*.MSR extensions. To list all the files in the indicated directory, 
select All Files (*.*) from the Files of Type list box. 

 
 Note If you want to open a QuantIR or Quick IR method from TQ Analyst, 

make sure the method file and its associated spectral data files are 
stored in the same directory before using the Open Method 
command.  
 
 
2. Choose OK. 
 
 
3. If a dialog box appears prompting you to enter a password, type 

the correct password for the selected method and then choose 
OK. 

 
 The person who created the method and set up the password 

requirement determines what password must be used to reopen the 
method. 

 
The method parameters appear in a new method window, which 
automatically becomes the active window. The method file name is 
displayed in the title bar. 
 

 Note If you open a QuantIR or Quick IR®+ method from TQ Analyst, you 
must use the Save Method As command in the TQ Analyst File menu 
and enter a new file name in order to save the method on a disk. The 
original QuantIR or Quick IR+ method will not be changed.  
 
 



 

88 TQ Analyst User’s Guide Thermo Fisher Scientific 

Saving a method It is always a good practice to save your work while creating a method 
or editing the method parameters. 
 

 Note If you want to change the file name of the method, use the Save 
Method As command.  
 
To save a method: 
 
1. Select the method you want to save by clicking the method 

window or choosing the method name in the Window menu. 
 
 
2. Choose Save Method from the File menu. 
 
 If the method you are saving has a file name, the method is saved 

on the selected disk using the same name.  
 
 If the method does not have a file name, the Save Method As 

dialog box appears.  
 
 
3. If the Save Method As dialog box appears, type a file name and 

select the directory and disk where you want the method saved.  
 
 
4. When you are finished, choose OK. 

 
 The readout for Last Saved Date on the Description tab will be 

updated to show the current date and time. The Revision readout 
will be incremented by one.  

 
 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 89 

Saving a method 
with a new file 

name 

Save the current method with a new file name when you want to 
modify it but also want to keep a copy of the original method. 
 
Three files are created when you save a method with a new file name. 
All three files will use the base file name you enter. The method 
specifications are saved in the file “methodfilename.QNT.” The 
spectral data for the standards specified in the method are stored in two 
associated library files (“methodfilename.LBD” and 
“methodfilename.LBT”). 
 
To save a method with a new file name: 
 
1. Select the method you want to save by clicking the method 

window or choosing the method name in the Window menu. 
 
 
2. Choose the Save Method As command from the File menu. 
 
 The Save Method As dialog box appears.  
 
 
3. Type a file name for the method in the File Name text box. 
 
 The software automatically adds the extension “.QNT” to the end 

of the file name you enter. 
 
 
4. Select the directory and disk where you want the method saved.  
 
 
5. Choose OK. 
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Saving a method 
with a minimum 

file size 

If you run any diagnostic routines on a method after the method is 
calibrated and then save the method on a disk, the diagnostic results 
will be saved along with the method parameters and calibration results. 
To save a method with a minimum file size, save the method 
immediately after you calibrate it. 
 
Some of the sample checking features also increase the size of the 
method file. If you don’t plan to use the spectrum checks, such as the 
full spectrum check or the measurement region spectrum check, make sure 
the check boxes for these features are off (see Report tab). The check box 
for Fit Value (see Report tab) should also be off unless you want the 
full spectrum fit values or the measurement region fit values reported with 
the analysis results. See the chapter titled “Preparing a Method For 
Sample Analysis” for more information on sample checking and fit 
values.  
 
 

Opening spectra Use the Open Spectrum command in the File menu to retrieve one or 
more spectra or a group of spectra stored in spectral data files on a disk. 
When you open a spectrum, TQ Analyst displays the spectrum in the 
active spectral window or in a new spectral window if no spectral 
window currently exists. 
 

 Note Open Spectrum only displays the data in the selected spectral file. If 
you want to open a spectrum and add the spectrum to the Standards 
table, use the Open Standard button on the Standards tab instead of 
the Open Spectrum command.  
 
You can use Open Spectrum to open spectra that were saved using any 
Thermo Scientific software or spectra that are in another format, or 
“file type,” such as GRAMS386 and CSV. The file name extensions for 
the common file types are shown in the following table.  
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File Type Extension 

Spectra  .SPA 

Group of spectra  .SPG 

JCAMP-DX .JDX 

PCIR .IRD, .IFG 

Nicolet SX/DX .SPC, .NIC 

Comma-separated text .CSV 

Perkin-Elmer .SP 

Mattson .IGM, .ABS, .DRT, .SBM, .RAS 

Spectacle .IRS, .SDA, .UVD 

GRAMS386 .SPC, .GLD 

*Nicolet SX and DX files both use the Nicolet SX/DX file type. 

 

The available file types are shown in a list box in the Open dialog box.  
 

 Note You can list all the files in the indicated directory by selecting All Files 
(*.*) from the Files of Type list box in the Open dialog box.  
 
If you want to import spectra collected in another spectroscopic 
analysis program that we do not support, use that program to save the 
spectra in one of the formats listed above before attempting to import 
them into TQ Analyst.  
 
 

Saving a spectrum If you want to save a spectrum you collected in TQ Analyst as a Thermo 
Scientific spectral data file, use the View Standards button on the 
Standards tab to display the spectrum in a spectral window. Then select 
the spectrum you want to save and use the Save Spectrum As command 
in the TQ Analyst File menu to save the selected spectrum. The 
spectrum will be saved as a Thermo Scientific spectral file (*.SPA 
extension). When two or more spectra are selected in the spectral 
window, they will be saved as a Thermo Scientific spectral group 
(*.SPG extension). 
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You can also save spectra that are displayed in a TQ Analyst task 
window, such as the Region Selection or Corrections task window, by 
selecting the spectrum or spectra you want to save and then choosing 
Save Spectrum As from the File menu.  
 
 

Protecting  
a method 

You can activate a security system to keep the method parameters and 
calibration spectra safe from inadvertent or deliberate changes. A 
protected method can be opened in TQ Analyst only when the correct 
password is entered. You don’t need to enter a password to analyze a 
sample with a protected method, whether you are running the method 
from TQ Analyst or from another Thermo Scientific application, such 
as OMNIC or RESULT. 
 
To protect a method: 
 
1. Select the method you want to protect by clicking the method 

window or choosing the method name in the Window menu. 
 
 
2. Choose Save Method As from the File menu. 
 
 The Save Method As dialog box appears.  
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3. Turn on the Password check box in the Save Method As dialog 
box. 

 

  
 
 
4. Choose OK. 
 
 A dialog box appears prompting your to enter a password. 
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5. Type a password for this method and choose OK. 
 
 Another dialog box appears prompting you to confirm your 

password. 
 
 
6. Type exactly the same password a second time and choose OK. 
 

 Notice Store your passwords in a safe place! Once you close a protected 
method, you won’t be able to reopen or delete it without the correct 
password.  
 
 

Turning off 
password protection 

You can turn off password protection by resaving the method with the 
“Password” check box off. You must know the correct password in order 
to turn off password protection.  
 
To turn off password protection for a method: 
 
1. Choose Open Method from the File menu.  
 
 The Open Method dialog box is displayed. 
 
 
2. Select the file name of the method you want to change and 

choose OK. 
 
 A dialog box appears prompting you to enter the password for the 

selected method. 
 
 
3. Enter the correct password and choose OK. 
 
 The method is opened in a new method window. 
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4. Choose Save Method As from the File menu. 
 
 The Save Method As dialog box appears.  
 
 
5. Turn off the Password check box. 
 

  
 
 
6. Choose OK. 
 
 

Exporting 
data to a text file 

Use the Export to Text File command in the File menu to copy the 
contents of a table that is displayed in the active window to a 
spreadsheet or text processing application. All of the data that can be 
displayed in the selected table will be exported. For example, if a 
diagnostic task window displays data for one component at a time, the 
diagnostic results for all components will be exported. 
 
The data are displayed in an application window. If TQ Analyst locates 
Microsoft® Excel® on your computer, the data are displayed in an Excel 
application window. If the Excel application is not found, the data 
appear in a window for a text processing application, such as NotePad 
or Write. The results are formatted using the settings for the report 
parameters (see the Report tab) in the current method. 
 
You can save the displayed information in a spreadsheet file (*.XLS 
extension) or text file (*.TXT extension) or copy portions of the 
displayed data or the entire contents of the file to the Clipboard. The 
contents of the Clipboard can then be pasted into a word processing or 
other application used for generating reports. 
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Exporting 
standards to a  

text file 

Use the Standards to Text File command in the File menu to copy the 
concentration and spectral data for all of the standards in the current 
method to a spreadsheet or text file as comma-separated variables 
(.CSV file name extension).  

 
When you choose Standards to Text File, the Save As dialog box is 
displayed showing the default file name for the CSV file 
(TQDATA.CSV). You can enter a unique name for the file 
(recommended) and specify a different location or leave the default file 
name and location. When you are finished, choose Save.  
 

 Note If you leave the default file name and extension, the software will 
overwrite your data the next time you save information using the 
Standards to Text File command.  
 
Use Explorer or My Computer to locate and open the *.CSV file. If 
TQ Analyst locates Microsoft® Excel® on your computer, the data are 
displayed in an Excel application window. If the Excel application is 
not found, the data appear in a window for a text processing 
application, such as NotePad or Write.  
 
The data are saved in the following format: 
 
Concentration data 
  (Std1) (Std2) (Std3) (Std4) (Std5) (Std6) 
  A B C D E F 
0 (Usage) 0 0 1 1 1 1 
1 (comp1) 82 65 62 59 44 33 
2 (comp2) 10 19 20 21.5 28 32.5 
3 (comp3) 101 120 145 171 194 225 
 
Spectral data 
4070.03 (Freq1) -.046 -.025 0.068 0.083 0.001 0.024 
4071.96 (Freq2) 0.037 0.001 0.002 0.009 0.004 0.02 
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Row 1 of the concentration data shows how the TQ Analyst Usage 
parameter is set for each standard, where 0 = calibration, 1 = validation, 
2 = correction, and 3 = ignore. The concentration data for each 
component in each standard are provided next.  
 
The spectral information for the standards appears after the 
concentration data. Row 1 of the spectral data gives the X-axis location 
(frequency) of the first measurement and the Y-axis (intensity) value at 
that location for each standard. Rows 2 through the end of the spectral 
data show the frequency and intensity values for any additional 
measurements. 
 
 

Setting up 
the printer 

Use the Printer Setup command in the File menu to specify a printer 
and set the print parameters before you print images or information on 
paper. 
 
To set up the printer: 
 
1. Choose Printer Setup from the File menu.  
 
 The Printer Setup dialog box appears. This is a standard Windows 

dialog box. For more information on using this type of dialog box, 
see your Windows documentation.   

 
 
2. Select the printer you want to use from the list box. 
 
 You can also specify portrait or landscape page orientation. 
 

 Note The page orientation setting in Windows Control Panel or in the 
printer setup dialog box for other applications is not affected by the 
setting you make here.  
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3. If you want to set the printer parameters, click the Options 
button in the Printer Setup dialog box. If you don’t want to set 
the parameters, choose OK.  

 
 If you choose Options, a dialog box appears showing the current 

settings of the printer parameters. This is a standard Windows 
dialog box and varies in appearance depending on your printer. See 
the manuals that came with your Windows software and printer for 
complete information on setting the printer parameters. After you 
set the printer parameters, choose OK to close the dialog box, and 
then choose OK to close the Print Setup dialog box. 

 
 

Printing a method Print a method when you want a paper copy of the method parameter 
settings, table entries and calibration data. You can also print the 
contents of a spectral window or the selected task window, such as the 
Region Selection or Corrections window. 
 
To print a method: 
 
1. Select the window you want to print.  
 
 This can be a method window, a task window or a spectral window. 
 
 
2. Make sure the printer is turned on and ready. 
 
 
3. Choose the Print command from the File menu. 
 
 A Print dialog box appears allowing you to specify items such as the 

number of components to print. If you are printing a task window, 
you can also select which items in the window to print. Set the 
parameters as desired and then choose OK.  
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 If a method window was selected, a summary of the method is 
printed. If a task window was selected, the items you selected in the 
Print dialog box will be printed. 

 
 

Analyzing a sample 
from TQ Analyst 

You can analyze an unknown sample spectrum using any TQ Analyst 
method without quitting the TQ Analyst software. The method must 
be calibrated before it can be used to analyze a sample spectrum.  
 
The sample spectrum must be stored in a spectral data file before it can 
be analyzed. A large number of Thermo Scientific and other file 
formats are accepted.  
 
The file name extensions for the common file types that can be selected 
for analysis are shown in the following table.  
 

File Type Extension 

Spectra  .SPA 

Group of spectra  .SPG 

JCAMP-DX .JDX 

PCIR .IRD, .IFG 

*Nicolet SX/DX .SPC, .NIC 

Comma-separated text .CSV 

Perkin-Elmer .SP 

Mattson .IGM, .ABS, .DRT, .SBM, .RAS 

Spectacle .IRS, .SDA, .UVD 

GRAMS386 .SPC, .GLD 

*Nicolet SX and DX files both use the Nicolet SX/DX file type. 

 



 

100 TQ Analyst User’s Guide Thermo Fisher Scientific 

 Note If you want to analyze multiple samples from TQ Analyst and send the 
results to a spreadsheet or text file, use the Multiple Quantify 
command in the Diagnostics menu. See the next section for more 
information.  
 
To analyze a sample from TQ Analyst: 
 
1. Select the method you want to run by clicking the method 

window or choosing the method name in the Window menu. 
 
 
2. Click the Quantify button on the TQ Analyst toolbar. 
 
 The Open Spectrum dialog box is displayed. 
 
 
3. Select a spectral data file and choose OK.  
 

You can select spectra that were saved using any Thermo Scientific 
software or spectra that are in another format, or “file type,” such as 
GRAMS386 and CSV. Use the Files of Type list box to select a 
specific file type, or choose “All Files” to see all the files in the 
current directory. 

 
 Note If a warning message about mismatched parameters appears when you 

select a spectrum to quantify, the parameter settings used to collect the 
sample spectrum are significantly different from the settings that are 
saved with the current method. For optimum performance, all 
standards and samples should be collected using the same settings for 
the collection parameters. You can deal with the warning three ways: 
collect the spectrum again using the proper settings for the collection 
parameters, edit the settings in the current method or ignore the 
warning and continue analyzing samples.  
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 TQ Analyst begins analyzing the spectrum you selected using the 
current method. Depending on how the method parameters are set, 
you may be prompted to enter needed information, such as a 
pathlength value. Follow the instructions that appear on the screen.  

 
 When the analysis is finished, a dialog box appears showing the 

results. If the current method is for quantitative analysis (see the 
Analysis Type parameter on the Description tab), the results will 
indicate the concentrations of the specified components in each 
sample.  
 

 
 

If the method is designed to classify the unknown sample spectrum 
based on a set of known spectra, the names and match values of the 
reported spectra will be provided.  
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A peak height or peak area may be reported if the method is set up 
to make simple measurements of the spectra that are quantified. 
 

 
 

Depending on how the parameters on the Report tab are set, the 
results may contain additional information, such as the titles and 
file names of the method and the spectra that are quantified.  
 

 If a problem occurred during the analysis, a warning may be 
printed with the analysis results. The parameters that produce the 
warnings are also included on the Report tab. Press the Explain 
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button when the Report tab is displayed for instructions on 
interpreting warnings. 
 

 Note You can print the contents of the Quantify dialog box by clicking the 
Print button in the dialog box.   
 
 
4. Click the arrows on the scroll bar or move the scroll box to 

bring each portion of the table of results into view. 
 
 
5. When you are finished viewing the analysis results, choose OK 

to close the dialog box. 
 
 

Analyzing 
multiple samples 
from TQ Analyst 

If you want to analyze a group of samples from TQ Analyst, use the 
Multiple Quantify command from the Diagnostics menu. When you 
use Multiple Quantify, the analysis results are placed in a spreadsheet 
(Microsoft® Excel®) or text file.  

 
You can run Multiple Quantify on any TQ Analyst method. The 
method must be calibrated before Multiple Quantify can be used. 
 
You can select one or more spectral data files to be quantified or select 
an input file that lists the file names of the spectra to be quantified. A 
large number of Thermo Scientific and other file formats are accepted. 
The file name extensions for the common file types that can be analyzed 
using Multiple Quantify are shown in the following table.  
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File Type Extension 

Spectra  .SPA 

Group of spectra  .SPG 

JCAMP-DX .JDX 

PCIR .IRD, .IFG 

Nicolet SX/DX .SPC, .NIC 

Comma-separated text .CSV 

Perkin-Elmer .SP 

Mattson .IGM, .ABS, .DRT, .SBM, .RAS 

Spectacle .IRS, .SDA, .UVD 

GRAMS386 .SPC, .GLD 

*Nicolet SX and DX files both use the Nicolet SX/DX file type. 

 

To analyze multiple samples from TQ Analyst: 
 

1. Select the method you want to run by clicking the method 
window or choosing the method name in the Window menu. 
 
 

2. Choose Multiple Quantify from the Diagnostics menu. 
 

 The Open dialog box is displayed. 
 
 

3. Select the spectral data files you want to quantify or select an 
input file. 
 
You can select spectra that were saved using any Thermo Scientific 
software or spectra that are in another format, or “file type,” such as 
GRAMS386 and CSV. Use the Files of Type list box to select a 
specific file type, or choose “All Files” to see all the files in the 
current directory. You may need to change directories or drives to 
locate the files you want to analyze.  
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• To select one or more spectral files to be quantified, set the Files 
of Type list box to “.SPA.” Then select the spectral data files you 
want to quantify and choose OK. To select more than one file, 
select the first file you want to include and then hold down the 
Control key while you click any additional file names. 

 
• If you want to select a spectral group file, set the Files of Type 

list box to “.SPG.” Then select the spectral group file you want 
to quantify and choose OK. 

 
• If you want to quantify a series of spectral files that are listed in a 

text file, change the Files of Type list box to “TXT.” Then select 
the text file that contains the list of file names.  

 
 Note The input file must be formatted properly for use with Multiply 

Quantify. For information on formatting the input file, refer to the 
Method Diagnostics chapter in this document.  
 
 
4. Click OK to begin the analysis.  
 
 Depending on how the method parameters are set, you may be 

prompted to enter needed information, such as a pathlength value. 
Follow the instructions that appear on the screen. (If you are 
quantifying spectral files that are listed in an input file and the file 
includes any additional information that is required for the 
analysis, these prompts will not appear.)  

 
 When the analysis is finished, the results are displayed in an 

application window. If TQ Analyst locates the Microsoft® Excel® 
spreadsheet application on your computer, the data are displayed in 
an Excel application window. If Excel is not found, the data appear 
in a window for a text processing application, such as NotePad or 
Write. The results are formatted using the settings for the report 
parameters (see the Report tab) in the current method.  
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 If you close the result window, the data will be saved in the file 

QUANTIFY.TXT (or QUANTIFY.XLS).  
 

 Notice The contents of the file QUANTIFY.TXT (or QUANTIFY.XLS) will 
be overwritten the next time you use Multiple Quantify. If you want to 
keep your analysis results, use the Save As command to save them with a 
new file name.   
 
 

Running TQ Analyst 
methods from 

other applications 

TQ Analyst is designed to work hand-in-hand with your Thermo 
Scientific spectral analysis software, such as OMNIC®, ECO®, Integra®, 
and RESULT™. When you are ready to use a TQ Analyst method for 
repeated sample analysis, review the procedures described here. If you 
need help, look in the documentation that came with your Thermo 
Scientific spectral analysis software for more information.  
 
 

Running a 
method from OMNIC 

OMNIC is Thermo Scientific general-purpose software package for 
collecting and analyzing spectral data. You can use the commands in 
the OMNIC Analyze menu to quickly open and run a TQ Analyst 
method. See the procedure below for specific instructions.  
 

 Note If you need help using an OMNIC command, see your OMNIC on-
line help.  
 
To run a TQ Analyst method from OMNIC: 
 
1. Start the OMNIC application. 
 

2. Choose Quant Setup from the OMNIC Analyze menu. 
 
 The Open Method dialog box appears on the display.  
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3. Select a TQ Analyst method file and choose OK.  
 
 When you select a method, the name of the application that was 

used to create the method appears in the Origin box. The title of 
the selected method appears in the Method Title box. TQ Analyst 
method files have a “.QNT” extension.  

 

4. If you need to collect the spectrum to be quantified, turn on the 
Collect and Bench check boxes in the Parameter group.  

 
 When these check boxes are on, OMNIC resets the parameters on 

the Collect and Bench tabs in the OMNIC Experiment Setup 
dialog box to match the settings in the selected TQ Analyst 
method. This ensures that the spectra of the unknown samples will 
be collected using the parameter settings that were used to collect 
the method’s calibration spectra.  

 
 Note If you turn on the Collect and Bench check boxes in the Parameter 

group, TQ Analyst will overwrite the Collect and Bench parameter 
settings in your OMNIC software. Leave the Collect and Bench check 
boxes off if you want to use the settings in your OMNIC software to 
collect the spectrum you want to quantify.  
 

5. Click OK to close the Open Method dialog box. 
 

6. Use the commands in the OMNIC Collect menu to collect a 
sample spectrum or open a spectral data file that is stored on a 
disk.  

 

7. Select the displayed spectrum.  
 

8. Choose Quantify from the OMNIC Analyze menu. 
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 The spectrum is then analyzed using the selected method. 
Depending on how the method parameters are set, you may be 
prompted to enter needed information, such as a pathlength value. 
Follow the instructions that appear on the screen.  

 
 When the analysis is finished, a dialog box appears showing the 

results. If the current method is for quantitative analysis, the results 
will indicate the concentrations of the specified components in 
each sample as shown in the example below.  

 

  
 

The quantify dialog boxes that show up in OMNIC are the same as 
the TQ Analyst quantify dialogs. See the section titled “Analyzing a 
Sample From TQ Analyst” in this chapter for more examples of the 
quantify dialog boxes.  

 
 Note You can print the contents of the Quantify dialog box by clicking the 

Print button in the dialog box.  
 

9. Click the arrows on the scroll bar or move the scroll box to 
bring each portion of the table of results into view. 

 

10. When you are finished viewing the analysis results, choose OK 
to close the dialog box. 
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See your OMNIC documentation if you need more information about 
running quantitative or other methods from OMNIC.  
 
 

Running methods  
from other Thermo 

Scientific applications 

We sell application-specific software, such as ECO, Integra and 
RESULT, that are fully compatible with TQ Analyst. The procedure for 
running a TQ Analyst method is different for each application. See the 
documentation that came with your application-specific spectral 
analysis software for details on analyzing samples using a TQ Analyst 
method.  
 

Moving method files 
to another computer 

TQ Analyst method files can be moved from one computer to another 
and then run without recalibration. This enables you to develop 
methods on one computer and run the methods on one or several other 
computers. Depending on your requirements for calibration transfer, 
the procedure may range from simply copying the proper files to 
rigorous testing and validation.  
 
This section describes how to move a method by copying the 
appropriate method file and moving it to the new computer. In some 
cases, you will also need to copy the method’s standards library to the 
new computer.  
 
To move a method in order to edit or run the method in the new 
location, copy the files listed below to the new computer. The files can 
be placed in any subdirectory. 
 
• The TQ Analyst method file (.QNT extension). 

• The standards library that is associated with the method. The 
standards library is contained in two files which have the same base 
name as the method (methodfilename.LBD and 
methodfilename.LBT). The library files must be placed in the same 
directory as their associated method. 
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 Note Spectral measurement methods do not have a standards library. To 
transfer these methods, you need to copy only the method (.QNT) 
file.  
 
To move a method in order to run (but not edit) the method in the 
new location, copy the files listed below to the new computer. The files 
can be placed in any subdirectory. In most cases, these minimum 
requirements will allow you to run the method on the new computer 
but not edit the method or update its calibration files.  
 
• The TQ Analyst method file (.QNT extension). 

• If you are moving a Search Standards or QC Compare search 
method, the library files that are associated with the method (.LBD 
and .LBT extensions) must also be copied onto the new computer. 
The library files are also required if you are moving a discriminant 
analysis method and you want to calculate fit values or use the 
sample checking features during sample analysis (see the Report tab). 
The library files must be placed in the same directory as their 
associated method. 

 
 Note If you move a Search Standards or QC Compare search method to 

another computer, you will be able to run and edit the method in the 
new location. There is no way to protect these methods from changes 
because the entire standards library is required in order to run the 
method.  
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 5 Managing TQ Analyst Windows 
 
 
 
The TQ Analyst Window menu commands and toolbar can be used to 
manipulate TQ Analyst windows, such as method and spectral windows. 
This chapter describes how to use these tools to create, display, select, 
rearrange and close TQ Analyst windows. 
 
The main portion of the TQ Analyst window may be used to display 
method windows, task windows, and spectral windows. Many windows 
can be displayed on the screen at once. The exact number depends on 
the amount of memory in your computer. 
 
You can maximize, minimize and resize a method window, task 
window, or spectral window just as you can the TQ Analyst window. 
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Method windows A method window contains all of the parameters and functions needed 
to create a TQ Analyst method. The method parameters specify how the 
method will work.  
 
 

 
 
 
 
 

To see descriptions of the 
parameters in the active 

method window, click the 
Explain button on the 

toolbar to open the Explain 
help window. Then click 
the tab that contains the 
parameter and click the 

parameter name. 

 

Method Window 
 
 
Method parameters are grouped by function. Each group of parameters 
is contained on a file card which has a tab that is always visible at the 
top of the method window. To display a group of parameters, click the 
corresponding tab. The file card containing the parameters is brought 
to the front. 
 
Use the scroll bar at the right edge of the method window to scroll 
additional parameters into view. 
 
 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 113 

Task windows Special task windows are available on several of the method tabs and all 
of the diagnostic displays. The task windows often contain tables and 
plots of spectral and method data to help you make a selection or 
complete a procedure. For example, the Region Selection task window 
shown in the illustration below allows you to choose the limits and 
baseline of the analysis regions for a method and to specify how the 
region and baseline will be measured. 
 

 
 
 

To see descriptions of the 
features in a task window, 

click the Explain button on 
the toolbar to open the 

Explain help window and 
then click the feature.  

 
 
 

For step-by-step 
instructions on completing 
the task (selecting regions, 

for example), click the How 
To button in the task 

window. 

 
 

Task Window 
 
You can save spectra that are displayed in a task window, such as the 
Region Selection or Corrections task window, by selecting the spectrum 
or spectra you want to save and then choosing Save Spectrum As from 
the File menu. See “Saving a Spectrum” in the chapter on File 
Management for more information. 
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If the task window contains a table of data, you can use the Export to 
Text File command in the File menu to copy the contents of the table 
to a spreadsheet or text processing application. All of the data that can 
be displayed in the selected table will be exported. For example, if a 
diagnostic task window displays data for one component at a time, the 
diagnostic results for all components will be exported. See “Exporting 
Data to a Text File” in the chapter on File Management for more 
information. 
 

Spectral windows TQ Analyst allows you to open and display spectral data files and work 
with displayed spectra. A spectral window is opened automatically when 
you open a spectrum or display the selected standards in your method. 
The illustration below shows the spectral window with several spectra 
displayed. 
 
 

Use the commands in the View 
menu to rearrange the 

displayed spectra. The View 
menu becomes active whenever 
a spectral window is displayed. 

For information on a 
command in the View menu, 

click the menu name and then 
use the up or down arrow key 

on the keyboard to select a 
command in the open menu. 

Press the F1 key on the 
keyboard to display help 

information on the selected 
command. When you are 
finished reading the Help 

information, close the Help 
window by choosing Exit from 

the File menu. 
 

 
Spectral Window 
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Spectral windows let you view several kinds of spectral data, such as 
spectra you have collected or processed or the results from a diagnostic 
analysis. The previous illustration shows a spectral window containing 
several spectra and identifies the main parts of the window. Each of 
these items is explained briefly in the sections that follow. 
 
You can use the mouse to select a displayed spectrum and any of the 
commands in the View menu to rearrange the spectra in the window. 
When a spectrum is selected, it is displayed in red in the spectral 
window. 
 
The View menu becomes active whenever a spectral window is 
displayed. For information on a command in the View menu, click the 
menu name and then use the up or down arrow key on the keyboard to 
select a command in the open menu. Press the F1 key on the keyboard 
to display help information on the selected command. When you are 
finished reading Help information, close the Help window by choosing 
Exit from the File menu. 
 
You can customize the way TQ Analyst displays spectral data by setting 
the View and Window options. Use the Options command in the Edit 
menu to display the Options dialog box. Click the General tab and 
then click the General Options button. Click the View tab to see the 
View options or click the Window tab to see the Window options. 
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Title box 
 

 

The title box near the top of a spectral window shows the title of the 
spectrum that was last selected or that is currently selected. If two 
spectra are selected, the title in the title box changes to "Two spectra 
selected." If more than two spectra are selected, "Multiple spectra 
selected" appears in the title box.  
 
You can use the title box to perform the following operations. 

• Display a list of spectrum titles. 

• Select listed spectra. 

• Deselect a listed spectrum. 

• Select a different spectrum using the arrow keys. 

• Change the title of the selected spectrum. 

To remove the list of spectra, press Tab or Enter on the keyboard or 
simply click outside the title box. The currently selected spectra remain 
selected. 
 
 

Collection and 
Processing Information 

 
 

To see information about how the selected spectrum was collected and 
processed, click the Information button (labeled "i") to the left of the 
title box or double-click the spectrum's title in the title box. To see 
information about a spectrum that is not selected, first click the arrow 
to the right of the title box to display the list of spectrum titles and then 
double-click the title of the spectrum. The Collection And Processing 
Information window appears showing parameter settings and other 
information about the spectrum.  
 
You can perform the following operations within the Collection And 
Processing Information window.  

• Edit text in the Title, Comments, Custom Info 1 or Custom Info 2 
boxes 

• Copy information to the Clipboard 
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• Print information 

• Enter custom information to be printed later  
If you plan to print the spectrum, you can specify one or two pieces 
of information to be printed with it by typing the information in 
the Custom Info 1 and Custom Info 2 text boxes in the Collection 
And Processing Information window. Show Info Box must be 
turned on in the Print options (available through Options in the 
Edit menu) for this information to be printed. 

 
When you are finished using the Collection And Processing 
Information window, close it by choosing Close. If you don't want to 
save the changes you made to the information, choose Cancel. 
 
 

Axes 

 
 

Along the bottom and left side of a pane (or panes) in a spectral window 
are the X-axis and Y-axis. The scale and display limits of the X-axis 
depend on the spectral region you are displaying. If you display a 
different region by using the view finder or selection tool, the X-axis is 
automatically adjusted for the new region. 
 
For FT-IR applications in the mid-infrared range, the most commonly 
used X-axis units are the wavenumber (cm-1) and the micrometer (µm). 
Near-IR data are typically displayed in wavenumber or wavelength. You 
can specify the unit by using Display Setup in the View menu. 
 

 Note The scale of the X-axis is usually uniform across the spectrum. 
Sometimes, however, it is easier to see important peaks if a different X-
axis scale is used for different regions. Use Display Setup in the View 
menu to split the X-axis into two or three sections, each with a 
different scale.  
 
The unit used for the Y-axis depends on the final format used when the 
spectrum was collected and whether you have converted the spectrum 
to another format. You can set the initial Y-axis unit for collected 
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spectra by setting Final Format in the collection parameters (click the 
Collection Parameters button on the Standards Tab).  
 
The "Scale" commands and Display Limits in the View menu let you 
adjust the Y-axis scale.  
 
 

View Finder 
 

 

The view finder lets you adjust the display of all the spectra in a spectral 
window or task window to show a larger or smaller spectral region or a 
different region of the same size.  

The view finder contains a small image of the entire selected spectrum, 
regardless of which region of the spectrum is currently displayed. If 
more than one spectrum is selected in a spectral window, an image of 
the last spectrum selected appears in the view finder. If no spectrum is 
selected, the view finder is empty. 
 
If more than one spectrum is displayed in a spectral window, the 
horizontal range of the view finder encompasses the ranges of all the 
spectra. The currently displayed spectral region is indicated by the 
region markers, the blue vertical lines within the view finder.  
 
The next few sections provide information on using the view finder to 
adjust the display. 
 
 

Expanding or 
contracting the display 

To expand all the spectra horizontally about the center of the pane, 
click the top half of the view finder's Expand/Contract button. To 
contract the spectra horizontally about the center, click the bottom half 
of the button. You can press and hold down the mouse button during 
these operations to continuously expand or contract the display. 
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Displaying a 
different spectral region 

of the same size 

There are three ways to use the view finder to display a different spectral 
region of the same size: 

• To move your view of the spectrum to the right ("roll" to the right), 
click the top half of the Roll button.  

• To roll to the left, click the bottom half of the button. You can 
press and hold down the mouse button during these operations to 
roll continuously to the right or left. 

• Point anywhere between the region markers, press and hold down 
the mouse button, drag the markers to the desired location and 
then release the mouse button. 

• Click to the left of the left region marker or to the right of the right 
region marker. Whenever possible, the new displayed region will be 
centered on the location you clicked. The markers will move so 
that the clicked location is halfway between the markers. 

 
 

Changing the display limits 
by moving the region 

markers 

Drag a marker in the view finder left or right to the desired location. 
The current X values of both markers appear in a box above the view 
finder while you drag the marker.  

 
 

Displaying 
the entire spectrum 

Double-click between the region markers in the view finder to display 
the entire spectrum. 
 
 

Palette The palette of a spectral window contains six tools that allow you to 
perform the operations described in the table below. The palette is 
located in the lower-left corner of every spectral window and the 
windows that appear during data collection. The names and appearance 
of the palette tools indicate their functions. 
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To do this... Use this tool...  

Select items on the screen.  selection tool 

Expand or contract a spectrum.  selection tool 

Move an overlaid spectrum up or 
down within its pane.  selection tool 

Move a stacked spectrum into another 
pane.  selection tool 

Drag a spectrum into another spectral 
window.  selection tool 

Select annotations to be deleted.  selection tool 

Select a region of a spectrum or measure  
the uncorrected area of a region.  region tool 

Display X and Y values of points.  spectral cursor tool 

Measure the height of a peak.  peak height tool 

Measure the area under a peak.  peak area tool 

Label spectral features.  annotation tool 

Add text to be displayed or printed.  annotation tool 

Move sampling information or annotations.  annotation tool 

 
 
Only one tool can be used at a time. To use a tool, select it by moving 
the mouse pointer over the tool and clicking. The selected tool is 
highlighted on the screen. A tool remains selected until you select 
another tool. 
 
If you have selected any tool except the selection tool, when you move 
the pointer into a pane, a symbol representing the tool appears next to 
the pointer arrow to help you identify the tool being used.  
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When you use a tool, the readout above the palette may display 
information for the tool operation; for example, the X and Y values of 
the pointer location or the limits of the selected spectral region. To 
display the name of a tool on the palette, point to the tool and wait a 
moment. 
 
 

Creating a new 
method window 

A new method window is created when you perform the following 
operations: 

• Open a method that is stored on a disk. 

• Choose New Method from the TQ Analyst File menu. 
 
To close a method window, click the Close button on the TQ Analyst 
toolbar. 
 
If you make any changes to the parameters in a method window and 
then close the window, a message will appear asking whether to save 
the changes. Choose Yes to save the changes or choose No to close the 
window without saving. If you decide not to close the method window, 
choose Cancel. 
 
 

Displaying 
task windows 

To display a task window (if one exists) for a method tab, select the tab 
and then click the Edit button below the tab name. You can display the 
Region Selection task window, for example, by selecting the Regions 
tab and then clicking the Edit Regions button.  
 
A diagnostic task window can be displayed by choosing the diagnostic 
command from the Diagnostics menu. 
 
To close a task window, click the Close button on the TQ Analyst 
toolbar.  
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Displaying a 
spectral window 

A spectral window is opened automatically when you open a spectrum or 
display the selected standards in your method. All of the standards you 
select for display will appear in the same spectral window.  
 
To close the active spectral window, click the Close button on the 
TQ Analyst toolbar. All of the displayed spectra will be cleared from the 
spectral window when you close it. 
 
 

Displaying 
collect windows 

When you collect a spectrum in TQ Analyst, the collected data are 
displayed in the Collect Sample or Collect Background window. These 
windows operate the same in TQ Analyst as they do in Thermo 
Scientific general-purpose spectral analysis applications, such as 
OMNIC. See the documentation that came with your spectral analysis 
software for details about the collect windows. 
 
 

About the 
active window 

Only one window can be active at a time. To make a window active, 
click anywhere within it or choose the window name from the 
Window menu. 
 
When a window is active, its title bar is displayed in the color you 
specify using the Windows Control Panel. (See your Windows 
documentation for information on using Control Panel.) 
 

 Note When the active window is maximized, it shares its title with the 
TQ Analyst window. This is how the TQ Analyst window is configured 
when you open the application.  
 
 

Selecting  
a window 

The title of every open window is listed at the bottom of the Window 
menu. You can select one of these windows by choosing its title from 
the Window menu. 
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Resizing  
a window 

You can resize the active window by dragging one of its borders or 
corners or by clicking the Maximize or Restore button. 

 
 Note When the active window is maximized, it shares a title bar with the 

TQ Analyst window. This is how the TQ Analyst window is configured 
when you open the application.  
 
 

Tiling the 
open windows 

Use the Tile Windows command in the Window menu to resize and 
rearrange all the displayed windows so that they fit inside the 
TQ Analyst window without overlapping, like floor tiles. (Minimized 
windows and windows opened using other applications are not tiled.) 
The next illustration shows the TQ Analyst window with two method 
windows that are tiled.  

 

 

Tiled Method Windows 
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Tiling windows lets you easily move between windows when there are 
many windows on the screen. 
 

 Note If any windows have been minimized and appear as icons inside the 
TQ Analyst window, space will be left at the bottom of the TQ Analyst 
window to display these icons after the other windows are tiled.  
 
 

Cascading the 
open windows 

Use the Cascade Windows command in the Window menu to resize 
and layer all the windows and arrange them within the TQ Analyst 
workspace so that their title bars are visible. The illustration below 
shows three method windows that are cascaded.  
 
 

 
 

Cascaded Method Windows 
 
 

 Note If any windows have been minimized and appear as icons inside the 
TQ Analyst window, space will be left at the bottom of the TQ Analyst 
window to display these icons after the other windows are cascaded.  
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Closing the 
active window 

Use the Close button on the toolbar to close the current method 
window, task window, or spectral window. If you changed anything in 
the active window without saving your changes, a prompt will appear 
asking if you want to save the changes. Choose Yes to save the changes 
you made to the window or choose No to close the window without 
saving. If you decide to keep the window open, choose Cancel. 
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 6 Working with Standards 
 
 
You can use the tools on the Standards tab to open, collect and 
manipulate the spectra of the standards in a quantitative or classification 
method. Standards are known samples that are used to create the 
method calibration model or classification scheme.  
 
This chapter describes how to use the tools in TQ Analyst to: 

• Customize the format of the Standards table. 

• Sort the entries in the Standards table. 

• Open or collect a spectrum to use as a standard. 

• Collect a background spectrum 

• Replace the spectrum for a standard. 

• Delete a standard. 

• Display the spectrum of a standard and work with the displayed 
spectra. 

• Displaying the processed version of a standard 

• Choose the standards for a quantitative method. 

• Evaluate the standards in a quantitative method. 

• Identify and eliminate unnecessary standards in a quantitative 
method. 

• Merge standards that are essentially the same. 

• Restrict the Y-axis range. 
 
If you are interested in using TQ Analyst to create methods that only 
measure spectral features in a series of spectra, you can skip this 
chapter. Standards are not used in measurement methods. See the 
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chapter on “Creating a Spectral Measurement Method” in this 
document for more information. 
 
 

Standards tab All of the software functions that deal with selecting, evaluating, 
measuring and displaying the standards that will be used in a 
TQ Analyst method are provided on the Standards tab. To display 
these features, click the tab labeled “Standards” in the TQ Analyst 
window. 
 
 

 
 

TQ Analyst Window 
 
 

Standards table The Standards table displays all of the standards in the current method 
and shows how they are used in the method. If the method has no 
standards, the Standards table will be blank.  
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The spectrum title should contain unique, identifying information that 
allows you to match the spectrum with the material that was measured.  
 
The Usage column shows how each standard is used in the method. 
The options presented in the Usage drop-down list box depend on the 
current setting for Analysis Type (Description tab). For example, if 
Analysis Type is set to a quantitative technique, Usage can be set to 
Calibration, Validation, Correction, or Ignore. Calibration standards 
are used to create the method calibration model and correction curve if 
one is specified. The software uses validation standards to calculate the 
performance index after the method is calibrated. Correction standards 
are used along with the calibration standards to create a correction 
curve, if one is specified. Standards that have their Usage set to 
“Ignore” are excluded from the method. 
 
If you are creating a Discriminant Analysis or QC Compare search 
method, the Usage can be set to Calibration, Validation, or Ignore. 
Similarity Match and Search Standards methods can have the Usage set 
to Calibration or Ignore. 
 
If you are creating a quantitative method, the component columns 
show the concentration of each component in each standard. The Class 
column in a classification method shows the name of the group (class) 
that each standard is assigned to. 
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Customizing the format 
of the Standards table 

You can specify whether the standards that are listed in the Standards 
table will be identified by the file names or the titles of the 
corresponding spectra or both. 
 
To specify that the file names of the spectra will be listed in the 
Standards table, click the check box for Show Spectrum File Names on 
the Standards tab. If you want to see the titles of the spectra, click the 
check box for Show Spectrum Titles. When one or both of these check 
boxes are on, columns are added to the Standards table showing the file 
names and/or titles of the spectra for the standards. 
 

 Note File names will only be displayed for spectra that were opened using 
the Open Standard button on the Standards tab. Spectra that are 
collected in TQ Analyst are saved automatically in the standards library 
that is associated with the current method. As a result, these standards 
do not have individual file names. In addition, standards that are 
opened from a spectral group (.SPG) file will not save file names.  
 
 

Sorting the entries 
in the Standards table 

Use the Sort Standards button to rearrange the entries in the Standards 
table. You can sort the entries based on index number, file name, 
spectrum title, class, usage, or the concentration of a measured 
component.  
 
To sort the entries in the Standards table, click once on the column 
heading for the property you want the sort to be based on and then 
click the Sort Standards button at the top of the Standards tab. For 
example, to sort based on class, click the column heading labeled 
“Class” and then click Sort Standards.  
 
If you are viewing a quantitative method, you can sort by index 
number, file name, spectrum title, component concentration, and 
usage (calibration, validation, correction, or ignore). Classification 
methods can be sorted by index number, file name, spectrum title, 
usage, and class. 
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When the entries are sorted by index number, the software arranges the 
standards in the order they were added to the method. Sorting by file 
name or title places the entries in alphabetical order. Sorting by usage 
places calibration standards first, followed by validation standards and 
then correction standards. Standards that are designated “Ignore” are 
placed last. Sorting the standards by component concentration places 
the standard with the lowest concentration of the selected component 
at the top of the list and the standard with the highest concentration at 
the bottom of the list. Sorting by class places the entries in alphabetical 
order by class name. 
 
 

Opening a spectrum 
to use as a standard 

You can open spectra that are stored on a disk and add them to the 
Standards table for the current method or replace an existing standard. 
This can be accomplished in a single step by using the Open Standard 
button on the Standards tab. 
 

 Note If you simply want to open a spectrum and display it in a spectral 
window, use the Open Spectrum command in the File menu rather 
than the Open Standard button on the Standards tab.  
 
If you use stored spectra as standards, make sure all of the spectra were 
collected using the same settings for the data collection parameters. You 
should also use these same parameter settings to collect the spectra you 
want to quantify with this method. Using consistent parameter settings 
helps minimize differences in the spectra which are due to variations in 
sampling technique rather than to differences in sample composition 
and will improve the accuracy of your analysis. 
 
You can use Open Standard to open spectra that were saved in the 
standard Thermo Scientific format (*.SPA and *.SPG), or spectra that 
are in another format, or "file type," such as GRAMS386 or JCAMP-
DX. The file name extensions for the commonly used file types are 
shown in the following table. 
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File Type Extension 

Spectra  .SPA 

Group of spectra  .SPG 

JCAMP-DX .JDX 

PCIR .IRD, .IFG 

Nicolet SX/DX .SPC, .NIC 

Comma-separated text .CSV 

Perkin-Elmer .SP 

Mattson .IGM, .ABS, .DRT, .SBM, .RAS 

Spectacle .IRS, .SDA, .UVD 

GRAMS386 .SPC, .GLD 

*Nicolet SX and DX files both use the Nicolet SX/DX file type. 

 
If you want to import spectra collected in another spectroscopic 
analysis program that we don’t support, use that program to save the 
spectra in one of the formats listed above before attempting to import 
them into TQ Analyst.  
 
The available file types are shown in a drop-down list box in the Open 
dialog box.   
 

 Note You can list all the files in the indicated directory by selecting All Files 
(*.*) from the Files of Type drop-down list box.  
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To open a spectrum to use as a standard: 
 
1. Select a row in the Standards table. 
 

To add a standard, click anywhere in the open row at the bottom 
of the Standards table. If you want to replace a standard, click the 
row that contains the standard you want to replace. 

 
 
2. Click the Open Standard button on the Standards tab. 
 
 The Open dialog box is displayed. 
 
 
3. Select the spectral data file(s) you want to open from the list of 

available files.  
 
 If the spectrum you want to open is not listed, select a different 

drive or directory from the Drives or Directories list boxes or select 
another file format. When you select a file name, the spectrum’s 
title appears in the Title box and a condensed version of the 
spectrum itself appears below the title.  

 
 TQ Analyst allows you to open spectra that were saved using 

TQ Analyst or spectra that are in another format, or “file type,” 
such as GRAMS386 or JCAMP-DX. To list all the files in the 
indicated directory, select All Files (*.*) from the Files of Type 
drop-down list box. 
 
 

4. Click OK. 
 
 The spectrum is added to the list of standards and saved in the 

method standards library. If this is the first standard in your 
method, the data collection parameters in the current method will be 



 

134 TQ Analyst User’s Guide Thermo Fisher Scientific 

set automatically to match the settings that were used to collect the 
spectrum you opened. 

 
 If you selected multiple spectra to open or opened a spectral group 

(.SPG) file, all of the selected spectra will be added to the end of 
the Standards table. New rows are added to the table to 
accommodate the number of standards in the group. 

 
 Note If a warning message about mismatched standards appears when you 

open additional standards, the parameter settings used to collect the 
new standard are significantly different from the settings that are saved 
with the current method. For optimum performance, all method 
standards should be collected using the same settings for the collection 
parameters. You can deal with the warning three ways: collect the 
standard again using the proper settings for the collection parameters, 
edit the settings in the current method, or ignore the warning and 
continue adding standards.  
 
 

Collecting a 
spectrum to use as a 

standard 

If data collection is enabled, you can collect the spectrum of a standard 
and add the spectrum to the Standards table directly from TQ Analyst. 
This section explains how to use the Collection Parameters and Collect 
Standards buttons on the Standards tab to set the collection parameters 
and collect the spectrum of a new standard. The collection parameters 
define the collection process and configure the spectral display. 
 

 Note Access to the data collection features of TQ Analyst can be controlled 
by some Thermo Scientific spectral analysis applications, such as 
RESULT. When data collection is disabled, the Collect Standard, 
Collection Parameters and Collect Background buttons are removed 
from the Standards tab. The Collect Standard feature of the Assess 
Feasibility wizard also becomes unavailable. If these features are not 
available in your TQ Analyst application, data collection is disabled 
and you must use your spectral analysis application to collect standards. 
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Skip to the sections on importing calibration spectra and concentration 
data later in this chapter.  
 
 

Optimizing the 
collection parameters 

All of the spectra of the standards in your method should be collected 
using the same settings for the collection parameters. You should also 
use these same parameter settings to collect the spectra you want to 
quantify with this method. Using consistent parameter settings helps 
minimize differences in the spectra which are due to variations in 
sampling technique rather than to differences in sample composition. If 
you need to specify a parameter setting, it is important to do it before 
you collect the spectrum of the first standard in your method.  
 

 Note If you change the setting for a collection parameter after opening or 
collecting the spectra of one or more standards, TQ Analyst may warn 
you that the parameter setting should not be changed at this point. 
You will be given the option of overriding the warning or creating a 
new method with the new parameter settings.  
 
The standards must be collected in the same way you will collect the 
spectra of the unknown samples, using the same data collection 
parameters and the same spectrometer, if possible. The spectra of the 
standards should be of the highest achievable quality. Assuming that 
the sampling technique is reproducible, spectral quality is determined 
mainly by the resolution and signal-to-noise ratio of the spectral data. 
 
If you are analyzing gases, the spectra of the standards and samples 
should be collected at the same pressure and approximately the same 
temperature. This means if you have a concentrated gas standard that 
you need to dilute in order to lower its absorbance levels, you should 
back fill the cell to the targeted pressure with a gas that does not absorb 
in the analysis range, such as nitrogen or argon, or use a gas divider. 
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To display or change the collection parameters: 
 
1. Click the Collection Parameters button on the Standards tab.  
 

 Note If this button does not appear in your TQ Analyst application, data 
collection is disabled and you must use your spectral analysis 
application to set the collection parameters. See the documentation 
that came with your Thermo Scientific spectral analysis software, such 
as RESULT, for more information.  
 
 The Experiment Setup dialog box is displayed.  
 

 
 
 
2. Set the data collection and processing parameters. 
 
 The Collect tab contains the parameters that control data 

collection and processing. This is the same software screen that 
allows you to set the collection and processing parameters in your 
Thermo Scientific spectral analysis software. See the 
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documentation that came with that software for detailed 
descriptions of the collection and processing parameters.  

 
 
3. Set the Bench parameters. 
 
 The Bench tab contains the parameters that control the operation 

of your spectrometer or analyzer. (The term “bench” comes from 
the phrase “optical bench;” a generic name for FT-IR systems.) This 
is the same software screen that allows you to set the bench 
parameters in your Thermo Scientific spectral analysis software. See 
the documentation that came with that software for detailed 
descriptions of the bench parameters.  

 
 
4. When you are finished, choose OK.  
 
 Any changes you make to these parameter settings will take effect 

immediately. 
 
 

Collecting the 
calibration spectra 

To collect the spectrum of a standard, first select a row in the Standards 
table. To add a standard, click anywhere in the open row at the bottom 
of the Standards table. If you want to replace a standard, click the row 
that contains the standard you want to replace. When you are finished 
making your selection, click the Collect Standard button on the 
Standards tab to start collecting data.  
 
The process for collecting a spectrum in TQ Analyst is similar to the 
process for collecting a spectrum in your Thermo Scientific spectral 
analysis software. Refer to the documentation that came with that 
software for step-by-step instructions.  
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 Note If the Collect Standard button does not appear in your TQ Analyst 
application, data collection is disabled and you must use your spectral 
analysis application to collect standards. See the documentation that 
came with your Thermo Scientific spectral analysis software, such as 
RESULT, for more information.  
 
Depending on how the data collection parameters are set, you may be 
prompted to collect a background spectrum or enter a spectrum title 
during data collection. If you don’t enter a title during collection, the 
date and time of collection will be used. The new spectrum will be 
added to the open row at the bottom of the Standards table and saved 
in the method standards library. 
 

 Note When you collect a spectrum to use as a standard, TQ Analyst saves 
only a portion of the collection and processing information that is 
normally stored in a Thermo Scientific spectral data file. If you want to 
save all of the collection and processing information for your standards, 
save the standards as Thermo Scientific spectral data files by turning on 
the Save Automatically check box in Experiment Setup before collecting 
the standards. (Click the Collection Parameters button on the 
Standards tab to display the Experiment Setup dialog box. Save 
Automatically is located in the File Handling group on the Collect 
tab.)  
 
 

Importing the 
concentration values 

If you set up the concentration data for your standards in a spreadsheet 
file, rather than entering the values directly in TQ Analyst, you must 
import the concentration data into TQ Analyst in order to complete 
your method. Use the copy and paste features of Excel and TQ Analyst 
to import the concentration values.  
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To import the concentration values: 
 
1. Open TQ Analyst software and do the following: 

• Click the Components tab and enter the component names in 
the Components table, if you haven’t done this already. If you 
want to copy the entire table of concentration values in one 
operation, make sure the components are listed in the 
Components table in the same sequence as they appear in the 
spreadsheet file.  

• Click the Standards tab and make sure there are enough empty 
rows in the Standards table to add all of the data you want to 
copy. To add each blank row to the Standards table, click in 
the blank Spectrum Title cell at the bottom of the table, enter a 
placeholder name and then press the Enter key on your 
keyboard. If the Standards table already contains the file names 
and/or titles of the calibration spectra, make sure the standards 
are listed in the Standards table in the same sequence as they 
appear in the spreadsheet file.  

 
 
2. Switch to the spreadsheet application and use the Copy 

command to copy only the concentration values onto the 
Clipboard.  

 
 Start with the first data cell in the upper left corner of the 

spreadsheet. 
 
 
3. Select the TQ Analyst application, click the Standards tab and 

select the first cell that you want to paste the data into.  
 
 In most cases, this should be the first concentration column for the 

first component. 
 



 

140 TQ Analyst User’s Guide Thermo Fisher Scientific 

  
 
 
4. Choose Paste from the TQ Analyst Edit menu to paste the data 

into the Standards table.  
 
 

Collecting a 
background 

spectrum 

A background spectrum measures the response of the spectrometer 
without a sample in place. A background spectrum is used to eliminate 
signals that are due to the spectrometer and its environment from the 
sample spectrum.  

 
The background single-beam spectrum shows how the energy of the 
source is distributed over the displayed frequency range. It includes the 
characteristics of the spectrometer, including the detector, beamsplitter 
and atmospheric conditions. Each sample single-beam spectrum is 
ratioed against the background single-beam spectrum so that the 
absorptions in the final spectrum are due solely to the sample.  
 
The background spectrum you use to process your sample spectra 
should be collected under the same conditions as the sample spectra. If 
the conditions change over time, a new background may be needed. 
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Background spectra are typically collected in response to user prompts 
that appear during data collection. The software can be set up to 
prompt for background collection before or after every sample or after 
a specified period of time. You can also set up the software to use a 
specified background file. The options for specifying when background 
collection will occur are located with the data collection parameters in 
the Background Handling group. See “Optimizing the Collection 
Parameters” in this chapter for more information. Use the Collect 
Background button to collect a new background before the specified 
time has elapsed if your sampling or other conditions have changed.  
 

 Note Be sure to use the same settings for the data collection parameters when 
collecting a background spectrum as you plan to use for the standards. 
These same settings should also be used to collect the spectra of any 
samples you use this method to analyze. Using consistent parameter 
settings helps minimize differences in the spectra which are due to 
variations in sampling technique rather than to differences in sample 
composition.  
 
To collect a new background immediately, make sure there is not a 
sample in the spectrometer sample compartment, sampling module or 
accessory and then click the Collect Background button on the 
Standards tab. The Collect Background window appears and the 
spectrometer begins collecting data. During collection a live display of 
the data appears in the Collect Background window. When 
background collection is finished, the final background spectrum is 
displayed in the Collect Background window.  
 

 Note If the Collect Background button does not appear in your TQ Analyst 
application, data collection is disabled and you must use your spectral 
analysis application to collect background spectra. See the 
documentation that came with your Thermo Scientific spectral analysis 
software, such as RESULT, for more information.  
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Click the Close button on the TQ Analyst toolbar to close the Collect 
Background window. The new background becomes the current 
background for the active method. Any spectra you collect of standards 
or samples will be ratioed against the current background spectrum.  
 

 Note If Use Specified Background File is currently on, you will not be able 
to collect a new background until you select a different background 
handling option (see “Optimizing the Collection Parameters” in this 
chapter for more information).  
 
 

Replacing  
a standard 

If you suspect that the spectrum of a standard contains spectral errors, 
such as excessive instrument noise or strong absorptions in the analysis 
region or regions, you can easily replace the spectrum with a new one. 
 
To replace the spectrum of a standard, first copy the component 
concentration values (if it is a quantitative method) to the open row at 
the end of the Standards table. Then click anywhere in the new row 
and either open a new spectrum or collect a new spectrum for that 
standard. If the new spectrum contains a title or has a file name and 
these features are selected for display in the Standards table, the title 
and/or file name of the new spectrum will replace the title and/or file 
name of the spectrum that was replaced.  
 
Next, set the Usage and Class for the new standard, if those columns 
are present in the table. Finally, don’t forget to delete the old standard. 
To delete a standard, click anywhere in the corresponding row in the 
Standards table and choose Delete Row from the Edit menu. 
 
 

Deleting  
a standard 

To delete a standard, click the appropriate row in the Standards table 
and choose Delete Row from the Edit menu.  

 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 143 

If you want to delete multiple rows at the same time, click anywhere in 
the first row you want to delete. Then hold down the Shift key on the 
keyboard while you click any additional rows to be deleted. To delete 
the selected rows, choose Delete Row from the Edit menu.  
 

 Note The Sort button at the top of the Standards tab may help you place 
similar standards in sequential order in the Standards table so they can 
be easily deleted.  
 
 

Displaying  
the spectrum  
of a standard 

The spectra of the standards that are listed in the Standards table can be 
displayed in a spectral window. Many spectra can be displayed in the 
spectral window at the same time. If processing operations are specified 
in the method, you can select whether you want to see the original data 
or the processed versions when spectra are displayed. See the section on 
“Displaying The Processed Version of a Standard” for more 
information.  
 
Begin by selecting the standards you want to display. To select a 
standard for display, click its Display button in the Standards table.  
 
The display buttons are labeled with an icon that looks like a pair of 
eyeglasses. When a Display button is pressed, a plus (+) sign appears on 
the button and the corresponding spectrum is selected for display.  
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To display the spectra of the selected standards, click the View 
Standards button on the Standards tab. When you click View 
Standards, a spectral window appears showing the spectra of the 
selected standards.  
 
You can change the settings for the Display buttons while the spectral 
window is open. To update the contents of the spectral window, click 
the View Standards button again. 
 
 

Selecting a 
displayed spectrum 

You can select a displayed spectrum by clicking the spectrum in the 
spectral window. When a spectrum is selected, it is displayed in red in 
the spectral window. 
 
 

Rearranging 
displayed spectra 

The View menu becomes active whenever a spectral window is 
displayed. For information on a command in the View menu, click the 
menu name and then use the up or down arrow key on the keyboard to 
select a command in the open menu. Press the F1 key on the keyboard 
to display help information on the selected command. 
 
When you are finished reading Help information, close the Help 
window by choosing Exit from the File menu. 
 
 

Displaying the 
collection information 

for the standards 

The software saves key information about the standards in a 
quantitative or classification method. The information is saved in the 
method standards library.  
 
To display information about the standards in the current method, 
display the spectrum of any standard in a spectral window, click the 
spectrum to select it and then double-click the spectrum title. The 
Collection and Processing Information dialog box is displayed. The 
information in the Data Description group applies to all of the 
standards in the method. 
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 Note The information in the Data Collection Information and Spectrometer 

Description groups does not apply to the selected standard or the 
current method and should be ignored.  
 
 

Displaying the 
processed version of 

a standard 

If you specify that spectral processing will be used in your method, 
TQ Analyst lets you choose which version of the data will be displayed 
in the spectral window—the original version or the processed version.  

This applies to direct spectral processing, such as smoothing, derivatives 
and baseline correction, as well as any pathlength corrections that affect 
the spectral data, including the MSC (Multiplicative Signal 
Correction) and SNV (Standard Normal Variate) pathlength 
corrections. See the chapter titled “Processing Spectral Data” for 
information on setting up derivatives, smoothing or multipoint 
baseline correction for the method standards. The same corrections will 
be applied to any samples analyzed with the method. For information 
about the MSC and SNV pathlength options, see the chapter called 
“Principles of TQ Analyst” at the beginning of this document or the 
two chapters on creating a quantitative or classification method. 
 
To configure the software to always show the processed spectra of any 
standards that are displayed, turn on the check box for “Show Processed 
Spectra in View Standards.” The check box appears on the Standards 
tab. 
 

For instructions on 
displaying standards in a 

spectral window, click the 
Explain button on the 

toolbar and then click the 
View Standards button on 

the Standards tab.  
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 Note This check box is not available for QC Compare search and Search 
Standards methods.  
 
When this check box is on, the software checks whether any processing 
steps were applied to the standards before displaying them in a spectral 
window. If processing operations were specified, TQ Analyst displays 
the processed version of the standards rather than the original 
(unprocessed) version. This parameter is useful only when the check 
box for “Allow Spectral Processing” is on or when the MSC or SNV 
pathlength option is selected.  
 

 Note If you want to see the effects of a single processing step, such as 
smoothing, derivatives, or multipoint baseline correction, select the 
spectra you want to display by turning on their Display buttons in the 
Standards table (see the Standards tab) and then use the View 
Standards button on the Spectra tab (rather than the Standards tab) to 
display them. See the section “Viewing Selected Processing 
Operations” in the chapter “Processing Spectral Data” for more 
information.  
 
 

Using the Suggest 
Standards wizard to 

choose standards 

TQ Analyst provides a handy tool to help you choose standards for 
quantitative methods. The Suggest Standards wizard provides the 
number and approximate concentrations of the standards that are 
necessary to create an accurate calibration model for each component 
over the specified analysis range. Both calibration and validation 
standards are recommended. If your method already contains standards, 
the wizard evaluates those standards and recommends concentration 
values for any additional standards that are needed.  
 

 Note You must enter analysis limits for each component before using Suggest 
Standards. See the Components tab for information on setting analysis 
limits.  
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To start the wizard, click the Suggest Standards button on the 
Standards tab. The software displays a message asking whether you 
want recommendations for the minimum, typical, or optimum 
number of standards. After you respond to the message, the software 
fills in the Standards table with approximate concentration values for 
the recommended standards. If the Standards table already contains 
standards, the wizard prompts you to specify the number of standards 
you want to add. Then it recommends appropriate concentrations for 
the new standards. The recommended standards are titled "No 
spectrum assigned."  
 
When the Suggest Standards wizard is finished, you must prepare the 
standards, collect their spectra, and specify accurate concentration values 
for each component and each standard.  
 
 

Evaluating 
standards for 
quantitative 

methods 

If your method already contains standards, TQ Analyst provides a tool 
to help you determine whether they were prepared correctly and 
whether additional standards are needed. To start the process, click the 
Evaluate Standards button on the Standards tab. TQ Analyst runs a 
series of tests to determine the following: 

• Whether the concentrations of the standards are distributed 
throughout the specified analysis range for each component.  

• If the concentrations of the various components in the standards 
vary independently. 

 
 Note You must enter concentration values for the current standards and 

analysis limits for each component before using Evaluate Standards. See 
the Components tab for information on setting analysis limits. If you 
want the software to recommend standards based on the spectral data 
for a group of known samples, use the Select Standards command in 
the Diagnostics menu rather than the Evaluate Standards wizard. See 
the chapter on “Method Diagnostics” for more information.  
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When the wizard is finished, the software reports a “percent spanned” 
value, which indicates the percentage of the analysis range for each 
component that is described by the standards. Instructions on how to 
interpret the reported value are also provided.  
 
If the reported value for percent spanned is less than 70, the software 
recommends adding standards to the method. A warning message is 
displayed if the number of independent components is less than the 
number of components in the method.  
 

 Note If you want TQ Analyst to recommend which standards to add, run 
the Suggest Standards wizard when the Evaluate Standards wizard is 
completed. See the previous section of this chapter for more 
information.  
 
If the percent spanned value for your method is less than 70 or if the 
number of independent components is less than the number of 
components, we recommend running the Pairwise Concentration 
diagnostic (see the Diagnostics menu). The diagnostic results can help 
you compare the concentration of each component in each standard to 
the concentrations of the other components in the method. 
 
If the concentration of one or more components is dependent on the 
concentration of another component in all of the standards, the wizard 
will report that the standards were diluted serially. The wizard will also 
tell you if the concentrations of the components in all of the standards 
consistently sum to a constant value. Depending on the type of samples 
the method will analyze and the selected analysis type, these factors 
may or may not be important to the analysis. For brief descriptions of 
the algorithms available for quantitative analysis and the general 
requirements for each, click the Explain button on the toolbar to open 
the Explain help window, then click the Description tab and select each 
quantitative analysis type, or see the descriptions for the quantitative 
calibration techniques in the chapter on “Principles of TQ Analyst” in 
this document. 
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If the method contains a large number of standards (>100) and the 
standards span more than 95% of the analysis range for each component, 
the wizard gives you the opportunity to remove any standards that are 
not contributing significant information to the method calibration 
model. Removing unneeded standards helps simplify the method and 
minimize the amount of time it takes to calibrate. It also prevents the 
calibration model from overemphasizing regions that are represented by 
similar standards. 
 
If a message appears asking whether you want to prune the standard 
set, enter the lowest Percent Spanned value that you feel is necessary 
for your analysis and choose Continue. The value you enter should not 
be less than 95%. The software uses either the fractional factorial design 
model or a random model (using the maxi-min strategy) to select 
appropriate calibration and validation standards until it the method 
reaches the value you specified. The Usage parameter for all of the 
remaining standards will be set to "Ignore." You may leave the extra 
standards in the method or delete them by clicking the appropriate row 
in the Standards table and choosing Delete Row from the Edit menu. 
 
To display additional information about your standards, click the 
Detail button on the last screen in the Evaluate Standards sequence.  
 
 

Eliminating 
unnecessary 

standards 

If your method contains a large number of standards (>100) and the 
standards span more than 95% of the analysis range for each component, 
the Evaluate Standards wizard gives you the opportunity to remove any 
standards that are not contributing significant information to the 
method calibration model. Removing unneeded standards helps 
simplify the method and minimize the amount of time it takes to 
calibrate. It also prevents the calibration model from overemphasizing 
regions that are represented by similar standards. 
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To check if your method contains extra standards, run the Evaluate 
Standards wizard. To start the wizard, click the Evaluate Standards 
button on the Standards tab.  
 
If the method contains more than 100 standards and the wizard reports 
a Percent Spanned value that is greater than 95%, you will be 
prompted to specify a minimum Percent Spanned value and to prune 
any unneeded standards. Enter the Percent Spanned value that you feel 
is necessary for your analysis and choose OK. The value you enter 
should not be less than 95%.  
 
The software will randomly select appropriate calibration and 
validation standards until the Percent Spanned value reaches the value 
you specified. The Usage parameter for all of the remaining standards 
will be set to "Ignore." You may leave the extra standards in the 
method or delete them by clicking the appropriate row in the 
Standards table and choosing Delete Row from the Edit menu. 
 
 

Merging standards If your quantitative method includes two or more standards that have 
identical concentration values for all components, you can use the Merge 
Like Standards feature to create a composite standard that represents all 
of those standards. If you are developing a Discriminant Analysis or 
QC Compare search method, Merge Like Standards creates a 
composite standard for each class defined in your method. Each 
composite standard will represent all of the standards in the 
corresponding class.  
 
Merge Like Standards is available for two of the classification method 
types (Discriminant Analysis and QC Compare search) and for all of 
the quantitative methods except Simple Beer’s Law . The button is 
located on the Other tab. 
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This button is most useful when developing a Discriminant Analysis or 
QC Compare search method because it allows you to add a standard 
that is a composite of all the other standards in a given class. You may 
choose whether you want to use only the composite standard to 
represent the class or add the composite standard to the others by 
setting the Usage parameter in the Standards table. Adding the 
composite standard tends to weight the center of the class’ spectral 
characteristics more heavily than spectral features that are unique to 
certain standards.  
 
When you click Merge Like Standards for a quantitative method, TQ 
Analyst searches the calibration set for standards that have exactly the 
same concentration values for all components in the method. If any are 
found, the software creates an additional composite standard that can 
represent all of the standards in that “family.” Using Merge Like 
Standards with a classification method(available for Discriminant 
Analysis and QC Compare search methods only) adds a composite 
standard to each class.  
 
The spectral data for the original standards are averaged to create the 
spectrum for the composite standard. Composite standards are added to 
the end of the Standards table with titles “Composite standard A,” 
“Composite standard B,” etc.  
 
The Usage for composite standards is automatically set to 
“Calibration,” which means they will be included in the next 
calibration. If you want to exclude the original standards or any 
composite standard from calibration or any other operation, you must 
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change their usage from “calibration” to “ignore” (or remove the 
standard from your method). 
 
 

Restricting 
the Y-axis range 

If your method is set up to measure all of the data points in a spectral 
region or regions rather than peak heights or peak areas (i.e., if the 
Region Type parameter is set to Spectrum Range for all regions in the 
method), you can restrict the analysis to a specified Y-axis range. This 
allows you to eliminate data points in spectral regions that are or may 
be totally absorbing or in regions that contain excessive noise. Strong 
absorption bands tend to have more uncertainty and therefore should 
be excluded from the analysis region or regions of a quantitative or 
classification method.  
 
To restrict the Y-axis range: 
 
1. Turn on the check box for Restrict Analysis to Y-Axis Range. 
 
 
2. In the box labeled “Start,” enter the lowest intensity value that 

you want to include in the analysis. 
 
 
3. Select the box labeled “End” and enter the highest intensity 

value that will be included. 
 
 Only the data points that fall between the specified Y-axis limits 

will be used during calibration. If you run any diagnostic routines 
on the method, the Y-axis range for the diagnostic routines will also 
be restricted to the limits you specified. See the “Method 
Diagnostics” chapter of this manual for detailed descriptions of the 
diagnostic tools available in TQ Analyst. 
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 7 Processing Spectral Data 
 
 
 
Although spectroscopy assumes a direct and linear relationship between 
absorbance, concentration, and pathlength, it is not always possible to 
collect spectra where this is completely true. Placing the data in another 
format or applying certain processing steps often allows the software to 
better model these relationships. For example, an analysis may work 
best on the first or second derivative spectrum rather than the original 
spectrum or perhaps with a baseline anomaly removed.  
 
Processing steps such as smoothing, derivatives, and baseline correction 
are common practice in many infrared applications. If you plan to 
apply processing operations to your spectral data, keep the following 
points in mind: 

• All of the spectral data must be in the same format. If you use the 
first or second derivatives of the standards to create the calibration 
model, you must also analyze the first or second derivative spectra 
of the unknown samples. TQ Analyst is set up to do this 
automatically. Any processing steps that are specified for the 
standards are automatically applied to any unknown samples you 
use the method to analyze. If you convert a sample spectrum to its 
first or second derivative outside of TQ Analyst and then try to 
analyze it with a method that specifies derivatives, the software will 
display an error message. 

• Any processing operations that are applied to the standards must 
also be applied to the unknown samples (this also happens 
automatically in TQ Analyst). If you specify smoothing or baseline 
correction, it is important to first consider a representative pool of 
standards and known samples to be sure you will achieve the 
desired results. When applying baseline correction, for example, 
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you must be sure the same or similar baseline anomaly appears in 
all of the standards as well as the unknown samples.  

 
We recommend using the processing tools that are provided in 
TQ Analyst to apply smoothing, derivatives or baseline correction to 
your data. Processing your data in TQ Analyst will ensure that the 
standards and unknown samples are handled consistently, which will 
improve the accuracy of prediction and overall performance of your 
method. This chapter describes how to use certain tools on the 
Standards and Spectra tabs to: 

• Show or hide the Spectra tab, which is used for Processing spectral 
data. 

• Select the format of your spectral data (e.g., original, first derivative, 
second derivative). 

• Set up automatic smoothing. 

• Configure multipoint baseline correction. 

• Specify whether the original or the processed version of your 
spectral data will be displayed in the spectral window. 

 
If you want to work only with the original spectra with no additional 
spectral processing, make sure the following check box is off and skip to 
the next chapter.  
 

 
Turn this check box 

off to work with your 
original spectra with 

no additional spectral 
processing. 

 
 
This is the default configuration for TQ Analyst. If you are creating a 
Measurement Only method, the check box appears on the Measurements 
tab. For other analysis types, it appears on the Standards tab.  
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 Note This check box is not available for QC Compare search and Search 

Standards methods.  
 

 

Showing or 
hiding the  

Spectra tab 

TQ Analyst is initially configured to use the original spectra of the 
standards to create the method calibration model and to analyze the 
original data for the unknown samples. In this configuration, the 
Spectra tab does not appear with the other tabs at the top of the 
TQ Analyst window.  
 
If you decide you want to work with derivative spectra or apply 
smoothing or baseline correction to your spectral data, you must first 
turn on the check box called “Allow Spectral Processing.” If you are 
creating a Measurement Only method, this check box appears on the 
Measurements tab. For other analysis types, it appears on the Standards 
tab. 
 

 
 

 Note This check box is not available for QC Compare search and Search 
Standards methods.  
 
When the check box is on, TQ Analyst adds a new tab, called the 
Spectra tab, to your method. The Spectra tab appears adjacent to the 
Measurements tab in a Measure Only method. For other analysis types, 
the new tab appears next to the Standards tab. 
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You can use the parameters on the Spectra to set up processing 
operations for your spectral data, such as smoothing the data, 
calculating derivatives, and correcting spectral baselines. 
 
If you want to work only with the original spectra with no processing 
steps applied, make sure the check box for Allow Spectral Processing is 
off.  

Turn this check box 
off to work with your 
original spectra with 

no additional spectral 
processing. 

 
 

 
 
 
This is the default configuration for TQ Analyst. 
 
 

Displaying 
processed spectra 

If you specify that spectral processing will be used in your method, 
TQ Analyst lets you choose which version of the data will be displayed 
in the spectral window—the original version or the processed version.  
 
This applies to direct spectral processing, such as smoothing, 
derivatives and baseline correction, as well as any pathlength 
corrections that affect the spectral data, including the MSC 
(Multiplicative Signal Correction) and SNV (Standard Normal 
Variate) pathlength corrections. For information about the MSC and 
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SNV pathlength options, see the chapter called “Principles of 
TQ Analyst” at the beginning of this document. 
 
To configure the software to always show the processed spectra of any 
standards that are displayed, turn on the check box for “Show Processed 
Spectra in View Standards.”  
 
The check box appears on the Standards tab. 
 

For instructions on 
displaying standards in a 

spectral window, click the 
Explain button on the 

toolbar and then click the 
View Standards button on 

the Standards tab.  
 
When this check box is on, the software checks whether any processing 
steps were applied to the standards before displaying them in a spectral 
window. If processing operations were specified, TQ Analyst displays 
the processed version of the standards rather than the original version.  
 

 Note This check box is not available for QC Compare search and Search 
Standards methods.  
 
This parameter is useful only when the check box for “Allow Spectral 
Processing” is on or when the MSC or SNV pathlength option is 
selected.  
 

 Note If you want to see the effects of a single processing step, such as 
smoothing, derivatives, or baseline correction, select the spectra you 
want to display by turning on their Display buttons in the Standards 
table (see the Standards tab) and then use the View Standards button 
on the Spectra tab to display them. See the next section “Viewing 
Selected Processing Operations” for more information.  
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Viewing  
selected processing 

operations 

When setting up spectral processing, it is important to display a 
representative spectrum before and after the processing step in order to 
verify how the operation will work. Use the View Standards button on 
the Spectra tab to see the effects of a single processing step, such as 
smoothing, derivatives, or baseline correction.  
To view a selected processing operation: 
 
1. Click the Standards tab and select a few representative spectra 

to be displayed by turning on their Display buttons in the 
Standards table. 
 
The Display buttons are labeled with a pair of eyeglasses. When a 
Display button is on, a “+” sign appears on the button. The 
Display buttons for all of the other standards should be off.  

 
 
2. Select the processing function you want to apply. 

 
For example, if you want to set up derivatives, smoothing or 
multipoint baseline correction, set the data format, smoothing or 
baseline correction options as desired. See the sections on 
“Specifying the Format of Your Spectral Data,” “Setting Up 
Automatic Smoothing” and “Setting Up Multipoint Baseline 
Correction” in this chapter for instructions.  
 
If you need to see the original spectrum in order to determine the 
number of points for smoothing or the locations of the baseline 
points to be corrected, click the View Standards button on the 
Spectra tab to display your representative spectra. When you are 
finished viewing the representative spectra, click the Close button 
on the TQ Analyst toolbar to close the spectral window. 
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3. When you are finished setting up the processing operations, 
click the View Standards button on the Spectra tab to see the 
representative spectra with the specified changes. 
 

If you want to specify more than one processing step, we recommend 
setting them up in this order:  Data Format, Smoothing, Multipoint 
Baseline Correction. That way, you can see the effect of each 
processing step before and after it is applied as well as the cumulative 
effect of all of the specified processing operations. 
 
 

Specifying the 
format of your 
spectral data 

TQ Analyst allows you to specify a format for the spectral data you 
want to analyze. You can elect to analyze the original spectrum, as it 
was opened or collected in TQ Analyst, or you can analyze the first or 
second derivative spectrum (see example below).  

 
 

 
 
 
The first derivative is useful for revealing peaks that appear as shoulders 
in the original spectra. Use the second derivative to find the exact 
location (center) of shoulders in the original spectra.  
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The original spectra can be in any units; however, the derivative 
operation is usually applied to spectra that are in absorbance, Kubelka-
Munk or photoacoustic units. 
 
The parameter for selecting the data format is located on the Spectra 
tab. If the Spectra tab does not appear with the other tabs in the 
TQ Analyst window, the parameter that displays it is currently off. See 
the section on “Showing and Hiding the Spectra tab” in this chapter 
for more information. 
 
The default setting for the Data Format parameter performs all 
processing and analysis steps on the original spectra.  
 
To process and analyze your data in another format, click the arrow 
next to the list box to see the available options and then select a format.  
 

 
 
The choices available for setting Data Format are described briefly 
below. 
 
Format Description 
Spectrum Original spectrum as it was opened or collected 

in TQ Analyst 
First derivative First derivative of the original spectrum 
Second derivative Second derivative of the original spectrum 
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What is the first derivative? 
The first derivative shows the rate of change across the entire spectrum. 
This means that in the first derivative, shoulders become narrower and 
thus are easier to see. It is important to remember that the maximum 
and minimum points in the first derivative curve are the points of 
maximum rate of change and not the maximum and minimum points 
of the original peaks. The maximum and minimum points of the 
original peaks have a Y value of zero in the first derivative.  
 
What is second derivative? 
The second derivative shows the change in the rate of change across the 
spectrum. This curve is more complex than the first derivative, with 
significantly narrower bands. The second derivative is useful for finding 
exact peak locations since peaks in the second derivative appear at the 
same locations as peaks in the original spectrum. The second derivative 
has more baseline noise than the first derivative. For each derivative 
operation you perform, the noise level increases slightly, the signal 
strength decreases dramatically and the signal-to-noise ratio decreases.  
 
The conversion will be applied to the spectra of the standards as well as 
to any unknown sample spectrum analyzed with the method. All 
processing steps that affect the spectral data will be done in the selected 
format, including MSC pathlength correction, SNV pathlength 
correction, smoothing, baseline correction,  and any diagnostic 
analyses.  
 
To see the effect of a first or second derivative setting, leave Data 
Format set to “Spectrum.” Click the Standards tab and select a 
representative spectrum for display by clicking its Display button in the 
Standards table. See “Displaying the Spectrum of a Standard” in the 
chapter on “Working With Standards” for more information. Then 
click the Spectra tab and click the View Standards button. The original 
version of the selected spectrum will be displayed in a spectral window. 
Click the Close button on the TQ Analyst toolbar to close the spectral 
window. If you want to see the effects of first derivative, set Data 
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Format to “First Derivative” and then click View Standards again. The 
first derivative form of the representative spectrum will be displayed in 
a spectral window. When you are finished, click the Close button on 
the toolbar to close the spectral window. 
 
If you want to analyze derivative spectra, we recommend using the 
Data Format feature of TQ Analyst to perform the derivative 
conversion. You can collect the spectra of the standards outside of 
TQ Analyst if you wish. However, don’t import derivative spectra to 
set up a TQ Analyst method. The same goes for the unknown samples. 
For example, if you convert a sample spectrum to its first or second 
derivative outside of TQ Analyst and then try to analyze it with a 
method that specifies derivatives, the software will display an error 
message. 
 

 Note If you set up a method that uses first or second derivative spectra, don’t 
select one of the derivative options for defining the analysis regions. You 
should also avoid using the “area” Region Type to measure first 
derivative spectra, since the area of a derivative peak often goes to zero. 
When using derivative spectra, we recommend setting the Region Type 
to “Spectrum Range” for all of the method analysis regions. See the 
sections titled “Selecting the Analysis Regions” in the individual 
chapters on creating a quantitative, classification or spectral 
measurement method in this document for instructions on selecting 
analysis regions.  
 
 

Setting up 
automatic smoothing 

Smoothing allows you to improve the appearance of your spectra by 
smoothing peaks that are obscured by random noise. Reducing random 
noise can also decrease the error in a method calibration model.  
The smoothing algorithm is based on the assumption that spectral 
information due to sample absorptions varies slowly and is obscured by 
rapidly changing random noise.  
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The algorithm works by preferentially smoothing the high-frequency 
component of the spectral data. In this sense, “high frequency” refers to 
sequential data points that have dramatic differences in intensity.  
 
In other words, the algorithm seeks out and smoothes peaks that 
resemble random noise (see the example below).  
 

 
 
All of the software features for setting up smoothing are included on 
the Spectra tab. If the Spectra tab does not appear with the other tabs 
in the TQ Analyst window, the parameter that displays it is currently 
off. See the section on “Showing and Hiding the Spectra tab” in this 
chapter for more information. 
 

To see descriptions of 
the smoothing 

parameters, click the 
Explain button on the 

toolbar to open the 
Explain help window 

and then click the 
parameter name on 

the Spectra tab.  
 
TQ Analyst provides two smoothing filters:  the Savitzky-Golay filter 
and the Norris derivative filter. If you select the Savitzky-Golay 
smoothing filter, the settings for Data Points and Polynomial Order 
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determine the degree of smoothing. The Norris Derivative filter is 
defined by the settings for Segment Length and Gap Between 
Segments. You can smooth the original data or their first or second 
derivatives by setting the Data Format parameter.  
 
Savitzky-Golay smoothing 
To configure typical Savitzky-Golay smoothing, set the Data Format 
and smoothing parameters as described below. Savitzky-Golay 
smoothing can be applied to the original spectra or to the first or 
second derivative spectra.  
 
Data Format: “Spectrum” for simple smoothing 
 “First Derivative” for smoothed first derivative 
 “Second Derivative” for smoothed 2nd derivative 
Filter to Smooth Data: Savitzky-Golay filter 
Data Points: Determines the degree of smoothing. Can be set 

to any odd integer from 3 to 25 (should be > 
setting for Polynomial Order). Set to 7 data 
points for average smoothing. Increase for more 
smoothing; decrease for less.  

Polynomial Order Defines shape of curve for smoothing operation. 
Can be set to any integer from 2 to 6. Should be 
less than the setting for Data Points. Set to 3rd 
order (cubic) polynomial for average smoothing. 
Higher orders result in less smoothing; lower 
orders cause more smoothing. 

 
Norris derivative smoothing 
To configure typical Norris Derivative smoothing, set the Data Format 
and smoothing parameters as described below. The Norris-derivative 
smoothing filter is intended to be used with first or second derivative 
spectra. It is typically applied to Near-IR spectra.  
 
Data Format: “First Derivative” for smoothed first derivative 
 “Second Derivative” for smoothed 2nd derivative 
 
Filter to Smooth Data: Norris Derivative filter 
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Segment Length: Determines the degree of smoothing. Can be set 

to any odd integer from 1 to 25. Set to preferred 
number of points per segment (default is 5). 
Larger values increase smoothing (points in each 
segment are averaged); smaller values decrease 
smoothing. 

 
Gap Between Segments: Defines the distance between two consecutive 

segments. Can be set to any integer from 0 to 12. 
Set to preferred gap between segments (default is 
0). Increasing the gap lowers resolution. When 
working with derivatives, increased gap produces 
larger differences for broad peaks. 

 
To see the effects of smoothing, leave Filter To Smooth Data set to 
“No smoothing filter.” Click the Standards tab and select a 
representative spectrum for display by clicking its Display button in the 
Standards table. See “Displaying the Spectrum of a Standard” in the 
chapter on “Working With Standards” for more information. Then 
click the Spectra tab and click the View Standards button. The original 
version of the selected spectrum will be displayed in a spectral window. 
Click the Close button on the TQ Analyst toolbar to close the spectral 
window. If you want to see the effects of Savitzky-Golay smoothing, 
select the Savitzky-Golay filter, set Data Points and Polynomial Order 
and then click View Standards again. The smoothed version of the 
representative spectrum will be displayed in a spectral window. Set and 
reset the smoothing parameters and display the results until you are 
able to determine the optimum settings. When you are finished, click 
the Close button on the toolbar to close the spectral window. 
 
When smoothing is on, TQ Analyst applies the smoothing filter to the 
spectrum of every standard in the current method. The spectrum of any 
unknown sample you use the method to analyze will also be smoothed 
before the concentrations are measured (or the sample is classified).  
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 Notice The Savitzky-Golay algorithm smoothes all peaks. Smoothing degrades 
the effective spectral resolution of the data and can remove ("smooth 
out") small spectral features, including sample peaks (this is especially 
true for mid-IR spectra). If possible, increase the signal-to-noise ratio of 
the data by collecting more scans instead of smoothing.  
 
 

Setting up multipoint 
baseline correction 

A baseline consists of those portions of a spectrum where there are no 
significant absorptions. Ideally the intensity in these portions of the 
spectrum is zero absorbance units (or 100% transmittance). In reality 
baselines may be tilted, shifted or curved. 
 
Turn on multipoint baseline correction if you want to eliminate a 
significant baseline feature, such as a sloping, curving, shifted or 
otherwise undesirable baseline, that appears in the spectrum of every 
standard and affects the entire spectrum. Before deciding to use 
multipoint baseline correction, make sure the same baseline feature is 
present in the spectra of any samples the method will analyze.  
 
TQ Analyst provides two algorithms for correcting spectral baselines 
using a multipoint correction:  the piecewise linear correction and the 
spline correction.  
 
All of the software features for setting up multipoint baseline 
corrections are included on the Spectra tab. If the Spectra tab does not 
appear with the other tabs in the TQ Analyst window, the parameter 
that displays it is currently off. See the section on “Showing and 
Hiding the Spectra Tab” in this chapter for more information. 
 
If you are creating a quantitative, classification or spectral measurement 
method (excluding the SMLR method type), you may use the Regions 
tab to specify unique one- or two-point baselines for each region to be 
analyzed or measured rather than using the multipoint baseline 
correction provided on the Spectra tab. Using the Regions tab to define 
baselines is the preferred method for several reasons. First, you are 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 167 

forced to consider the baseline for each analysis region independently so 
the correction is often more accurate than an overall correction. 
Second, the software can usually apply independent baselines more 
consistently than multipoint baselines, which will improve the accuracy 
of prediction and overall performance of your method. Third, you can 
use the tools and spectra displayed in the Region Selection task 
window to select the baseline points interactively for each region. This is 
easier and often more accurate than entering baseline points in a table. 
For information on specifying unique baselines for each region, see the 
sections titled “Selecting the Analysis Regions” in the individual 
chapters on creating a quantitative, classification or spectral 
measurement method.  
 
Use the parameters in the Multipoint Baseline Correction group on the 
Spectra tab to turn on multipoint baseline correction and specify what 
kind of baseline correction will be used.  
 

 
To see descriptions of 

these parameters, 
click the Explain 

button on the toolbar 
and then click the 
parameter name. 

 
 
The type and degree of baseline correction depends on the algorithm 
(linear or spline) and the number and locations of the baseline points 
used for the correction. The baseline points specify where the 
correction should occur. The algorithm determines how the software 
calculates the values that are subtracted from each data point in the 
spectrum to correct the baseline. You can apply a baseline correction to 
the original spectra or to their first or second derivative spectra by 
setting the Data Format parameter.  
 



 

168 TQ Analyst User’s Guide Thermo Fisher Scientific 

Piecewise linear correction 
The algorithm for the piecewise linear correction interpolates a straight 
line between each baseline point you specify. It works best for 
correcting tilted baselines and other baselines that contain linear 
sections.  
 
Spline correction 
The spline correction algorithm interpolates a cubic polynomial curve 
based on at least four consecutive specified baseline points. Use it to 
correct baselines, or baseline sections, that are curved.  
 
Use the Baseline Points table to select the baseline points that will be 
used for baseline correction. You can specify as many baseline points as 
you wish.  
 

To see descriptions of the 
columns in this table, 

click the Explain button 
and then click each 

column heading.  
 
Each row in the table specifies a new baseline point. Each baseline 
point is defined by the starting and ending location of the region in 
which the point will be chosen and the method used to select the 
baseline point (Type).  
 
TQ Analyst provides the following options for choosing baseline 
points: 
 
Average in range Takes the average of the points between the start 

and end of the specified range. The selected point 
may or may not fall on the spectrum. 

Maximum in range Uses the highest (absorbance) or lowest 
(% transmittance) Y value on the spectrum between 
the start and end of the specified range. 
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Minimum in range Uses the lowest (absorbance) or highest 
(% transmittance) Y value on the spectrum between 
the start and end of the specified range. 

 
To select one of these options for the first baseline point, click the arrow 
in the first row of the Type column in the Baseline Points table to 
show the drop-down list box and then click the desired option. Then 
use the Start and End columns to define the X-axis location of the first 
and last data point in the first baseline region. The first baseline point 
will be chosen using the method and region you specified.  
 
When you finish defining each baseline point, the software 
automatically adds another row to the Baseline Points table. Repeat the 
steps above for each additional correction point you want to specify.  
 
To determine the best region for selecting each baseline point, use the 
View Standards button on the Spectra tab to display a representative 
spectrum of a method standard while making your selections. To select 
a spectrum for display, click the Standards tab and then click the 
Display button for a representative spectrum in the Standards table. 
See “Displaying the Spectrum of a Standard” in the chapter on 
Working With Standards” for more information. To see the 
uncorrected version of the selected spectrum, click the Spectra tab and 
then click the View Standards button. The spectrum will be displayed 
in a spectral window. 
 
The regions you choose should be on (or near) the baseline of the 
representative spectrum. Choose all of the baseline points you want to 
correct and record them on a piece of paper. Then click the Close 
button on the TQ Analyst toolbar to close the spectral window. Enter 
Start and End values for each baseline point in the Baseline Points table 
and specify the Baseline Type by choosing an option in the Type 
column. The resulting “baseline” is subtracted from the actual 
spectrum so that the baseline of the corrected spectrum appears flat and 
near zero absorbance units (or 100% transmittance). To see the 
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baseline corrected spectrum, click the View Standards button again. 
The baseline corrected version of the representative spectrum will be 
displayed in a spectral window.  
 
Set and reset the baseline points and display the results until you are 
able to determine the optimum settings that work for several 
representative spectra. When you are finished, click the Close button 
on the toolbar to close the spectral window. 
 
By selecting points carefully, you can correct baselines without using a 
large number of points. In general, you should select points at the 
beginning and end of baseline regions that need to be corrected and 
"low points" that are above zero absorbance (or high points below 
100% transmittance). When the selected points are brought to zero 
absorbance (or 100% transmittance), the points between the selected 
points will also be shifted so that their vertical position relative to the 
nearest selected points is maintained. Similarly, if you choose low 
points on both sides of a peak, the Y value of the peak will be decreased 
but the peak height measured from the low points will stay the same. 

 
 Notice Be careful not to introduce false peaks or other inaccuracies when you 

choose baseline points.   
 
When the linear or spline correction is selected and the baseline points 
are properly defined, TQ Analyst applies the correction to the 
spectrum of every standard in the current method. The spectrum of 
any unknown sample you use the method to analyze will also be 
baseline corrected before the concentrations are measured (or the 
sample is classified).  
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 8 Creating a Quantitative Method 
 
 
 
Read this chapter to learn the key steps in creating a successful 
quantitative method using TQ Analyst software. The following topics 
are covered: 

• Defining the problem 

• Choosing a sampling technique 

• Creating a new method file 

• Giving the method a title 

• Selecting a calibration technique 

• Choosing a pathlength option 

• Defining the method components 

• Running the feasibility test 

• Collecting the standards 

• Selecting the analysis regions 

• Customizing the method 

• Saving the method 

• Calibrating the method 

• Validating the method 

• Correcting component linearity 

• Where to go from here. 
 
Most of the operations described in this chapter are carried out in a 
method window. The method window is broken into a series of tabs. 
The tabs that appear when one quantitative method type is selected 
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may be different from the tabs that appear for another quantitative 
method. There are more tabs for the Partial Least Squares analysis type, 
for example, that for Simple Beer’s Law. 
 
The tabs are arranged in an order that is convenient for creating a 
quantitative method. If you select the tabs in sequence from left to 
right, starting with the Description tab, they will lead you step by step 
through the method development process. 
 
If you need information on updating the calibration data, running 
method diagnostics, or setting up sample reports, individual chapters 
on those topics are provided later in this document.  
 
If you want to create a classification method or one that only measures 
and reports spectral information, skip this chapter. Instructions for 
creating classification and spectral measurement methods are provided in 
the next two chapters of this document.  
 
 

Wizards for 
quantitative 

methods 

TQ Analyst offers a number of wizards to help you complete each 
quantitative method development task. From choosing the proper 
settings for method parameters to setting up your experimental design, 
the wizards can help make even your first attempt at developing a 
method a success.  
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The following table gives brief descriptions of the wizards available for 
creating quantitative methods. 
 

Location Wizard Function 
 
Description tab Suggest Analysis 

Type 
Recommends a setting for the 
Analysis Type parameter. 

Pathlength tab Suggest 
Pathlength Type 

Recommends a setting for the 
Pathlength Type parameter. 

Components tab Assess Feasibility Determines whether there is 
sufficient variability in the sample 
data that correlates with differences 
in sample composition. (Tells you 
whether your method is feasible.) 

Standards tab Suggest 
Standards 

Fills in the Standards table with the 
names and concentrations of the 
standards you should prepare and 
collect.  

 Evaluate 
Standards 

Determines whether the standards 
that are listed in the Standards table 
were prepared correctly and 
whether additional standards are 
needed. 

Regions tab Suggest Regions Chooses appropriate spectral regions 
for the analysis. 

Continued on next page 
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Location Wizard Function 
 
Other tab Suggest Factors Chooses factors or principal 

components (PCs) in a partial least 
squares or principal component 
regression method. Use the Edit 
Factors button to view or edit the 
chosen factors (PCs). 

Corrections tab Suggest 
Corrections 

Determines whether a correction 
curve will improve the accuracy of a 
quantitative method and suggests 
settings for the correction 
parameters for each component. 

 

 

To start a wizard, click the appropriate button on the specified tab. For 
example, to start the Analysis Type wizard, click the Suggest Analysis 
Type button on the Description tab.  
 
The wizards are intended to be used in the order shown in the table 
above. However, some of the wizards’ recommendations will be limited 
if they can’t access certain information. You may use the Pathlength 
Type wizard, for example, on a completely new method (all tables are 
blank) but the wizard can only help you distinguish the simple 
pathlength options, such as Constant, Known and Predict. The 
method must be fairly complete (components, standards and regions 
defined) before the Pathlength wizard can recommend a pathlength 
correction, such as Internal Reference or Multiplicative Signal 
Correction. The same is true for the Analysis Type wizard. If you select 
the “Undecided” option for Analysis Type and Pathlength Type, 
define your components and standards and then use the Regions 
wizard to recommend spectral regions for your method, the Regions 
wizard will recommend Analysis Type and Pathlength Type options as 
part of the region selection process.  
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The Suggest Factors wizard is available only for PLS and PCR 
methods. It suggests appropriate factors automatically during the 
calibration process. The Suggest Corrections wizard is not automatic 
(nor should it be). If you want to see what, if any, corrections are 
recommended, calibrate your method and then click the Suggest 
Corrections button on the Corrections tab. 
 
To learn the important steps and considerations for good quantitative 
method design and understand how to get the most out of the wizards, 
we recommend reviewing all of the material in this chapter in the order 
in which they are presented.  
 
You may use the wizard’s recommendations, alter them, delete them or 
overwrite them completely. We suggest using the wizards’ 
recommended settings as a starting point. Then add your knowledge of 
spectroscopy and the chemical system you are measuring to determine 
the optimum settings. 
 
 

Defining  
the problem 

Most researchers know which compound they need to measure before 
the sample arrives in their lab. You may be asked, for example, to set up 
a method to measure the amount of olefin in an oil sample or to 
identify the type of antioxidant in a polymer material. 
 
Knowing what to measure is not usually a problem; knowing how to 
measure it often is. The key is finding information in the sample 
spectrum that correlates with the components you need to measure. 
 
The first step in creating a quantitative method is to clearly define the 
system you are measuring by answering the following questions: 

• How many components are in the sample? 

• Which components do I need to measure? 
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• What range of concentrations of each component do I expect to 
find in the unknown samples? 

• What are the possible interferences? 

• How does the sample matrix affect each measured component? 
 
The answers will help you choose an appropriate sampling technique 
and define the experimental conditions that will be used for the 
analysis. 
 
 

Choosing a 
sampling technique 

Once you’ve defined the problem, the next step is to choose a sampling 
technique and define the experimental conditions for the analysis. In 
many cases, the physical characteristics of the sample dictate the 
sampling technique. For example, if you are analyzing powder samples 
in bottles that have narrow openings, you might use a fiber optic 
probe. Other samples, such as a polyol lubricant, might require a 
temperature-controlled, fixed-pathlength transmission cell.  
 
Choosing the optimum sampling technique for the material you want 
to measure is a critical step in achieving accurate quantitative results. It 
requires knowledge of infrared spectroscopy and the effects of 
interferences, which can adversely affect your results.  
 
The instrumentation industry offers a wide range of tools and 
accessories for material sampling and analysis. Each has benefits and 
drawbacks which may or may not be important to your analysis. Select 
the technique that consistently produces a quality spectrum with the 
least amount of effort and expense. 
 
You generally have some latitude in setting the experimental 
conditions. Two characteristics of spectral data that are especially 
important to quantitative measurements are spectral resolution and 
signal-to-noise ratio.  
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The signal-to-noise ratio of a spectrum defines how well the sample 
signal can be distinguished from signals that are due to random noise. 
In spectroscopy, signal-to-noise ratio is affected by the number of scans 
that are added together to produce the spectrum as well as the current 
settings for the source aperture and the electronic gain. See the 
documents that came with your spectrometer for instructions on 
optimizing these and other settings that define data collection. 
 
Choosing the proper spectral resolution depends on the selected 
sampling technique and the physical state of the samples. If you are 
analyzing solid or liquid samples in the mid-infrared range, we 
recommend starting with a resolution setting of 4 or 2 cm-1. Gas phase 
measurements may require 1 or even 0.5 cm-1 resolution to resolve the 
peaks, especially if the gas molecules are small (6 atoms or less). If the 
peaks in the spectra you collect at these recommended resolutions are 
not fully separated, switch to a lower resolution setting. Remember, the 
smaller the resolution value, the higher (better) is the resolution.  
 
Near-infrared peaks are overtones and combination bands which are 
broader than mid-infrared peaks and often overlap. We recommend 
starting with a resolution setting of 16 or 8 cm-1 for near-infrared data 
collection. If correlation values for minor constituents are low, 
increasing resolution (choosing a smaller resolution value) may 
improve separation. 
 
Keep in mind however, that the signal-to-noise ratio of the spectrum 
decreases as the resolution increases so you may want to also increase 
the number of scans. If you’re still not getting the resolution and peak 
shape you need after increasing the resolution, try another sampling 
technique. 
 
When creating quantitative methods, we recommend collecting or 
converting the spectra to absorbance or log (1/R) units. Since these 
units vary linearly with concentration in most cases, they are ideal for 
quantitative analysis. If you want to work with derivative spectra, use 
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the Data Format parameter on the Spectra tab to make the derivative 
conversion. See the chapter on “Processing Spectral Data” in this 
document for information on setting Data Format. 
 
 

Creating a 
new method file 

The first step in creating a method using TQ Analyst is to create a new 
method file. A method file contains all of the parameters that define 
how your method will operate. Your method must contain valid 
settings for all of the method parameters before it can be calibrated or 
run.  
 
To create a new method file: 
 
1. Choose New Method from the File menu. 
 
 The method parameters are displayed in a new method window. 

The Description tab, which contains the first group of method 
parameters, is already open.  

 
 
2. Choose Save Method As from the File menu.  
 
 The Save Method As dialog box is displayed.  
 
 
3. Type a file name for the new method in the File Name box and 

select the directory and disk where you want the method saved. 
 
 
4. Choose OK. 
 
 When you create a new method file, the method parameters are 

automatically set to their default values. You can change any of the 
parameter settings or use the default settings. 
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 Note Save your method frequently while creating the method or editing the 
method parameters.  

 

 

Giving the 
method a title 

Use the Method Title box on the Description tab to enter a title for 
your new method.  

 

 
 
 
You will use the method titles along with their file names to select a 
method to open. The title can also be displayed or printed with the 
analysis results. 
 
You may enter a longer description of the method in the Method 
Description box. You may also enter your name in the Developer’s 
Name box so people know who created the method.  
 
The Method Description and Developer’s Name parameters are also on 
the Description tab. Use the scroll bar to bring these parameters into 
view. 
 
 

Selecting a 
calibration technique 

Another important but difficult step in developing a quantitative 
method is choosing the algorithm used to create the method calibration 
model. The Analysis Type parameter on the Description tab provides a 
range of calibration techniques for quantitative analysis (see the list 
below).  
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To see detailed descriptions 
of the calibration options 
for quantitative methods, 

click the Explain button on 
the toolbar to open the 

Explain help window and 
then click each option in 

the software. 
 

 
We recommend leaving the Analysis Type set to “Undecided” until 
you’ve collected some spectral data. At this point, you don’t have 
enough information about the problem to make a good decision and 
you don’t need to decide yet.  
 
However, if you are experienced in chemistry and statistical analysis 
and understand the chemical system you are studying and its spectral 
response, you may feel comfortable selecting a calibration option now. 
Use the Explain Help feature of your TQ Analyst software to see 
descriptions of the calibration options available in TQ Analyst or see 
the chapter called “Principles of TQ Analyst” in this document. 
 
It is best to select the simplest technique that is capable of modeling 
the absorbance versus concentration response of the samples you want to 
analyze. You can always switch to another technique later if the results 
from the first attempt are unsatisfactory or try several techniques and 
choose the one that calculates component concentrations with the 
most accuracy. 
 
Each time you change the analysis type, the main TQ Analyst window is 
reconfigured so that only the method tabs and parameters which are 
needed to develop the type of method you selected are displayed on the 
screen. If you switch the analysis type between two options in the same 
group, for example if you change from Simple Beer’s Law to CLS, the 
information you entered and the settings you chose for the previous 
analysis type will be saved. 
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Choosing a 
pathlength option 

The parameters on the Pathlength tab define how the method will 
determine sample pathlength or thickness. Sample pathlength is 
important to quantitative measurements using spectral data because the 
intensities of the peaks in a sample spectrum are determined by the 
thickness as well as the composition of the sample. For more 
information on the effects of sample pathlength on quantitative 
measurements, see the chapter called “Principles of TQ Analyst” at the 
beginning of this document. 
 
There are several ways to account for differences in sample pathlength 
for quantitative methods, even if the exact pathlengths are unknown. 
To choose a pathlength treatment, select an option for the Pathlength 
Type parameter on the Pathlength tab.  
 

To see detailed descriptions 
of the pathlength options 
for quantitative methods, 

click the Explain button on 
the toolbar to open the 

Explain help window and 
then click each option in 

the software. 

 
 
In most cases, your sampling technique will dictate the correct 
pathlength option (frequently Constant or Known). If the pathlengths 
of your samples aren’t constant or known, we recommend setting the 
pathlength option to “Undecided.” Using this option will allow the 
TQ Analyst Pathlength wizard to recommend a pathlength setting for 
your method. The Pathlength wizard performs a statistical analysis of 
the spectral data from the standards to find the spectral peak or region 
that correlates best with variations in sample pathlength. 
 
Keep in mind, however, that the method must be fairly complete 
before the Pathlength wizard can recommend a pathlength setting 
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other than Constant or Known. For example, you must define the 
components, collect and identify the standards and select the spectral 
regions to be used for the analysis before the wizard can recommend a 
pathlength correction, such as Internal Reference or Multiplicative 
Signal Correction. If you select the “Undecided” option for Pathlength 
Type, define your components and standards and then use the Regions 
wizard to recommend spectral regions for your method, the Regions 
wizard will recommend a pathlength option as part of the region 
selection process.  
 
You may also try several pathlength types and then choose the one that 
produces the best results. Here are some brief guidelines: 
 
If sample pathlengths are… 

Always the same Constant 

Use this pathlength type… 

Variable and known  Known 
 (or easily measured)  

Variable and unknown  Predict 
 (or not easily measured) Internal Reference 
   Peak Ratio 
   MSC 
   SNV 
 
Some of the pathlength options require additional information, such as 
a default pathlength value or a pathlength peak. If a pathlength option 
requires additional information, parameters for entering the 
information will appear on the Pathlength tab when that pathlength 
option is selected. If you choose the Predict pathlength option, 
additional parameters to define the predicted pathlength component 
are displayed on the Components tab. 
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 Note The software offers more pathlength options for the multivariate 
quantitative techniques (CLS, SMLR, PLS and PCR) than for the 
Simple Beer’s Law technique. More pathlength options are available for 
multivariate analyses because a multivariate calibration model is better 
able to identify subtle changes in the spectral data that are due to 
differences in sample pathlength. If sample pathlength is unknown and 
difficult for you to measure, a multivariate analysis may be required to 
accurately analyze your samples.  
 
 

Running the 
feasibility test 

When developing a quantitative method, you can run a quick test to 
determine if there is sufficient sample information in the infrared 
spectra for accurate quantitative measurements. By “sample 
information,” we mean spectral features that are related to the sample 
components rather than to random noise or sample-to-sample variability. 
 
The feasibility test can be run as soon as you’ve finished setting the 
parameters on the Components tab. To start the feasibility test, click 
the Assess Feasibility button on the Components tab.  
 
The first screen for the Assess Feasibility wizard appears on your 
displayed. 
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The Assess Feasibility wizard guides you through a series of steps to 
collect or open the test spectra, define the spectral region you want to 
assess and run the test. You need to prepare only two standards and to 
measure them each three times to test for spectral variance. The two 
standards must contain different concentrations of each component 
you want to measure. The exact concentrations of the components in 
the standards are not important; but make sure the concentrations fall 
within the component analysis limits you specified. See “Specifying 
Analysis Limits” in the previous section for more information. 
 
You can collect the spectra in TQ Analyst (the wizard steps you 
through data collection) or open spectra that were collected in another 
Thermo Scientific spectral analysis application, such as OMNIC, 
Integra or RESULT. The wizard lets you specify how the data will be 
acquired. 
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 Note If the Collect Standard button does not appear in the Feasibility 
wizard, data collection is disabled and you must use your spectral 
analysis application to collect the standards for the feasibility test. 
When you are finished collecting the standards, use the Feasibility 
wizard to open the feasibility standards and run the feasibility test. See 
the documentation that came with your Thermo Scientific spectral 
analysis software, such as RESULT, for information on collecting 
standards.  
 
The feasibility test is a standard analysis of variance (ANOVA) statistical 
analysis that calculates both variation due to sample composition and 
variation due to sampling technique. When the test is completed, a 
Feasibility tab is added to the method window. The test results are 
displayed on the Feasibility tab along with a recommendation of 
whether you should continue developing your method.  
 
If the test results indicate that your method is not feasible, adjust the 
measurement parameters or try another sampling technique and then 
rerun the feasibility test.  
 
If these adjustments don’t change the feasibility test results, there is 
either too little variation between standards or too much variation 
between measurements of one or both standards. You must identify 
and eliminate the source of the problem before proceeding with 
method development. A small variation between standards usually 
occurs when the absorptions that are due to the species being measured 
are too weak. A low signal-to-noise ratio or inconsistent sampling 
technique can produce a large variation between measurements of the 
same standard. 
 
In some cases, the problem simply cannot be solved by spectral 
measurement. The Assess Feasibility wizard is designed to identify 
problems with the analysis early in development so you can avoid 
unnecessary work.  
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Defining the 
method components 

The next step in developing a new method is to specify what you want 
to measure. Use the Components tab to enter information about the 
components in a quantitative method, such as the component names 
and the unit that will be used to report their concentrations.  
 
This section covers the basic options that are important to defining 
components for any quantitative method. Depending on the current 
setting for Analysis Type (see the Description tab), other component 
settings may appear on the Components tab. For example, you may be 
able to set an option that forces the concentration values to sum to a 
constant or one that forces a component calibration curve through the 
origin. Use the Explain feature of TQ Analyst to see detailed 
descriptions of these and other options displayed on the screen.  
 
 

 
To see detailed descriptions 

of the items on this tab, 
click the Explain button on 

the toolbar to open the 
Explain help window and 
then click the item in the 

software. 

 
 

Components Tab 
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Entering the 
component names 

A unique name must be specified for each component the method will 
measure. The component names are entered in the Components table 
on the Components tab. When you use the method to analyze a sample 
spectrum, each component name will be displayed or printed next to 
the corresponding concentration value. 
 
To enter the component names: 
 
1. Select the Components tab. 
 
 
2. Click in the first row of the Component Name column, type the 

name of the first component and press Enter.  
 

 When you press Enter, the software adds a blank row to the end of 
the table.  

 
 
3. Continue entering names until all of the components have been 

specified.  
 
 
4. Use the Abbrev column to enter an abbreviated name for each 

component.  
 
 
5. Use the Unit column to enter the unit that will be used to 

measure the concentration of each component.  
 
 For example, if a component is measured in milligrams per liter, 

enter mg/liter for the unit. 
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6. Use the Digits column to specify the number of digits after the 
decimal symbol that will be used to enter and report the 
concentration values for each component. 

 
 Note The digits parameter defines the number of digits that are displayed in 

TQ Analyst or printed with the analysis results, not the number of 
significant digits that are used in the calculations.  
 
 

Specifying  
analysis limits 

You should also define the limits of the concentration range you want 
to measure for each component. These limits are needed to use the 
method performance and sample checking features of TQ Analyst as 
well as the Analysis Type wizard. We’ll talk more about these options 
later. 
 
To specify analysis limits for the components in your method: 
 
1. Turn on the check box for Use Analysis Limits at the top of the 

Components tab.  
 
 

  
 
 
 When the check box is on, TQ Analyst adds two columns to the 

Components table.  
 
 
2. In the column labeled “Analysis Low,” enter the lower limit of 

the analysis range for each component.  
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3. Use the column labeled “Analysis High” to specify the upper 
limit of each analysis range.  

 
 For optimum results, make the upper and lower limits of the 

analysis range about 5 percent higher and lower than the highest 
and lowest concentration values you expect to find in the unknown 
samples. 

 
 Note You must enter analysis limits for each component in order to use all of 

the wizards available in TQ Analyst software.  
 

 Note If you enter analysis limits for the components in your method, you 
can use the analysis limits sample checking feature to monitor the results 
from each sample. When analysis limits sample checking is active, a 
warning can be displayed or printed with the analysis results when a 
component concentration value falls outside the specified limits. See the 
chapter on “Preparing A Method For Sample Analysis” in this 
document for more information on sample checking.  
 

 Note Analysis limits are used to scale the method performance index. If you 
change the analysis limits for one or more components after the method 
has been calibrated once, the new performance index may be different 
from the performance index for the previous calibration. See the 
section titled “Calibrating the Method” in this chapter for more 
information on the performance index.  
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Collecting 
the standards 

When you are finished defining the method components, running the 
feasibility test and selecting a pathlength option, you are ready to collect 
the standards that will be used to develop and validate the calibration 
model. This section defines the various kinds of standards used in a 
TQ Analyst method and explains how to choose standards and collect 
their infrared spectra.  
 
 

What are standards? For quantitative analysis, standards are samples which have known 
concentrations of each component the method will be used to measure. 
TQ Analyst uses three types of standards for quantitative methods:  
calibration standards, validation standards, and correction standards.  
 
For now, we are only interested in standards used for calibration and 
validation. See the chapter on “Correcting Component Linearity” in 
this document for information on using correction standards in a 
TQ Analyst method. 
 
Calibration standards are used during the method calibration step to 
build a calibration model, which relates spectral features to component 
concentration. In order to do this, you must specify the concentration 
of each component in each calibration standard. We may also refer to 
the calibration standards as the “calibration set.”  
 
Validation standards are used only to evaluate the performance of a 
calibrated method. Since validation standards are not used to calculate 
the calibration model, they are an unbiased test of performance. Each 
time you calibrate a method, TQ Analyst uses the new calibration 
model to predict the component concentrations of the validation 
standards. Because the composition of the validation standards is 
known (you must supply this information just as you do for calibration 
standards), TQ Analyst can calculate the difference between the 
calculated concentrations and the actual concentrations. 
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Validation standards – a measure of performance 
Although validation standards are not required to calibrate or run a 
TQ Analyst method, they are key to the TQ Analyst philosophy. The 
software uses the validation standards to calculate a method 
performance index after each calibration. You can use the performance 
index to track the performance of your method as you develop or 
modify it. We strongly recommend that you include a few validation 
standards in every method you develop. If you don’t, you will miss out 
on this powerful feature of your TQ Analyst software. 
 
 

Choosing standards 
for quantitative methods 

Choosing the proper standards is probably the most critical factor in 
achieving accurate quantitative results. For example, if you don't 
include enough standards or don't distribute their concentrations or 
other properties throughout the specified analysis range, the calibration 
model may not accurately describe the behavior of the components you 
want to measure. In addition, some method types won't work if 
specific conditions aren’t met. A CLS method, for example, won’t give 
accurate results if the concentrations of the components in the 
standards don't vary independently. 
 
When using TQ Analyst software, there are two ways to select 
standards for a quantitative method. You can do it yourself, based on 
your experience and the guidelines provided here and elsewhere in this 
document. Or, you can use the software to help you determine the 
proper standards for your analysis.  
 
There are three techniques for selecting standards:  the Suggest 
Standards wizard, the Evaluate Standards wizard and the Select 
Standards diagnostic. The Suggest Standards wizard recommends the 
number and approximate concentrations of the standards for the 
current method. This is useful only if you are making new standards 
from scratch. If you already have standards or spectra from materials 
that could serve as standards, you can import the spectra and then use 
either the Evaluate Standards wizard or the Select Standards diagnostic 
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to determine which ones to include in the method. All three of these 
techniques follow the recommended guidelines for selecting standards 
for quantitative methods but let the computer do most of the work.  
 
The three techniques for selecting standards are explained in the 
sections that follow. 
 
 

Using the Suggest 
Standards wizard to select 

standards 

The Suggest Standards wizard provides the number and approximate 
concentrations of the standards that are necessary to create an accurate 
calibration model for each component over the specified analysis range. 
Both calibration and validation standards are recommended.  
 

 Note The Suggest Standards wizard is useful only if you are making new 
standards. If you already have standards or spectra from materials that 
could serve as standards, you can import the spectra and then use the 
Evaluate Standards wizard to determine which ones to include in the 
method. See the next section for more information.  
 
You can use the Suggest Standards wizard when the Standards table is 
blank. However, you must enter analysis limits for each component 
before using this wizard. See the section called “Defining the Method 
Components” for instructions. If the Standards table contains spectra 
or concentration values, the Suggest Standards wizard will evaluate the 
current standards and then recommend any additional standards it feels 
are necessary. 
 
The wizard uses the information in the Components table to construct 
a multidimensional sample space. Then it uses statistical guidelines to 
randomly select candidates from the sample space model. This process 
is repeated until the software generates a complete set of calibration 
and validation standards. 
 
To start the wizard, click the Suggest Standards button on the 
Standards tab. The software displays a message asking whether you 
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want recommendations for the minimum, typical, or optimum 
number of standards. After you respond to the message, the software 
fills in the Standards table with approximate concentration values for 
the recommended standards. The recommended standards are titled 
"No spectrum assigned."  
 
When the wizard is finished, you must prepare the standards, collect 
their spectra, and specify accurate concentration values for each 
component in each standard. All of these operations are described in 
later in this chapter. 
 
 

Using the Evaluate 
Standards wizard to select 

standards 

The Evaluate Standards wizard reviews the standards that are currently 
in the Standards table and lets you know if additional standards are 
recommended. It can also recommend appropriate concentrations for 
the new standards. Both calibration and validation standards are 
recommended.  
 

 Note The Evaluate Standards wizard is useful only if the Standards table 
already contains standards or spectra from materials that could serve as 
standards. See the section titled “Importing the Calibration Spectra” 
later in this chapter for instructions on importing standards. If you are 
making new standards, you can use the Suggest Standards wizard to 
recommend the number and approximate concentrations of the 
standards to include in the method. See the previous section for more 
information.  
 
The Evaluate Standards wizard works only when the Standards table 
contains spectra or concentration values for at least one standard. You 
must also enter analysis limits for each component before using this 
wizard. See the section called “Defining the Method Components” for 
instructions.  
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 Note If you want the software to recommend standards based on the spectral 
data for a group of known samples, use the Select Standards command 
in the Diagnostics menu rather than the Evaluate Standards wizard. See 
the chapter on “Method Diagnostics” for more information.  
 
The wizard uses the information in the Components table to construct 
a multidimensional sample space. Following statistical guidelines, the 
wizard matches the spectral and/or concentration data in the Standards 
table with candidates from the sample space model.  
 
To start the wizard, click the Evaluate Standards button on the 
Standards tab. When the wizard is finished, the software reports a 
“percent spanned” value, which indicates the percentage of the analysis 
range for each component that is described by the standards. 
Instructions on how to interpret the reported value are also provided. 
See “Evaluating Standards” in the chapter called “Working With 
Standards” for more information.  
 

 Note If you want TQ Analyst to recommend which standards to add, run 
the Suggest Standards wizard when the Evaluate Standards wizard is 
completed. See the previous section of this chapter for more 
information.  
 
When the wizard is finished, you must analyze the standards and then 
specify accurate concentration values for each component in each 
standard. Both of these operations are described in the sections that 
follow. 
 
 

Selecting  
standards manually 

You may prefer to select your own standards, based on your experience 
in chemistry and statistical analysis. If you want to select the standards 
for a quantitative method, consider the following guidelines before you 
begin. 
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• Use sufficient quantity.  
To determine the number of standards required, consider the 
number of components and the range of concentrations you expect 
to find in the unknown samples. The more components there are, 
the more standards are required. Similarly, the wider the 
concentration range, the more standards are required. In general, 
the more standards used to create the calibration model the better 
it will represent “real world” samples.  
 
Be sure to include at least two additional standards that can be used 
to validate the model. The concentration of each component in the 
validation standards should fall within the specified concentration 
range for each component in the method. See the section titled 
“What are Standards?” to learn how TQ Analyst uses validation 
standards to measure method performance.  
 
You should also consider the calibration technique that will be used 
and any requirements it has for choosing standards. Refer to the 
section called “Principles of TQ Analyst” at the beginning of this 
document for more information. 

 
• Use representative mixtures.  

The composition of the standards should be similar to the 
composition of the samples you want to measure. This insures that 
spectral baselines are handled properly and that all substances in the 
sample are properly modeled.  
 
For example, if your method must measure olefins in the presence 
of aromatics, your standards should be mixtures of olefins and 
aromatics. If you used the spectra of pure olefin for the standards, 
the calibrated method would not know how to deal with the 
additional presence of the aromatics.  
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• Use representative concentrations.  
If you know that the concentration of a particular component will 
vary in “real world” samples, do not prepare standards in which the 
concentration of that component is constant. The component 
concentrations for the calibration standards should reflect the 
expected concentration range for each component that will be 
measured.  
 
Generally, you should bracket the expected concentrations with 
your standards. For example, if you are measuring a single 
component, make one standard with a component concentration 
that is slightly lower than the lowest concentration you expect and 
make another standard with a component concentration which is 
slightly higher than the highest concentration you expect. The 
remaining concentrations should fall somewhere in between. Never 
use a method to calculate concentrations beyond the concentration 
range of the standards. 
 
It is extremely important that you verify the reported 
concentrations of the standards. Your quantitative results can be, at 
best, only as accurate as the standards used to create the calibration 
model. 

 
• Vary concentrations independently.  

The concentrations of the components in the standards should vary 
independently. Avoid using serial dilutions of one standard to 
make the other standards. 
 
For example, suppose you have a two component mixture for one 
standard and then you dilute it to make a second standard. The 
concentrations of the components in the second standard will be 
different from those in the first standard. However, the variation in 
each component concentration will be the same; that is, the 
component concentrations may not vary independently. As a 
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result, the calibrated method will not be able to distinguish one 
component from the other even though you have two standards. 

 
• Avoid using zero concentrations.  

When preparing solid or liquid mixture standards that may have 
molecular interactions, make sure each component in the standards 
has some reasonable concentration. In other words, don’t allow the 
concentration of any component to be so low that it is essentially 
zero. This ensures that the calibration model accounts for 
molecular interactions, which frequently occur between 
components in liquid and solid sample mixtures. 

 
Use the Standards table on the Standards tab to design your 
experiment. Following the guidelines provided above, enter proposed 
concentration values for all of the standards you plan to make.  
 
The column headings on the right side of the Standards table should 
show the name and measurement unit for each component the method 
is set up to analyze. Use these fields to fill in the concentration of each 
component in each standard. Make sure the concentration values you 
enter are correct and match the specified unit. If the component 
columns do not appear in the Standards table, switch to the 
Components tab and fill out the Components table. See the section 
called “Defining the Method Components” earlier in this chapter for 
instructions.  
 
When you are finished, let the TQ Analyst Standards wizard evaluate 
your experiment design. To start the wizard, click the Evaluate 
Standards button on the Standards tab. The wizard reviews the 
concentration values are currently in the Standards table and lets you 
know if additional standards are recommended. It can also recommend 
appropriate concentrations for the new standards. See “Evaluating 
Standards” in the chapter called “Working With Standards” for more 
information. 
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Some people prefer to design the experiment in a spreadsheet file, such 
as Microsoft® Excel®, and then paste the concentration data into the 
Standards table. See “Importing the Calibration Data” in this chapter 
for information on setting up the spreadsheet file and copying the data 
to the Standards table in TQ Analyst. 
 
When you are finished designing the experiment, you must prepare the 
standards, collect their spectra, and specify accurate concentration 
values for each component in each standard. All of these operations are 
described in the sections that follow. 
 
 

Preparing and 
analyzing the standards 

When you are finished designing your experiment and testing the 
design, it is time to prepare and analyze the real standards and update 
the concentration data.  
 
If you are making the standards now, carefully prepare the component 
mixtures following the guidelines set up in your experiment. As you 
prepare the component mixtures, there will inevitably be differences 
between the proposed concentrations and the actual values. For 
example, if you are preparing mixtures of caffeine and starch, standard 
#1 may call for 10.85 mg caffeine and 4.73 mg of starch. As you weigh 
the materials, carefully enter the actual concentration values and units 
into the Standards table or spreadsheet file, if one was used. Make sure 
the concentration values you enter are correct and match the specified 
unit. Some labs require that standards are analyzed by another (non-
infrared) method to verify or determine their actual concentration 
values before using them in a quantitative method. 
 
If you imported the calibration spectra, use a non-infrared method to 
determine the actual concentration values of the standards and then 
enter the actual concentration values in the Standards table or 
spreadsheet file, if that is preferred. Make sure the concentration values 
you enter are correct and match the specified unit.  
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Collecting the 
spectra of the standards 

Once the standards are prepared and the correct concentration data 
recorded, the spectra must be carefully collected and stored on a disk. 
You can use TQ Analyst or another Thermo Scientific spectral analysis 
package, such as OMNIC, Integra, or RESULT, to collect the spectra of 
the standards.  
 
Before collecting the spectral data, you must make sure the data 
collection parameters are set to optimum values. See the next section for 
details. 
 

 Note If you imported the spectra of the standards, skip the sections on 
optimizing the collection parameters and collecting the spectra of the 
standards.  
 
 

Optimizing the 
collection parameters 

The standards must be collected in the same way you will collect the 
spectra of the unknown samples, using the same data collection 
parameters, if that is possible. The spectra of the standards should be of 
the highest achievable quality. Assuming that the sampling technique is 
reproducible, spectral quality is determined mainly by the resolution 
and signal-to-noise ratio of the spectral data. The parameters that define 
resolution and signal-to-noise ratio are part of the data collection 
parameter set.  
 
If you are using TQ Analyst to collect the calibration spectra, use the 
Collection Parameters button on the Standards tab to display the data 
collection parameters. See the chapter called “Working With 
Standards” in this document for more information.  
 

 Note If the Collection Parameters button does not appear in your 
TQ Analyst application, data collection is disabled in TQ Analyst. You 
must use your spectral analysis application, such as RESULT, to set the 
data collection parameters. See the documentation that came with your 
spectral analysis software for more information.  
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If you are using another Thermo Scientific spectral analysis package to 
collect the calibration spectra, see the documentation that came with 
that software for instructions on setting the data collection parameters.  
 
Once the parameters have been set, we recommend using the chosen 
settings to collect all of the calibration and validation standards as well 
every unknown sample you use the method to analyze.  
 

 Note If you change the setting for a collection parameter after opening or 
collecting the spectra of one or more standards, TQ Analyst may warn 
you that the parameter setting should not be changed at this point. 
You will be given the option of overriding the warning or creating a 
new method with the new parameter settings.  
 
If you are analyzing gases, the spectra of the standards and samples 
should be collected at the same pressure and approximately the same 
temperature. This means if you have a concentrated gas standard that 
you need to dilute in order to lower its absorbance levels, you should 
back fill the cell to the targeted pressure with a gas that does not absorb 
in the analysis range, such as nitrogen or argon, or use a gas divider. 
 
 

Collecting the  
spectral data 

When you are finished setting (and testing) the data collection 
parameters, you are ready to collect the spectrum of each standard. You 
can use TQ Analyst, another Thermo Scientific spectral analysis 
package, such as OMNIC, Integra, or RESULT, or another application 
to collect the calibration spectra.  
 
To collect the spectrum of a standard in TQ Analyst, click the Collect 
Standard button on the Standards tab.  
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 Note If the Collect Standard button does not appear in your TQ Analyst 
application, data collection is disabled in TQ Analyst. You must use 
your spectral analysis application, such as RESULT, to collect 
standards. See the documentation that came with your spectral analysis 
software for more information.  
 
The process for collecting a spectrum in TQ Analyst is exactly like the 
process for collecting a spectrum in your Thermo Scientific spectral 
analysis software. Refer to the documentation that came with that 
software for step-by-step instructions.  
 
Depending on how the data collection parameters are set, you may be 
prompted to collect a background spectrum or enter a spectrum title 
during data collection. If you don’t enter a title during collection, the 
date and time of collection will be used. The new spectrum will be 
added to the open row at the bottom of the Standards table and saved 
in the method standards library. 
 

 Note When you collect a spectrum to use as a standard, TQ Analyst saves 
only a portion of the collection and processing information that is 
normally stored in a Thermo Scientific spectral data file. If you want to 
save all of the collection and processing information for your standards, 
save the standards as Thermo Scientific spectral data files by turning on 
the Save Automatically check box in Experiment Setup before collecting 
the standards. (Click the Collection Parameters button on the 
Standards tab to display the Experiment Setup dialog box. Save 
Automatically is located in the File Handling group on the Collect 
tab.)  
 
As you collect the spectra, be sure to note any special sampling 
conditions that may affect the spectral data, such as the temperature 
and pressure of a gas cell, the cell pathlength or the packing pressure of 
a diffuse reflectance accessory. It you used TQ Analyst software to 
collect the standards, this information can be stored with the data 
collection parameters in the Experiment Description entry box. To see 
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the Experiment Description entry box, click the Collection Parameters 
button on the Standards tab. When you are finished entering the 
experiment description, click Save and then click OK to close the 
dialog box. 
 
If you are collecting the spectra outside of TQ Analyst, be sure to 
carefully name and save each spectrum in a file when you are finished 
collecting it. If you are using a software package from another 
manufacturer to collect the calibration spectra, be sure to save the 
spectra in a format that is compatible with TQ Analyst. See the section 
titled “Opening a spectrum to use as a standard” in the chapter called 
“Working With Standards” for a list of compatible file types.  
 
 

Importing the 
calibration spectra 

If you used another spectral analysis package to collect the calibration 
spectra rather than collecting them directly in TQ Analyst, you must 
import the spectra into TQ Analyst in order to complete your method.  
 
Use the Open Standard button on the Standards tab to import the 
spectra of the standards. Begin by clicking anywhere in the first blank 
row of the Standards table. Then click the Open Standard button and 
select the first file you want to import.  
 
TQ Analyst allows you to open spectra that were saved using 
TQ Analyst or spectra that are in another format, or “file type,” such as 
GRAMS386 or JCAMP-DX. To list all the files in the indicated 
directory, select All Files (*.*) from the Files of Type drop-down list 
box.  
 
If you want to open spectra you collected in an application from 
another manufacturer, make sure you save the spectra in a compatible 
format before attempting to import them into TQ Analyst. See the 
section titled “Opening a spectrum to use as a standard” in the chapter 
called “Working With Standards” for a list of compatible file types. 
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The spectrum is added to the list of standards and saved in the method 
standards library. If this is the first standard in your method, the data 
collection parameters in the current method will be set automatically to 
match the settings that were used to collect the spectrum you opened. 
 
You can add each spectrum individually or select a number of spectra 
and add them all at once. If the spectra are stored in a spectral group 
file (.SPG extension), set the File Type list box to “.SPG” and then 
select the group file you want to add.  
 
If you selected multiple spectra to open or opened a spectral group 
(.SPG) file, all of the selected spectra will be added to the end of the 
Standards table. New rows are added to the table to accommodate the 
number of standards in the group. 
 

 Note If a warning message about mismatched standards appears when you 
try to add a standard, the parameter settings used to collect the new 
standard are significantly different from the settings that are saved with 
the current method. For optimum performance, all method standards 
should be collected using the same settings for the collection 
parameters. You can deal with the warning three ways: collect the 
standard again using the proper settings for the collection parameters, 
edit the settings in the current method, or ignore the warning and 
continue adding standards.  
 
 

Importing the 
concentration values 

If you set up the concentration data in a spreadsheet file, rather than 
entering the values directly in TQ Analyst, you must import the 
concentration data into TQ Analyst in order to complete your method. 
Follow the instructions provided below to set up the spreadsheet file. 
Then use the copy and paste features of Excel and TQ Analyst to 
import the concentration values.  
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Setting up a 
 spreadsheet file 

Some people prefer to enter the concentration data for the standards in 
a spreadsheet file, such as Microsoft® Excel®, and then paste the data 
into the Standards table. To do this, follow the template below to set 
up the spreadsheet file. 
 
 

 Concentration Values 
Standard Component 1 Component 2 Component 3 
 1 0.462 1.037 0.869 
 2 0.628 1.954 1.027 
 3 0.937 2.895 1.359 
 
 

 Note If you’ve already entered the component names in the Components 
table in TQ Analyst software, make sure the components are listed in 
the spreadsheet file in the same sequence. For example, if Glucose 
appears in row 1 of the Components table, make sure Glucose appears 
in column 1 of the spreadsheet file. If you need help, see the section on 
“Entering the Component Names” earlier in this chapter.  
 
 

Importing the 
spreadsheet data 

When you are finished entering or updating the concentration values in 
the spreadsheet file, such as Microsoft® Excel®, you are ready to import 
the data into the Standards table in TQ Analyst.  
 
To import the concentration values for the standards: 
 
1. Open TQ Analyst software and do the following: 

• Click the Components tab and enter the component names in 
the Components table, if you haven’t done this already. If you 
want to copy the entire table of concentration values in one 
operation, make sure the components are listed in the 
Components table in the same sequence as they appear in the 
spreadsheet file.  
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• Click the Standards tab and make sure there are enough empty 
rows in the Standards table to add all of the data you want to 
copy. To add each blank row to the Standards table, click in 
the blank Spectrum Title cell at the bottom of the table, enter a 
placeholder name and then press the Enter key on your 
keyboard. If the Standards table already contains the file names 
and/or titles of the calibration spectra, make sure the standards 
are listed in the Standards table in the same sequence as they 
appear in the spreadsheet file.  

 
 
2. Switch to the spreadsheet application and use the Copy 

command to copy only the concentration values onto the 
Clipboard.  

 
 Start with the first data cell in the upper left corner of the 

spreadsheet. 
 
 
3. Select the TQ Analyst application, click the Standards tab and 

select the first cell that you want to paste the data into.  
 
 In most cases, this should be the first concentration column for the 

first component. 
 

  
 
 
4. Choose Paste from the TQ Analyst Edit menu to paste the data 

into the Standards table.  
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Once the data are in TQ Analyst, you can use a wizard to review the 
concentration values. To start the wizard, click the Evaluate Standards 
button on the Standards tab. 
 
 

Specifying Usage The column labeled “Usage” in the Standards table allows you to 
specify how each standard will be used in the method. To set the usage 
for a standard, simply choose an option in the Usage list box. 
 
For quantitative methods, you can set the usage to “calibration,” 
“validation,” “correction,” or “ignore.” 
 
Standards designated as “Calibration” will be used to create the method 
model during calibration. In TQ Analyst, calibration standards are also 
used to calculate a correction curve, if one is specified.  
 
Validation standards will be used to evaluate the performance of a 
method once the method is calibrated. The results from the validation 
standards are also used to calculate the performance index.  
 
Correction standards are used along with the calibration standards to 
calculate a correction curve, if one is specified. Correction standards are 
not used in calibration. See the section called “Correcting Component 
Linearity” in this chapter for more information. 
 
Use the “ignore” setting to temporarily exclude a standard from the 
method. 
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Selecting the 
analysis regions 

The final step in building a method is to identify the spectral 
information in the standards which correlates best with the components 
you want to measure. Similar to the process for selecting the standards, 
choosing the component peaks or regions is another difficult task in 
quantitative method design. Specialized training in chemistry and 
spectral interpretation is sometimes required, especially when choosing 
regions for a CLS or PLS analysis. 
 
If you are creating an SMLR method, you may want to divide one or 
more of the selected regions by another peak or region by specifying a 
denominator peak. If you specify denominator peaks, the software uses 
the second region for each component as the denominator peak.  
 
The following sections describe how to use the wizard to select the 
analysis regions for your method and explain how to specify 
denominator peaks for an SMLR method. 
 
 

Using the wizard to 
select the analysis 

regions 

Use the Regions tab to select the analysis regions and specify how they 
will be measured. If you need help choosing the proper analysis 
regions, take advantage of the software’s built-in expertise by using the 
Suggest Regions wizard. The wizard performs a statistical analysis of 
the calibration standards and then recommends one or more spectral 
peaks or regions for each component the method is set up to measure. It 
also indicates how the peaks or regions should be measured and what 
baseline should be used.   
 
If you are creating a quantitative method, the wizard starts 
automatically when you select the Regions tab. When you are finished 
interacting with the wizard, click the Edit Regions button on the 
Regions tab. The suggested peaks or regions are displayed in the 
Region Selection task window. The peaks or regions the wizard 
recommends will depend on the spectral information for the standards 
and the current settings for the Analysis Type and Pathlength Type 
parameters. 
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 Note If the Analysis Type or Pathlength Type parameter is set to 

“Undecided,” TQ Analyst will choose appropriate settings for one or 
both parameters while recommending analysis regions. When selecting a 
calibration technique (Analysis Type) and pathlength treatment 
(Pathlength Type), the wizard chooses the simplest option that 
adequately models the chemical system to be measured. If the 
Pathlength Type is set to Internal Reference or Peak Ratio, which 
require a pathlength peak, but no pathlength peak is currently specified, 
the wizard will also recommend a pathlength peak.  
 
All of the wizard’s recommendations are based solely on the 
concentration and spectral information for the calibration standards. If 
the standards truly represent the unknown samples you wish to 
measure, the recommendations are statistically valid.  
 
You are free to change the recommended Analyst Type or Pathlength 
Type setting or the recommended regions at any time. When setting 
these and other parameters in a quantitative method, we recommend 
using the simplest option that adequately models the chemical system 
to be measured. You can always switch to another technique later if the 
results are unsatisfactory or try several techniques and choose the one 
that calculates component concentrations with the most accuracy. 
 

 Note If you switch the analysis type between two options in the same group, 
for example if you change from Simple Beer’s Law to CLS, the 
information you entered and the settings you chose for the previous 
analysis type will be saved.  
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To see a description of an 
item in this task window, 
click the Explain button 

on the toolbar to open 
the Explain help window 

and then click the item. 
For step-by-step 

instruction on editing 
regions, click the How 
To button in the task 

window. 

 
 

Region Selection Task Window 
 
 
The spectra of the standards that contain low, medium and high 
concentrations of the components that absorb in region 1 are displayed 
in the graphical window. Additional information about the current 
region is provided in the Regions table, located at the bottom of the 
task window.  
 
Since region selection is usually an iterative process, consider the 
recommended regions only as a starting point. You may need to adjust 
the regions or other settings in the Region Selection task window, such 
as the Region Type and Baseline Type, to achieve the best results. See 
the Explain and How To help for the Region Selection task window 
for instructions on optimizing regions using the tools in the Region 
Selection task window.  
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Any changes you make to the Region Selection task window will be 
saved automatically when you close the window. To close the Region 
Selection task window, click the Close button on the TQ Analyst 
toolbar. 
 
To display the Region Selection window after one or more regions 
have been selected, click the Edit Regions button on the Regions tab. 
 
 

Setting up a 
denominator peak 

or region for an 
SMLR method 

You can design a method that calculates the ratio of your component 
peaks by setting Calculate Ratios on the Other tab. This can be useful 
for minimizing pathlength differences in the standards and samples.  
 
If you specify ratios, the software uses the second region for each 
component as the denominator peak. All of the other regions will be 
divided by the result for the second region. 
 

 Note If you want to limit the ratio to a single component peak, set the 
number of regions used for each component to 2. See the Component 
Regions table on the Other tab for details on specifying regions for 
SMLR methods.  
 
To define a denominator peak or region for the components in an 
SMLR method: 
 
1. Click the Other tab. 
 
 
2. In the Calculate Ratios group, turn on the check box for Use 

Second Region As Denominator.  
To see detailed descriptions 

of the items in this group, 
click the Explain button on 

the toolbar to and then 
click the item in the 

software. 
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3. Indicate whether you want to limit the region the software will 

use to locate a denominator peak by setting the check box for 
Limit Region For Denominator Peak. 

 
This parameter is designed for advanced users who are familiar with 
SMLR analyses. Make sure you look at some typical spectra of 
samples and standards before deciding to limit the region for the 
denominator peak. People typically limit the region only when 
they want the software to locate a denominator peak that is in the 
same area as the first component peak. This helps ensure that the 
two peaks have similar shapes, which makes the ratio more 
accurate. 
 
 

4. If you turned on the Limit Region For Denominator Peak 
check box, specify the region limits by entering a value for 
Maximum Distance From First Region.  

 
Limit the region for locating the denominator peak by entering its 
maximum distance in data points from the peak maximum in the 
first component region. 

 
 

Customizing 
the method 

If you have been following the guidelines provided in this chapter, your 
method contains all of the information needed for calibration, 
including: 

• Descriptions of the components being measured. 

• Representative standards measured using reproducible sampling 
technique. 

• Spectral regions which correlate to known component information. 
 
Depending on the calibration technique (Analysis Type) you selected, 
there are other features and settings in the software that may be used to 
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customize your method. For example, if you want to calculate 
derivative spectra or apply smoothing or baseline correction, turn on 
the check box for Allow Spectral Processing on the Standards tab. (See 
the chapter called “Processing Spectral Data” in this document for 
more information.) 
 
Use the parameters on the Report tab to configure the sample reports. 
See the section on “Setting Up Sample Reports” in the chapter called 
“Preparing a Method for Sample Analysis” for details.  
 
 

 
 
 

To see detailed 
descriptions of the 

features on the Report 
tab, click the Explain 

button on the toolbar to 
open the Explain help 

window and then click 
the feature.  

 
 

Report Tab for PLS Method 
 
 
The parameters on the Other tab allow you to customize certain 
features of a quantitative method, such as the number of factors used 
for a PLS method or the number of regions used for each component 
in an SMLR method. 
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To see detailed 
descriptions of the 

features on the Other 
tab, click the Explain 

button on the toolbar to 
open the Explain help 

window and then click 
the feature.  

 
 

Other Tab for PLS Method 
 
 
Feel free to consider or try all of the features included in your method. 
If you don’t have time to review them or don’t need special 
enhancements, leave the default settings provided in the software. 
TQ Analyst is designed to provide a working method with a minimum 
of effort.  
 
The method should produce acceptable results for most sample types 
when the method parameters are set to their default values. To see the 
default settings for a quantitative method, choose New Method from 
the File Menu and set the Analysis Type to one of the quantitative 
options. 
 
If you prefer using other method specifications or have specifications 
you need to follow, you may change the settings for any method 
parameter at any time. 
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Saving the method We recommend that you save your work regularly when creating or 
editing methods. Be sure to save the method again before you calibrate 
it. 
 
To save your method: 
 
1. Select the method you want to save by clicking the method 

window or by choosing the method name in the Window menu. 
 
 
2. Choose Save Method from the File menu. 
 
 If the method does not have a file name, the Save Method As 

dialog box appears.  
 
 
3. If the Save Method As dialog box appears, type a file name and 

select the directory and disk where you want the method saved.  
 
 
4. Choose OK. 
 
 

Calibrating 
the method 

When you are finished selecting a calibration technique, choosing a 
pathlength option, defining the components, running the feasibility test, 
collecting the standards, selecting the analysis regions and saving, your 
method is ready for calibration. For quantitative methods, calibration 
produces the mathematical model that will be used to calculate 
component concentrations in the unknown samples.  
 
To calibrate a quantitative method, click the Calibrate button on the 
TQ Analyst toolbar. Calibration may take 1 second or several hours, 
depending on the number of calibration standards used and the selected 
calibration technique. When calibration is completed, the calibration 
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readout on the TQ Analyst toolbar changes from red to green and the 
“Uncalibrated” message changes to “Calibrated.”  
 
When you calibrate a quantitative method, the software calculates a 
calibration model and then uses the model to quantify the method's 
calibration standards. If validation and correction standards are specified 
in the method, the validation and correction standards are also 
quantified. The calibration data are displayed in the Calibration 
Results task window.  
 
 

 
 
 
 

To see descriptions of 
the items in this 

window, click the 
Explain button on the 

toolbar to open the 
Explain help window 

and then click the 
item. 

 
 

Calibration Results Task Window 
 
 
The information provided in the Calibration Results task window can 
help you identify standards that may be outliers.  
 
The table in the lower half of the task window shows the calculated 
and actual concentration values and the % difference value for each 
standard that contains the selected component.  
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Calibration Table 
 
 
Compare the % difference values for the validation standards to those 
of the calibration standards. If the validation standards consistently 
show larger difference values than the calibration standards, the 
calibration model may be overfit. This can result when too many factors 
are used in a PLS method or the polynomial order of a component 
correction curve is too high. If linearity corrections are specified in your 
method, make sure the polynomial order for each correction curve is 
the lowest order that provides the desired correction.  
 
To see the error associated with each factor used in the current PLS 
method, click the Edit Factors button on the Other tab or run the 
PRESS diagnostic from the Diagnostic menu. You may edit the 
number of factors used in a PLS method from the Edit Factors window 
or the Other tab.  
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 Note TQ Analyst performs a cross validation step as part of the calibration 
process for PLS methods. During cross validation, the software removes 
individual or multiple standards and then analyzes them as validation 
standards. If duplicate standards are present in the method, the 
software will remove and analyze all of them during the same cross 
validation iteration. This process removes some bias when calculating 
the recommended number of factors for a PLS analysis. We define 
“duplicate standard” as any standard that has exactly the same 
concentration values as another standard for all components in the 
method.  
 
Two plots are shown at the top of the task window.  
 
 

 
 

Calibration Plots 
 
 
The Calculated versus Actual plot compares the calculated 
concentration value to the actual concentration value for each standard 
that contains the selected component. The calculated values are the 
concentration values that were calculated using the calibrated method. 
The actual values are the known concentration values that were entered 
in the Standards table. The % Difference plot shows the differences 
between the calculated and the actual concentration values relative to 
the actual values.  
 
All of the standards that contain the selected component and have their 
usage set to "calibration," "correction," and "validation" are 
represented in the plots. Calibration standards are represented with 
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circles, validation standards are represented with plus signs (+), and 
correction standards are represented with triangles. You use the Usage 
parameter on the Standards tab to set the usage of each standard. 
 
If a method calculates concentration values perfectly (i.e., the 
calculated value for every standard matches its actual value exactly), the 
data points in the Calculated vs. Actual plot will form a line exactly 45 
degrees from both axes and the data points in the % Difference plot 
will form a horizontal line at exactly zero % difference. A typical % 
Difference plot will show data points distributed randomly above and 
below the zero line within a narrow concentration range. 
 
Outliers show up in the calibration plots as data points that are far away 
from the others. The greater the distance between a data point and 
these ideal lines, the greater is the difference between the calculated 
value and the actual value for the corresponding standard. 
 
If you suspect that a standard is an outlier, check that the 
concentration and pathlength values were entered correctly in the 
Standards table (see Standards tab). You should also display the 
spectrum of the outlier standard. If the quality of the spectrum is poor, 
replace the spectrum with a new one. If the data look okay, consider 
the chemical makeup of the standard and how the standard is used in 
the method. For example, a validation standard is a better indicator of 
the accuracy of a calibration model than a calibration or correction 
standard because calibration and correction standards are used to 
generate the model while validation standards are not. It is up to you to 
decide whether or not an outlier standard should be included in the 
calibration or validation set.  
 
If a pathlength column is displayed in the table, the concentration 
values shown in the plots have been adjusted for differences in 
pathlength. The pathlength adjusted concentration values are the 
calculated and actual concentration values displayed in the table 
multiplied by the appropriate pathlength value.  
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Each data point in the plots is linked to a standard in the table. To 
identify the standard that is associated with a data point in a plot, click 
the data point. The corresponding standard will be highlighted in the 
table. To find the data point that corresponds with a standard in the 
table, click anywhere in the row. The associated data point will be 
highlighted in the plots.  
 
To select the next or previous component in the method, click the 
Next or Back button in the Select Component group. The name (or 
abbreviated name) and index number for the selected component are 
displayed above the buttons.  
 

 
 
When you select another component, the concentration values for the 
new component are displayed in the Standards table and plots.  
 
If the method includes at least two validation standards, TQ Analyst 
calculates a performance index for each component in the method as 
well as an overall performance index for all the components combined. 
The performance indices indicate how accurately a calibrated method 
can quantify the validation standards. The component performance 
values are displayed in the Calibration Results window (see below). 
The overall performance index appears on the TQ Analyst toolbar.  
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Depending on the selected Analysis Type, additional performance 
information may appear on the Calculated verses Actual plot in the 
upper left corner of the Calibration Results window.  
 
For Simple Beer’s Law methods, the information string will look like 
the following: 
 
 Y = 0.0319x + 0.000     Corr. Coeff.: 0.99990 
 
where m equals the slope of the Calculated verses Actual plot and b is 
the Y-axis intercept. The correlation coefficient for the plotted values is 
also provided. The closer this value is to “one” the more linear is the 
relationship between the calculated and actual values for the selected 
component. 
 
If you are calibrating a CLS, PLS or PCR method, the following 
information may also be provided: 
 
 Corr. Coeff.: 0.96762   Bias: 0.231   RMSEC: 0.165 
 
The correlation coefficient provides the same information for these 
methods as it does for Simple Beer’s Law. The RMSEC (Root Mean 
Square Error of Calibration) refers to the uncertainty of calibration for 
the selected component (square error values, calculate the average and 
then take the square root). Bias refers to a systematic difference 
between the expected values and the true values. Bias is reported only if 
the difference is significant (above zero).  
 
When you are finished viewing the calibration results, click the Close 
button on the TQ Analyst toolbar to close the Calibration Results 
window. 
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Specifying the intercept 
for Beer’s Law 

calibration 

If you are creating a Simple Beer’s Law method, you can specify 
whether you want to force each component calibration curve through 
the origin (0,0) or allow the curve to intercept the Y-axis at any point. 

 
The ideal concentration versus absorbance curve is a straight line that 
runs through the origin (0,0). However, certain experimental 
conditions can increase the absorption readings for the standards. This 
effect is more pronounced in standards that contain low concentrations 
of the compound that is being measured than in the higher 
concentration standards. As a result, the real calibration curve may not 
be straight and it may not pass through the origin. The Intercept 
parameter allows you to choose whether you want to use the unaltered 
calibration data to calculate the calibration curve for your method or 
force the curve through the origin. 
 
Use the Intercept list box in the Components table to specify the 
intercept for each component in your method.  
 

To see descriptions of the 
columns in this table, 

click the Explain button 
on the toolbar and then 

click the column 
heading. 

 

 
 

Components Table 
 
 
If the Intercept parameter is set to NonZero, TQ Analyst uses the 
measured absorbance values for all of the standards to calculate the best 
linear fit calibration curve. 
 
When Intercept is set to Zero, the software forces the component 
calibration curve through the origin even if the data points from the 
standards that contain low concentrations of the component are no 
longer on the curve. 
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 Note Forcing the curve to pass through the origin is not the same as adding 

the zero point to the calibration curve. Adding the zero point 
artificially weights the calibration curve in favor of passing through 
zero but does not force it to do so. If you want to add the zero point to 
a component calibration, add a calibration standard that contains zero 
concentration of the component to your method.  
 
 

Validating the 
method 

The final step in developing a quantitative method is to validate the 
method. Validation simply means to verify that the method can analyze 
real world samples with sufficient accuracy.  
 
There are several ways to validate a method using TQ Analyst software. 
For example, if method includes validation standards, you can use the 
performance index and the validation data displayed in the Calibration 
Results task window to evaluate performance. If you did not include 
validation standards in the method, you can prepare a few additional 
standards, analyze them with the completed method and use the results 
to validate the method. You can also use the Cross Validation 
diagnostic to validate a method. All of these options are discussed in 
the sections that follow. 
 
 

Performance index If the method includes at least one validation standard, TQ Analyst 
calculates a performance index during calibration. The performance 
index is a number that indicates how accurately a calibrated method 
can quantify the validation standards. TQ Analyst provides two 
algorithms for calculating the performance index for quantitative 
methods: % Difference (default) and RMSE.  
 

 Note To select which algorithm the software will use to calculate the 
performance index, choose Options from the Edit menu and then click 
the Diagnostics tab. See the glossary entries for % Difference and 
RMSE for details on these performance index algorithms.  
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The software calculates a performance index for each component in the 
method as well as an overall performance index for all the components 
combined. The component performance values are displayed with the 
calibration results (see the previous section). The overall performance 
index appears on the TQ Analyst toolbar.  
 
If you calibrate the method more than once, the overall performance 
value from the previous calibration is retained. This allows you to 
determine whether the changes you make to a method actually improve 
its performance. It’s up to you to decide what is an acceptable 
performance value. 
 
 

Validation data The calibration data from the validation standards are also important 
indicators of performance. If the calculated values for the components in 
the validation standards are close enough to the actual values, your 
method is complete and ready for repeated sample analysis. 
 
If you did not include validation standards, you can still validate the 
method by preparing a few additional standards and using the 
completed method to analyze them.  
 

 Note We do not recommend using calibration standards to validate a 
method. Since calibration standards are included in the calibration 
model, their results would be significantly biased.  
 
You can run the validation standards individually or use the External 
Validation diagnostic routine to run them automatically. External 
Validation can be used to analyze a large group of validation standards 
that are listed in a spreadsheet or text file. The validation data are 
placed in a spreadsheet (Microsoft® Excel®) or text file. See the chapter 
on “Method Diagnostics” in this document for more information on 
External Validation.  
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If the method calculates the component concentrations in the 
validation standards with sufficient accuracy, your method is complete 
and ready for repeated sample analysis.  
 
 

Cross 
Validation diagnostic 

If you are calibrating a quantitative method that does not include 
validation standards, you can use the Cross Validation diagnostic 
routine to evaluate the method’s performance. The Cross Validation 
diagnostic quantifies each calibration standard in the method as if it 
were a validation standard. This is accomplished by sequentially 
removing the specified number of standards from the calibration set, 
calibrating the method and using the new calibration model to quantify 
the standards that were removed from the calibration set.  
 
The process is repeated until all of the standards in the calibration set 
have been quantified as validation standards. You specify the number 
of standards to remove for each iteration in a dialog box that is 
displayed when you start the Cross Validation diagnostic. If the 
method calculates the component concentrations in the validation 
standards with sufficient accuracy, your method is complete and ready 
for repeated sample analysis.  
 
 

Sources of error If the % difference value for one or more components in a validation 
standard is too high, you must identify what caused the error and try to 
correct it. Some typical sources of error are listed below: 

• The concentration of a component in a standard is incorrect. 

• The concentration of a component in a standard was entered 
wrong. 

• The standards don’t accurately describe the component’s 
absorbance versus concentration behavior (i.e., there are too few 
standards or the concentrations of the standards are not spaced 
correctly). 
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• Spectral errors caused by sampling, instrument noise, or strong 
absorptions are present in the calibration spectra. 

• The analysis region or regions don’t correlate well with changes in 
component concentrations. 

• Other components in the standards are producing interfering peaks 
in the analysis region for this component. 

• An inappropriate pathlength treatment was chosen. See “Choosing 
a Pathlength Option” in this chapter for more information. 

 
Continue checking for errors and recalibrating the method until the 
validation results for all components are acceptable. If you are sure the 
method is free of errors but the calculated concentrations for one or 
more components still differ significantly from the actual 
concentrations and the errors tend to change regularly as a function of 
concentration, you may need to calculate a correction curve for that 
component. See “Correcting Component Linearity” for more 
information. 
 
 

Correcting 
component linearity 

If the absorbance vs. concentration plot for a component in a 
quantitative method is slightly curved instead of linear, you can use the 
Corrections tab to set up a correction curve for the component. You 
may also generate a bias correction. 
 

To see descriptions of 
the items in this 

window, click the 
Explain button on the 

toolbar to open the 
Explain help window 

and then click the 
item. 

 
Corrections Tab 
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 Note The Corrections tab is not available for Simple Beer’s Law methods.  
 
There are two types of corrections you may specify:  linearity 
corrections and bias corrections. You may specify a different correction 
for each component in the method.  
 
If you’re not sure whether corrections are needed, press the Suggest 
Corrections button on the Corrections tab. The Corrections wizard 
uses the performance index to determine if corrections will improve the 
method’s performance for each component. If a linearity correction is 
chosen, the wizard increases the order of the correction curve until the 
predicted results from the validation spectra no longer improve or an 
inflection occurs in the correction curve. The spectral information used 
to determine the correction for the selected component, the suggested 
curve order, and the coefficients and performance index for the selected 
curve order are displayed in the Corrections task window.  
 

 Note If you think a bias correction may be needed due to a slight change in 
experimental conditions, collect a few standards under the new 
conditions and set their Usage (Standards table) to “Correction.” Then 
run click the Corrections tab, set Correction Standards to “Correct 
with correction standards only” and then click Suggest to run the 
Corrections wizard. A bias correction will be recommended only if the 
wizard finds a significant bias between the original calibration curve 
and the correction curve.  
 
A different correction curve may be recommended for each component. 
Use the Back and Next buttons in the Corrections task window to 
display the recommended correction for each component in the 
method. 
 
If you want to use the recommended corrections exactly as you see 
them, click the Close button on the TQ Analyst toolbar. The 
recommended corrections are saved automatically when you close the 
Corrections task window. If the check box for Calculate Coefficients 
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After Each Calibration in the Corrections task window is on, the 
wizard will reevaluate the corrections each time you calibrate the 
method and, if necessary, update the correction coefficients.  
 

 Note The settings for the other correction parameters (Curve Order and 
Force Through Zero) will not be updated even if the Calculate 
Coefficients After Each Calibration check box is on.  
 
When you use the method to quantify a corrected component, a 
correction factor is extracted from the curve and applied to the 
component results before they are reported. The final result is the 
corrected concentration. 
 
 

Editing 
correction parameters 

You may edit the recommended correction for any component by 
changing the settings in the Corrections task window. To display the 
Corrections task window, click the Edit Correction button on the 
Corrections tab. 
 
For brief instructions on how to interact with the Corrections task 
window, click the How To button in the window. To see a detailed 
description of a feature in the Corrections task window, open the 
Explain window and then select the feature. The information in the 
Explain window will change each time you select another feature in the 
Corrections task window. 
 
Use the Correction list box in the Edit Correction group to choose the 
type (linearity or bias) and degree of correction. If you don’t want to 
apply a correction to a component calibration, set the Correction list 
box to “No Correction.” You can also force the curve through the zero 
point by turning on the Force Through Zero check box.  
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 Note If you are measuring component concentrations that are close to zero, 
you may improve the accuracy of your method by forcing the 
component correction curve through the origin. We do not recommend 
forcing the curve through the origin if you are measuring component 
concentrations which are well above zero.  
 
If you change either of these settings, the new correction curve is 
calculated and immediately displayed. The curve coefficients and the 
method performance index are also updated.  
 
If you want to enter values for the correction coefficients, you must first 
turn off the Calculate Coefficients After Each Calibration check box at 
the bottom of the Corrections window. When the check box is off, the 
fields in the Coefficients table become active. Then type the value for 
each correction coefficient in the appropriate field. 
 
If you edit the correction parameters for one or more components, 
leave the Calculate Coefficients After Each Calibration check box off. 
This prevents the Corrections wizard from updating the correction 
coefficients and overwriting the values you specified each time the 
method is calibrated.  
 

 Notice When the Calculate Coefficients After Each Calibration check box is 
off, the correction coefficients will not be updated, even if you change 
the method so that the correction is no longer valid. You must be sure 
to check any specified corrections each time you calibrate the 
method.  
 
If you want to edit the linearity correction for another component, use 
the Back or Next button in the Corrections task window to select the 
component, then repeat the procedure described above to edit the 
correction parameters. 
 
When you are finished editing the correction parameters for all 
components, click the Close button on the TQ Analyst toolbar to close 
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the Corrections task window. The corrections you specified will be 
saved automatically. 
 
 

Where to 
go from here 

Method development is an iterative process. Take time to try the 
options available for developing a quantitative method to see if there is 
room for further improvement. We also recommend reviewing the 
information on quantitative methods in the chapter called “Principles 
of TQ Analyst” at the beginning of this document.  
 
Each time you make a significant change to the method, calibrate the 
method and look at the performance indices for the component you are 
trying to improve. If the new performance index is higher than the 
previous one, keep going. If the performance index goes down, undo 
the changes you made to the method since the last calibration. 
 
TQ Analyst also provides a collection of useful diagnostic routines for 
quantitative analysis. See the chapter called “Method Diagnostics” in 
this document for more information. Detailed explanations of the 
diagnostic displays, including tips on how to interpret the diagnostic 
results, are also available on-line by pressing the Explain button when 
the diagnostic window is open.  
 
If you need information on updating the calibration data or setting up 
sample reports, individual chapters on those topics are provided later in 
this document.  
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 9 Creating a Classification Method 
 
 
 
Read this chapter to learn how to build a successful classification 
(qualitative) method using TQ Analyst software. The following topics 
are covered: 

• Defining the problem 

• Choosing a sampling technique 

• Creating a new method file 

• Giving the method a title 

• Selecting a classification technique 

• Choosing a pathlength option 

• Defining the method classes 

• Collecting the standards 

• Selecting the analysis regions 

• Customizing the method 

• Saving the method 

• Calibrating the method 

• Validating the method 

• Where to go from here. 
 
Most of the operations described in this chapter are carried out in a 
method window. The method window is broken into a series of tabs. 
The tabs that appear when one classification method type is selected may 
be different from the tabs that appear for another classification method. 
There are more tabs for Discriminant Analysis methods, for example, 
than for the Search Standards analysis type.  
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The tabs are arranged in an order that is convenient for creating a 
classification method. If you select the tabs in sequence from left to 
right, starting with the Description tab, they will lead you step by step 
through the method development process. 
 
If you need information on updating the calibration data, running 
method diagnostics, or setting up sample reports, individual chapters 
on those topics are provided later in this document.  
 
If you want to create a quantitative method or one that only measures 
and reports spectral information, skip this chapter. Instructions for 
creating quantitative and spectral measurement methods are provided in 
other chapters of this document.  
 
 

Wizards for 
classification 

methods 

TQ Analyst offers a number of wizards to help you complete each 
classification method development task. From choosing the proper 
settings for method parameters to setting up your experimental design, 
the wizards can help make even your first attempt at developing a 
method a success.  
 
The following table gives brief descriptions of the wizards available for 
creating classification methods. 
 
 

Location Wizard Function 
 
Description 
tab 

Suggest 
Analysis Type 

Recommends a setting for the 
Analysis Type parameter. 

Regions tab Suggest 
Regions 

Chooses appropriate spectral 
regions for the analysis. 
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To start a wizard, click the appropriate button on the specified tab. For 
example, to start the Analysis Type wizard, click the Suggest Analysis 
Type button on the Description tab.  
 
The wizards are intended to be used in the order shown in the table 
above. You may use the wizard’s recommendations, alter them, or 
overwrite them completely. We suggest using the wizards’ 
recommended settings as a starting point. Then add your knowledge of 
spectroscopy and the chemical system you are measuring to determine 
the optimum settings. 
 
To learn the important steps and considerations for good classification 
method design and understand how to get the most out of the wizards, 
we recommend reviewing all of the material in this chapter in the order 
in which they are presented.  
 
 

Defining  
the problem 

TQ Analyst offers a variety of techniques for comparing and 
identifying unknown samples based on the spectra of known materials. 
These “classification” techniques are all qualitative measurements 
because they can tell you what’s in a sample (or which class it belongs 
to), but not how much of a component the sample contains. In other 
words, classification methods can’t produce concentration values like 
quantitative methods. However, you can set up a classification method 
that classifies samples based on target concentrations of a specific 
component or combination of components. In this case, each class 
defines one of the target concentrations. Qualitative techniques can 
also indicate how closely a sample matches a group of known materials 
so you can distinguish “good” samples from “bad” ones.  
 
There are a number of factors to consider when setting up a 
classification method using absorption spectroscopy. The most 
important considerations are the number of different materials (or 
different quantities of the same material) the algorithm must 
distinguish, the number of standards available to define each known 
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material and the quality of the spectral information available for the 
standards and unknown samples. Each of these factors plays an 
important role in helping you determine the proper experimental 
design. 
 
The first step in creating a classification method is to define the 
analytical problem by answering the following questions: 
 

How much information do you have about the unknown samples? 
What do you want to compare them to? 
What information is needed from the comparison?  

 
For example, are you simply trying to verify the purity of a known 
sample or determine whether it is compound a, b, or c or are you 
trying to identify a material that is completely unknown? 
 
The answers will help you choose an appropriate sampling technique 
and define the experimental conditions that will be used for the 
analysis. 
 
 

Choosing a 
sampling technique 

Once you’ve defined the problem, the next step is to choose a sampling 
technique and define the experimental conditions for the analysis. In 
many cases, the physical characteristics of the sample dictate the 
sampling technique. For example, if you are analyzing different grades 
of cellulose, you might use an integrating sphere to collect the sample 
data. Other samples, such as an edible oil, might require a quartz 
cuvette for transmission analysis.  
 
Choosing the optimum sampling technique for the material you want 
to measure is a critical step in achieving accurate classification results. It 
requires knowledge of spectroscopy and the effects of interferences, 
which can adversely affect your results.  
 



 

236 TQ Analyst User’s Guide Thermo Fisher Scientific 

The instrumentation industry offers a wide range of tools and 
accessories for material sampling and analysis. Each has benefits and 
drawbacks which may or may not be important to your analysis. Select 
the technique that consistently produces a quality spectrum with the 
least amount of effort and expense. 
 
You generally have some latitude in setting the experimental 
conditions. Two characteristics of spectral data that are especially 
important to qualitative measurements are spectral resolution and 
signal-to-noise ratio.  
 
Increasing spectral resolution may improve a classification method’s 
ability to distinguish classes. Remember, the smaller the resolution 
value, the higher (better) is the resolution. Keep in mind however, that 
the signal-to-noise ratio of the spectrum decreases as the resolution 
increases so you may want to also increase the number of scans (or the 
collection time). If you’re still not getting the resolution and peak 
shape you need after increasing the resolution, try another sampling 
technique. 
 
When creating classification methods, we recommend collecting or 
converting the spectra to absorbance or log (1/R) units. Since these 
units tend to vary linearly with concentration and many qualitative 
methods need to distinguish classes based on component concentrations, 
they are preferred for classification analyses. If you want to work with 
derivative spectra, use the Data Format parameter on the Spectra tab to 
make the derivative conversion. See the chapter on “Processing Spectral 
Data” in this document for information on setting Data Format. 
 
 

Creating a 
new method file 

The first step in creating a method using TQ Analyst is to create a new 
method file. A method file contains all of the parameters that define 
how your method will operate. Your method must contain valid 
settings for all of the method parameters before it can be calibrated or 
run.  
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To create a new method file: 
 
1. Choose New Method from the File menu. 
 
 The method parameters are displayed in a new method window. 

The Description tab, which contains the first group of method 
parameters, is already open.  

 
 
2. Choose Save Method As from the File menu.  
 
 The Save Method As dialog box is displayed.  
 
 
3. Type a file name for the new method in the File Name box and 

select the directory and disk where you want the method saved. 
 
 
4. Choose OK. 
 
 When you create a new method file, the method parameters are 

automatically set to their default values. You can change any of the 
parameter settings or use the default settings. 

 
 Note Save your method frequently while creating the method or editing the 

method parameters.  
 
 

Giving the 
method a title 

Use the Method Title box on the Description tab to enter a title for 
your new method.  
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You will use the method titles along with their file names to select a 
method to open. The title can also be displayed or printed with the 
analysis results. 
 
You may enter a longer description of the method in the Method 
Description box. You may also enter your name in the Developer’s 
Name box so people know who created the method.  
 
The Method Description and Developer’s Name parameters are also on 
the Description tab. Use the scroll bar to bring these parameters into 
view. 
 
 

Selecting a 
classification 

technique 

Another important step in developing a classification method is choosing 
the technique that will be used to compare and classify the unknown 
samples. The Analysis Type parameter on the Description tab provides 
a range of techniques for classifying samples (see the list below).  

 
 
 
 

To see detailed 
descriptions of the 

options for classification 
methods, click the 

Explain button on the 
toolbar to open the 

Explain help window and 
then click each option in 

the software. 
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All of the classification methods compare the spectrum of an unknown 
sample with the spectra of one or more groups (classes) of known 
materials (standards). Similarity Match and Distance Match methods 
may be used to compare the spectrum of an unknown material to a 
single group (class) of similar standards. Discriminant Analysis, 
Distance Match and QC Compare search methods are typically used to 
compare an unknown to several classes of standards in order to find the 
best matched class. A Search Standards method compares the unknown 
to many different materials, where each material is represented by only 
one standard, and finds the closest match. 
 
A Search Standards method uses only one standard to define each class 
(TQ Analyst consider each standard as a separate class). Similarity 
Match methods need at least one standard in each class but allow 
multiple standards per class. The other method types use statistical 
algorithms to determine similarity and thus require at least two 
standards to define each class. 
 
The various classification methods also differ in the kind of 
information they provide about an unknown sample. For example, a 
Similarity Match method compares the unknown sample to a single 
class of standards and reports a match value, which is a measure of 
similarity. A Search Standards method reports the index number and 
title of each selected class (standard) as well as a match value between 0 
and 100. 
 
The result of a discriminant analysis is the name of the class that is most 
similar to the unknown sample spectrum and a measurement of the 
distance between the unknown sample and each reported class. The 
closer each distance value is to zero, the better is the match. 
 
The result of a QC Compare search is the single best match from each 
reported class. The classes are listed in order of importance; the class 
that contains the best matched spectrum is listed first. The index 
number of each standard is given as well as a match value between 0 and 
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100. The match value tells you how well the standard matches the 
unknown. A match value of 100 indicates a perfect match. 
 
The result of a Distance Match method is the percentage of frequencies 
that exceed a specified distance threshold. The answers will range from 
100 to 0, where 0 (percent frequencies exceeding the threshold) is a 
perfect match. If one class is defined in the method, the software 
reports the distance value for that class. If multiple classes are used, the 
software reports the class name and distance value for the specified 
number of classes. The best matched class (the one with the smallest 
distance value) is listed first.  
 
The basic concepts behind the classification techniques are summarized 
in the table below. 
 
If you . . . Then use . . . 

are interested in monitoring the  Similarity Match 
purity of a material being produced Distance Match 
by some process 

want to screen incoming materials to  Discriminant Analysis 
determine if they are compound a, b, or c Distance Match 
 QC Compare search 

are trying to identify a material that  Search Standards 
you know little or nothing about 
 
Unlike the quantitative group, there is no “Undecided” option for 
classification methods. You must select a classification option in the first 
stage of development. If you need help choosing a classification option, 
TQ Analyst provides a wizard to help you decide. To start the wizard, 
click the Suggest Analysis Type button on the Description tab and 
follow the path for qualitative methods. The wizard poses a series of 
questions and then selects a classification option based on your 
answers.  
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You are free to change the recommended classification option (Analysis 
Type) setting at any time. If you still can’t decide, we recommend 
starting with the Discriminant Analysis option because it provides the 
most flexibility and produces a more thorough classification report. 
You can always switch to another technique later if the results from the 
first attempt are unsatisfactory or try several techniques and choose the 
one that classifies your samples with the most accuracy.  
 
Each time you change the analysis type, the main TQ Analyst window is 
reconfigured so that only the method tabs and parameters which are 
needed to develop the type of method you selected are displayed on the 
screen. If you switch the analysis type between two options in the same 
group, for example if you change from Similarity Match to 
Discriminant Analysis, the information you entered and the settings 
you chose for the previous analysis type will be saved.  
 
Use the Explain Help feature of your TQ Analyst software to see 
detailed descriptions of the classification options available in 
TQ Analyst or see the chapter called “Principles of TQ Analyst” in this 
document. 
 
 

Choosing a 
pathlength option 

Sample pathlength (thickness) is important to classification analyses 
because it affects the concentrations of the sample components. This is 
especially true for Distance Match and Discriminant Analysis methods 
when the method must discriminate between various materials that 
contain different amounts of a key compound.  
 
If the pathlengths of the standards and the unknown samples are 
different and component concentrations are important to your 
classification analysis, the method should include a pathlength 
correction to account for the differences. A pathlength correction may 
also allow you to tighten class distribution for spectra that have 
significant anomalies, due to scattering or some other problem.  
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The parameters on the Pathlength tab define how the method will 
handle sample pathlength. TQ Analyst offers the following pathlength 
options for Similarity Match, Distance Match and Discriminant 
Analysis methods.  
 

To see detailed descriptions 
of these pathlength options, 
click the Explain button on 

the toolbar and then click 
each option in the software. 

 
 

 Note No pathlength options are available for the Search Standards and QC 
Compare search classification techniques. If you are creating a Search 
Standards or QC Compare search method, skip to the section titled 
“Collecting the Standards.”  
 
Some of the pathlength options require additional information, such as 
a pathlength peak or region. If a pathlength option requires additional 
information, parameters for entering the information will appear on 
the Pathlength tab when that pathlength option is selected.  
 
In most cases, your sampling technique will dictate the correct 
pathlength option (usually Constant, which means it has no effect on 
your spectral data). You may also try several pathlength types and then 
choose the one that produces the best results. Here are some brief 
guidelines: 
 
If sample pathlengths are... 

Always the same Constant 

Use this pathlength type... 

Variable and unknown but  Peak Ratio 
 Pathlength peak exists 

Variable and unknown and MSC 
 no Pathlength peak exists SNV 
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The Peak Ratio, MSC and SNV pathlength options all correct the 
spectral data rather than the calculated concentration values. 
Pathlength corrections that operate on the calculated concentration 
values would be useless for a classification method since no 
concentration values are available.  
 
If you are creating a classification method that contains standards 
collected at different pathlengths and you can find a peak that varies 
only with pathlength, use the Peak Ratio pathlength option. The Peak 
Ratio pathlength correction is especially useful for Distance Match and 
Discriminant Analysis methods when the method must discriminate 
between various materials that contain different amounts of a key 
component. Peak Ratio scales the spectrum based on the pathlength 
peak, leaving the concentration differences intact.  
 
If the pathlengths of the standards and the unknown samples are 
different but you can’t find a peak that varies only with pathlength, use 
the MSC or SNV pathlength correction.  
 
If the pathlengths of the standards and the unknown samples are all the 
same, use the Constant pathlength option. 
 
For descriptions of the Constant, Peak Ratio, MSC and SNV 
pathlength options, see the sections with those names in the chapter 
called “Principles of TQ Analyst” at the beginning of this document.  
 
 

Defining the 
method classes 

If you are creating a Discriminant Analysis or QC Compare search 
method, the next step is to define the groups (classes) the unknown 
samples will be compared to.  
 

 Note If you are creating a Similarity Match or Search Standards method, you 
don’t need to specify classes. Skip to the next section, titled “Collecting 
the Standards.”  
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Use the Classes tab to enter information about the classes of spectra in 
a Discriminant Analysis or QC Compare search method (see the 
picture below).  
 
 

 
 
 
 

To see descriptions of 
the items in this 

window, click the 
Explain button on the 

toolbar to open the 
Explain help window 

and then click the 
item. 

 
 

Classes Tab 
 
 
A unique name must be specified for each class. The class names are 
entered in the Classes table. When you use the method to analyze a 
sample spectrum, the class names will be displayed or printed along with 
the analysis results. 
 
To enter the class names: 
 
1. Select the Classes tab. 
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2. Click in the first row of the Class Name column and type the 
name of the first class. 

 
 
3. Press Enter.  
 
 TQ Analyst adds a blank row to the end of the table.  
 
 
4. Continue entering class names until all of the classes have been 

specified. 
 
 
5. Use the Abbrev column to enter abbreviated names for each 

class.  

 The abbreviated name will be used whenever the full class name 
doesn’t fit in the available space. If no abbreviated names are 
entered, the default abbreviations are used. 

 
 

Collecting 
the standards 

When you are finished selecting a classification technique, defining the 
method classes and selecting a pathlength option, you are ready to 
collect the standards that will be used to develop and validate the 
method. This section defines the various kinds of standards used in 
classification methods and explains how to choose standards and collect 
their infrared spectra.  
 
 

What are standards? For classification analyses, standards are simply samples that have the 
characteristic you want to track. For example, if you want to set up a 
method that classifies materials based on composition or purity, you 
don’t need to know everything that is present in the standards. 
However, you must know which class each standard belongs to.  
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TQ Analyst uses two kinds of standards for classification methods:  
calibration standards and validation standards.  
 
Calibration standards are used during the method calibration step to 
build a distribution model, if one is needed. In order to do this, you 
must specify the class for each calibration standard in the method. If 
your classification method does not use a distribution model (models 
are not used for Search Standards and Similarity Match methods), the 
calibration standards are simply used for comparison. We may also 
refer to the calibration standards as the “calibration set.”  
 
Validation standards are used to evaluate the performance of a 
calibrated Discriminant Analysis or QC Compare search method 
(Similarity Match and Search Standards methods do not use validation 
standards). You must specify the class for each validation standard 
included in your method. Validation standards are an unbiased test of 
performance because they are not used to calculate the distribution 
model. Each time you calibrate a Discriminant Analysis or QC 
Compare search method, the software uses the new distribution model 
to classify the validation standards.  
 
Validation standards – a measure of performance 
Although validation standards are not required to calibrate or run a 
Discriminant Analysis or QC Compare search method, they are key to 
the TQ Analyst philosophy. The software uses the validation standards 
to calculate a method performance index after each calibration. You can 
use the performance index to track the performance of your method as 
you develop or modify it. We strongly recommend that you include a 
few validation standards in every Discriminant Analysis or QC 
Compare search method you develop. If you don’t, you will miss out 
on this powerful feature of your TQ Analyst software. 
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Choosing standards for 
classification methods 

Choosing the proper standards is probably the most critical factor in 
achieving accurate classification results. For example, if you don't 
include enough standards or if they don’t describe all of the variation in 
a class, the distribution model may not accurately describe the behavior 
of the samples you want to classify.  
 
Consider the following guidelines before you begin selecting standards 
for a classification method. 
 
• Use sufficient quantity.  

To determine the number of standards required for each class, 
consider the classification technique. The Search Standards 
technique allows only one standard per class. All of the others 
require multiple standards to define each class.  
 

• If the method requires multiple standards, we generally 
recommend using at least three standards per class. The key point is 
to make sure you include enough standards to adequately represent 
the variation you expect to see in the samples the method will 
classify. In general, the more standards used to define a class the 
better it will represent “real world” samples. However, be careful 
not to overrepresent certain variations (by using too many 
standards that have the characteristic) so the distribution is well 
balanced. 
 
If you are creating a Discriminant Analysis or QC Compare search 
method, be sure to include at least two additional standards that 
can be used to validate the distribution model (at least one 
validation standard per class is ideal). The validation standards 
should represent a typical spectrum in the corresponding class. See 
the section titled “What are Standards?” to learn how TQ Analyst 
uses validation standards to measure method performance.  
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• Use representative mixtures.  
The composition of the standards should be similar to the 
composition of the samples you want to measure. This insures that 
baseline features are handled properly and that all substances in the 
sample are properly modeled. This is especially true for Search 
Standards methods, which use only one standard to define each 
class. If you are creating a method that allows multiple standards 
per class, make sure you include examples of any variation you 
expect to see in the unknown samples. The calibrated method can 
then model this variation and classify the unknown samples with 
greater accuracy. 

 

Optimizing the 
collection parameters 

The standards must be collected in the same way you will collect the 
spectra of the unknown samples, using the same data collection 
parameters and the same spectrometer, if possible. The spectra of the 
standards should be of the highest achievable quality. Assuming that 
the sampling technique is reproducible, spectral quality is determined 
mainly by the resolution and signal-to-noise ratio of the spectral data. 
The parameters that define resolution and signal-to-noise ratio are part 
of the data collection parameter set.  
 
Use the Collection Parameters button on the Standards tab to display 
the data collection parameters. See the chapter called “Working With 
Standards” in this document for more information.  

 
 Note If the Collection Parameters button does not appear in your 

TQ Analyst application, data collection is disabled in TQ Analyst. You 
must use your spectral analysis application, such as RESULT, to set the 
data collection parameters. See the documentation that came with your 
spectral analysis software for more information.  
 
Once the parameters have been set, we recommend using the chosen 
settings to collect all of the calibration and validation standards as well 
every unknown sample you use the method to analyze.  
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 Note If you change the setting for a collection parameter after opening or 
collecting the spectra of one or more standards, TQ Analyst may warn 
you that the parameter setting should not be changed at this point. 
You will be given the option of overriding the warning or creating a 
new method with the new parameter settings.  
 

Collecting the 
spectra of the standards 

Once the standards are prepared and the optimal parameter settings 
defined, the calibration spectra must be carefully collected and stored 
on a disk.  
You can use TQ Analyst or another Thermo Scientific spectral analysis 
package, such as OMNIC or RESULT, to collect the calibration spectra. 
To collect the spectrum of a standard in TQ Analyst, click the Collect 
Standard button on the Standards tab.  
 

 Note If the Collect Standard button does not appear in your TQ Analyst 
application, data collection is disabled in TQ Analyst. You must use 
your spectral analysis application, such as RESULT, to collect 
standards. See the documentation that came with your spectral analysis 
software for more information.  
 
The process for collecting a spectrum in TQ Analyst is exactly like the 
process for collecting a spectrum in your Thermo Scientific spectral 
analysis software. Refer to the documentation that came with that 
software for step-by-step instructions.  
 
Depending on how the data collection parameters are set, you may be 
prompted to collect a background spectrum or enter a spectrum title 
during data collection. If you don’t enter a title during collection, the 
date and time of collection will be used. The new spectrum will be 
added to the open row at the bottom of the Standards table and saved 
in the method standards library. 
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 Note When you collect a spectrum to use as a standard, TQ Analyst saves 
only a portion of the collection and processing information that is 
normally stored in a Thermo Scientific spectral data file. If you want to 
save all of the collection and processing information for your standards, 
save the standards as Thermo Scientific spectral data files by turning on 
the Save Automatically check box in Experiment Setup before collecting 
the standards. (Click the Collection Parameters button on the 
Standards tab to display the Experiment Setup dialog box. Save 
Automatically is located in the File Handling group on the Collect 
tab.)  
 
As you collect the spectra, be sure to note any special sampling 
conditions that may affect the spectral data, such as the temperature 
and pressure of a gas cell, the cell pathlength or the packing pressure of 
a diffuse reflectance accessory.  
 
If you are collecting the spectra outside of TQ Analyst, be sure to name 
and save each spectrum in a file when you are finished collecting it. 
Then use the Open Standard button on the Standards tab to add each 
spectrum to the Standards table. See the chapter called “Working With 
Standards” in this document for more information.  
 

 Note If a warning message about mismatched standards appears when you 
open additional standards, the parameter settings used to collect the 
new standard are significantly different from the settings that are saved 
with the current method. For optimum performance, all method 
standards should be collected using the same settings for the collection 
parameters. You can deal with the warning three ways: collect the 
standard again using the proper settings for the collection parameters, 
edit the settings in the current method, or ignore the warning and 
continue adding standards.  
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Specifying 
class and usage 

After adding each spectrum to the Standards table, you must indicate 
how it will be used in the method. For example, if you are creating a 
Discriminant Analysis, Distance Match, or QC Compare search 
method, you must specify the class each standard belongs to and how 
each standard will be used in the method. Similarity Match and Search 
Standards methods only require information about usage. 
 
 

Selecting the class If you are building a Discriminant Analysis, Distance Match, or QC 
Compare search method, a column labeled “Class” appears in the 
Standards table. Use the Class column to specify the class each standard 
belongs to.  
 
To select the class for a standard, choose an option in the Class list box. 
The items in the list box are the classes that are specified on the Classes 
tab. If no class names were entered on the Classes tab, the Class list box 
in the Standards table will be blank. 
 

 Note You must enter class names and specify the class each standard belongs 
to before calibrating the method.  
 
 

Specifying Usage The column labeled “Usage” in the Standards table allows you to 
specify how each standard will be used in the method. To set the usage 
for a standard, simply choose an option in the Usage list box. 
 
For Discriminant Analysis and Distance Match methods, you can set 
the usage to “calibration,” “validation,” or “ignore.” Standards that are 
specified as “calibration” will be used to create the distribution model 
during calibration. Validation standards will be used to evaluate the 
performance of a method once the method is calibrated. The results 
from the validation standards are also used to calculate the performance 
index. Use the “ignore” setting to temporarily exclude a standard from 
the method. 
 



 

252 TQ Analyst User’s Guide Thermo Fisher Scientific 

The standards in a Similarity Match, QC Compare search, or Search 
Standards method can be set to “calibration” or “ignore.” Use the 
“calibration” setting for standards that you want to include in the 
comparison. If you want to temporarily exclude a standard from the 
method, set its usage to “ignore.”  
 
 

Selecting the 
analysis regions 

The final step in building a method is to identify the usable spectral 
information in the standards. We recommend using as much of the 
spectral information as possible for classification methods. However, the 
following features should be excluded: 

• Peaks or regions that are totally absorbing (for example, absorbance 
values that are higher than 1.5 absorbance units or 1.5 log 1/R 
units).  

• Regions that contain excessive random noise. 

• Peaks or regions that you know are unrelated to the measured 
components, such as those from carbon dioxide or water. 

 
If you want the software to select the regions, use the Regions wizard 
on the Regions tab. The wizard starts automatically when you select 
the Regions tab.  
 

 Note If the Pathlength Type is set to Peak Ratio, make sure you specify a 
pathlength peak before running the Regions wizard. To specify a 
pathlength peak, click the Pathlength tab and enter appropriate values 
in the Pathlength Region table. If you start the Regions wizard without 
specifying a pathlength peak, the wizard will reset the Pathlength Type 
to Constant.  
 
For most classification applications, all of the useful information in the 
spectrum is used in the analysis. The wizard provides a few tips on the 
types of peaks or regions you should exclude from the analysis.  
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When you are finished interacting with the wizard, click the Edit 
Regions button on the Regions tab. The Region Selection task window 
appears on the display.  
 

 
 

To see a description of 
an item in this task 

window, click the 
Explain button on the 

toolbar to open the 
Explain help window 

and then click the 
item. For step-by-step 
instruction on editing 

regions, click the How 
To button in the task 

window. 

 
 

Region Selection Task Window 
 
The spectra of the first three standards that are listed in the Standards 
table are displayed in the graphical window and one analysis region is 
recommended. The recommended region will contain all of the data 
points between the X-axis limits of the displayed spectra. Additional 
information about the selected region is provided in the Regions table, 
located at the bottom of the Region Selection task window.  
 
Since region selection is usually an iterative process, the recommended 
region should be considered only as a starting point. You may need to 
adjust the region or other settings in the Region Selection task window 
to achieve the best results. Any changes you make to the Region 
Selection task window will be saved automatically when you close the 
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window. To close the task window, click the Close button on the 
TQ Analyst toolbar. 
 
To display the Region Selection window after one or more regions 
have been selected, click the Edit Regions button on the Regions tab. 
 
 

Customizing 
the method 

If you have been following the guidelines provided in this chapter, your 
method contains all of the information needed for calibration, 
including: 

• Descriptions of the classes. 

• Representative standards measured using reproducible sampling 
technique. 

• Spectral regions which correlate to known component information. 
 
Depending on the classification technique (Analysis Type) you 
selected, there are other features and settings in the software that may 
be used to customize your method. For example, if you want to 
calculate derivative spectra or apply smoothing or baseline correction, 
turn on the check box for Allow Spectral Processing on the Standards 
tab. (See the chapter called “Processing Spectral Data” in this 
document for more information.) 
 
Use the parameters on the Report tab to configure the sample reports. 
See the section on “Setting Up Sample Reports” in the chapter called 
“Preparing a Method for Sample Analysis” for details.  
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To see detailed 
descriptions of the 

features on the Report 
tab, click the Explain 
button on the toolbar 

to open the Explain 
help window and then 

click the feature.  

 
 

Report Tab for Discriminant Analysis Method 
 
The parameters on the Other tab allow you to customize certain 
features of a classification method, such as the number of principal 
components used for a Discriminant Analysis method or the search 
algorithm for a Search Standards method. 
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To see detailed 
descriptions of the 

features on the Other 
tab, click the Explain 
button on the toolbar 

to open the Explain 
help window and then 

click the feature.  

 
 

Other Tab for Discriminant Analysis Method 
 
Feel free to consider or try all of the features included in your method. 
If you don’t have time to review them or don’t need special 
enhancements, leave the default settings provided in the software. 
TQ Analyst is designed to provide a working method with a minimum 
of effort.  
 
The method should produce acceptable results for most sample types 
when the method parameters are set to their default values. To see the 
default settings for a classification method, choose New Method from 
the File Menu and set the Analysis Type to one of the classification 
options. 
 
If you prefer using other method specifications or have specifications 
you need to follow, you may change the settings for any method 
parameter at any time. 
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Saving the method We recommend that you save your work regularly when creating or 
editing methods. Be sure to save the method again before you calibrate 
it. 
 
To save your method: 
 
1. Select the method you want to save by clicking the method 

window or by choosing the method name in the Window menu. 
 
 
2. Choose Save Method from the File menu. 
 
 If the method does not have a file name, the Save Method As 

dialog box appears.  
 
 
3. If the Save Method As dialog box appears, type a file name and 

select the directory and disk where you want the method saved.  
 
4. Choose OK. 
 
 

Calibrating 
the method 

When you are finished selecting a classification technique, choosing a 
pathlength option, defining the classes, collecting the standards, 
selecting the analysis regions and saving, your method is ready for 
calibration. For discriminant analysis methods, calibration produces the 
distribution model that will be used to classify the unknown samples. 
No distribution model is created for similarity match, search standards 
and QC Compare search methods. However, the software uses the 
“calibration” step to test the method for consistency and proper 
experimental design.  
 
To calibrate a classification method, click the Calibrate button on the 
TQ Analyst toolbar. Calibration takes only a second. When calibration 
is completed, the calibration readout on the TQ Analyst toolbar 
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changes from red to green and the “Uncalibrated” message changes to 
“calibrated.”  
 
When you calibrate a discriminant analysis method, the software 
calculates a distribution model and then uses the model to classify the 
method's calibration standards. If validation standards are specified in 
the method, the validation standards are also classified. The calibration 
data are displayed in the Calibration Results task window.  
 
 

 
 
 

To see descriptions of 
the items in this 

window, click the 
Explain button on the 

toolbar to open the 
Explain help window 

and then click the 
item. 

 
 

Calibration Results Task Window 
 
 
The information provided in the Calibration Results task window can 
help you identify standards that were assigned to the wrong class and 
possibly understand why they were misclassified.  
 
The table in the lower half of the task window shows the actual and the 
calculated class as well as the distance value for each standard in the 
method. The name and distance value for the next closest class are also 
provided.  
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Calibration Results Table 
 
 
If you want to see the distance value between a standard and one of the 
other classes in the method, use the Back or Next button in either the 
Select X-axis or Select Y-axis group to select the class. When you select 
a new class, a column for the selected class appears in the table showing 
the distance between each standard and the selected class. 
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The pairwise distance plot is shown at the top of the task window.  
 

 
 

Pairwise Distance Plot 
 
The plot shows graphically the Mahalanobis distance between each 
standard and the two classes that are selected for the X- and Y-axis of 
the plot. Mahalanobis distance is an algorithm for calculating the 
distance of a sample from the mean of a set of standards.  
 
Data points that correspond with the calibration and validation 
standards for the class that is selected for the Y-axis are represented 
with triangle symbols. Squares are used to represent the standards that 
define the class that is displayed on the X-axis. If data points for other 
standards fall within the displayed range for the X- or Y-axis, they will 
be displayed as circles. 
 
Data points for validation standards are displayed in a different color 
than the points for the calibration standards so you can distinguish 
them. You use the Usage parameter on the Standards tab to set the 
usage of each standard. 
 
Use the Back and Next buttons in the Select Y-axis and Select X-axis 
groups to select which class is assigned to each axis in the plot. When 
you select a new class, the name (or abbreviated name) and index 
number of the new class are displayed below the group name.  
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TQ Analyst calculates boundaries for each class based on the number of 
standards in the class. The boundaries, displayed as perpendicular gray 
lines in the pairwise distance plot, show the 95% confidence intervals 
for the two classes that are selected for the X- and Y-axis.  
 
Use the Pairwise Distance plot to compare the standards for all of the 
classes in your method. If all of the calibration and validation standards 
for the class that is selected for the X-axis of the pairwise distance plot 
are similar to each other, the data points for those standards will be 
clustered in the upper left corner of the plot. Similarly, if the standards 
for the class that is selected for the Y-axis are well defined, the data 
points for those standards will be clustered in the lower right corner of 
the plot. The greater the distance between a data point and the other 
data points in the cluster, the greater is the difference between the 
corresponding standard and the other standards in the class. 
 
If data points for standards from other classes are clustered with the 
calibration and validation standards for one of the classes in your 
method, especially if the data points fall inside the boundary (gray line) 
for the selected class, the two classes are similar and the method may 
not be able to distinguish them.  
 
If one or more standards were assigned to the wrong class, a message 
will also appear indicating the number of standards that were 
misclassified. If a standard was classified incorrectly, check that the class 
was specified correctly in the Standards table (see the Standards tab). 
Then display the spectrum of the misclassified standard. If the quality 
of the spectrum is poor, replace the spectrum with a new one.  
 
Each data point in the plot is linked to a standard in the table. To 
identify the standard that is associated with a data point in a plot, click 
the data point. The corresponding standard will be highlighted in the 
table. To find the data point that corresponds to a standard in the 
table, click anywhere in the row. The associated data point will be 
highlighted in the plot.  



 

262 TQ Analyst User’s Guide Thermo Fisher Scientific 

 
The number of principal components that were used to calibrate the 
method is shown above the Calibration Results table. If the 
% Variability Described readout appears in the task window, the 
principal components used in the current calibration do not describe 
all the variability in the calibration spectra. You may want to increase 
the setting for the maximum number of principal components to 
calculate. You can edit this value from the Principle Components 
group on the Other tab.  
 
If you edit the maximum number of principal components to calculate, 
calibrate the method again to see if the % Variability Described value 
increased. If the % Variability Described readout is no longer displayed 
in the Calibration Results task window, the value has reached 99.9%. 
 
If a Discriminant Analysis method includes at least one validation 
standard, TQ Analyst calculates a performance index which appears on 
the TQ Analyst toolbar. The performance index indicates how 
accurately a calibrated method can classify the validation standards.  
 
When you are finished viewing the calibration results, click the Close 
button on the TQ Analyst toolbar to close the Calibration Results 
window. 
 
 

Validating  
the method 

The final step in developing a classification method is to validate the 
method. Validation simply means using the method to analyze a few 
real world samples in order to test the method’s performance.  
 
There are several ways to validate a method using TQ Analyst software. 
For example, if method includes validation standards, you can use the 
performance index and the validation data displayed in the Calibration 
Results task window to evaluate performance. If you did not include 
validation standards in the method or if the method doesn’t require 
them, you can prepare a few additional standards, analyze them with 
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the completed method and use the results to validate the method. Both 
of these options are discussed in the sections that follow. 
 
 

Performance index If the method includes at least one validation standard, TQ Analyst 
calculates a performance index during calibration. The performance 
index is a number that indicates how accurately a calibrated method 
can classify the validation standards. The performance index appears on 
the TQ Analyst toolbar.  
 

 Note See the performance index entry in the glossary at the end of this 
document for information on the algorithm used to calculate the 
performance index for classification methods.  
 
If you calibrate the method more than once, the performance value 
from the previous calibration is retained. This allows you to determine 
whether the changes you make to a method actually improve its 
performance. It’s up to you to decide what is an acceptable 
performance value. 
 
 

Validation data The calibration data from the validation standards are also important 
indicators of performance. If all of the validation standards were 
classified correctly, your method is complete and ready for repeated 
sample analysis. 
 
If you did not include validation standards, you can still validate the 
method by preparing a few additional standards and using the 
completed method to analyze them.  
 

 Note We do not recommend using calibration standards to validate a 
method. Since calibration standards are included in the distribution 
model, their results would be significantly biased.  
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You can run the validation standards individually or use the External 
Validation diagnostic routine to run them automatically. External 
Validation can be used to analyze a large group of validation standards 
that are listed in a spreadsheet or text file. The validation data are 
placed in a spreadsheet (Microsoft® Excel®) or text file. See the chapter 
on “Method Diagnostics” in this document for more information on 
External Validation.  
 
If the method classifies the validation standards correctly, your method 
is complete and ready for repeated sample analysis.  
 
 

Sources of error If one or more standards were classified incorrectly, you must identify 
what caused the error and try to fix it. Some typical sources of error are 
listed below: 

• The standard is assigned to the wrong class.  

• The region, region type or baseline treatment is inappropriate for 
the analysis region or regions. 

• The standards don’t accurately describe the class (i.e., there are too 
few standards or the standards don’t adequately represent the 
variation in the class). 

• The classes are too similar. 

• Spectral errors caused by sampling, instrument noise, or strong 
absorptions are present in the calibration spectra. 

• The selected region or regions don’t include enough or appropriate 
spectral information.  

• Other components in the standards are producing interfering peaks 
in the analysis region or regions. 

• An inappropriate pathlength treatment was chosen. See “Choosing 
a Pathlength Option” in this chapter for more information. 
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Continue checking for errors and recalibrating the method until the 
validation results are acceptable.  
 
 

Where to 
go from here 

Method development is an iterative process. Take time to try the 
options available for developing a classification method to see if there is 
room for further improvement. We also recommend reviewing the 
information on classification methods in the chapter called “Principles 
of TQ Analyst” at the beginning of this document.  
 
Each time you make a significant change to the method, calibrate the 
method and look at the performance indices for the component you are 
trying to improve. If the new performance index is higher than the 
previous one, keep going. If the performance index goes down, undo 
the changes you made to the method since the last calibration. 
 
TQ Analyst also provides a collection of useful diagnostic routines for 
classification methods. See the chapter called “Method Diagnostics” in 
this document for more information. Detailed explanations of the 
diagnostic displays, including tips on how to interpret the diagnostic 
results, are also available on-line by pressing the Explain button when 
the diagnostic window is open.  
 
If you need information on updating the calibration data or setting up 
sample reports, individual chapters on those topics are provided later in 
this document.  
 
 



 

266 TQ Analyst User’s Guide Thermo Fisher Scientific 

 10 Creating a Spectral Measurement 
Method 
 
 
 
You can use TQ Analyst to set up methods that simply measure 
spectral features and report the measured values. These “measure only” 
methods can be used to determine peak heights or areas, peak locations 
and even the noise in a given spectral region. 
 
Read this chapter to learn the key steps in creating a spectral 
measurement method using TQ Analyst software. The following topics 
are covered: 

• Defining the problem 

• Choosing a sampling technique 

• Creating a new method file 

• Giving the method a title 

• Selecting a measurement technique 

• Choosing a pathlength option 

• Defining the measurements 

• Collecting representative sample spectra 

• Selecting the analysis regions 

• Setting up a denominator peak or region 

• Customizing the method 

• Saving the method 

• Calibrating the method 

• Validating the method 
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• Where to go from here. 
 
Most of the operations described in this chapter are carried out in a 
method window. The method window is broken into a series of tabs. 
The tabs are arranged in an order that is convenient for creating a 
spectral measurement method. If you select the tabs in sequence from 
left to right, starting with the Description tab, they will lead you step 
by step through the method development process. 
 
If you need information on running diagnostics or setting up sample 
reports, individual chapters on those topics are provided later in this 
document.  
 
If you want to create a quantitative or classification method, skip this 
chapter. Instructions for creating quantitative and classification 
methods are provided in the previous two chapters of this document.  
 
 

Defining  
the problem 

The first step in creating a spectral measurement method is to define the 
analytical problem by answering the following question: 

 
How much information do you have about the samples you want 
to measure? 

What spectral information do you want to measure or report? 
 
For example, are you simply trying to consistently measure a certain 
peak in a series of similar spectra or are you interested in defining a 
process for producing validation reports? The answers will help you 
choose an appropriate sampling technique and define the experimental 
conditions that will be used for the analysis.  
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Choosing a 
sampling technique 

Once you’ve defined the problem, the next step is to choose a sampling 
technique and define the experimental conditions for the analysis. In 
many cases, the physical characteristics of the sample dictate the 
sampling technique. For example, if you are analyzing polymer beads, 
you might use a single-bounce ATR (Attenuated Total Reflectance) 
sampling accessory with a built in pressure device. Other samples, such 
as gas mixtures, might require a multipath gas cell.  
 
 

Creating a 
new method file 

The first step in creating a method using TQ Analyst is to create a new 
method file. A method file contains all of the parameters that define 
how your method will operate. Your method must contain valid 
settings for all of the method parameters before it can be calibrated or 
run.  
 
To create a new method file: 
 
1. Choose New Method from the File menu. 
 
 The method parameters are displayed in a new method window. 

The Description tab, which contains the first group of method 
parameters, is already open.  

 
 
2. Choose Save Method As from the File menu.  
 
 The Save Method As dialog box is displayed.  
 
 
3. Type a file name for the new method in the File Name box and 

select the directory and disk where you want the method saved. 
 
 
4. Choose OK. 
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 When you create a new method file, the method parameters are 
automatically set to their default values. You can change any of the 
parameter settings or use the default settings. 

 
 Note Save your method frequently while creating the method or editing the 

method parameters to avoid losing data in the event of a computer 
problem or power failure.  
 
 

Giving the 
method a title 

Use the Method Title box on the Description tab to enter a title for 
your new method.  

 

 
 
 
You will use the method titles along with their file names to select a 
method to open. The title can also be displayed or printed with the 
analysis results. 
 
You may enter a longer description of the method in the Method 
Description box. You may also enter your name in the Developer’s 
Name box so people know who created the method.  
 
The Method Description and Developer’s Name parameters are also on 
the Description tab. Use the scroll bar to bring these parameters into 
view. 
 
 

Selecting a 
measurement 

technique 

Another important step in developing a spectral measurement method is 
choosing what you want to measure. A spectral measurement method 
can be configured to do any of the following: 

• Measure the height or area of a peak or region. 
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• Measure the ratio of two spectral peaks. 

• Measure the random noise in a given region. 

• Measure the width at half maximum of the largest peak in a region. 

• Locate the largest peak in a specified region. 

• Find where a peak is reduced to 1%, 2%, 5% or 10% of its 
maximum height. 

 
You can measure up to 50 peaks or regions in a spectral measurement 
method.  
 

 Note You can also design a method that calculates the ratio of two spectral 
peaks by setting the TQ Analyst Pathlength Type option to Peak 
Ratio. See “Choosing a Pathlength Option” in this chapter for more 
information.  
 
Methods that report peak heights or areas are typically used to 
consistently measure a peak or area in a series of spectra. The 
absorbance values could then be used to plot a calibration curve by hand 
or on a computer that can calculate spectral plots. 
 
An optional linear function can be applied to the absorbance values 
from each measured peak for simple mathematical corrections. Each 
function is defined by its slope and intercept values. If a linear correction 
is specified for a given peak, the corrected absorbance value is reported 
instead of the measured value. 
 
People use methods that measure spectral noise to test spectrometer 
performance or to validate a specific analysis. You can configure a 
method to measure either RMS noise or peak-to-peak noise in a specified 
region. 
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Some people need to consistently measure the width of a peak in a 
spectral region or simply report the peak’s exact location. These 
measurements are often useful for validation purposes or to detect 
changes in the location or shape of a peak. Peak width values and peak 
locations are reported in the X-axis unit of the corresponding 
spectrum. 
 
Others simply want to report the location where a peak is reduced to a 
certain percentage of its maximum value. Percent-of-maximum 
measurements are typically used for instrument validation. For 
example, you can use them to report the X-axis location where the 
energy in a single-beam spectrum is reduced to a level that is no longer 
useful. You can also use percent-of-maximum measurements to 
monitor the components of a chemical reaction.  
 
At this point, you only need to specify that you are creating a spectral 
measurement method. To do this, set the Analysis Type parameter on 
the Description tab to “Measurement Only.”  
 

 
 
 
 

To see a detailed 
description of the 

Measurement Only 
option, click the Explain 
button on the toolbar to 

open the Explain help 
window and then click 

the option in the 
software. 

 
 



 

272 TQ Analyst User’s Guide Thermo Fisher Scientific 

You will have an opportunity to specify the measurement technique 
later in this chapter. 
 
 

Choosing a 
pathlength option 

You can design a method that calculates the ratio of two spectral peaks 
by setting the TQ Analyst Pathlength Type to “Peak Ratio” and 
specifying the denominator peak or region as the pathlength peak. See 
the section on “Selecting the Analysis Regions” in this chapter for 
instructions. If you specify a denominator peak, the software will apply 
it to all of the measurements specified in the current method.  
 

To see descriptions of 
these pathlength options, 

click Explain and then 
click each option in the 

software. 
 

 
 Note If you don’t want to use a denominator peak for any of the 

measurements in your method, set the Pathlength Type to “Constant.” 
When Pathlength Type is set to Constant, the software makes no 
mathematical pathlength correction for any of the measurements 
specified in the method.  
 
 

Defining the 
measurements 

The next step in developing a spectral measurement method is to define 
each measurement. Use the Measurements tab to enter information 
about the measurements in a Measure Only method, such as the label 
and unit that will be reported. You can also specify a multiplicative 
factor or offset value for each measurement.  
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Entering labels You can make up to 50 measurements in a spectral measurement method. 
A unique name or label must be specified for each measurement. Enter 
the labels in the Measurements table on the Measurements tab. When 
you use the method to analyze a sample spectrum, each label and unit 
will be displayed or printed next to the corresponding measurement 
result. 
 
 

 
 
 

To see descriptions of 
the items in this 

window, click the 
Explain button on the 

toolbar to open the 
Explain help window 

and then click the 
item. 

 
 

Measurements Tab 
 
 
To label the measurements: 
 
1. Select the Measurements tab. 
 
 
2. Click in the first row of the Measurement Label column, type a 

label for the first measurement and press Enter. 
 
 When you press Enter, the software adds a blank row to the end of 

the table.  
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3. Continue entering labels until all of the measurements have 

been specified. 
 
 
4. Use the Abbrev column to enter abbreviated labels for each 

measurement.  
 
 The abbreviated labels will be used whenever the full label doesn’t 

fit in the available space. If no abbreviated labels are entered, the 
default abbreviations are used. 

 
 
5. Use the Unit column to enter the unit that will be used to report 

each measured value.  
 
 
6. Use the Digits column to specify the number of digits after the 

decimal symbol that will be used to report each measured value.  
 

 Note The digits parameter defines the number of digits that are displayed in 
TQ Analyst or printed with the analysis results, not the number of 
significant digits that are used in the calculations.  
 
When you use this method to analyze a sample spectrum, the measured 
value for each peak or region that is specified in the Measurements table 
will be reported in the Quantify dialog box, using the specified label, 
unit and digits. 
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Applying a multiplicative 
factor or offset value 

You can do simple calculations with a measured value by defining a 
multiplicative factor or offset value. When you use the method to 
measure a sample spectrum, the specified corrections will be applied to 
each measured value according to the following equation: 
 
 <Corrected value> = slope * <measured value> + intercept 
 
Only the corrected values will be reported. 
 

 Note If you are applying linearity corrections to a measurement that is the 
ratio of two spectral peaks, the correction is applied to the calculated 
ratio instead of the measured value. See the section called “Choosing a 
Pathlength Option” in this chapter for information on setting up 
methods that take the ratio of two spectral peaks.  
 
To specify factors or offset values for the measurements in your method: 
 
1. Turn on the Linear Correction check box on the Measurements 

tab. 
 
 When the Linear Correction check box is on, TQ Analyst adds a 

Slope column and an Intercept column to the Measurements table.  
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2. In the column labeled “Slope,” enter a multiplicative factor for 
each measurement.  

 
 If you don’t want to apply a factor to a measurement, enter “1” in 

the Slope field. 
 
 
3. Use the column labeled “Intercept” to specify offset values for 

the spectral features to be measured.  
 
 Enter “0” in the Intercept field if you don’t want to use an offset. 
 
The specified linear corrections will be applied to each measured value. 
Only the corrected values will be reported. 
 
 

Collecting 
representative 

sample spectra 

When you are finished defining the measurements and selecting a 
pathlength option, you are ready to collect the spectra of a few 
representative samples. You will use the representative spectra to set up 
the analysis regions for the method. This section explains how to choose 
representative samples and collect their infrared spectra.  
 
 

Choosing 
representative samples 

Choosing typical samples is probably the most critical factor in making 
accurate measurements of spectral data. For example, if you specify a 
complex baseline correction for a peak or region, you must be sure the 
peak or region looks similar in all of the spectra that will be measured. 
 
When selecting representative samples for a spectral measurement 
method, consider the following guidelines. 
 
• Use sufficient quantity.  

To determine the number of samples required, consider the type of 
measurement you want to make. If you are measuring a peak height, 
width, or area with a simple baseline, two or three samples should 
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be sufficient. Two or three samples should also be enough for 
measuring the noise in a spectral region or finding where a peak is 
reduced to a percentage of it maximum value. If you want to 
measure a complex peak with overlapping bands or specify a 
complex baseline correction, such as quadratic removed, make sure 
you collect enough sample spectra to be sure the peak has a 
relatively consistent shape and location.  
 
The key point is to make sure you include enough samples to 
adequately represent the variation you expect to see in the samples 
the method will measure. In general, the more samples used to set 
up the regions the better they will represent “real world” samples.  

 
• Use representative mixtures.  

The composition of the representative samples should be similar to 
the composition of the samples you want to measure. This insures 
that spectral baselines are handled properly and that all substances 
in the sample are represented.  
 
Make sure you include examples of any variation you expect to see 
in the samples the method will measure. If you consider the 
variations when selecting the analysis regions, the method will 
measure the unknown samples with greater accuracy.  

 
 

Optimizing the data 
collection parameters 

For best results, the representative samples should be collected in the 
same way you will collect the spectra of the unknown samples, using 
the same settings for the data collection parameters. The spectra of the 
representative samples should be of the highest achievable quality. 
Assuming that the sampling technique is reproducible, spectral quality is 
determined mainly by the resolution and signal-to-noise ratio of the 
spectral data. The parameters that define resolution and signal-to-noise 
ratio are part of the data collection parameter set.  
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See your Thermo Scientific spectral analysis software for details on 
setting the data collection parameters. Once the parameters have been 
set, we recommend using the chosen settings to collect the 
representative samples as well as every unknown sample you use the 
method to measure.  
 
 

Collecting the 
sample spectra 

Once the samples are prepared and the optimal parameter settings 
defined, the spectra must be carefully collected and stored on a disk.  

Use another spectral analysis package, such as Thermo Scientific 
OMNIC or RESULT software, to collect the sample spectra. Refer to 
the documentation that came with that software for step-by-step 
instructions. Be sure to name and save each spectrum in a file when 
you are finished collecting it.  
 
 

Selecting the 
analysis regions 

The final step in building a method is to select the spectral peaks or 
regions and specify how they will be measured. If you want to divide 
the measurement peak by another peak, you must also specify the 
denominator peak. This feature could be used to calculate the signal-to-
noise ratio of a spectrum, for example, by measuring the signal in the 
analysis region and the noise in the pathlength region. 
 
 

Selecting the 
spectral peaks or 

regions 

Use the Regions tab to select the spectral peaks or regions and specify 
how they will be measured. 

 
To specify the peaks or regions to be measured: 
 
1. Click the Regions tab. 
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2. Click the Edit Regions button on the Regions tab. 
 
 The Open Spectrum dialog box is displayed.  
 
 
3. Select a few spectral data files that are similar to the spectra you 

want to measure with this method and choose OK. 
 
 The Region Selection task window is displayed. 
 

 
 

To see detailed 
descriptions of the items 

in this task window, click 
the Explain button on 

the toolbar to open the 
Explain help window and 

then click the item. For 
step-by-step instruction 
on editing regions, click 

the How To button in 
the task window. 

  
 
 
4. Use the tools in the task window to specify the X-axis limits, 

Region Type, and baseline of the first peak or region that will 
be measured.  

 
• Click the Region Type list box and select the type of 

measurement you want to make. The options are described 
briefly below. For detailed descriptions of these Region Type 
options, click the How To button in the Region Selection task 
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window and display the topic on “Selecting the Region 
Measurement Type.” 

 
Region Type options Description 

Fixed location height Finds the nearest data point to the specified X-
axis location. Uses that point and the two points 
on either side to find the interpolated maximum. 
Then measures the intensity at that location. 
(Same as OMNIC Peak Height tool.) 

Average ht in range Reports the average intensity value in the 
specified X-axis range. Useful for measuring noise 
levels or baseline drift rather than a peak 
maximum. 

Maximum ht in range Reports the maximum intensity value in the 
specified X-axis range. Useful for measuring 
peaks that tend to shift position slightly. 

Minimum ht in range Reports the minimum intensity value in the 
specified X-axis range. Useful for measuring 
peaks that point downward and may shift slightly 
along the X-axis. 

Absolute max in range Reports the maximum intensity value, positive or 
negative, in the specified X-axis range. 

Area Calculates the sum of the intensity values in the 
specified X-axis range. 

Computed area Calculates the area of the spectral region that falls 
between the specified baseline points (or the 
specified baseline range). 

Continued on next page 
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Region Type options Description 

RMS noise Measures RMS noise in the specified X-axis range. 
Useful for testing spectrometer performance or 
validating a specific analysis.  

Peak-to-peak noise Measures peak-to-peak noise in the specified X-axis 
range. Useful for testing spectrometer performance or 
validating a specific analysis.  

Interpolated ht  Uses the two nearest data points to measure  
at exact loc interpolated intensity at the specified X-axis location. 

Good for measuring baseline intensity or producing 
the numerator value for signal-to-noise 
measurements. 

Peak location Reports the interpolated location of the largest  
(interpolated) peak in the specified X-axis range. Useful for 

detecting changes in peak location for validation.  
Peak height Finds the interpolated location of the largest  
(interpolated) peak in the specified X-axis range and measures the 

intensity at that location. Ideal for measuring peak 
height. 

Peak width Measures the width at half maximum of the  
(at half max) largest peak in the specified X-axis range. Useful for 

detecting changes in peak shape for validation. 
Location at Reports the X-axis location where the  
x% of peak max largest peak in the specified X-axis range is reduced to 

1, 2, 5, or 10 percent of its maximum height. If the 
peak has two locations that match these criteria, the 
software reports the location that is nearest the peak 
maximum. Useful for finding where the energy levels 
off in a single-beam spectrum. 

 
• When you are finished setting the Region Type, use the Location 

column to specify the X-axis location or region to be measured. The 
Fixed Location Height Region Type requires one X-axis value. All of 
the others except Computed Area require two X-axis values. Use the 
first Location box to specify the first data point to be included in the 
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region. Use the second Location box to specify the last data point to 
be included. Location values are not used for the Computed Area 
Region Type. 

 
• Now define the spectral baseline. Use the first list box in the Baseline 

Type column to specify a baseline type for the corresponding region. 
The options are described briefly below. For detailed descriptions of 
these Baseline Type options, click the How To button in the Region 
Selection task window and display the topic “Selecting the Baseline 
Measurement Type.” 

 
Baseline Type options            Description 

One Point Calculates a horizontal line that passes through the 
spectrum at the specified baseline point and 
subtracts its absorbance from the peak or region. 
Use the Point 1 column to specify the baseline 
offset. 

Two point Calculates a line that passes through the spectrum 
at two baseline points and subtracts its absorbance 
from the peak or region. Use the Point 1 and Point 
2 columns to specify the baseline points. 

Baseline offset Subtracts a constant from a measured peak or each 
point in a spectral region. Use the Offset field to 
specify the constant. Useful for subtracting a 
constant value that is not a data point in the 
spectrum. 

Linear removed Calculates a linear least squares fit over the 
specified region and subtracts it from the region. 
Useful for correcting baselines that vary. 

Quadratic removed Calculates a 2nd order polynomial over the specified 
region and subtracts it from the region. Useful for 
removing baseline curvature. 

None Measures the peak or region from zero absorbance 
units 
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• If you selected a one-point or two-point baseline, use the lower 
list box in the Baseline Type column to specify how each 
baseline point will be chosen. The techniques available for 
choosing baseline points are summarized below. For detailed 
descriptions of these Baseline Point options, click the How To 
button in the Region Selection task window and display the 
topic on “Selecting the Baseline Measurement Type.” 

 
Baseline Point options     Description 

Fixed location Uses the intensity value at the specified X-axis 
location to define each baseline point. (Allows you 
to pick a specific baseline point.) 

Average in range Uses the average intensity value in the specified 
baseline range to define each baseline point. 
(Useful for picking a baseline point in a noisy 
region.) 

Maximum in range Uses the maximum intensity value in the specified 
baseline range to define each baseline point. 
(Useful for picking the highest baseline point in 
the range.) 

Minimum in range Uses the minimum intensity value in the specified 
baseline range to define each baseline point. 
(Useful for picking the lowest baseline pint in the 
range.) 

 
• If you selected the One Point, Fixed Location combination, use 

the Point 1 entry box to specify the X-axis location where you 
want to draw the horizontal baseline. The Two Point, Fixed 
Location pair lets you define two points (Point 1 and Point 2) 
for drawing the baseline.  
 
The remaining options require two baseline points (Point 1 
and Point 2) but use two values to define each of them. The 
software selects each baseline point from the specified baseline 
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range using she selected technique.  
 
If you selected the Baseline Offset Baseline Type, use the Offset 
column in the Regions table to define the constant. 

 
 You can also specify the analysis regions and baseline points 

graphically, by moving the markers in the graphical window. For 
information on specifying regions graphically, click the How To 
button in the Region Selection task window. 

 
 
5. For each additional region you want to measure, click the Next 

button in the Select Region box to select the next region and 
then repeat step 4 to specify the X-axis limits, Region Type, and 
baseline for that region.  

 
 
6. When you are finished specifying regions, click the Close 

button on the TQ Analyst toolbar to close the Region Selection 
task window.  

 
The specifications for the measured regions will be saved 
automatically and displayed in the Regions table on the Regions 
tab.  

 
 

Setting up a 
denominator peak 

or region 

You can design a method that calculates the ratio of two spectral peaks 
by setting the TQ Analyst Pathlength Type to “Peak Ratio” and 
specifying the denominator peak or region as the pathlength peak. This 
feature can be used to calculate a signal-to-noise ratio, for example, by 
setting up the noise measurement as the denominator peak. If you 
specify a denominator peak, the software will apply it to all of the 
measurements specified in the current method.  
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 Note If you don’t want to use a denominator peak for any of the 
measurements in your method, set the Pathlength Type to “Constant” 
and skip this section. When Pathlength Type is set to Constant, the 
software makes no mathematical correction for any of the 
measurements specified in the method.  
 
To define a denominator peak or region for all of the measurements in 
a spectral measurement method: 
 
1. Click the Pathlength tab. 
 
2. Set the Pathlength Type parameter to “Peak Ratio.”  
 
 The Pathlength Region table appears on the Pathlength tab.  
 

 
To see detailed 

descriptions of the 
pathlength options for 
spectral measurement 

methods, click the Explain 
button on the toolbar to 

open the Explain help 
window and then click 

each option in the 
software. 

  
 
3. Click the Edit Region button on the Pathlength tab.  
 
 The Open dialog box is displayed. 
 
4. Select a few spectral data files that are similar to the spectra you 

want to measure with this method and choose OK.  
 

The Region Selection task window is displayed.  
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To see detailed 
descriptions of the items 

in this task window, 
click the Explain button 

on the toolbar to open 
the Explain help 

window and then click 
the item. For step-by-

step instruction on 
editing regions, click the 

How To button in the 
task window. 

  
 
5. Use the tools in the task window to specify the X-axis limits, 

Region Type, and baseline for the denominator peak.  
 
 See “Selecting Spectral Peaks or Regions” in the previous section 

for instructions. 
 
6. Click the Close button on the TQ Analyst toolbar to close the 

Region Selection task window.  
 
 The specifications for the pathlength peak will be saved 

automatically and displayed in the Pathlength Region table on the 
Pathlength tab. When you use this method to analyze a sample 
spectrum, each reported value will be the ratio of the measured peak 
and the denominator peak.  

 
 Note For more information about setting pathlength options and defining 

the region for the Peak Ratio pathlength setting, click the Explain 
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button on the TQ Analyst toolbar to open the Explain help window 
and then click a feature on the Pathlength tab.  

Customizing 
the method 

If you have been following the guidelines provided in this chapter, your 
method contains all of the information needed for calibration, 
including: 

• Descriptions of the measurements. 

• Representative samples measured using reproducible sampling 
technique. 

• Spectral regions defined.  
 
There are other features and settings in the software that may be used 
to customize your method. For example, if you want to calculate 
derivative spectra or apply smoothing or baseline correction, turn on 
the check box for Allow Spectral Processing on the Standards tab. (See 
the chapter called “Processing Spectral Data” in this document for 
more information.) 
 
Use the parameters on the Report tab to configure the sample reports. 
See the section on “Setting Up Sample Reports” in the chapter called 
“Preparing a Method for Sample Analysis” for details.  
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To see detailed 
descriptions of the 

software features in a 
spectral measurement 

method, click the 
Explain button on the 

toolbar to open the 
Explain help window and 

then click the feature.  

 
 

Report Tab for Measure Only Method 
 
 
Feel free to consider or try all of the features included in your method. 
If you don’t have time to review them or don’t need special 
enhancements, leave the default settings provided in the software. 
TQ Analyst is designed to provide a working method with a minimum 
of effort.  
 
The method should produce acceptable results for most sample types 
when the method parameters are set to their default values. To see the 
default settings for a spectral measurement method, choose New Method 
from the File Menu and set the Analysis Type to “Measurement Only.”  
 
If you prefer using other method specifications or have specifications 
you need to follow, you may change the settings for any method 
parameter at any time. 
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Saving the method We recommend that you save your work regularly when creating or 
editing methods. Be sure to save the method again before you calibrate 
it. 
 
To save your method: 
 
1. Select the method you want to save by clicking the method 

window or by choosing the method name in the Window menu. 
 
 
2. Choose Save Method from the File menu. 
 
 If the method does not have a file name, the Save Method As 

dialog box appears.  
 
 
3. If the Save Method As dialog box appears, type a file name and 

select the directory and disk where you want the method saved.  
 
 
4. Choose OK. 
 
 

Calibrating 
the method 

When you are finished choosing a pathlength option, defining the 
measurements, collecting representative sample spectra, selecting the 
analysis regions and saving, your method is ready for calibration. 
 
Spectral measurement methods do not require calibration in the same 
sense that quantitative and discriminant analysis methods do. These 
methods are intended for reporting information about or simple 
measurements from spectral data, rather than predicting behavior in 
unknown samples, so they don’t require a calibration model. However, 
TQ Analyst uses the “calibration” step to test a spectral measurement 
method for consistency and experimental design.  
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To calibrate a spectral measurement method, click the Calibrate button 
on the TQ Analyst toolbar. Calibration takes only a second. When 
calibration is completed, the calibration readout on the TQ Analyst 
toolbar changes from red to green and the “Uncalibrated” message 
changes to “calibrated.”  
 
 

Validating  
the method 

The final step in developing a spectral measurement method is to validate 
the method. Validation simply means using the method to analyze a 
few real world samples in order to test the method’s performance.  
 
You can run the samples individually or use the External Validation 
diagnostic routine to run them automatically. External Validation can 
be used to analyze a large group of validation samples that are listed in 
a spreadsheet or text file. The validation data are placed in a 
spreadsheet (Microsoft® Excel®) or text file. See the chapter on 
“Method Diagnostics” in this document for more information on 
External Validation.  
 
If the validation results are acceptable, your method is complete and 
ready for repeated sample analysis. If the method measures or reports 
incorrect values for the validation samples, you must identify what 
caused the error and try to fix it.  
 
Some typical sources of error are listed below: 

• The region, region type or baseline treatment is inappropriate for 
the spectral featured that is measured. See “Selecting the Analysis 
Regions” in this chapter for more information. 

• The spectral information from the unknown samples is different 
from the samples that were used to select the analysis regions. See 
“Choosing Representative Samples” in this chapter for more 
information. 
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• Spectral errors caused by sampling, instrument noise, or strong 
absorptions are present in the sample spectra. See “Replacing a 
Standard” in the chapter called “Working With Standards” for 
more information. 

• Other components in the samples are producing interfering peaks 
in the selected analysis region. See “Choosing Standards for Spectral 
Measurement Methods” in this chapter for more information. 

• An inappropriate pathlength treatment was chosen. See “Choosing 
a Pathlength Option” in this chapter for more information. 

 
Continue checking for errors and recalibrating the method until the 
validation results are acceptable.  
 
 

Where to 
go from here 

Method development is an iterative process. Take time to try the 
options available for developing a spectral measurement method to see if 
there is room for further improvement. We also recommend reviewing 
the information on spectral measurement methods in the chapter called 
“Principles of TQ Analyst” at the beginning of this document.  
 
Remember to calibrate the method each time you change a method 
parameter.  
 
TQ Analyst provides a few diagnostic routines for spectral 
measurement methods. See the chapter called “Method Diagnostics” in 
this document for more information. Detailed explanations of the 
diagnostic displays, including tips on how to interpret the diagnostic 
results, are also available on-line by pressing the Explain button when 
the diagnostic window is open.  
 
If you need information on setting up sample reports, see the chapter 
titled “Preparing a Method for Sample Analysis.” 
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 11 Preparing a Method for Sample 
Analysis 
 
 
If your calibrated method is performing acceptably, you are ready for 
the final step in the method development process. Read this section to 
learn how to set up the sample reports, run a test sample, and set 
security options on your completed method.  
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Setting up the 
sample reports 

The parameters on the Report tab allow you to choose the information 
you want to include in your sample reports, including any spectrum or 
result warnings. 
 

 
 
 
 
 
 

To see detailed descriptions 
of the items in this window, 
click the Explain button on 

the toolbar to open the 
Explain help window and 

then click the item. 

 
 

Report Tab for Measurement Only Method 
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Adding and 
removing report features 

You can specify the information you want included in your sample 
reports by clicking the desired options on the Report tab. For example, 
if you want the method title displayed or printed in each sample report, 
make sure the check box for that feature is on. If you don’t want to 
include an item, turn off the corresponding check box. 
 

 Note Uncertainty values for PLS and PCR methods are calculated and 
reported only if the method includes validation standards and the 
Uncertainty Value check box on the Report tab is on.  
 
 

Turning sample 
checking options 

on and off 

You can use the software’s built-in sample checking features to monitor 
the samples you analyze with a method for possible problems. 
TQ Analyst can catch three types of problems during sample analysis: 

• Problems with the collection parameters 

• Problems with the sample spectra, and  

• Problems with the analysis results.  
 
If a sample checking feature is active and a sample fails the check, a 
warning appears on the sample report as shown in the example below. 
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Parameter check The parameter check compares the parameter settings that were used to 

collect each unknown sample spectrum to the settings used to collect the 
calibration spectra for the current quantitative or classification method. 
If the settings for certain key collection parameters (resolution and Y-
axis unit) don’t match, TQ Analyst can display or print a warning on 
the sample report. 
 

 Note The data collection parameter check is not available for spectral 
measurement methods.  
 
To turn on the parameter checking feature, set the check box for Data 
Collection Parameter Check on the Report tab. 
 

 
 
Then specify what action TQ Analyst should take if a spectrum fails 
the parameter check by choosing an option in the corresponding Action 
list box. 
 
If Action is set to “Warn” and a sample you quantify with the active 
method fails the Data Collection Parameter Check, TQ Analyst 
displays or prints the quantitative or qualitative results for that 
spectrum along with the following message: “Warning: Data collection 
parameter settings don’t match those in method.”  
 
If Action is set to “Warn and don’t report values,” TQ Analyst displays 
or prints the warning message but not the quantitative or qualitative 
results. 
 
 



 

296 TQ Analyst User’s Guide Thermo Fisher Scientific 

Spectrum checks The spectrum checks, such as the full spectrum check and the 
measurement region spectrum check, compare each unknown sample 
spectrum to the calibration spectra in the current method. The full 
spectrum check uses all of the spectral data in the entire X-axis range of 
the calibration spectra for the comparison. The measurement region 
spectrum check compares the spectral information in the specified 
analysis regions. 
 
The sample spectrum is then assigned a fit value that is scaled to 100, 
where 100 is a perfect match. If the fit value falls below a predefined 
threshold in the current method, the sample is flagged and the 
specified action is taken.  
 
The spectrum checks can be turned on in three steps. First turn on the 
checking feature by selecting Full Spectrum Check or Measurement 
Region Spectrum Check.  
 

 
 
Then enter a threshold (0 to 100) for the spectrum’s fit value. Finally, 
select what action will be taken if a spectrum fails the check by 
choosing an option in the Action list box. 
 
If Action is set to “Warn” and a sample you quantify with the active 
method fails the full spectrum check, TQ Analyst displays or prints the 
quantitative or qualitative results for that spectrum along with the 
following message: “Warning: full spectrum check indicates a 
significant difference from standards.”  
 
If Action is set to “Warn and don’t report values,” TQ Analyst displays 
or prints the warning message but not the quantitative or qualitative 
results. 
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 Note If the Fit Values check box on the Report tab is on, the full spectrum fit 
value and the measurement region fit value for each unknown sample 
spectrum will be reported with the analysis results.  
 
 

Result checks The result checks compare the analysis results for each component to a 
predefined threshold or limits in the current method. If a measured 
peak height or area, or a calculated concentration value or match value 
falls outside the specified limits or below the threshold, TQ Analyst 
flags the result and takes the specified action. 
 
The result checks can be turned on in three steps. First, turn on the 
checking feature by setting the appropriate check box (Analysis Limits 
Check, Acceptance Limits Check, uncertainty value check, Standard 
Error of Measurement Check, Match Value Check, or Distance Value 
Check).  
 

 
 
Then enter a threshold or limits for the analysis result. You can set the 
limit for the Distance Value Check in a Discriminant Analysis method 
or the Match Value Check in the other classification methods directly 
from the Report tab.  
 
The limits for the Analysis Limits Check, Acceptance Limits Check, 
uncertainty value check and Standard Error of Measurement Check 
must be specified on the Components tab for quantitative methods or 
the Measurements tab for Measurement Only methods.  
 

 Note The uncertainty value sample checking feature is available only for PLS 
and PCR methods and works only if the method includes validation 
standards.  
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 Note Standard error of measurement sample checking is available only for 
CLS methods and works only if the method includes validation 
standards.  
 
Finally, select what action will be taken if a spectrum fails the check by 
choosing an option in the Action list box. 
 
If Action is set to “Warn” and a sample you quantify with the current 
method fails the corresponding check, TQ Analyst displays or prints 
the result along with a warning that the result is above or below the 
specified limit or threshold.  
 
If Action is set to “Warn and don’t report values,” only the warning 
appears on the report. 
 
 

Running a  
test sample 

It is a good idea to retest a new method by using it to analyze a few 
known samples before distributing the method to your labs for repeated 
sample analysis. Testing the method also allows you to check out the 
sample reports the method will produce. 
 
The sample spectrum must be stored in a spectral data file before it can 
be analyzed.  
 
To analyze a sample from TQ Analyst: 
 
1. Select the method you want to run by clicking the method 

window or choosing the method name in the Window menu. 
 
 
2. Click the Quantify button on the TQ Analyst toolbar. 
 
 The Open Spectrum dialog box is displayed. 
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3. Select a spectral data file and choose OK.  
 

You can select spectra that were saved using any Thermo Scientific 
software or spectra that are in another format, or “file type,” such as 
GRAMS386 and CSV. Use the Files of Type list box to select a 
specific file type, or choose “All Files” to see all the files in the 
current directory. 

 
For more information on analyzing samples from TQ Analyst, refer to 
the sections titled “Analyzing a sample from TQ Analyst,” and 
“Analyzing multiple samples from TQ Analyst” in this document. 
 
 

Saving and 
protecting your 

method 

To save your completed method, choose the Save Method As 
command from the File menu. You can set a security code in the Save 
Method As dialog box so others can’t open or change your method file 
without your permission. To protect the current method, turn on the 
Password check box in the Save Method As dialog box.  
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When you choose OK to close the dialog box, another dialog box 
appears asking you to type a password for the method.  
 

 
 
Type a password and choose OK. Then retype the password to confirm 
it and choose OK again. 
 
If you decide to protect a method, make sure you write down the 
password and store it in a safe place. You won’t be able to reopen or 
delete the method without it.  
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 Note You don’t have to enter a password to run a protected method from 

another Thermo Scientific application, such as OMNIC or RESULT.  
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 12 Updating the Calibration Data for 
a Method 
 
 
 
You may find it necessary to update the calibration data for a method, 
either on a development system or on a system that is located in a 
process or other laboratory environment. This process typically 
involves adding, replacing or deleting one or more standards and then 
recalibrating the method.  
 
See the chapter on “Working With Standards” for information on 
adding, replacing and deleting standards in a TQ Analyst method. The 
spectrum for a new standard can come from a file or the operator may 
collect the standard directly in TQ Analyst. Collecting new standards 
in TQ Analyst ensures that the new standards will match the other 
standards in the method (TQ Analyst automatically uses the same 
settings for the data collection parameters). If you add or replace 
standards, make sure you update the component concentration values 
associated with those standards.  
 
When you are finished updating the standards, click the Calibrate 
button on the TQ Analyst toolbar to calibrate the new method. See the 
sections called “Calibrating The Method” in the individual chapters in 
creating a quantitative, classification or spectral measurement method for 
details on interpreting the calibration results.  
 

 Note If you update the calibration data, make sure you check whether any 
corrections were specified for the calibrated method. If corrections were 
specified, check whether the corrections are still valid and update or 
delete them as necessary.  
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When you are satisfied with the calibration results, choose Save 
Method from the File menu to save the updated method.  
 
Each time you calibrate and save a method, the Revision code on the 
Description tab increments. This will help you track changes made to a 
method when the initial development has been completed. 
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 13 Method Diagnostics 
 
 
 
TQ Analyst provides a collection of useful diagnostics for each of the 
analysis types. If you use the wizards and other automatic features of 
TQ Analyst software, most of these diagnostic routines won’t be 
necessary. Whenever possible, the software runs statistical and other 
analyses on your data and uses the results to provide default values and 
recommendations during method development. In most cases, the 
default values and recommendations will be the optimum settings for 
your analysis 
 
If you are experienced in chemistry and statistical analysis or have 
favorite diagnostic routines you typically run on new methods or use to 
solve specific problems, read this chapter. Our software provides many 
of the diagnostic routines commonly used for spectroscopic analysis, 
including interactive displays of the diagnostic results. Use them to: 

• Identify when too much or too little data are used to create the 
method calibration model. 

• Look for inaccuracies in the data that affect calibration. 

• Help you make adjustments to improve the method’s performance. 
 
Detailed explanations of the diagnostic displays, including tips on how 
to interpret the diagnostic results, are available for each diagnostic task 
window. To display information about a diagnostic task window, click 
the Explain button on the TQ Analyst toolbar while the task window is 
open and selected.  
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The on-line help also includes information on each diagnostic, 
including examples of typical diagnostic results. Look for them in the 
Diagnostics section under the TQ Analyst Help Topics item in the 
Help menu. 
 
All of the diagnostic routines provided in the software are listed in the 
Diagnostics menu. Many of the diagnostics are available only for 
certain method types or certain stages of development. For example, 
you can run the Principal Component Spectra diagnostic on any 
quantitative or discriminant analysis method but you must collect or 
open the spectral data files for the standards before the diagnostic can 
be used.  
 
To see the diagnostic commands that are available for the current 
method, select the method by clicking the method window or selecting 
its name in the Window menu. Then click the Diagnostics menu name 
at the top of the TQ Analyst window.  
 
Diagnostic routines that are currently available for the selected method 
are listed on the menu in black type; routines that are unavailable 
appear in gray and cannot be selected, either because they don’t apply 
to the method type or the method doesn’t include enough information 
to run them. 
 



 

306 TQ Analyst User’s Guide Thermo Fisher Scientific 

The following table provides a list of the diagnostic routines available 
in TQ Analyst and the compatible method types. 
 
 
Name Available for… 

Eigenanalysis All quantitative methods, Discriminant 
 Analysis, Distance Match 
Principal Component Spectra All quantitative methods, Discriminant 
 Analysis, Similarity Match, Distance  
 Match 
Pairwise Concentration All quantitative methods 
Spectrum Outlier All quantitative methods 
Pure Component Spectra All quantitative methods 
Statistical Spectra All quantitative methods, Discriminant 
 Analysis, Distance Match 
Cross Validation All quantitative methods 
External Validation All method types 
Residual Spectra CLS, PLS, PCR, Similarity Match and  
 Distance Match methods 
Multiple Quantify All method types 
PRESS PLS methods 
Principal Component Scores PLS, PCR, Discriminant Analysis  
 and Distance Match methods 
Factor Loading PLS methods 
Leverage PLS methods 
Loading Spectra PLS methods 
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Eigenanalysis 
diagnostic 

The Eigenanalysis diagnostic determines the distribution of spectral 
variation and concentration (or class) in the principal components of a 
calibration set. The diagnostic results can help you determine if you 
have enough independent sources of spectral variation relative to the 
number of components or classes in a quantitative or classification 
method. For example, if your method is trying to quantify seven 
components, or to distinguish between 7 classes, the spectral data for 
the standards must contain at least seven independent sources of 
variation for the method to work.  
 
You can run the Eigenanalysis diagnostic on any quantitative, 
Discriminant Analysis or Distance Match method. You must fill in the 
Standards table on the Standards tab and the Components table on the 
Components tab (quantitative methods only) or the Classes table on 
the Classes tab (Discriminant Analysis and Distance Match methods 
only) before the Eigenanalysis diagnostic can be used.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Eigenanalysis command from the Diagnostics menu. The 
diagnostic results are displayed in a task window. The data show how 
the variation in the calibration standards is distributed over the number 
of principal components that are found.  
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The Concentration Contribution column indicates the percentage of 
the variation in concentration that is described by each principal 
component. The Full Spectrum Contribution column shows how the 
variation in the entire spectral range of the standards is distributed 
among the principal components. The Analysis Region Contribution 
column shows the variation in the analysis region or regions. This 
column appears in the Eigenanalysis task window only if the method is 
calibrated.  
 
A statement at the top of the diagnostic window indicates whether 
there is sufficient variability in the standards to analyze the specified 
number of components or to distinguish the specified number of 
classes in the method. 
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Principal Component 
Spectra diagnostic 

The Principal Component Spectra diagnostic displays the principal 
component spectra for the following method types: 

• All quantitative methods 

• Discriminant Analysis 

• Similarity Match 

• Distance Match. 
 
A principal component spectrum is the orthogonal spectrum that 
represents the amount of variability described by a principal component. 
These spectra can help you determine the proper number of principal 
components or factors to use for the analysis (look for prominent 
spectral features that appear in the first few principal component 
spectra). 
 
One principal component spectrum is included for each principal 
component that is needed to describe 99.9% of the spectral variation in 
the standards. At least one principal component spectrum is created for 
each component or class that is specified in the method (or a minimum 
of 10 principal component spectra). 
 
The principal component spectra show how the spectral information in 
a calibration set is represented by the principal components and how 
much of the total spectral variation each principal component 
describes. This information can help you determine if there are enough 
sources of variation in your data. You can also use this diagnostic to 
verify the number of principal components required to describe the 
spectral variation in a calibration set.  
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Sources of variation in the calibration spectra will produce distinct 
features in the principal component spectra. The features may look like 
a spectral peak or a derivative peak. A noisy or featureless principal 
component spectrum indicates that the corresponding (and any 
subsequent) principal component contributes little useful information 
to the calibration model. 
 

 Note This same information is provided in tabular form in the Full Spectral 
Contribution column of the Eigenanalysis diagnostic results.  
 
You can run the Principal Component Spectra diagnostic on any 
quantitative or discriminant analysis method. You must specify the 
spectral data files for the standards (see the Standards tab) before using 
this diagnostic. All of the data in the full spectral range of the 
calibration and validation spectra are used to calculate the principal 
component spectra. Only the spectral information is examined; any 
concentration data that is specified in the method will not be used. 
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Principal Component Spectra command from the 
Diagnostics menu.  
 
The diagnostic results are displayed in a spectral window. The selected 
spectrum is displayed in red. 
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Each principal component spectrum appears in a separate pane. The 
spectra are labeled “PC 1,” “PC 2,” etc. followed by the percentage of 
the spectral variance described by that principal component and the 
cumulative percent variance described by all of the principal 
components combined.  
 
Use the Title box in the spectral window to display a list of the titles of 
the principal component spectra. To select another spectrum, click its 
title in the list of titles or click the displayed spectrum. 
 
You can use the View Finder and any of the commands in the View 
menu to change the limits of the spectral window or to rearrange the 
spectra in the window. You can also use the tools on the palette, such 
as the selection tool or the annotate tool, to interact with the displayed 
spectra.  
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Pairwise 
Concentration 

diagnostic 

The Pairwise Concentration diagnostic can help you evaluate your 
calibration set for the active quantitative method. The Pairwise 
Concentration diagnostic allows you to compare the concentration of 
each component in each standard to the concentrations of the other 
components that are present in the standard. The diagnostic results can 
help you verify that the component concentrations of your standards 
are distributed evenly over the analysis range for each component in the 
method. The results will also indicate whether the component 
concentrations of the standards vary independently.  
 
The Pairwise Concentration diagnostic is available only for quantitative 
methods. You must fill in the Components table on the Components 
tab and enter the titles and concentration data for the standards in the 
Standards table (Standards tab) before using the Pairwise 
Concentration diagnostic (spectral data are not required).  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Pairwise Concentration command from the Diagnostics 
menu.  
 
The diagnostic results are displayed in a task window. The data show 
how the concentration of each component in each standard relates to 
the concentrations of every other component in the standard.  
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The concentrations of components 1 and 2 in each standard are 
displayed in a table at the bottom of the window. The plot shows the 
concentration of component 1 in each standard along the X-axis and 
the concentration of component 2 along the Y-axis. 
 
Data points in the plot that correspond with calibration standards are 
represented with circles. Plus signs (+) are used to represent validation 
standards and triangles are used for correction standards. The Usage 
parameter on the Standards tab defines how each standard is used in a 
method. 
 
The ideal pairwise concentration plot will have data points that are 
distributed randomly over all areas of the plot. The limits of the X- and 
Y-axis should cover the specified analysis range for the selected 
component. Data points that are clustered or that fall in a line indicate 
that the two components do not vary independently.  
 
Each concentration value in the table is linked to a data point in the 
plot. To see the data point that corresponds with a concentration value 
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in the table, click anywhere in the corresponding row. The data point 
will be highlighted in the plot. 
 
To see the standard that is linked to a data point in the plot, click the 
data point. The title of the standard will be highlighted in the table. 
 
 

Spectrum 
Outlier diagnostic 

The Spectrum Outlier diagnostic finds the spectra of the standards 
which are most unlike the spectra of the other standards and uses either 
the Dixon or Chauvenet test for outliers to determine whether the 
difference is significant. The diagnostic results can help you identify 
standards that are outliers based on the spectral information for all of 
the standards. Since the diagnostic ranks each standard based on its 
distance from the mean, the results are also useful for selecting 
standards.  
 
The Spectrum Outlier diagnostic is available only for quantitative 
methods. You must fill in the Components table on the Components 
tab, the Standards table on the Standards tab and the Regions table on 
the Regions tab before the diagnostic can be used.  
 
The diagnostic calculates the mean spectrum for all of the standards in 
the method and then measures the distance between the mean 
spectrum and the spectrum of each standard. The mean spectrum is a 
calculated spectrum that shows the average of the spectral features that 
are present in the spectra of all of the standards.  
 
A test is applied to the standard with the highest rank to see if it is 
statistically different from the standard with the next highest rank. If 
the number of standards in the method is less than 30, the Dixon test 
for outliers is used. If there are 30 or more standards, the Chauvenet test 
is used. If the standard fails the test, the standard is considered an 
outlier.  
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If the highest ranked standard is identified as an outlier, the standard 
with the next highest rank is tested. This process continues until a 
standard passes the outlier test. 
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Spectrum Outlier command from the Diagnostics menu. 
The diagnostic results are displayed in a task window.  
 

 
 
The histogram displayed shows the Mahalanobis distance values of the 
standards ranked from smallest (closely clustered) to largest (most 
unlike the others). A vertical gray line is used in the histogram to 
separate standards that passed the Dixon test (left side of the separator) 
from standards that failed (right side of the separator). A summary of 
the results is displayed below the histogram.  
 

 Note Although Mahalanobis distance values are used in discriminant 
analysis, this diagnostic routine cannot be used to evaluate the 
standards in a discriminant analysis method.  
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The distance value and rank of each standard is also displayed in a table 
at the bottom of the task window. Each standard in the table is linked 
to a bar in the histogram. To see the bar that corresponds with a 
standard in the table, click anywhere in the corresponding row. The 
bar will be highlighted in the histogram. 
 
To see the standard that is linked to a bar in the histogram, click the 
bar. The title of the spectrum for the standard will be highlighted in 
the table. 
 
If an outlier is found, make sure the component concentration values 
that were entered for the outlier standard (see Standards tab) are 
correct. You should also display the spectrum of the outlier standard. If 
the quality of the spectrum is poor, replace the spectrum with a new 
one. When you are finished, rerun the Spectrum Outlier diagnostic. 
 
 

Pure Component 
Spectra diagnostic 

The Pure Component Spectra diagnostic displays the calculated pure 
component spectrum for each component in a quantitative method and 
one pathlength spectrum. Each pure component spectrum is composed 
of the spectral information that correlates with the concentration 
information for a given component in all of the standards.  
 
The following assumptions are made: 

• All of the components that are present in each standard are 
included as components in the method. 

• There are no chemical interactions between components that affect 
the absorbance in the analysis region or regions. 

 
 Note If the method is configured to measure sample properties rather than 

component concentrations (see Component Interactions check box), 
the “pure component spectra” are actually “single component spectra,” 
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which means they are handled as if no other “components” (properties, 
really) are contained in the sample.  
 
The calculated pure component spectra can help you evaluate the 
spectral information that will be used to measure each component in a 
quantitative method. Compare the calculated pure component spectra 
to the real spectra of the individual components, if those spectra are 
available. The spectral information in each calculated pure component 
spectrum should be unique. If the calculated pure component spectra 
for two or more components in your method look the same or very 
similar, correlations between spectral and concentration information 
will be difficult to distinguish and the quantitative results will not be 
accurate.  
 
If you are creating a CLS method, you can also use the pure 
component spectra to determine if there are other sources of variation 
in the analysis region or regions of the standards that should be 
included in the calibration model. To determine if additional 
components are present, compare the calculated pure component 
spectra created by this diagnostic to the real pure component spectra. 
To do this, use your Thermo Scientific spectral analysis software to 
display the real spectrum. Then click the calculated spectrum in this 
task window to select it and use the Copy command in the Edit menu 
to copy the spectrum to the Clipboard. Use the Paste feature in your 
Thermo Scientific spectral analysis software to paste the spectrum into 
the selected spectral window. 
 
When calculating pure component spectra, the software considers 
pathlength as an additional component. Any spectral information that 
correlates with differences in the pathlengths of the standards is placed 
in the calculated pathlength spectrum. 
 
The pathlength spectrum shows the spectral information in the 
standards which the model attributes to pathlength. When the 
Pathlength Type (see Pathlength tab) is set to Constant, the pathlength 
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spectrum may not represent true pathlength but the interpretation is 
the same. The spectrum represents those spectral features which are 
constant in all of the standards. 
 
The Pure Component Spectra diagnostic is available only for 
quantitative methods. You must fill in the Components table on the 
Components tab and the Standards table on the Standards tab before 
the diagnostic can be used. All of the data in the full spectral range of 
the calibration and validation spectra are used to calculate the pure 
component spectra.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Principal Component Spectra command from the 
Diagnostics menu.  
The diagnostic results are displayed in a spectral window. The selected 
spectrum is displayed in red. 
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Each pure component spectrum is displayed in a separate pane. The 
spectra are labeled with the component names from the Components 
table (Components tab). The pathlength spectrum is labeled 
“Pathlength.”  
 
Use the Title box in the spectral window to display a list of the titles of 
the pure component spectra. To select another spectrum, click its title 
in the list of titles or click the displayed spectrum. 
 
You can use the View Finder and any of the commands in the View 
menu to change the limits of the spectral window or to rearrange the 
spectra in the window. You can also use the tools on the palette, such 
as the selection tool or the annotate tool, to interact with the displayed 
spectra.  
 

 Note The information provided in the pure component spectra can help you 
select analysis regions for the components in your method. To display 
the pure component spectra in the spectral display area of the Region 
Selection task window, click the  tool on the View palette in the task 
window. The pure component spectra will replace whatever spectrum 
or spectra that were previously displayed in the window.  
 
 

Statistical 
Spectra diagnostic 

The Statistical Spectra diagnostic generates a series of calculated spectra 
that illustrate the variation present in the standards and, for quantitative 
methods, the spectral regions that correlate with changes in component 
concentration.  
 
You can run the Statistical Spectra diagnostic on any quantitative, 
Discriminant Analysis or Distance Match method. You must fill in the 
Components table on the Components tab (or the Classes table on the 
Classes tab) and the Standards table on the Standards tab before this 
diagnostic can be used. All of the data in the full spectral range of the 
calibration and validation spectra are used to calculate the statistical 
spectra.  
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For quantitative methods, the diagnostic uses the spectral and 
concentration information for all of the standards to generate a mean 
spectrum, a variance spectrum, a multiple correlation spectrum, and a 
separate correlation spectrum for each component in the method, 
including the pathlength component. The mean spectrum shows the 
dominant features that are present in all of the standards. The variance 
spectrum shows the spectral information that varies in the standards 
(independent of concentration). The correlation spectra show the 
spectral regions that correlate with changes in component 
concentration. This information can help you choose analysis regions 
for your method or understand why specific regions are suggested. The 
statistical spectra can also be useful for choosing the proper analysis 
type. For example, if nonoverlapping regions of high correlation exist 
for each component, a simple calibration model such as SMLR may 
work well for the analysis.  
 

 Note If you run the Statistical Spectra diagnostic on quantitative method 
that is set up to measure sample properties, rather than component 
concentrations (see Component Interactions check box), a multiple 
correlation spectrum will not be generated.  
 
If you run the diagnostic on a discriminant analysis method, it 
calculates a variance spectrum and a mean spectrum for each class.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Statistical Spectra command from the Diagnostics menu. 
The diagnostic results are displayed in a spectral window. The selected 
spectrum is displayed in red.  
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Each statistical spectrum is displayed in a separate pane. For 
quantitative methods, the multiple correlation spectrum appears first, 
followed by the correlation spectrum for each component in the 
method, the pathlength correlation spectrum, the mean spectrum, and 
the variance spectrum.  
 
If you run the diagnostic on a discriminant analysis method, the mean 
spectrum for each class appear first, followed by the variance spectrum 
(labeled “Within Class Standard Deviation”). 
 
The mean spectrum shows the average of the spectral features that are 
present in all of the standards. The variance spectrum shows the 
spectral variance in the standards. It is produced by calculating the 
square root of the spectral variance at each X value over all of the 
standards. The multiple correlation spectrum shows the correlation 
coefficient of the combined standards at each X-axis value. Each 
component correlation spectrum provides the correlation coefficient of 
the selected component at each X-axis value.  
 



 

322 TQ Analyst User’s Guide Thermo Fisher Scientific 

The component correlation spectra can help you choose the analysis 
regions for the components in your method. Try to find at least one 
unique region that shows high correlation in each component 
correlation spectrum. If unique regions do not exist for one or more 
components, choose the regions that have the highest correlation in the 
multiple correlation spectrum. If a component correlation spectrum 
shows little or no correlation, the component may be difficult to 
quantify because there is little unique spectral information that 
correlates with changes in component concentration.  
 

 Note To display a statistical spectrum in the spectral display area of the 
Region Selection task window, click the  tool on the View palette in 
the task window. The statistical spectra will replace whatever spectrum 
or spectra that were previously displayed in the window.  
 
Compare each component correlation spectrum to the variance 
spectrum to determine the significance of any highly correlated spectral 
regions. If a spectral region shows high correlation but low variance, 
the region is important to the analysis but the magnitude of the 
variation is small. The best regions will have high correlation and high 
variance.  
 
If one or more unique regions exist for each component in the method, 
use the Simple Beer's Law analysis type. If the component correlation 
spectra show regions of high correlation but the regions overlap 
somewhat, try using the CLS analysis type. If no unique features exist 
or some of the component correlation spectra show low correlation in 
all regions, try using the PLS analysis type. 
 
Use the Title box in the spectral window to display a list of the titles of 
the statistical spectra. To select another spectrum, click its title in the 
list of titles or click the displayed spectrum. 
 
You can use the View Finder and any of the commands in the View 
menu to change the limits of the spectral window or to rearrange the 
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spectra in the window. You can also use the tools on the palette, such 
as the selection tool or the annotate tool, to interact with the displayed 
spectra.  
 
 

Cross 
Validation diagnostic 

The Cross Validation diagnostic shows how well a calibrated 
quantitative method performs by quantifying each calibration standard 
as if it were a validation standard. The diagnostic results can help you 
identify standards that may be outliers. You may also use Cross 
Validation to validate a method that does not include validation 
standards.  
 
The Cross Validation diagnostic is available only for quantitative 
methods. The method must be calibration before Cross Validation can 
be used.  
 
When you run Cross Validation, the software quantifies each 
calibration standard in the method as if it were a validation standard. 
This is accomplished by sequentially removing the specified number of 
standards from the calibration set, calibrating the method and using the 
new calibration model to quantify the standards that were removed 
from the calibration set. The process is repeated until all of the 
standards in the calibration set have been quantified as validation 
standards.  

 
 Note If duplicate standards are present in the method, the software will 

remove and analyze all of them during the same cross validation 
iteration. We define “duplicate standard” as any standard that has 
exactly the same concentration values as another standard for all 
components in the method.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Cross Validation command from the Diagnostics menu. 
The following dialog box is displayed. 
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Enter the number of calibration standards you want to remove for each 
calibration iteration or use the suggested value. If the method includes 
many standards, you may want to remove more standards per iteration 
to reduce the calculation time.  
 
The diagnostic results are displayed in a task window.  
 

 
 
The table in the lower half of the task window shows the calculated 
and actual concentration values and the % difference value for each 
cross validation standard that contains the selected component. A 
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cumulative and component performance index for each cross validation 
calibration are also provided in the table.  
 

 Note These performance values will only be provided if validation standards 
are specified in the Standards table (see Standards tab).  
 
Two plots are shown at the top of the task window. The Calculated 
versus Actual plot compares the calculated concentration value of each 
standard in the validation set to its actual concentration value. The 
calculated values are the concentration values that were calculated using 
the calibrated method that excludes that standard. The actual values are 
the known concentration values that were entered in the Standards 
table (see Standards tab).  
 
The % Difference plot shows the differences between the calculated 
and the actual concentration values relative to the actual values.  
 
If a pathlength column is displayed in the table, the concentration 
values shown in the plots have been adjusted for differences in 
pathlength. The pathlength adjusted concentration values are the 
calculated and actual concentration values displayed in the table 
multiplied by the appropriate pathlength value.  
 
Each data point in the plots is linked to a standard in the table. To 
identify the standard that is associated with a data point in a plot, click 
the data point. The corresponding standard will be highlighted in the 
table. To find the data point that corresponds to a standard in the 
table, click anywhere in the row. The associated data point will be 
highlighted in both plots.  
 
To select the next or previous component in the method, click the 
Next or Back button in the Select Component group.  
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The name (or abbreviated name) and index number for the selected 
component are displayed above the buttons. When you select another 
component, the cross validation data for the new component are 
displayed in the cross validation table and plots.  
 
Use the cumulative and component performance indices listed in the 
Cross Validation Results table to evaluate how the method will 
perform when the corresponding standard is excluded from the 
calibration set. 
 

 Note If you removed two or more standards for each cross validation 
iteration, the performance indices for the standards in each group that 
was removed will be identical.  
 
If a method calculates concentration values perfectly (i.e., the 
calculated value for every standard matches its actual value exactly), the 
data points in the Calculated vs. Actual plot will form a line exactly 45o 
from both axes. The greater the distance between a data point and this 
ideal line, the greater is the difference between the calculated and the 
actual value for the corresponding standard.  
 
A typical % Difference plot will show data points distributed randomly 
above and below the zero line within a narrow concentration range.  
 
If you suspect that a standard is an outlier, check that the 
concentration and pathlength values were entered correctly in the 
Standards table (see the Standards tab). You should also display the 
spectrum of the outlier standard. If the quality of the spectrum is poor, 
replace the spectrum with a new one.  
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If the data look okay, consider the chemical makeup of the standard 
and how the standard is used in the method. Cross validation data 
provide a true measure of accuracy because only the validation data are 
included in the displayed results. Validation data are better indicators 
of the accuracy of a calibration model than calibration or correction 
data because calibration and correction standards are used to generate 
the model while validation standards are used only for validation. It is 
up to you to decide whether or not an outlier standard should be 
included in the calibration or validation set.  
 
 

External 
Validation diagnostic 

External Validation allows you to quantify a large group of validation 
spectra using any TQ Analyst method and store the data in a format 
that is accessible to other applications.  
 
The validation results include the calculated concentration value, the 
actual concentration value and the % difference ((calculated - actual / 
actual) * 100) for each component in each validation sample. A 
performance index is also provided for each component in the method 
as well as the slope and intercept of the line that represents the calculated 
versus actual plot for each component. The slope and intercept values 
are used to measure linearity. 
 
An input file must be used to specify the file names and component 
concentrations of the spectra to be quantified. You can use any 
spreadsheet or text editor application to create the input file. If you use 
a spreadsheet application to create the input file, you must save the file 
as a tab delimited text file in order to use it with External Validation.  
 

 Note The input file must be formatted properly for use with External 
Validation. For more information, refer to the next section.  
 
The validation data are placed in a spreadsheet (Microsoft® Excel®) or 
text file.  
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You can run External Validation on any TQ Analyst method. The 
method must be calibrated before External Validation can be used. 
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the External Validation command from the Diagnostics menu. 
The standard Windows Open dialog box appears listing files of the text 
(*.TXT) file type. To list all the files in the indicated directory, select 
All Files (*.*) from the Files of Type drop-down list box. Select the file 
that contains the list of validation spectra you want to quantify and 
click OK to begin the analysis.  
 
When the analysis is finished, the results are displayed in an application 
window. If TQ Analyst locates the Microsoft® Excel® spreadsheet 
application on your computer, the validation data are displayed in an 
Excel application window. If Excel is not found, the data appear in a 
window for a text processing application, such as NotePad or Write.  
 
The validation results include the calculated concentration value, the 
actual concentration value and the % difference ((calculated - actual / 
actual) * 100) for each component in each validation sample. A 
performance index is also provided for each component in the method 
as well as the slope and intercept of the line that represents the 
calculated versus actual plot for each component. 
 
If you close the result window, the data will be saved in the file 
VALID.TXT (or VALID.XLS).  
 

 Notice The contents of the file VALID.TXT (or VALID.XLS) will be 
overwritten the next time you use External Validation. If you want to 
keep your analysis results, use the Save As command to save them with a 
new file name.  
 
 

Formatting an input file In order to use the External Validation diagnostic to quantify a group 
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for External Validation of validation spectra, the file names and component concentrations of 
the validation spectra must be specified in an input file. You can use 
any spreadsheet or text editor application to create the input file. If you 
use a spreadsheet application to create the input file, the file must be 
saved in text format with tab delimiters.  
 
The input file must be formatted according to the sample and 
specifications provided below. 
 
Example 

file header information 

Index File name Pathlength C1 C2 C3 

1 {tab} PLS01.SPA {tab} 1.0 {tab} 1.94 {tab} 0.99 {tab} 1.92 {CR} {LF} 

2 {tab} PLS02.SPA {tab} 1.0 {tab} 1.26 {tab} 0.5 {tab} 4.01 {CR} {LF} 

3 {tab} PLS03.SPA {tab} 1.0 {tab} 2.59 {tab} 0.57 {tab} 1.49 {CR} {LF} 
 
where: CR = carriage return 

LF = line feed 
 
You can include any number of lines in the file header information or 
use different column headings in the table. TQ Analyst starts reading 
the first line that begins with a “1”. Any information that is placed at 
the top of the file will be ignored. 
 
Make sure you use tabs to separate the entries in each column of the 
table. 
 
The pathlength values are required only when the Pathlength Type 
parameter in the current method is set to “Known” and the method is 
set up to prompt the operator to provide a pathlength value for each 
sample that is quantified (Pathlength Prompt check box is on). If one of 
the other pathlength settings is specified in the method, the pathlength 
information in the input file will be ignored. 
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 Note You may also use an External Validation input file with the Multiple 
Quantify command in the Diagnostics menu. Any additional 
information that is present in an External Validation input file will be 
ignored when the file is used with Multiple Quantify.  
 
 

Residual 
Spectra diagnostic 

The Residual Spectra diagnostic quantifies a spectrum using the active 
method and then displays the residual spectrum or spectra for the 
spectrum that was quantified.  
The Residual Spectra diagnostic is a handy tool for troubleshooting 
problems with the unknown samples. For example, if the uncertainty 
values for one or more spectra that are quantified with a method are 
significantly higher than usual or the calculated concentration values 
are much higher or lower than expected, the residual spectra can help 
you determine the source of the problem (the residual spectrum 
represents graphically the prediction error or uncertainty). If you know 
that your spectrometer or the samples you are measuring have changed, 
you can also use the Residual Spectra diagnostic to find out if the 
method is still valid. 
 
The Residual Spectra diagnostic can be run on any CLS, PLS, or PCR 
method using any spectrum that is compatible with TQ Analyst and 
the selected method (i.e., any spectrum that has the same data spacing 
and Y-axis unit as the method's calibration spectra). This diagnostic 
may also be used with the classification methods that calculate residual 
spectra (Similarity Match and Distance Match). The method must be 
calibrated before the Residual Spectra diagnostic can be used. Only the 
spectral information in the specified analysis region or regions are used 
to calculate the residual spectrum or spectra. 
 
If you run the diagnostic on a CLS or PCR method, the software 
calculates the following two spectra: 

• The unknown sample spectrum that the method was used to 
quantify. 
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• The cumulative residual spectrum.  
 
If you run it on a PLS method, the following spectra are created: 

• The unknown sample spectrum that the method was used to 
quantify. 

• A residual spectrum for each component in the method.  
 
The software calculates the cumulative residual spectrum by subtracting 
the spectral information that is accounted for by all components in the 
calibrated method from the unknown sample spectrum. To generate 
each component residual spectrum, the software subtracts the spectral 
information for each component from the sample spectrum.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Residual Spectra command from the Diagnostics menu.  
 
The diagnostic results are displayed in a spectral window.  
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If you ran the diagnostic on a CLS or PCR method, the software 
displays the sample spectrum followed by the cumulative residual 
spectrum. If a PLS method was active, the sample spectrum is displayed 
first followed by a residual spectrum for each component in the 
method. Each spectrum is placed in a separate pane. The selected 
spectrum is displayed in red.  
 
Look for large features that resemble a spectral peak or a derivative peak 
in the residual spectra. These types of features represent portions of the 
spectral data that are not described by the calibrated method.  
 
Use the Title box in the spectral window to display a list of the titles of 
the spectra that are displayed in the window. To select another 
spectrum, click its title in the list of titles or click the displayed 
spectrum. 
 
You can use the View Finder and any of the commands in the View 
menu to change the limits of the spectral window or to rearrange the 
spectra in the window. You can also use the tools on the palette, such 
as the selection tool or the annotate tool, to interact with the displayed 
spectra.  
 
 

Multiple Quantify Use Multiple Quantify when you want to quantify two or more spectra 
using the current method and place the calculated results in a format 
that is accessible to other applications, such as a spreadsheet (Microsoft® 
Excel®) or text file. You can select one or more spectral data (*.SPA) 
files or a spectral group (*.SPG) file to be quantified or select an input 
file that lists the file names of the spectra to be quantified.  
 
You can run Multiple Quantify on any TQ Analyst method. The 
method must be calibrated before Multiple Quantify can be used. 
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When you choose Multiple Quantify, the standard Windows Open 
dialog box appears listing spectral data files (*.SPA) in the SPECTRA 
directory.  
 
Select the spectral data files you want to quantify. You may need to 
change directories or drives to locate them. To select more than one 
file, hold down the Control key and click the desired file names. To 
select a spectral group, set the Files of Type list box to Spectral Groups 
(*.SPG), choose the group file you want to analyze and then click 
Open.  
 
If you want to quantify a series of spectral files that are listed in a text 
file, select the text file (*.TXT extension) that contains the list of file 
names. You can list all the files in the indicated directory by selecting 
All Files (*.*) from the Files of Type drop-down list box. 
 

 Note The input file must be formatted properly for use with Multiply 
Quantify. See the next section for more information.  
 
Click OK to begin the analysis. Depending on how the method 
parameters are set, you may be prompted to enter needed information, 
such as a pathlength value. Follow the instructions that appear on the 
screen. (If you are quantifying spectral files that are listed in an input 
file and the file includes any additional information that is required for 
the analysis, these prompts will not appear.) 
 
When the analysis is finished, the results are displayed in an application 
window. If TQ Analyst locates the Microsoft® Excel® spreadsheet 
application on your computer, the data are displayed in an Excel 
application window. If Excel is not found, the data appear in a window 
for a text processing application, such as NotePad or Write. The results 
are formatted using the settings for the report parameters (see Report 
tab) in the current method.  
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When you are finished reviewing the results, close the results window 
by clicking the close button in the upper right corner of the window. 
The data will be saved in the file QUANTIFY.TXT (or 
QUANTIFY.XLS).  
 

 Notice The contents of the file QUANTIFY.TXT (or QUANTIFY.XLS) will 
be overwritten the next time you use Multiple Quantify. If you want to 
keep your analysis results, use the Save As command to save them with a 
new file name.  
 
 

Formatting an  
input file for  

Multiple Quantify 

You can use the Multiple Quantify command in the Diagnostics menu 
to quantify a series of spectral files that are listed in a spreadsheet or text 
file. You can use any spreadsheet or text editor application to create the 
input file. If you use a spreadsheet application to create the input file, 
the file must be saved in text format with tab delimiters.  
 
The input file must be formatted according to the sample and 
specifications provided below. 
 
Example 

file header information 

Index File name Pathlength 

1 {tab} TQX_SBL1.SPA {tab} 1.0 

2 {tab} TQX_SBL2.SPA {tab} 1.0 

3 {tab} TQX_SBL2.SPA {tab} 1.0 
 
You can include any number of lines in the file header information or 
use different column headings in the table. TQ Analyst starts reading 
the first line that begins with a "1". Any information that is placed at 
the top of the file will be ignored. 
 
Make sure you use tabs to separate the entries in each column of the 
table. 
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The pathlength values are required only when the Pathlength Type 
parameter in the selected method is set to Known and the method is 
set up to prompt the operator to provide a pathlength value for each 
sample that is quantified (Pathlength Prompt check box is on). The 
pathlength values are ignored if the method doesn't require them. See 
the sections titled “Choosing a Pathlength Option” in the chapters on 
creating TQ Analyst methods for more information. 
 

 Note You may also use an External Validation input file with Multiple 
Quantify. Any additional information that is present in an External 
Validation input file will be ignored when the file is used with Multiple 
Quantify. See the section on “External Validation” in this chapter for 
more information.  
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PRESS diagnostic The PRESS diagnostic basically runs a cross validation but only on the 
calibration standards in a PLS method. It shows how the predicted 
residual error sum of squares (PRESS) value changes as the number of 
factors used to calibrate the component is increased. This information 
can help you choose the optimum number of factors to use for each 
component in a PLS method.  
 
The PRESS diagnostic is only available for Partial Least Squares (PLS) 
quantitative methods. The method must be calibrated before the 
PRESS diagnostic can be used.  
 
When a PLS method is calibrated, all of the relevant concentration 
information and spectral information in the analysis region or regions of 
the calibration standards is condensed into a set of factors. Each factor 
represents an independent source of variation in the data.  
 
Factors are ranked by the amount of variance they describe. The first 
factor describes most of the variation in the calibration standards. Each 
additional factor describes most of the remaining variation. Therefore, 
the first factor contains most of the common information in the data. 
The rest of the factors contain information that is more specific, 
representing small variations in the data which are often important to 
the analysis.  
 
The information provided by the PRESS diagnostic can help you 
choose the optimum number of factors to use for each component in a 
PLS method. For example, the PRESS value is an indicator of 
calibration error in a PLS method. Each time a factor that represents 
useful information is added to the calibration model, the error is 
reduced so the PRESS value decreases. At some point, the PRESS value 
will either reach a minimum, level off, or begin to increase. If you add 
factors after that point has been reached, the method's performance 
will not improve and could decrease if the calibration model becomes 
overfit. 
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 Note Only the standards that have their usage set to calibration are used by 
the PRESS diagnostic. Validation standards are not used. The Usage 
parameter on the Standards tab specifies the usage of each standard.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the PRESS command from the Diagnostics menu. The 
diagnostic results are displayed in a task window.  
 

 
 
The plot illustrates graphically how the PRESS value for the selected 
component changes as the software increases the number of factors 
used to calibrate the method. The plots starts at zero. The second point 
in the plot represents the first factor.  
 
The table displayed in the lower right corner of the task window shows 
the numerical PRESS values for the selected component. 
 
The recommended number of factors to use for the selected 
component is displayed below the plot. TQ Analyst automatically 
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selects the optimum number of factors to use the first time a PLS 
method is calibrated. 
 
You can specify the number of factors to use for the selected 
component the next time the method is calibrated by entering a value 
in the Number of Factors to Use box.  
 
To select the next or previous component in the method, click the 
Next or Back button in the Select Component group.  
 

 
 
The name (or abbreviated name) and index number for the selected 
component are displayed above the buttons. When you select another 
component, the PRESS values for the new component are displayed in 
the table and plot.  
 
If you're not sure what is the optimum number of factors to use for a 
component in your method, use the recommended value displayed in 
the PRESS diagnostic task window. If you want to use a different 
value, select the minimum number of factors that produce the lowest 
PRESS value. If there is no clear minimum in the PRESS plot for a 
component in your method, the Loading Spectra diagnostic routine 
may provide additional help in choosing the optimum number of 
factors.  
 

 Note If you want to limit the number of factors the software calculates for 
the components in a PLS method, see the Factors For Last Calibration 
table on the Other tab.  
 
 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 339 

Principal Component 
Scores diagnostic 

The Principal Component Scores (PC Scores) diagnostic measures how 
accurately each standard in a PLS, PCR, or discriminant analysis 
method is represented by each principal component that was used to 
calibrate the method by calculating score values. A score value represents 
the multidimensional distance of a standard projected onto a principal 
component.  
 
This diagnostic can only be run on a PLS, PCR, Discriminant Analysis 
or Distance Match method. The method must be calibrated or ready 
for calibration before the PC Scores diagnostic can be used.  
 
When a PLS, PCR, Discriminant Analysis or Distance Match method 
is calibrated, all of the relevant spectral information in the analysis 
region or regions of the calibration spectra is condensed into a set of 
principal components. Each principal component represents an 
independent source of spectral variation in the data.  
 
The PC Scores diagnostic ranks the principal components according to 
the amount of variance they describe. The first principal component 
describes most of the variation in the calibration spectra. Each 
additional principal component describes most of the remaining 
variation. Therefore, the first principal component contains most of 
the common information in the data. The rest of the principal 
components contain information that is more specific, representing 
small variations in the data which are often important to the analysis.  
 
The diagnostic results can help you determine whether the principal 
components that were calculated for the calibrated method accurately 
represent the spectral data for each standard in the method. They 
highlight any patterns or trends in your data, which may or may not be 
significant to your application. They can also help you identify 
standards that may be outliers or, if you are creating a discriminant 
analysis method, evaluate how the standards are assigned to the classes 
in the method.  
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To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Principal Component Scores command from the 
Diagnostics menu.  
 
The diagnostic results are displayed in a task window.  
 

 
 
The score values for principal component 1 and principal component 2 
for each standard are displayed in a table at the bottom of the task 
window. These are the two most significant principal components in 
the method.  
 
The plot shows graphically the "distance" between each standard and 
the two principal components that are selected for the X- and Y-axis of 
the plot.  
 
Use the Back and Next buttons in the Select Y-axis and Select X-axis 
groups to select which principal component is assigned to each axis.  
 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 341 

 
 
When you select a new principal component, the index number of the 
new principal component is displayed above the buttons. 
 
If you are running this diagnostic on a quantitative method, data 
points in the plot that correspond with calibration standards are 
represented with a circle. A plus sign (+) is used to represent validation 
standards and a triangle is used for correction standards. The Usage 
parameter on the Standards tab defines how each standard is used in a 
method. For classification methods, the PC Scores diagnostic assigns 
each class a unique symbol (for up to seven classes). 
 
Each score value in the table is linked to a data point in the plot. To 
see the data point that corresponds with a score value in the table, click 
anywhere in the corresponding row. The data point will be highlighted 
in the plot. To see the standard that is linked to a data point in the 
plot, click the data point. The title of the standard will be highlighted 
in the table. 
 
If you are creating a PLS or PCR method, the data points in each PC 
Scores plot should be distributed randomly. The data points in the PC 
Scores plot for a Discriminant Analysis or Distance Match method 
should be clustered by class. 
 
A data point that is isolated from the others indicates that the 
corresponding standard is different from the other standards in the 
method. This difference may be due to a characteristic of the standard 
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that is important to the analysis or it may be caused by an error or a 
problem with the spectrum.  
 
If you find an outlier standard, check the data that was entered in the 
Standards table and display the spectrum for that standard. If the 
quality of the spectrum is poor, replace the spectrum with a new one. If 
the spectrum looks okay, consider the chemical makeup of the 
standard. It is up to you to decide whether an outlier standard should 
be included in the calibration or validation set. 
 
 

Factor 
Loading diagnostic 

The Factor Loading diagnostic shows the relationship between the 
spectral and concentration information that is described by each factor 
that is calculated for each component in a PLS method. This 
information can help you identify standards that may be outliers and 
decide whether or not to include them in your method.  
 
The Factor Loading diagnostic is only available for Partial Least 
Squares (PLS) quantitative methods. The method must be calibrated 
before the Factor Loading diagnostic can be used.  
 
When you calibrate a PLS method, the software condenses all of the 
relevant concentration and spectral information in the analysis region or 
regions of the calibration standards into a set of factors. Each factor 
represents an independent source of variation in the data.  
 
Factors are ranked by the amount of variance they describe. The first 
factor describes most of the variation in the calibration standards. Each 
additional factor describes most of the remaining variation. Therefore, 
the first factor contains most of the common information in the data. 
The rest of the factors contain information that is more specific, 
representing small variations in the data which are often important to 
the analysis.  
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There is a set amount of variability in the spectral data for the 
calibration standards. There is also a set amount of variability in the 
concentration values of the standards. The Factor Loading diagnostic 
allows you to consider them separately for each standard in the method 
and evaluate how they contribute to the factors for each component. 
This information can help you identify standards that may be outliers 
and decide whether or not to include them in your method.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Factor Loading command from the Diagnostics menu. The 
diagnostic results are displayed in a task window.  
 

 
 
The loading value for the spectral contribution and the concentration 
contribution of each standard for the selected factor and the selected 
component are displayed in a table at the bottom of the task window. 
The plot shows graphically how the spectral loading values compare 
with the concentration loading values. 
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Use the Back and Next buttons in the Select Component group to 
select which component loading data you want to view. The index 
number and name (or abbreviated name) for the currently selected 
component are displayed above the control buttons.  
 

 
 
Use the Back and Next buttons in the Select Factor group to select 
which factor loading data you want to view for the selected 
component. The number of the currently selected factor is displayed 
above the control buttons.  
 

 
 
Each time you select a new component or factor, the software updates 
the spectral and concentration loading data in the table and plot.  
 
Each standard in the table is linked to a data point in the plot. To see 
the data point that corresponds with a standard in the table, click 
anywhere in the corresponding row. The data point will be highlighted 
in the plot. To see the standard that is linked to a data point in the 
plot, click the data point. The title of the standard will be highlighted 
in the table. 
 
For a given component and factor, the data points in an ideal factor 
loading plot will be distributed evenly along a line that is 45 degrees 
from both axes. This shows that the standards are contributing evenly 
to the factor and no standard is influencing the factor significantly 
more than the others. Data points that are close to this ideal line 
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represent standards that are well described for the corresponding factor. 
The higher the spectral and concentration loading values for a given 
standard, the more significant the standard is to the selected factor. A 
plot that shows some data points clustered together with an isolated 
point elsewhere may indicate an outlier. 
 
Keep in mind, however, that the plots for each factor can be quite 
different. For example, the data points in the plot for the first factor are 
often distributed randomly because, although much of the variation is 
described, the information may not be highly correlated with 
concentration.  
 
If most of the data points in a factor loading plot are clustered in the 
lower left corner of a plot (smaller spectral and concentration 
contribution) and one or more data points are clustered in the upper 
right corner of the plot (larger spectral and concentration 
contribution), the standards that have higher loading values have a 
significant influence on the factor and should be examined.  
 
The difference in the loading value (spectral or concentration) may be 
due to a characteristic of the standard that is important to the analysis 
or it may be caused by an error or a problem with the spectrum. Check 
the data that was entered in the Standards table for the corresponding 
standards and display the spectrum of each standard. If the quality of 
the spectrum is poor, replace the spectrum with a new one. If the data 
look okay, consider the chemical makeup of each standard. It is up to 
you to decide whether or not an outlier standard should be included in 
the calibration or validation set. 
 

 Note If you want to limit the number of factors the software calculates for 
the components in a PLS method or change the number of factors 
used, see the Factors For Last Calibration table on the Other tab.  
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Leverage diagnostic The Leverage diagnostic provides the following information about the 
calibration standards in a PLS method.  

• How much influence each standard has on the method model. 

• How accurately the calibration model describes each standard. 
 
This information can help you identify standards that may be outliers.  
 
The Leverage diagnostic is available only for Partial Least Squares (PLS) 
quantitative methods. The method must be calibrated before the 
Leverage diagnostic can be used.  
 
When you calibrate a PLS method, TQ Analyst saves the leverage and 
residual values for each component and each standard. The Leverage 
diagnostic shows the relationship between the leverage and residual 
values for each component and each standard in a PLS method. The 
residual values plotted by the Leverage diagnostic have been divided by 
their standard error to produce the “studentized” residual value. This 
places all standards on a similar scale, regardless of their leverage values, 
and makes it easier to identify standards that may be outliers. 
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Leverage command from the Diagnostics menu. The 
diagnostic results are displayed in a task window.  
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The numerical leverage and residual values for each standard are 
displayed in a table at the bottom of the task window. The plot shows 
graphically how the leverage values compare with the studentized 
residual values for the selected component.  
 
Use the Back and Next buttons in the Select Component group to 
select which component leverage and residual data you want to view.  
 

 
 
The index number and name (or abbreviated name) for the currently 
selected component are displayed above the control buttons. When 
you select a new component, the software updates the leverage and 
residual data in the table and plot.  
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Each standard in the table is linked to a data point in the plot. To see 
the data point that corresponds with a standard in the table, click 
anywhere in the corresponding row. The data point will be highlighted 
in the plot. To see the standard that is linked to a data point in the 
plot, click the data point. The title of the standard will be highlighted 
in the table. 
 
The data points in the leverage plot should be distributed evenly 
throughout the plot. A data point that is isolated from the others 
indicates that the corresponding standard is different from the other 
standards in the method.  
 
The center horizontal line represents zero residual values. If a standard 
has a high residual value (i.e., if it appears high above or below the zero 
residual line), the analysis region or regions of the spectrum for that 
standard contain features which are not modeled by the calibrated 
method.  
 
If the leverage value for a standard is high, the standard is significant to 
the calibration model for the selected component. Standards that have 
high leverage values usually have low residual values because most of 
the spectral information in the analysis region or regions is included in 
the calibration model.  
 
If you find a standard with a leverage value that is noticeably different 
from the leverage values for the other standards in the method, check 
the data that was entered in the Standards table and display the 
spectrum for that standard. If the quality of the spectrum is poor, 
replace the spectrum with a new one. If the data look okay, consider 
the chemical makeup of the standard. The difference in the leverage 
value may be due to a characteristic of the standard that is important to 
the analysis or it may be caused by an error or a problem with the 
spectrum. It is up to you to decide whether or not an outlier standard 
should be included in the calibration set. 
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Loading 
Spectra diagnostic 

The Loading Spectra diagnostic displays a loading spectrum for each 
factor that is needed to describe 99.9% of the variation in the standards 
for a PLS method. A loading spectrum is the orthogonal spectrum that 
represents the amount of variability described at each X value for a 
given factor.  
 
The software generates the loading spectra for each component in a 
separate operation. It creates at least one loading spectrum for each 
component (or a minimum of 10 loading spectra).  
 
The loading spectra show how the spectral and concentration 
information in a calibration set is represented by the factors in a PLS 
method and how much of the total variance each factor describes. This 
information can help you determine if there are enough sources of 
variation in your data. You can also use this diagnostic to verify the 
number of factors required to describe the variation in a calibration set.  
 
The Loading Spectra diagnostic is available only for Partial Least 
Squares (PLS) quantitative methods. The method must be calibrated 
before the Loading Spectra diagnostic can be used. The software uses 
the concentration data and all of the spectral data in the full spectral 
range of the calibration spectra to generate the loading spectra.  
 
To start the diagnostic, select the method by clicking the method 
window or choosing the method name in the Window menu. Then 
choose the Factor Loading command from the Diagnostics menu. The 
following dialog box is displayed: 
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Select a component by clicking its name in the Select Component list 
box. The loading spectra for the component you selected are displayed 
in a spectral window. The selected loading spectrum is displayed in red.  
 

 
 
Sources of variation in the calibration data will produce distinct 
features in the loading spectra. The features may look like a spectral 
peak or a derivative peak. A noisy or featureless loading spectrum 
indicates that the corresponding (and any subsequent) factor 
contributes little useful information to the calibration model. 
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Use the Title box in the spectral window to display a list of the titles of 
the loading spectra. To select another spectrum, click its title in the list 
of titles or click the displayed spectrum. 
 
You can use the View Finder and any of the commands in the View 
menu to change the limits of the spectral window or to rearrange the 
spectra in the window. You can also use the tools on the palette, such 
as the selection tool or the annotate tool, to interact with the displayed 
spectra.  
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 14 Troubleshooting Tips 
 
 
 
The following comments may help you troubleshoot some common 
problems when creating or running a new method. 
 
When creating or modifying a method: 

• If a warning message about mismatched standards appears when 
you open additional standards, the parameter settings used to 
collect the new standard are significantly different from the settings 
that are saved with the current method. For optimum performance, 
all method standards should be collected using the same settings for 
the collection parameters. You can deal with the warning three 
ways: collect the standard again using the proper settings for the 
collection parameters, edit the settings in the current method or 
ignore the warning and continue adding standards. 

• If a software feature is unavailable (displayed in gray), it is either 
not appropriate for the selected analysis type or a required 
parameter (possibly located elsewhere) is not selected. Use the 
software’s convenient Explain Help feature to get more 
information. Click the Explain button on the TQ Analyst toolbar to 
display the Explain help window. Then click the software feature 
you need information for. The help window updates to display 
information about the feature you clicked.   

 
When using a method to analyze a sample: 

• If you want to set the Collect and Bench parameters in Thermo 
Scientific OMNIC spectral analysis software and use the settings to 
collect a spectrum to be quantified, open the Quant Setup dialog 
box (choose Quant Setup from the OMNIC Analyze menu), select 
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the method and make sure the Collect and Bench check boxes in the 
Parameter group are off.  

 
 Note If the Collect and Bench check boxes in the Parameter group are on 

when you select a method, TQ Analyst will change the Collect and 
Bench parameter settings in your OMNIC software to match the 
settings that are specified in the selected method.  
 
• If a warning message about mismatched parameters appears when 

you select a spectrum to quantify, the parameter settings used to 
collect the sample spectrum are significantly different from the 
settings that are saved with the current method. For optimum 
performance, all standards and samples should be collected using 
the same settings for the collection parameters. You can deal with 
the warning three ways: collect the spectrum again using the proper 
settings for the collection parameters, edit the settings in the 
current method or ignore the warning and continue analyzing 
samples. 

 
• If you turned on the Uncertainty Values check box (Report tab) for 

a PLS or PCR method but no uncertainty values appear in the 
sample reports, make sure at least one validation standard is specified 
in the method (see the Standards tab).  
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Appendix A:  Using the Keyboard 
 
 
 
This chapter provides easy instructions on interacting with TQ Analyst 
software features using keyboard commands instead of a mouse. See 
your Windows documentation for complete information on using the 
keyboard to perform these and other standard Windows operations. 
 
 

Tabbing through  
a window or dialog 

box 

In a window or dialog box that contains several features, use the Tab 
key to move to the feature with which you want to interact. As you 
“tab” through a window or dialog box, the features become highlighted 
or marked with a dotted rectangle (or both) as they become active. 
Once a feature is active, you can use the appropriate keys on the 
keyboard to interact with it. 
 
 

Selecting an 
item in a list 

To select an item in a list, tab to the list and then use the up or down 
arrow key to move to the item. 

 

Turning a 
check box on or off 

To turn a check box on or off, tab to the check box and then press the 
space bar. 

 

Selecting an 
option button 

To select an option from a group of option buttons, tab to the option 
and then press the space bar. 
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Choosing a 
command button 

To choose a command button (such as OK) after tabbing to it, press 
Enter. 
 
 

Keyboard shortcuts The next section describes how to use key combinations to open 
TQ Analyst menus or choose commands.  
 
 

Selecting menus Use the Alt key along with the underlined letter in a menu name on the 
screen to open the menu from the keyboard. For example, to open the 
File menu, hold down the Alt key and then type F. 
 
 

Choosing commands You can choose a menu command from the keyboard in two ways: 

• Type the key combination. If there is a key combination for a 
command, the key combination will be displayed next to the 
command name in the menu. (The menu does not have to be 
selected in order to choose a command using its key combination.) 

• If the menu that contains the command is selected, type the 
underlined letter in the command name on the screen or use the up 
and down arrow keys on the keyboard to select the command and 
then press the Enter key. 
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Appendix B:  Comparison of Internal 
Reference and Peak Ratio Pathlength 
Types 
 
 
 
This section describes two experiments which could be configured for 
either Internal Reference or Peak Ratio pathlength correction. The 
examples are included to demonstrate the difference between the 
Internal Reference and Peak Ratio pathlength options available in 
TQ Analyst and to help you understand when each of them should be 
used. 
 

This example is a contrived situation to show you a case where Peak 
Ratio does not work. In this example we measure a set of spectra of the 
same standard solution in several different pathlength cells. 

Case 1 

 
Assume you are measuring a hypothetical analytical peak height, A, and 
a pathlength peak height, b, from each standard spectrum. Remember, 
there is always some error or noise associated with every spectral 
measurement. A small amount of error is included in the measurements 
as shown in the table on the next page. 
 
The concentration, C, of each standard is the same, 1.00. For the 
purposes of this example, we assume that it has no error. 
 
When setting up a calibration curve, concentration is generally plotted 
on the X-axis. This is the “known” value or the independent variable. 
The absorbance of the analytical measurement, A, is plotted on the Y-
axis. This value depends on the concentration and is called the 
dependent variable. When an unknown sample is quantified, this 



 

358 TQ Analyst User’s Guide Thermo Fisher Scientific 

model is used in reverse; the independent variable, A, is measured and 
the corresponding dependent variable, C, is calculated. 
 
A calibrated method using Internal Reference, A = b * C, calculates the 
product of pathlength times concentration, b * C, for a measured value 
of the analytical region, A. A is the dependent variable and the product 
b * C is the independent variable. 
 
A method based on Peak Ratio, A / b = C, calculates just 
concentration, C. But this calculation is based on the pathlength 
corrected analytical measurement, A / b. The calibrated method cannot 
tell you anything about measurement error because this error is masked 
by ratioing the raw data before presenting it to the method. 
 
The following data demonstrates this case. The pathlength times 
concentration column, b * C, shows the result calculated by a method 
using Internal Reference pathlength type. The absorbance over 
pathlength column, A / b, shows the pathlength corrected data that 
will be the dependent input into a method using the Peak Ratio 
pathlength type. 
 
 
Std   A       b       C    b * C A / b 

1 3.45 1.70 1.00 1.70 2.03 
2 6.76 3.40 1.00 3.40 1.99 
3 10.44 5.10 1.00 5.10 2.05 
4 13.36 6.80 1.00 6.80 1.96 
5 17.20 8.50 1.00 8.50 2.02 
 
 
If we plot this data you can easily see why the Peak Ratio pathlength 
type cannot be used. The calibration points will always form a vertical 
line. A concentration value of 1.00 will always result using this 
calibration, regardless of the actual spectral measurement. 
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For Internal Reference, the calibration points form a line which can be 
used as a calibration curve. 
 

This example is a more realistic situation where either Internal 
Reference or Peak Ratio could be used. However, it still demonstrates 
why Internal Reference is a better choice for pathlength type than Peak 
Ratio. 

Case 2 

 
This example contains six hypothetical standards all at different 
concentrations and measured in different pathlength cells. 
 
As with Case 1, assume you are measuring a hypothetical analytical 
peak height, A, and a pathlength peak height, b, from each standard 
spectrum. Remember, there is always some error or noise associated 
with every spectral measurement. These are the dependent variables. 
 
Again, for the purposes of this example, we assume that it has no error 
in the concentration values, C. 
 



 

360 TQ Analyst User’s Guide Thermo Fisher Scientific 

The pathlength times concentration column, b * C, shows the result 
calculated by a method using the Internal Reference pathlength type. A 
is the dependent variable; the product b * C is the independent 
variable. 
 
The absorbance over pathlength column, A / b, shows the pathlength 
corrected data that will be the dependent variable input into a method 
using Peak Ratio pathlength type. The independent variable is just 
concentration, C, in this case. 
 
 
Std   A       b       C    b * C A / b 
1 1.4 5.0 0.20 1.00 0.28 
2 3.6 3.0 0.67 2.00 1.20 
3 6.6 2.0 1.50 3.00 3.30 
4 10.4 2.0 2.00 4.00 5.20 
5 15.0 4.0 1.25 5.00 3.75 
6 20.4 5.0 1.20 6.00 4.08 
 
If we plot the dependent vs. independent variables you can see how the 
data would be used to calculate a calibrated method or “working 
curve.” 
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The Internal Reference pathlength treatment does a better job showing 
the effect of measurement error in these standards. The slight non-
linearity could easily be corrected using a second order correction curve. 
 
Unlike Case 1, this data does allow you to construct a calibration curve 
from the Peak Ratio data. However, there is no trend to the errors or 
any way to smoothly compensate for them. Our only option here is to 
just fit the best straight line to the data. 
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Glossary 

A 
Absolute Maximum In Range region type  A 

technique for measuring the intensity of a 
single point in a spectral region. Absolute 
Maximum In Range reports the maximum 
intensity value, either positive or negative, in 
the specified X-axis range.  

absorbance  A measure of how much of the 
incident radiation that is directed at a sample is 
absorbed by the sample. Absorbance is defined 
by the formula A = log10 (1/T), where T is the 
fractional transmittance. 

absorbance peak  A region of an absorbance 
spectrum where the sample absorbs radiation. 

absorbance spectrum  A spectrum that shows 
how the absorptivity of a sample varies with 
frequency, or wavelength. 

absorptivity  A property of a compound that 
describes how readily a fixed number of 
molecules absorb radiation at a specific X-axis 
location. 

acceptance limits  The highest and lowest 
measured or calculated values that are within 
the tolerance limits of a process control 
application.  

acceptance limits check  A sample checking 
feature that compares the measured or 
calculated values for the spectra you quantify 
with a method to the acceptance limits 
specified in the method. If a measured or 
calculated value is above the upper acceptance 
limit or below the lower acceptance limit, the 
sample is flagged and the specified action is 
taken. 

action button   
1) A feature on some method tabs that allows 
you to perform a task. For example, pressing 
the Edit Regions button on the Regions tab 
displays a task window for graphically editing 
analysis regions.   
 
2) One of several features on the toolbar that 
allows you to perform a specific operation.  

Action list box  A drop down list box that 
allows you to select the action you want 
TQ Analyst to take if the corresponding 
sample checking feature is on and a spectrum 
you quantify with the current method fails the 
corresponding sample check.  
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active window  The window that is affected by 
software operations.  

analysis limits  The upper and lower limits of 
the analysis range for a component.  

analysis limits check  A sample checking feature 
that compares the calculated values for the 
spectra you quantify with a method to the 
analysis limits specified in the method. If a 
component concentration value is above the 
upper analysis limit or below the lower 
analysis limit for that component, the sample 
is flagged and the specified action is taken. 

analysis range  The concentration range of a 
component that is described in a method 
model.  

analysis region  The portion or portions of the 
spectrum that will be used for the analysis. 
The analysis region can contain several bands. 

analysis results  The measured or calculated 
values that are displayed on the screen when 
you use a method to quantify an unknown 
sample spectrum.  

Analysis Type parameter  A parameter that 
defines the type of results a method will 
produce when you use it to analyze an 
unknown sample spectrum and the algorithm 
that will be used for the analysis. 

ANOVA  An acronym for the standard Analysis 
of Variance statistical analysis. The ANOVA 
table is a standard format for reporting the 
degree of variation in a data set. 

Area region type  A technique for measuring the 
intensity of a spectral region. Area calculates 
the sum of the intensity values in the specified 
X-axis range. The trapezoidal rule is used to 
determine the area. 

Average Height In Range region type  A 
technique for measuring the intensity of a 
spectral region. Average Height In Range 
reports the average intensity value in the 
specified X-axis range.  

Average In Range baseline option  A technique 
for choosing baseline points in order to 
calculate a corrected measurement. Average In 
Range uses the average intensity value in the 
specified baseline range to define each baseline 
point.  

B 
background spectrum  A single-beam spectrum 

obtained without a sample in place. A single-
beam sample spectrum can be ratioed against 
the background spectrum to remove the 
effects of the background. 

band  A spectral feature that contains only one 
peak. 
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baseline  The portion of an absorbance 
spectrum that is not part of the peaks. The 
baseline represents those regions where the 
sample absorbs little or no energy. 

baseline corrected measurement  The intensity 
of a peak or region measured from the spectral 
baseline. See corrected measurement. 

Baseline Offset baseline type  A technique for 
calculating a corrected measurement. Baseline 
Offset subtracts a constant from the specified 
measured peak or each point in the specified 
region. The Offset parameter defines the value 
of the constant.  

baseline point  A point through which the 
baseline of a spectral region will be drawn. 
The drawn baseline is subtracted from the 
intensity of the peak or region to produce a 
corrected measurement.  

beamsplitter  A device inside the interferometer 
that splits the infrared beam coming from the 
source into two beams of nearly equal energy. 
Usually one beam passes through the 
beamsplitter, is reflected from the 
interferometer’s moving mirror and returns to 
the beamsplitter. The other beam is reflected 
from the beamsplitter and then is reflected 
from the interferometer’s fixed mirror and 
returns to the beamsplitter. The recombined 
beam exits the interferometer, passes through 
the sample and travels to the detector. 

Beer-Lambert-Bougher law  A mathematical 
law which states that absorbance increases in 
proportion to concentration:  A = a b c 

 Where: A  = absorbance 
 a = absorptivity (constant) 
 b = pathlength 
 c = concentration 

C 
Calibrate button  A button on the toolbar that 

allows you to calibrate a method. 

calibrate  To analyze a set of standards in order 
to calculate a method model for predicting 
component concentrations in unknown 
samples.  

calibration curve  A method model that is based 
on two or more calibration standards which 
contain different amounts of the components 
to be measured in a quantitative analysis. 

calibration model  A mathematical relationship 
that describes how the spectral data for the 
calibration standards correlate with the 
concentration or classification data. See 
method model.  
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Calibration Results window  The task window 
that appears after a quantitative, discriminant 
analysis, or Distance Match method is 
calibrated. The Calibration Results window 
shows the calibration tables and plots and the 
performance index for each component or 
class in the method. 

calibration set  The standards that are used to 
create the method model when a method is 
calibrated. 

calibration spectrum  The spectrum of a 
calibration standard. 

calibration standard  A standard that is used to 
create the method model during calibration. 
In TQ Analyst, calibration standards are also 
used to calculate a correction curve, if one is 
specified.  

Chauvenet test  A statistical test used to 
determine whether a standard is an outlier. If 
the deviation of a standard from the mean is 
so large that the probability of occurrence is 
less than 1/20, the Chauvenet test considers 
the standard an outlier.  

check box  A small box that can be selected to 
turn the adjacent parameter on and off. The 
parameter is on when a check mark appears in 
the box and off when the box is blank.  

Christiansen effect  A condition in which rapid 
changes in the refractive index of a substance 
in the vicinity of a sample peak leads to 
scattering which, combined with absorption of 
light, causes a shift in the sample peak’s 
measured peak maximum. 

class  A group of calibration standards that have 
a common set of characteristics.  

Classical Least Squares analysis type  A 
quantitative analysis calibration technique 
based on the classical least squares algorithm. 

classification analysis  To find the calibration 
standard or class that most closely matches an 
unknown sample spectrum or verify that the 
sample spectrum is similar to the spectra in a 
specified class.  

classification method  A method that classifies 
an unknown sample spectrum by finding the 
calibration standard or class that most closely 
matches the sample spectrum or by verifying 
that the sample spectrum is similar to the 
spectra in a specified class.  

classify  To find the calibration standard or class 
that most closely matches an unknown sample 
or to verify that a sample spectrum is similar 
to the spectra in a specified class.  

Close button  A button on the TQ Analyst 
toolbar that allows you to close the active 
window.  
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Collection and Processing Information dialog 
box  A dialog box that contains information 
about the active spectrum. To display the 
collection and processing information for a 
displayed spectrum, select the spectrum and 
then double-click its title box. 

command  A word or phrase in a menu that you 
can choose in order to perform an action.  

component  A chemical compound contained in 
a sample mixture. 

component residual spectrum  The spectral 
information in an unknown sample spectrum 
that is not explained by a particular 
component. Each component residual 
spectrum is generated by removing the spectral 
information for a single component from the 
spectrum of the unknown sample. See residual 
spectrum and cumulative residual spectrum. 

Computed Area region type  A technique for 
measuring the intensity of a spectral region. 
Computed Area calculates the area of the 
spectral region that falls between the specified 
baseline points (or the specified baseline 
range). 

concentration  The amount of a component 
that is present in the standards used for 
calibration and validation or in an unknown 
sample mixture. 

concentration unit  The unit of measurement 
that is associated with the concentration values 
of a measured component. 

concentration value  The specified or reported 
concentration of a component in a standard or 
sample. 

conformity spectrum  A spectrum that shows 
point by point where deviations occur 
between two spectra. 

Constant pathlength type  A technique for 
handling pathlength differences in standards 
and unknown samples. Select the Constant 
pathlength option when the spectra of the 
calibration standards and the unknown 
samples are collected at the same pathlength. 
The pathlength value does not need to be 
known because it is not a factor in any 
calculations. 

corrected concentration  The concentration 
value multiplied by the specified correction 
coefficient. 

corrected measurement  The intensity of a peak 
or region measured from the spectral baseline. 
See baseline corrected measurement. 

correction  The process of calculating a linear or 
higher order polynomial which can be applied 
to the concentration values calculated by a 
calibrated method to improve the accuracy of 
the analysis. 
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correction coefficient  The value for the 
variables c0, c1, c2, etc. that will be used to 
calculate each term in the polynomial 
equation for a correction curve. The general 
format for the equation is shown below:  

 Xc = c0 + c1X + c2X2 + c3X3 + c4X4 + c5X5 

 Where X is the calculated concentration of  
 component X, Xc is the corrected  
 concentration of component X, and ci is the  
 coefficient for each term in the equation  
 (c0 = constant, c1 = first order, etc.).  

correction curve  A linear or higher order 
polynomial which can be applied to the 
concentration values calculated by a calibrated 
method to improve the accuracy of the 
analysis. 

correction standard  A standard that is used 
along with the calibration standards to 
calculate a correction curve. Correction 
standards are not used in calibration.  

Corrections task window  A task window that 
allows you to display the calculated verses 
actual plot for each component in a 
quantitative method and contains tools for 
defining a correction curve. 

correlation coefficient  A measure of the linear 
relationship between two variables. A value of 
"one" implies that there is a direct linear 
relationship between two variables. A value of 
"zero" implies that there is no relationship 
between the two variables.  

Correlation search algorithm  An algorithm for 
the Search Standards analysis that determines 
the correlation between the unknown sample 
spectrum and each calibration spectrum by 
calculating their correlation coefficients. 

correlation spectrum  A calculated spectrum 
that shows the correlation between the spectral 
information and component concentrations of 
a single standard. The correlation spectrum is 
produced by calculating the correlation 
coefficient at each X-axis value.  

cross validation  A technique for validating a 
quantitative method without using validation 
standards. A specified number of calibration 
standards are removed from the calibration set, 
then the method is calibrated and the new 
method model is used to quantify the 
standards that were removed. This process is 
repeated until all of the calibration standards 
have been quantified as validation standards.  



 

Thermo Fisher Scientific TQ Analyst User’s Guide 369 

cross validation standard  A standard or group 
of standards that are used to validate a method 
model during cross validation. Cross 
validation standards are calibration standards 
that have been temporarily removed from the 
method model. The temporary model is then 
used to quantify the removed standard or 
standards. 

cumulative residual spectrum  The spectral 
information in an unknown sample spectrum 
that is not explained by the calibrated method 
that was used to quantify the spectrum. The 
cumulative residual spectrum is calculated by 
subtracting the spectral information that is 
accounted for by all components in the 
calibrated method from the unknown sample 
spectrum. See residual spectrum and 
component residual spectrum. 

D 
data collection parameter check  A sample 

checking feature that compares the data 
collection parameter settings used to collect an 
unknown sample spectrum that is quantified 
with a method to the settings used to collect 
the calibration spectra. If the settings for 
certain key collection parameters don't match, 
the sample is flagged and the specified action 
is taken. 

data collection parameters  A set of parameters, 
such as resolution, that define the data 
collection process. 

default setting  The state each method 
parameter is set to when a new method is 
created. 

derivative  The rate of change of the Y value 
with respect to the X value. See first derivative. 

detector  A device inside the spectrometer or 
analyzer that produces an electrical signal in 
response to the intensity of the 
electromagnetic radiation (light) striking it. 

detrending  Removing a linear or quadratic 
curve from a spectral region in order to 
remove baseline variation. 

diagnostic task windows  Task windows that 
display diagnostic results and allow you to 
adjust related parameters. 

dilution factor  A mathematical function 
applied to the concentrations of standards 
and/or samples that are diluted by some 
amount. The concentration value of each 
diluted standard and sample should be divided 
by the specified dilution factor.  
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Discriminant Analysis analysis type  A 
classification analysis technique. Discriminant 
Analysis applies the spectral information in the 
specified regions of an unknown sample 
spectrum to a stored method model in order 
to determine which class of standards is most 
similar to the unknown. A measurement of 
the Mahalanobis distance between the 
unknown sample and each reported class is 
also provided.  

Distance Match analysis type  A classification 
analysis technique. Distance Match calculates 
a residual spectrum for each class and measures 
its distance from the class average. The result 
is the percentage of frequencies that exceed the 
Distance Match threshold.  

Distance Match threshold  A parameter that 
defines the acceptable differences between the 
unknown sample and each class in a Distance 
Match analysis. The Distance Match threshold 
must be set in standard deviation units 
(typically 5). 

distance value  The numerical result from a 
Discriminant Analysis or Distance Match 
analysis. Discriminant analysis distance values 
are calculated using the Mahalanobis distance 
algorithm. The distance value from a Distance 
Match method represent the percentage of 
frequencies that exceed the distance match 
threshold.  

 The distance values from both of these analysis 
types tell you how well the sample matches the 
standards in each class that is reported. The 
smaller the distance value the better is the 
match. 

distance value check  A parameter that 
compares the distance values for the spectra 
you quantify with a discriminant analysis 
method to the threshold distance value 
specified in the method. If the distance value 
for the best matched class is above the 
threshold distance value, the sample is flagged 
and the specified action is taken. 

Dixon test  A statistical test used to determine 
whether a standard is an outlier. If the 
deviation of a standard from the mean is 
outside a 95% confidence threshold, the 
Dixon test considers the standard an outlier.  

drop down list box  A parameter that allows 
you to select an item from a list of available 
options.  

E 
Explain button  An action button on the 

TQ Analyst toolbar that allows you to open 
the Explain help window. 
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Explain help window  A window that provides 
help information on the selected feature in the 
active window. The active window can be a 
method window or a task window. Use the 
Explain button to open the Explain help 
window and the Close button to close it. 

extension  A period and three numbers or letters 
at the end of a file name. You can indicate the 
kind of data contained in a file by using an 
appropriate extension. 

extraction factor  A mathematical function 
applied to the concentrations of the standards 
and/or samples which are extracted by some 
amount. The concentration value of each 
extracted standard and sample should be 
multiplied by the specified extraction factor.  

F 
F ratio  The ratio of two variances. This ratio 

follows a well-defined distribution based on 
the number of degrees of freedom for both 
variances. The TQ Analyst feasibility wizard 
uses F ratios to determine if the variability in 
the method standards is significant. 

factor  A set of principal components that 
contain spectral and concentration 
information. Factors are used to describe the 
variation in a partial least squares analysis. 

factorial design  A technique for selecting the 
component concentrations of the standards in 
a quantitative analysis. A factorial design 
investigates the effects of a number of different 
variables simultaneously. A factorial design can 
be implemented using a full factorial design 
model or a fractional factorial design model.  

feasibility standard  A standard or sample used 
for the feasibility assessment.  

feasibility assessment  A test run on two 
representative samples to determine whether 
there is sufficient variability in the sample data 
that correlates with differences in sample 
composition to develop a successful 
quantitative method.  

file  A collection of spectral or method 
information, given a name and stored on a 
disk. 

file name  The name that identifies a file. 

first derivative  The rate of change of the Y 
value with respect to the X value. See 
derivative. 

First Derivative In Range region type  A 
technique for measuring a spectral region. 
First Derivative In Range measures an estimate 
for the first derivative at each data point in the 
specified region. 



 

372 TQ Analyst User’s Guide Thermo Fisher Scientific 

Fixed Location baseline option  A technique 
for choosing baseline points in order to 
calculate a corrected measurement. Fixed 
Location uses the intensity value at the 
specified baseline location to define each 
baseline point.  

Fixed Location Height region type  A 
technique for measuring the intensity of a 
single point in a spectral region. Fixed 
Location Height finds the nearest data point 
to the specified X-axis location and uses that 
point and the two points on either side to find 
the interpolated maximum. Then, it measures 
the intensity at that location.  

fixed mirror  The mirror in the interferometer 
of a Fourier-Transform Infrared (FT-IR) 
spectrometer that reflects the infrared beam 
back to the beamsplitter. 

Force Through Zero parameter  A parameter 
that forces a correction curve to pass through 
the origin at zero concentration.  

fractional factorial design model  A technique 
for selecting the component concentrations of 
the standards in a quantitative method. The 
fractional factorial design model selects a well-
organized portion of the total number of 
combinations found in the full factorial design 
model.  

frequency  The number of light wave cycles that 
occur per unit time or space. In TQ Analyst, 
frequency is expressed in wavenumbers (cm-1). 

full factorial design model  A technique for 
selecting the component concentrations of the 
standards in a quantitative method. A full 
factorial design model uses all combinations of 
the variables that can be formed. Since this 
often requires a large number of standards, a 
fractional factorial design model is typically 
used.  

full spectrum check  A sample checking feature 
that compares each unknown sample spectrum 
that is quantified with a method to the 
calibration spectra. The comparison is made 
over the full spectral range. The result of the 
comparison is a fit value. If a spectrum fit 
value falls below the threshold fit value, the 
sample is flagged and the specified action is 
taken. 

full spectrum fit value  The numerical result 
from the full spectrum check or the 
measurement region spectrum check. The fit 
value tells you how well the sample matches 
the calibration standards. The fit values range 
from 0 to 100. A fit value of 100 indicates a 
perfect match. 

full width half height (FWHH)  See Peak 
Width (At Half Maximum) region type. 
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H 
hidden spectrum  A spectrum that has been 

removed from the screen by using the Hide 
Spectrum command in the View menu. The 
spectrum remains open and can be displayed 
again by using the Show Spectrum command. 

I 
index number  Numbers used throughout 

TQ Analyst software to indicate which 
component, standard, analysis region, etc., out 
of the total number defined in a method is 
being examined. 

infrared (IR)  The region of the electromagnetic 
spectrum extending from approximately 
12,800 cm-1 to 30 cm-1.  

infrared beam  The infrared beam of light 
emitted by the source in an infrared 
spectrometer. The beam travels from the 
source to the detector. 

intercept  The distance from the origin of 
coordinates along a coordinate axis to the 
point at which a line or curve intersects the 
axis. 

interferogram  The signal produced by the 
constructive and destructive addition of light 
when two infrared beams in the interferometer 
of a Fourier-Transform Infrared (FT-IR) 
spectrometer are recombined. 

interferometer  A device that splits and then 
recombines the infrared beam in a Fourier-
Transform Infrared (FT-IR) spectrometer. 
The output signal is an interferogram. 

Internal Reference pathlength type  A 
technique for handling pathlength differences 
in standards and unknown samples. Select the 
Internal Reference pathlength option when 
you want to specify a peak that will be used to 
compensate for differences in sample 
pathlength. 

K 
Known pathlength type  A technique for 

handling pathlength differences in standards 
and unknown samples. Select the Known 
pathlength option when the pathlength values 
of the calibration standards and the unknown 
samples vary but can be measured by a 
technique that is not based on infrared 
absorbance. The pathlength values must be 
specified by the user and are used in the 
calibration and analysis of unknown samples.  
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L 
least squares algorithm  A statistical 

quantitative analysis technique. The least 
squares algorithm determines the most 
probable value of a quantity from a set of 
measurements by choosing the value which 
minimizes the sum of the squares of the 
deviations of those measurements.  

leverage value  The distance between a 
calibration standard and the center of a 
method model. The leverage values tell you 
how much the standard is influencing the 
model. The leverage values range between 0 
and 1, where 1 indicates the highest leverage.  

linear correction  The mathematical equation of 
a straight line (Y = m ( x + b)) that can be used 
to apply a multiplicative factor or offset value 
to a measured intensity value. For example, 
Conc = m ( A + b), where A = measured 
absorbance, m = the multiplicative factor, and 
b = the offset value. 

Linear Removed baseline type  A technique for 
calculating a corrected measurement. Linear 
Removed calculates a linear least squares fit 
over the specified region. Then it subtracts the 
value of this line at each data point in the 
region from the spectrum intensity at the same 
data point. The resulting region has all of its 
linear information removed, leaving only the 
higher order part of the region.  

loading value  The distance of a calibration 
standard in the spectral or concentration 
direction from the selected factor. If the 
spectral or concentration loading value for a 
given standard is large (positive or negative), 
the standard is significant to the factor.   

Location At 1% (2%, 5%, 10%) of Peak 
Maximum region type  A technique for 
finding where the intensity in a spectral region 
is reduced to 1%, 2%, 5%, or 10% of its 
maximum height.  

locked pane  A stacked pane into which a 
spectrum cannot be moved. Locking a pane 
that contains a spectrum allows you to scroll 
spectra on the screen while maintaining the 
position of the spectrum in the locked pane. 
An X appears in the pane lock of a pane when 
the pane is locked.  

M 
Mahalanobis distance  An algorithm for 

calculating the distance of a sample from the 
mean of a set of standards. 

match  The result of a Search Standards, 
Discriminant Analysis, Distance Match, or 
QC Compare Search analysis. The match is 
the spectrum (Search Standards) or class 
(Discriminant Analysis, Distance Match, 
QC Compare Search) that is most similar to 
the unknown sample spectrum. 
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Match Type parameter  A parameter that 
defines the scale for the match values 
calculated from a Similarity Match analysis. If 
Match Type is set to "Find Similarities," the 
match values will be scaled from 0 to 100 
where 100 is a perfect match. If Match Type is 
set to "Find Residual Differences," the match 
values will be scaled from 100 to 0 where 0 is a 
perfect match.  

match value  The numerical result from a 
Similarity Match, Search Standards, Distance 
Match, or QC Compare Search analysis.  

match value check  A sample checking feature 
that compares the match values for the spectra 
you quantify with a method to the threshold 
match value specified in the method. If a 
match value does not meet the threshold 
match value, the sample is flagged and the 
specified action is taken. 

maxi-min strategy  A strategy for selecting 
standards from a large pool of possible 
standards. The basic steps are outlined below:  

 1. Find the standard that is closest to the mean for 
all standards and add it to the calibration set. 

 2. Add the standard that is farthest away from the 
mean. 

 3. For each remaining standard in the pool, 
calculate its distance to each standard already in 
the calibration set. Find the minimum of these 
distances and assign it to the remaining standard. 

 4. Find the remaining standard with the maximum 
distance assigned to it and add it to the calibration 
set. 

 5. Repeat steps 3 and 4 until the requested number 
of standards are chosen. 

Maximum Height In Range region type  A 
technique for measuring the intensity of a 
single point in a spectral region. Maximum 
Height in Range reports the maximum 
intensity value in the specified X-axis range. 

Maximum In Range baseline option  A 
technique for choosing baseline points in 
order to calculate a corrected measurement. 
Maximum In Range uses the maximum 
intensity value in the specified baseline range 
to define each baseline point.  

mean spectrum  A calculated spectrum that 
shows the average of the spectral features that 
are present in a group of spectra.  

measurement warnings  Sample checking 
features which can be used to monitor the 
unknown sample spectra that are quantified 
with a method for possible problems. Use the 
Report tab to turn the measurement warnings 
on and off and to specify how they will 
operate.  
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Measurement Only analysis type  A TQ 
Analyst analysis type that allows you to 
measure the heights or areas of peaks in a 
spectrum, take the ratio of two measured 
peaks, measure the noise in a given region, 
measure the width at half maximum of the 
largest peak in a region, locate the largest peak 
in a region, or find where a peak is reduced to 
1%, 2%, 5%, or 10% of its maximum height. 

measurement region spectrum check  A sample 
checking feature that compares each unknown 
sample spectrum that is quantified with a 
method to the method's calibration spectra. 
Only the specified analysis regions are 
compared. The result of the comparison is 
called a fit value. If a spectrum fit value falls 
below the threshold fit value, the sample is 
flagged and the specified action is taken. 

measurement unit  The unit of measurement 
that is associated with a measured peak or 
region. 

menu  A list of commands that you can choose 
to carry out an action or see information. 

menu bar  The horizontal list of menu names 
near the top of the TQ Analyst window. 

menu name  The name of a menu that appears 
in the menu bar. You can see the commands 
available in a menu by selecting the menu 
name. 

method  A set of parameters and spectra that can 
be used to create a method model. 

method file name  The standard Windows file 
name you enter when you save a TQ Analyst 
method on a disk (*.QNT extension). 

method model  A mathematical relationship 
that describes how the spectral data for the 
calibration standards correlate with the 
concentration or classification data. See 
calibration model.  

method parameter  A parameter that specifies 
how a method will work. There are several 
distinct types of method parameters, including 
text boxes, readouts, option buttons, check 
boxes, and drop down list boxes. 

method title  A one-line description of a 
TQ Analyst method. The method title is 
displayed in the Open Method dialog box 
when the method file name is selected. The 
title can also be displayed or printed with the 
analysis results. 

method window  A window that contains 
parameters and functions for creating a 
TQ Analyst method.  

micrometer  An X-axis unit typically used for 
infrared wavelength. One micrometer equals 1 
x 10-6 meter. 
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Minimum Height In Range region type  A 
technique for measuring the intensity of a 
single point in a spectral region. Minimum 
Height In Range reports the minimum 
intensity value in the specified X-axis range. 

Minimum In Range baseline option  A 
technique for choosing baseline points in 
order to calculate a corrected measurement. 
Minimum In Range uses the minimum 
intensity value in the specified baseline range 
to define each baseline point.  

mixture spectrum  A spectrum of a sample that 
contains two or more components. 

moving mirror  The mirror in the 
interferometer of a Fourier-Transform 
Infrared (FT-IR) spectrometer that reflects the 
infrared beam back to the beamsplitter while 
moving toward and away from the 
beamsplitter in a repeating cycle. 

multiple correlation spectrum  A calculated 
spectrum that shows the correlation between 
the spectral information and the 
concentrations of all of the components in all 
of the standards. The multiple correlation 
spectrum is produced by calculating the 
correlation coefficient at each X-axis value 
over all of the standards.  

multiplicative factor  A numerical value that 
can be applied to a measured intensity value 
according to the following equation:  

 <Corrected value> = factor x <measured intensity> 

Multiplicative Signal Correction pathlength 
type  A technique for handling pathlength 
differences in standards and unknown 
samples. Select the Multiplicative Signal 
Correction pathlength option when you want 
to use a mathematical function to compensate 
for differences in sample pathlength and there 
is a multiplicative contribution to the spectral 
signal that correlates with sample pathlength. 

N 
noise  Random signals produced by a number of 

components in a spectrometer, including the 
detector and signal-processing electronics. 

non-linear  A measured response, y, that does 
not vary in proportion to some other quantity, 
x. (y  ax + b). In a quantitative analysis, non-
linear usually means that spectral absorbance, 
y, does not vary in proportion to 
concentration, x (i.e., the component does not 
obey the Beer-Lambert-Bougher Law). 
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O 
offset value   

1)  A numerical value that can be applied to a 
measured intensity value according to the 
following equation: 

  <Corrected value> = <measured intensity> + offset 

2)  A constant that is subtracted from each data 
point in a region to determine the baseline 
corrected measurement. See baseline offset. 

OMNIC®  Thermo Scientific comprehensive 
software package for general FT-IR 
applications. 

One Point baseline type  A technique for 
estimating the baseline of a spectral region. A 
one-point baseline is a horizontal line that 
passes through the spectrum at the specified 
baseline point. The software subtracts the 
drawn baseline from the intensity of the peak 
or region to produce a corrected measurement. 

Open Method dialog box  A dialog box that 
allows you to open a TQ Analyst or other 
compatible analytical method that is stored on 
a disk. 

optical bench  The component of a 
spectrometer or analyzer that contains the 
optics, generally including the source, 
interferometer, and detector. 

option button  A small circle in a dialog box or 
window that you can click to select one option 
from a group of options.  

orthogonal spectrum  A spectrum that 
represents an independent source of variation 
in a data set. In method types such as PLS and 
PCR, mixture spectra are reduced to a smaller 
set of orthogonal spectra which, through linear 
combination, can be used to approximate the 
original mixture spectrum. 

orthogonal vectors  Directions in 
multidimensional space that are at right angles 
to one another. For example, the X- and Y-
axes in a plot are orthogonal vectors in two 
dimensional space. In a quantitative analysis, 
orthogonal vectors are spectra that represent 
independent sources of variation in a data set. 

outlier  A standard that is significantly different 
from the other standards in a calibration set as 
determined by the diagnostic plots, the Dixon 
test, or the Chauvenet test. The difference 
may be due to valid differences in the 
composition of the standard or to an error in 
preparing the standard or entering its 
associated data.  

overfit model  A calibration model that is very 
specific to the calibration standards. An overfit 
model can quantify the calibration standards 
with great accuracy but cannot produce the 
same level of accuracy when quantifying a 
validation standard or sample.  
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P 
pane  A rectangular area of a spectral window in 

which a spectrum can be displayed. 

parameter  A setting within the software that 
affects how the active method analyzes an 
unknown sample spectrum or reports the 
analysis results. 

partial least squares algorithm  A statistical 
quantitative analysis technique. The partial 
least squares (PLS) algorithm examines the 
specified region or regions of the calibration 
spectra to determine which areas are varying 
statistically as a function of component 
concentration. The PLS calibration model is 
developed in one operation using spectral and 
concentration information from the standards. 
Intensity and wavelength information are used 
in the analysis.  

Partial Least Squares analysis type  A 
quantitative analysis technique based on the 
partial least squares algorithm. 

pass/fail indicator  A sample checking feature 
that uses the threshold match value to 
determine whether a "pass" or "fail" message 
will be displayed or printed next to the match 
values from a Similarity Match, Distance 
Match, Search Standards, or QC Compare 
Search analysis.  

pathlength  The distance that a beam of 
electromagnetic energy travels within a 
sample. When analyzing samples that are in 
the solid state, "sample pathlength" is often 
referred to as "sample thickness." 

pathlength peak  A spectral peak that can be 
used to compensate for differences in 
pathlength between the standards and the 
unknown samples. The measured intensity of 
the pathlength peak must vary only with 
pathlength; it cannot include absorptions from 
other components or impurities in the sample 
mixture. This can be a peak from a weighed 
amount of a component that is added to the 
calibration standards and unknown samples or 
it can be a peak that is due to the sample 
matrix. 

Pathlength Type parameter  A parameter that 
defines how the method will account for 
differences in pathlength between the 
standards and the unknown samples.  

peak  A region of a spectrum where the sample 
absorbs radiation. 

peak height  The intensity (Y value) of a 
spectrum at a given X value.  

Peak Location (Interpolated) region type  A 
technique for finding the exact location of a 
peak in a spectral region. Peak Location 
(Interpolated) reports the location of the 
largest peak in the specified region. 
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Peak Ratio pathlength type  A technique for 
handling pathlength differences in standards 
and unknown samples. Select the Peak Ratio 
pathlength option when you want to specify a 
reference peak that will be used to compensate 
for differences in sample pathlength. All of the 
data points in the analysis region or regions of 
the calibration spectra are divided by the 
reference peak value. The pathlength 
correction is applied before the method is 
calibrated. 

Peak Width (At Half Maximum) region type  
A technique for consistently measuring the 
width of a peak in a spectral region. Peak 
Width (At Half Max) reports the width at half 
maximum for the largest peak in the specified 
region. This type of measurement is also 
referred to as FWHH (full width at half 
height).  

peak-to-peak noise  A measurement of signal 
noise in which the lowest noise peak is 
subtracted from the highest noise peak. 

Peak-To-Peak Noise region type  A technique 
for measuring the noise in a spectral region. 
Peak-to-Peak Noise reports the calculated 
peak-to-peak noise value for the specified 
region.  

performance index  A measure of how 
accurately a calibrated method can quantify or 
classify the validation standards. TQ Analyst 
provides two algorithms for calculating the 
performance index for quantitative methods: 
% Difference (default) and RMSE. The 
average distance ratio algorithm is used to 
calculate the performance index for 
discriminant analysis methods.  

Predict pathlength type  A technique for 
handling pathlength difference in standards 
and samples. Select the Predict Pathlength 
option when you want to use the pathlength 
information in the calibrated method to 
predict the pathlength of each sample that is 
analyzed with the method. The predicted 
pathlength value is used to calculate 
component concentrations in the unknown 
samples.  

Predicted Residual Error Sum of Squares  See 
PRESS value. 

PRESS value  An acronym for Predicted 
Residual Error Sum of Squares. The PRESS 
value for a given factor in a partial least squares 
analysis is the sum of the (residual 
concentration error)2 over the standards that 
are removed for each cross validation iteration.  



 

Thermo Fisher Scientific TQ Analyst User’s Guide 381 

principal component  One or more orthogonal 
vectors that describe the spectral or 
concentration variation in a principal 
component regression or partial least squares 
analysis, or the spectral variation in a 
discriminant analysis. The first principal 
component describes most of the variation in 
the calibration standards. Each additional 
principal component describes most of the 
remaining variation. 

principal component regression algorithm  A 
statistical quantitative analysis technique. The 
principal component regression (PCR) 
algorithm examines the specified region or 
regions of the calibration spectra to determine 
which areas are varying statistically as a 
function of component concentration. The 
PCR method model is generated in two steps: 
step 1 uses the spectral data from the 
calibration standards to determine spectral 
variation; step 2 correlates spectral variation 
with concentration. The intensities of all data 
points in the specified region or regions are 
used in the analysis. 

Principal Component Regression analysis type  
A quantitative analysis technique based on the 
principal component regression algorithm.  

principal component spectrum  The 
orthogonal spectrum that represents the 
amount of variation described by a principal 
component. 

pure component spectrum  A calculated 
spectrum that represents the spectral 
information that correlates with the 
concentration information for a given 
component in all of the standards.  

Q 
QC Compare search analysis type  A 

classification analysis technique. QC Compare 
search compares the spectral information in 
the specified region or regions of an unknown 
sample spectrum with the spectra of the 
calibration standards to determine which class 
of standards is most similar to the unknown. 
The result of this comparison is the single best 
match from each reported class. 

Quadratic Removed baseline type  A technique 
for calculating a corrected measurement. 
Quadratic Removed calculates a 2nd order 
polynomial over the specified region. Then it 
subtracts the value of the curve at each data 
point in the region from the spectrum 
intensity at the same data point. The resulting 
region has all of its (quadratic) curvature 
removed, leaving only the higher order part of 
the region.  

qualitative analysis  To identify the 
composition of a sample mixture.  

quantify  To use a calibrated method to analyze 
an unknown sample.  
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Quantify button  A button on the TQ Analyst 
toolbar that allows you to quantify an 
unknown sample spectrum using the active 
method. The method must be calibrated 
before it can be used to quantify samples. 

Quantify dialog box  A dialog box that displays 
the analysis results after an unknown sample 
spectrum is quantified. 

quantitative analysis  To measure the 
concentrations of one or more components in 
a sample mixture.  

R 
random design  A method for selecting the 

component concentrations of the standards 
that will be used to calibrate a quantitative 
method. The random design technique applies 
the maxi-min strategy to a large set of 
potential standards to select which standards 
will be used to create the method model. The 
random design allows you to easily add 
standards later. 

readout  A field used to display information or 
values provided by TQ Analyst, such as the 
version number of a method. Readout fields 
have a colored background, which indicates 
that their contents cannot be changed. 

region  A portion of a spectrum that lies 
between two X-axis locations. See spectral 
region.  

Region Selection task window  A task window 
that allows you to display the spectrum of one 
or more standards and contains tools for 
editing the analysis regions used in a method. 

residual concentration error  The calculated 
concentration of a component in a standard 
minus the actual concentration of the 
component in that standard.  

residual spectrum  The spectral information in 
an unknown sample spectrum that is not 
explained by the calibrated method that was 
used to quantify the spectrum. Only the 
spectral information in the specified analysis 
region or regions are used to calculate the 
residual spectrum or spectra. See cumulative 
residual spectrum and component residual 
spectrum. 

residual value  A value that indicates how well a 
spectrum is described by a method model. 
The residual value is calculated from the 
amount of the spectrum that is not described 
by the model divided by the overall size of the 
spectrum. A small residual value indicates a 
better fit. 
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resolution  A measure of how well closely spaced 
peaks in a spectrum are differentiated. The 
higher the resolution, the more separated two 
closely-spaced peaks will appear. Increasing 
the resolution requires that the distance 
traveled by the moving mirror in the 
interferometer be increased. 

RESULT™  Thermo Scientific spectral analysis 
software for process applications. 

result warnings  Sample checking features 
which can be used to monitor the analysis 
results for possible problems. Use the Report 
tab to turn the result warnings on and off and 
to specify how they will operate.  

RMS (Root Mean Square) noise  A statistical 
measurement of random instrument noise.  

RMS Noise region type  A technique for 
measuring noise in a spectral region. RMS 
Noise reports the RMS noise value for the 
specified region.  

RMSE  An acronym for Root Mean Square 
Error. In TQ Analyst, RMSE is one of the 
algorithms available for calculating the 
performance index for quantitative methods. 
The closer the RMSE value is to zero, the 
better the method will perform. 

S 

sample  A compound being analyzed. 

sample checking  To monitor the unknown 
sample spectra that are analyzed with a 
method or the analysis results for possible 
problems. See analysis limits check, acceptance 
limits check, full spectrum check and 
measurement region spectrum check. 

sample matrix  A compound in which the 
components in a sample mixture are dispersed 
or dissolved. 

sample mixture  A sample that contains two or 
more components. 

sample report  All of the information that is 
displayed on the screen after using a 
TQ Analyst method to quantify an unknown 
sample spectrum, including the analysis 
results.  

sample spectrum  The spectrum of an unknown 
material being analyzed. 

sampling technique  The technique used to 
prepare and collect the spectrum of a sample 
or standard. Examples include transmission 
and diffuse reflection. 
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score value  A measurement of the 
multidimensional distance of a standard 
projected onto a principal component. The 
score value shows how much of the variation 
in the spectrum of the standard is described by 
the principal component. 

scroll bar  A bar running along the right side or 
bottom of a list box or window that is used to 
scroll text or stacked spectra into view. Items 
can be scrolled by clicking one of the scroll 
arrows at either end of the scroll bar or by 
dragging the scroll box along the scroll bar.  

search algorithm  The algorithm used to 
compare the unknown sample spectrum with 
each calibration spectrum in a Search 
Standards analysis.  

Search Standards analysis type  A classification 
analysis technique. Search Standards compares 
the specified region or regions of an unknown 
sample spectrum with each calibration 
spectrum and finds the standards that most 
closely match the unknown. The index 
number and title of each reported standard are 
given as well as a match value between 0 and 
100. 

Search Type parameter  A parameter that 
allows you to select the search algorithm that 
will be used for the Search Standards analysis. 

second derivative  The rate of change of the 
first derivative with respect to the X value. 

Second Derivative In Range region type  A 
technique for measuring a spectral region. 
Second Derivative in Range measures an 
estimate for the second derivative at each data 
point in the specified region. 

shoulder  A small hump or variation in 
curvature on the side of a peak. A shoulder 
may indicate the presence of a small peak that 
is obscured by the larger peak. 

signal-to-noise ratio (SNR)  The ratio of the 
intensity of a signal to the intensity of the 
noise that accompanies it. 

SIMCA  An acronym for Soft Independent 
Modeling of Class Analogy. SIMCA is a 
classification technique that generates an 
independent model for each class. Each model 
is based on its own set of principal 
components. When the method is used to 
quantify an unknown sample spectrum, the 
software compares the sample spectrum with 
each model and applies a statistical analysis to 
the pooled results. For details see Wold, S. 
Pattern Recognition 1976, 8, 127-139. 

Similarity Match analysis type  A classification 
analysis technique. Similarity Match compares 
the spectral information in the specified 
region or regions of an unknown sample 
spectrum with that of a known set of standard 
spectra to determine how closely the sample 
matches the standards. The result of this 
comparison is called a match value.  
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Simple Beer's Law analysis type  A quantitative 
analysis technique based on the Beer-Lambert-
Bougher Law. The calibration model is the 
best fit straight line in an absorbance 
measurement versus concentration plot. A 
separate calibration curve is created for each 
component.  

single-beam spectrum  A spectrum (data in the 
frequency domain) obtained by Fourier 
transforming an interferogram (data in the time 
domain). A single-beam spectrum shows the 
response at all frequencies in the spectral range. 
This response is influenced by the beamsplitter, 
relative source output, detector, and other 
optical components in the instrument. A 
sample single-beam spectrum can be ratioed 
against a background single-beam spectrum to 
produce a sample spectrum with the 
background information removed. 

slope  The rate at which an ordinate of a point 
of a line on a coordinate plane changes with 
respect to a change in the abscissa (i.e., the rise 
divided by the run). 

source  A component inside the optical bench of 
an infrared spectrometer or analyzer that emits 
the infrared radiation that travels to the 
detector. 

spectral measurement  A peak height, peak area, 
or region of a spectrum measured from a null 
reference point. An absorbance spectrum, for 
example, would be measured from zero 
absorbance units.  

spectral measurement method  A TQ Analyst 
analysis technique that measures spectral 
features and reports the measured values. You 
can set up a spectral measurement method 
that measures peak heights or peak areas in a 
sample spectrum, calculates the ratio of two 
measured peaks, measures random noise or 
peak width, or finds peak locations. 

spectral region  A portion of a spectrum 
between two X-axis locations.  

spectral window  A window used to display a 
spectrum or spectra. A spectral window 
contains one or more panes, each of which can 
contain one spectrum.  

spectrum  A graphical representation of the 
intensity of the radiation reaching the detector 
at each X-axis location measured. The 
intensity at a given X-axis location is 
determined by the characteristics of the 
sample, if one is present. 
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spectrum collection date and time  The date 
and time a spectrum was collected and saved 
on a disk. The collection date and time is 
stored with the spectrum during sample 
collection. You can view a spectrum’s 
collection date and time by displaying the 
spectrum in a spectral window, selecting the 
spectrum, and then double-clicking the title 
box.  

spectrum file name  The standard Windows file 
name you enter when you save a spectrum in a 
file on a disk (*.SPA extension).  

Spectrum Range region type  A technique for 
measuring a spectral region. Spectrum Range 
measures the intensities of all the data points 
in the specified region rather than a single 
value.  

spectrum title  A description of a spectrum that 
is saved with the spectrum. 

spectrum warnings  Sample checking features 
which can be used to monitor the unknown 
sample spectra that are quantified with a 
method for possible problems. Use the Report 
tab to turn the spectrum warnings on and off 
and to specify how they will operate.  

Squared Derivative search algorithm  An 
algorithm for the Search Standards analysis. 
The squared derivative difference is defined as 
the sum of the squares of the differences 
between the first derivative of the sample 
spectrum and the first derivatives of the 
calibration spectra in the specified regions, 
where the sums are taken over all data points. 
The sample and calibration spectra are placed 
on a common Y-axis scale before the squared 
derivative differences are calculated.  

Squared Difference search algorithm  An 
algorithm for the Search Standards analysis. 
The squared difference is defined as the sum 
of the squares of the differences between the 
unknown sample spectrum and each 
calibration spectrum in the specified regions, 
where the sums are taken over all data points. 
The sample and calibration spectra are placed 
on a common Y-axis scale before the squared 
differences are calculated.  

stacked spectra  Spectra with panes that are 
displayed in a column on the screen. 

standard  Known samples that model the 
behavior of the unknown samples that will be 
analyzed with the method. For quantitative 
analysis, standards are samples which have 
known concentrations of each component the 
method will be used to analyze. For 
classification analyses, standards are samples 
that have the characteristic you want to track. 
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standard deviation  A measure of sample 
distribution about the mean or average. For a 
normal distribution, the probability that a 
measured value lies within one standard 
deviation, , of the mean is approximately 
67%; within 2 is approximately 95%. 
Standard deviation is the square root of 
variance. 

   = (  (yi - yave)2 ) / (n -1) 

 The standard deviation on variance values 
indicates the spread or scatter in a set of data. 

standard error check  A sample checking feature 
that compares the analysis results for the 
spectra you quantify with a method to the 
standard error limit specified in the method. If 
the standard error value associated with a 
calculated component result is above the 
standard error limit, the sample is flagged and 
the specified action is taken. 

standard error limit  A parameter that defines 
the maximum standard error value allowed in 
order to pass the standard error check.  

standard error value  The relative error of a 
measurement expressed as a percentage of the 
actual values. 

Standard Normal Variate pathlength type  A 
technique for handling pathlength difference 
in standards and samples. The Standard 
Normal Variate (SNV) pathlength setting 
scales the spectral data in order to compensate 
for differences in sample pathlength. This 
allows you to analyze samples with different 
pathlengths when it is difficult or impossible 
to obtain an independent measure of sample 
pathlength. The spectra of the standards and 
any unknown samples the method is used to 
analyze are all scaled independently.  

standards library  A collection of spectra of 
known materials used for calibration, 
validation, or correction. A method standards 
library is contained in two files which have the 
same base name as the method (method 
filename.LBD and method filename.LBT). 

Stepwise Multiple Linear Regression analysis 
type  A quantitative analysis technique based 
on the multiple linear regression algorithm. 
Stepwise Multiple Linear Regression (SMLR) 
expresses concentration as a function of the 
absorbance at multiple frequencies. When the 
SMLR algorithm is used, the software selects 
the analysis regions. Each component is 
calibrated independently.  

studentized residual value  The residual value 
of a spectrum after it has been scaled by the 
leverage value. 
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T 
tab  A software feature that looks like a file card 

and contains a group of method parameters. 
Each file card has a tab that is always visible at 
the top of the active method window.  

task window  A special window that appears 
when you choose certain commands or action 
buttons. A task window contains the features 
needed to use the command or complete the 
action. Examples of task windows include the 
Region Selection task window, the 
Corrections task window, and the diagnostic 
task windows. 

text box  A parameter that allows you to enter 
information that you want to save with a 
method, such as the method title. Text boxes 
have a white background, which indicates that 
their contents can be changed.  

threshold distance value  A parameter that 
defines the maximum distance value allowed 
to pass the distance value check.  

threshold F ratio  An internal parameter that 
defines the minimum F ratio required to pass 
the feasibility assessment. The threshold 
F ratio is a fixed value and cannot be changed. 
If the calculated F ratio is greater than or equal 
to the threshold F ratio, we can conclude that 
the variability in the feasibility standards is 
significant at a 95% confidence level and the 
method is feasible. 

threshold fit value  A parameter that defines the 
minimum fit value required to pass the full 
spectrum check or the measurement region 
spectrum check.  

threshold match value  A parameter that 
defines the minimum match value required to 
pass the match value check or trigger the 
pass/fail indicator.  

toolbar  A long narrow strip at the top of the 
TQ Analyst window that contains action 
buttons.  

TQ Analyst window  The window that 
contains the TQ Analyst menu bar and 
toolbar. The main portion of the TQ Analyst 
window may be used to display method 
windows, spectral windows and task windows. 

transmission spectrum  A spectrum that shows 
how the transmittance of a sample varies with 
frequency or wavelength. 
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transmittance (%)  The fraction of the radiation 
that remains after a beam of electromagnetic 
radiation passes through a sample. Percent 
transmittance is defined by the formula T = 
(P/P0) * 100, where P is the radiation that 
passes through the sample and P0 is the 
radiation when no sample is present. 

Two Point baseline type  A technique for 
estimating the baseline of a spectral region. A 
two-point baseline is a line that passes through 
the spectrum at two specified baseline points. 
The software subtracts the drawn baseline 
from the intensity of the peak or region to 
produce a corrected measurement. 

U 
uncertainty limit  The highest uncertainty value 

allowed in order to pass the uncertainty value 
check. 

uncertainty value  An empirically derived value 
that indicates the relative, estimated precision 
of a quantitative result.  

uncertainty value check  A parameter that 
allows you to monitor the uncertainty values 
that are reported when a method is used to 
quantify an unknown sample spectrum. If the 
uncertainty value check is on and a reported 
uncertainty value is above the uncertainty 
limit, the specified action is taken. 

uncorrected measurement  A peak height, peak 
area, or region of a spectrum measured from a 
null reference point. An absorbance spectrum, 
for example, would be measured from zero 
absorbance units.  

unknown sample spectrum  The spectrum of a 
sample of unknown composition. 

Usage parameter  A parameter that defines how 
each standard will be used in a TQ Analyst 
method.  

V 
validation  Using a calibrated method to 

quantify validation standards. Because 
validation standards are not used to create the 
method model, validation can be used to 
verify that a method is capable of quantifying 
unknown sample spectra with the desired 
accuracy. 

validation set  The standards that are used to 
validate the method model after a method is 
calibrated. 

validation spectrum  The spectrum of a 
validation standard. 
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validation standard  A standard that is used to 
evaluate the performance of a calibrated 
method. The results from the validation 
standards are also used to calculate the 
performance index.  

variance spectrum  A calculated spectrum that 
shows the spectral variance in the standards. 
The variance spectrum is produced by 
calculating the square root of the spectral 
variance at each X value over all of the 
standards.  

 

 

W 
wavelength  The distance between 

corresponding points in consecutive light 
waves. Wavelength is measured in 
micrometers and is often used as the X-axis 
unit of an infrared spectrum. 

wavenumber  The number of waves per 
centimeter, expressed as cm-1. Wavenumber is 
the inverse of wavelength and is often used as 
the X-axis unit of an infrared spectrum. 

window  A rectangular area on the screen that 
can contain method tabs, spectral data, data 
plots or software features. Examples include 
method windows, spectral windows, and task 
windows. 

working curve  See calibration curve. 
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Index 

% Difference plot, 326 
% difference values 

for quantitative methods, 218 
% transmittance, 28 
% Variability Described readout, 263 

A 
abbreviations 

for class names, 246 
for component names, 189 
for measurement names, 275 

Absolute Maximum In Range region type, 281 
absorbance, 28, 30 
absorbance range 

restricting, 154 
absorption bands 

excluding, 154 
absorptivity, 30 
Acceptance Limits Check 

check box, 298 
specifying limits for, 298 

action buttons, 81 
Action parameter, 296, 297 
active window, 124 

and TQ Analyst title bar, 125 
closing, 127 
resizing, 125 

actual class 
for method standards, 259 
specifying, 252 

adding 
password to a method, 94 
report features, 295 
standards to a method, 133, 139, 204, 251 

advantages 
of CLS, 38 
of PCR, 45 

of PLS, 43 
of Simple Beer's Law, 36 
of SMLR, 42 

algorithm 
baseline correction, 169 
Discriminant Analysis, 54 
Distance Match, 52 
internal reference pathlength correction, 68 
peak ratio pathlength correction, 63, 70 
QC Compare search, 55 
Search Standards, 56 
Similarity Match, 50 
SNV pathlength correction, 73 

analysis limits 
and Evaluate Standards wizard, 149, 196 
and method performance index, 191 
and sample checking, 191 
and Suggest Standards wizard, 148 
and wizards, 191 
recommended, 191 
specifying, 190 

Analysis Limits Check 
check box, 298 
specifying limits for, 298 

analysis of variance results, 187 
analysis range 

percent spanned, 150 
specifying, 190 

analysis regions 
for classification methods, 253 
for quantitative methods, 209 
for spectral measurement methods, 279 
optimizing for classification methods, 255 
optimizing for quantitative methods, 212 
sources of error (classification), 265 
sources of error (quantitative), 227 
sources of error (spectral measurement), 291 
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using Pure Component Spectra diagnostic to select, 320 
using Regions Wizard to select, 209 
using Statistical Spectra diagnostic to select, 321 

analysis results 
exporting, 105 
printing, 105 

Analysis Type parameter 
and Regions wizard, 210 
changing the setting, 182, 210, 242 
options for classification methods, 239 
options for quantitative methods, 181 
recommended setting, 210 
setting for classification methods, 241 
setting for quantitative methods, 182 
Undecided, 210 

Analysis Type wizard, 23, 241 
analyzing a group of samples, 105 
analyzing a sample 

from OMNIC, 108 
from Thermo Scientific applications, 111 
from TQ Analyst, 101, 299 

analyzing spectra listed in an input file, 105 
annotation tool, 122 
ANOVA table, 187 
Assess Feasibility button, 185 
Assess Feasibility wizard, 23 
Assess Feasibility wizard, 186 
Average Height In Range region type, 281 
axes 

for spectral window, 119 
splitting the X-axis, 119 

B 
Background Handling group, 143 
background single-beam, 142 
background spectrum, 140, 203, 250 

conditions for collecting, 142 
current background defined, 144 
defined, 142 

base file name, 91 
baseline 

and CLS, 38 

and PLS, 43 
and Simple Beer's Law, 36 
and SMLR, 41 
correcting, 168 
defined, 168 
displaying baseline corrected spectra, 159 
specifying for quantitative methods, 211 
specifying for spectral measurement methods, 283 

baseline correction 
and Data Format, 169 
and sample spectra, 172 
linearity removed, 283 
multipoint, 168 
offset, 283 
one-point, 283 
piecewise linear, 168, 170 
quadratic removed, 283 
spline, 170 
two-point, 283 
viewing, 159, 171 
viewing multipoint, 160 
warning message, 172 

baseline curve 
and SNV pathlength correction, 72 

baseline points 
for multipoint baseline correction, 169 
for one- or two-point baseline correction, 284 
selecting for baseline correction, 170 
techniques for choosing, 284 

Baseline Points table, 170 
Baseline Type parameter, 283 

compared with multipoint baseline correction, 169 
Beer’s Law, 30 
Beer-Lambert-Bougher Law, 30 
Bench parameters 

resetting, 109 
bias 

avoiding during validation, 225 
for CLS, PLS and PCR calibrations, 222 

button 
action, 81 
Assess Feasibility, 185 
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Calibrate, 77, 304 
Close, 77 
Collect Background, 143 
Collect Standard, 139, 202, 250 
Collection Parameters, 138 
Edit Corrections, 229 
Edit Factors, 218 
Edit Regions, 280 
Evaluate Standards, 149 
Explain, 19, 77 
How To, 21 
Merge Like Standards, 152 
Open Standard, 135 
Quantify, 77, 102, 299 
Sort Standards, 132 
Suggest Analysis Type, 5, 241 
Suggest Corrections, 228 
Suggest Pathlength Type, 23, 62, 63 
Suggest Regions, 209 
Suggest Standards, 149 
View Standards (Spectra tab), 160 
View Standards (Standards tab), 146 

buttons 
Display, 145 

C 
Calculate Coefficients parameter, 230 
calculated class 

for method standards, 259 
Calculated versus Actual plot, 326 

for CLS, PLS and PCR, 222 
for Cross Validation diagnostic, 326 
for quantitative methods, 219 
for Simple Beer's Law, 222 
ideal, 220 

calculating derivative spectra, 161 
calculating ratios 

in a spectral measurement method, 58 
in an SMLR method, 212 

Calibrate button, 77, 304 
calibrating 

classification method, 258 

quantitative method, 216 
spectral measurement method, 290 

calibration 
evaluating for quantitative methods, 220 

calibration curve, 35 
adding zero point to, 224 
defined, 31 
intercept for Simple Beer's Law, 223 

calibration data 
Pathlength column, 220 
updating, 303 

calibration error, 222 
calibration indicator, 78 
calibration model, 29 

accounting for pathlength differences, 60 
and internal reference pathlength correction, 68 
and peak ratio pathlength correction, 70 
CLS, 38 
PCR, 44 
PLS, 42, 219 
selecting (classification), 49 
selecting (quantitative), 33 
Simple Beer's Law, 36 

calibration models 
for classification methods, 48 
for quantitative methods, 30 
for spectral measurement methods, 59 
multivariate quantitative, 32 
simplest quantitative, 31 

calibration results 
saving, 92 

Calibration Results task window 
closing, 222 
for classification methods, 259 
for quantitative methods, 217 

calibration set 
defined, 30 
for classification methods, 247 
for quantitative methods, 192 
iterations for cross validation, 226, 324 
leverage and residual values for, 349 
loading spectra for, 350 
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merging like standards, 153 
principal component spectra for, 310 
principal components of, 308 

calibration spectra 
collecting, 139 
deleting, 144 
displaying, 145 
importing, 204 
replacing, 144 
setting collection parameters, 137 

calibration standards 
collecting, 201 
compared with validation standards, 218 
exported values for, 99 
for classification methods, 247 
for quantitative methods, 192 
requirements for, 36 
selecting, 131 
symbols displayed in plots, 220 
used in Cross Validation diagnostic, 324 
warning message, 225 

calibration technique 
selecting, 182 
switching, 33, 50 

Cascade Windows command, 126 
cascading windows, 126 
category. See class 
CD-ROM drive 

requirements for TQ Analyst, 9 
Chauvenet test for outliers, 315 
check box, 298 

Acceptance Limits Check, 298 
Analysis Limits Check, 298 
Collect, 109 
Data Collection Parameter Check, 296 
Distance Value Check, 298 
Fit Values, 298 
Full Spectrum Check, 297 
Match Value Check, 298 
Measurement Region Spectrum Check, 297 
Parameter, 109 
Password, 95, 300 

Uncertainty Value, 298 
check boxes, 82 
chemical interactions 

and CLS, 38 
and PLS, 43 
and Simple Beer's Law, 36 
and SMLR, 41 

choosing 
sampling technique for classification methods, 236 
sampling technique for quantitative methods, 178 
sampling technique for spectral measurement methods, 

269 
standards for classification methods, 248 

class 
actual versus calculated, 259 

class names 
entering, 246 
entering abbreviations for, 246 

Class parameter, 252 
classes 

recommended for QC Compare search, 56 
recommended for Search Standards, 56 
specifying, 244 

Classes tab, 245 
classical least squares. See CLS 
classification method 

Discriminant Analysis, 53 
Distance Match, 51 
QC Compare search, 55 
Search Standards, 56 
Similarity Match, 50 

classification methods, 46, 49 
and sample pathlength, 61 
calibrating, 258 
calibration models, 48 
choosing a sampling technique, 236 
collecting the standards, 246 
creating a new method file, 237 
customizing, 255 
defining the problem, 235 
displaying principal component spectra, 310 
how to create, 233 
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optimizing analysis regions, 255 
optimizing collection parameters, 249 
Pathlength Type, 62 
performance index, 264 
principal components, 263 
protecting from changes, 300 
recommended data format, 237 
running a test sample, 299 
saving, 258 
selecting a pathlength option, 243 
selecting analysis regions, 253 
selecting Analysis Type, 239 
selecting classification technique, 239 
selecting method type, 49 
selecting resolution, 237 
selecting standards, 248 
setting usage for method standards, 252 
signal-to-noise ratio, 237 
specifying classes, 244, 252 
standards defined, 246 
titling the method, 238 
troubleshooting, 353 
using Eigenanalysis diagnostic to determine variation, 

308 
using Statistical Spectra diagnostic to determine 

variation, 320 
validating, 263 
warnings reported but no sample results, 296, 297 
wizards, 234 

clock speed needed to run TQ Analyst, 9 
Close button, 77 
closing 

active window, 127 
method window, 123 
spectral window, 124 
task window, 123 

CLS method, 37 
advantages, 38 
bias of calibration, 222 
calibration model, 38 
chemical interactions, 38 
conditions for using, 37 

correlation coefficient of calibration, 222 
disadvantages, 38 
EZ Edition, 4 
linearity, 38 
number of standards, 37 
overlapping peaks, 38 
Professional Edition, 37 
root mean square error of calibration, 222 
sample matrix, 38 
spectral baselines, 38 
typical samples, 38 
when to use, 38 

coefficient 
correlation, 222 
editing correction, 230 
for correction curve, 228 

Coefficients table, 230 
Collect Background button, 143 
Collect Background window, 124, 143 
Collect check box, 109 
Collect parameters 

resetting, 109 
Collect Sample window, 124 
Collect Standard button, 139, 202, 250 
Collect tab, 139 
collecting 

spectrum, 139, 202, 250, 279 
standard, 136, 201 

collection and processing information 
displaying, 118 
for all standards, 146 

collection parameters 
checking automatically, 296 
displaying, 138 
for background spectra, 143 
for classification method standards, 249 
for quantitative method standards, 201 
for standards, 133 
matching with OMNIC, 353 
mismatched, 102 
mismatched warning, 353 
optimizing, 137 
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resetting, 109 
using consistent settings, 143 

Collection Parameters button, 138 
color requirements for TQ Analyst, 9 
combining like standards, 152 
command 

Cascade Windows, 126 
Copy, 318 
Cross Validation, 324 
Delete Row, 144 
Display Setup, 119 
Eigenanalysis, 308 
Example Methods, 14, 17 
Exit, 10 
Export to Text File, 97 
External Validation, 328 
Factor Loading, 343 
Leverage, 347 
Loading Spectra, 350 
Multiple Quantify, 106, 334 
New Method, 87 
Open Method, 88 
Open Spectrum, 92 
Options, 11 
Pairwise Concentration, 313 
Paste, 142, 207 
PRESS, 337 
Principal Component Scores, 340 
Principal Component Spectra, 310 
Print, 100 
Printer Setup, 99 
Pure Component Spectra, 317 
Quant Setup, 108 
Quantify, 109 
Residual Spectra, 331 
Save Method, 90 
Save Method As, 91 
Save Spectrum As, 93 
Spectrum Outlier, 315 
Standards to Text File, 98 
Statistical Spectra, 320 
Technical Support, 14 

Tile Windows, 125 
TQ Analyst Help Topics, 14 
TQ Analyst Tour, 14, 17 

command prompt 
entering text at, 7 

commands 
choosing, 77 
View menu, 117 

comments 
for spectra, 118 

component 
correcting linearity, 227 
naming, 189 
performance index, 221 
specifying digits, 189 
specifying unit, 189 

component concentration, 29, 30 
for method standards, 198 

component digits 
entering, 189 

component names 
entering, 189 
entering abbreviations for, 189 

component peaks 
Simple Beer's Law, 34 

component residual spectra, 332 
component unit 

entering, 189 
component warnings 

turning on and off, 295 
components 

specifying, 188 
Components tab, 189 

and pathlength component, 184 
composite standard 

creating, 153 
defined, 153 
title for, 153 
usage, 154 

Computed Area region type, 281 
concentration data 

copying, 98 
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concentration of component, 29, 30 
concentration values 

importing, 140, 206 
reporting, 295 

concentrations 
bracketing, 198 

Constant pathlength type, 64 
and spectral measurement methods, 273 
used in classification methods, 244 
when to use, 64 

context-sensitive Help, 18 
contracting displayed spectra, 120 
conventions used in this manual, 6 
Copy command, 318 
copying 

active table, 97 
diagnostic data, 97 
method, 91 
method files to another computer, 111 
table in a task window, 116 
table of standards, 98 

correcting 
component linearity, 227 
measured values, 276 
spectral baselines, 168 

correction 
linearity in a spectral measurement method, 58 
multiplicative signal, 70 
multipoint baseline, 168 
pathlength using internal reference, 67 
pathlength using MSC, 70 
pathlength using peak ratio, 69 
pathlength using SNV, 71 
viewing baseline corrections, 160 

correction curve 
and sample results, 229 
coefficients, 228 
overfit, 218 
when to use, 227 

correction curves 
and Simple Beer's Law, 37 

correction standards 

defined, 131, 208 
exported values for, 99 
quantifying, 217 
selecting, 131 
symbols displayed in plots, 220 

Correction task window 
closing, 229 

corrections 
displaying baseline corrected spectra, 171 
displaying processing, 147 
for sample pathlength, 59 
viewing selected, 160 

Corrections task window, 228 
printing, 100 

Corrections wizard, 24, 228 
and Calculate Coefficients check box, 230 

correlation coefficient 
for CLS, PLS and PCR calibrations, 222 

correlation spectra 
and Statistical Spectra diagnostic, 321 

creating 
classification method, 233 
new method, 87 
new method file, 180, 237, 269 
new method window, 123 
quantitative method, 173 
spectral measurement method, 267 

cross validation 
in PLS calibration, 219 

Cross Validation diagnostic, 324 
and duplicate standards, 324 
used for method validation, 226 

cumulative residual spectrum, 332 
current background 

defined, 144 
curve coefficients, 228 
curve order 

choosing, 229 
Curve Order parameter, 229 
customizing 

classification methods, 255 
format of Standards table, 132 
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quantitative methods, 213 
sample reports, 295 
spectral measurement methods, 288 
TQ Analyst, 11 

D 
Data Collection Parameter Check check box, 296 
data collection parameters, 137 

checking automatically, 296 
displaying, 138 
for background spectra, 143 
for classification method standards, 249 
for quantitative method standards, 201 
for spectral measurement methods, 278 

Data Description group 
for method standards, 146 

data format 
for classification methods, 237 
for quantitative methods, 180 

Data Format parameter, 162 
and multipoint baseline correction, 169 
and smoothing, 166 

Data Points parameter, 166 
default 

export file, 98 
result file, 108 

default settings 
for method parameters, 180 

Delete Row command, 144 
deleting 

multiple standards, 145 
report features, 295 
standards, 144 

denominator peak 
SMLR methods, 212 
spectral measurement methods, 58, 285 

derivative spectra 
calculating, 161 
defining analysis regions for, 164 
importing, 164 

derivatives 
displaying, 159 

viewing, 160 
Description tab 

Method Title parameter, 181 
detrending, 72 
Developer's Name parameter, 181 
diagnostic 

Cross Validation, 324 
Eigenanalysis, 308 
External Validation, 225, 291, 328 
Factor Loading, 343 
Leverage, 347 
Loading Spectra, 350 
Multiple Quantify, 334 
Pairwise Concentration, 313 
PRESS, 337 
Principal Component Scores, 340 
Principal Component Spectra, 310 
Pure Component spectra, 317 
Residual Spectra, 331 
Spectrum Outlier, 315 
Statistical Spectra, 320 

Diagnostic options, 12 
diagnostic results 

saving, 92 
diagnostic windows 

printing, 100 
diagnostics, 305 

restricting the Y-axis range, 154 
Diagnostics menu, 305 
dialog box 

Collection and Processing Information, 146 
enter iterations for Cross Validation diagnostic, 226, 

324 
Enter Password, 89 
Experiment Setup, 109 
General Options, 13 
Open Method, 109 
Open Spectrum, 93, 102 
Options, 11 
Print, 100 
Print Options, 100 
Printer Setup, 99 
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Quant Setup, 353 
Quantify, 105, 275 
quantitative results, 103 
Save Method As, 90, 95 
select component for Loading Spectra diagnostic, 350 
Windows Open, 329 

dialog boxes 
setting options for, 11 
tabbing in, 355 
Windows, 99 

difference plot, 219 
difference values 

for quantitative methods, 218 
digits 

for method components, 189 
for spectral measurements, 275 

Digits parameter, 190, 275 
disadvantages 

of CLS, 38 
of PCR, 46 
of PLS, 44 
of Simple Beer's law, 37 
of SMLR, 42 

Discriminant Analysis method, 47, 53, 74 
algorithm, 54 
calculating principal components, 54 
calibration, 54 
creating composite standards, 153 
distance values, 55 
Mahalanobis distance, 54 
number of classes, 53 
performance index, 263 
score values, 54 
selecting a distribution model, 55 
variance spectrum, 54 
when to use, 55 
within class variance, 54 

display buttons, 145 
display monitor 

requirements for TQ Analyst, 9 
displaying 

collection parameters, 138 

How To help windows, 22 
method window, 123 
Region Selection task window, 212 
Spectra tab, 157 
spectral window, 124 
spectrum, 92, 145 
task windows, 123 
uncertainty values, 354 

Distance Match 
threshold, 52 

Distance Match method, 51 
algorithm, 52 
calibration, 52 
match value, 52 
match value limit, 53 
number of standards, 52 
pass/fail indicator, 53 
performance index, 263 
residual spectrum, 52 
when to use, 53 

Distance Match threshold, 52 
distance metrics. See Mahalanobis distance 
distance value 

reporting, 295 
Distance Value Check check box, 298 
distance values 

for Discriminant Analysis, 55 
distribution model 

selecting for Discriminant Analysis, 54, 55 
Dixon test for outliers, 315 
drop down list boxes, 83 
duplicate standards 

and Cross Validation diagnostic, 324 
merging, 152 

E 
Edit Corrections button, 229 
Edit Factors button, 218 
Edit menu, 11, 142, 144, 207, 318 
Edit Regions button, 280 
editing 

correction curve coefficients, 230 
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factors in a PLS method, 339 
Eigen values. See Eigenanalysis or PC Scores diagnostic 
Eigen vectors. See Eigenanalysis or PC Scores diagnostic 
Eigenanalysis diagnostic, 308 
eliminating unnecessary standards, 151 
entering 

class names, 245 
component names, 189 
measurement labels, 274 
method file name, 180 
spectrum file name, 204 

error 
calibration, 222 
for classification methods, 265 
for PLS factors, 218 
for quantitative methods, 226 
for spectral measurement methods, 291 
using Residual Spectra diagnostic to evaluate, 331 

Evaluate Standards button, 149 
Evaluate Standards wizard, 195 

and Standards Selection diagnostic, 149, 196 
pruning standards, 152 
requirements for analysis limits, 149, 196 

example methods, 6, 14 
installing without, 8 
viewing, 17 

example spectra, 6 
Exit command 

for TQ Analyst software, 10 
for Windows help, 16 

exiting 
TQ Analyst software, 10 
Windows help topics, 16 

expanding displayed spectra, 120 
Explain button, 19, 77 
Explain help window, 19 

operation of, 20 
export file 

default, 98 
method, 97 
method standards, 98 

Export to Text File command, 97 

exporting 
analysis results, 105 
data, 97 
method data, 97 
spectral and concentration data, 98 

extension 
for exported standards file, 98 
for method files, 91 
for method library files, 91 
for QuantIR method files, 89 
for Quick IR method files, 89 
for TQ Analyst method files, 10 
spectral file, 93 
spectral group, 93 
spreadsheet file, 97 
text file, 97 

extensions 
common for method files, 89 
common for spectral files, 92, 101 

External Validation diagnostic, 328 
formatting input file, 330 
typical use, 225, 291 

EZ Edition of TQ Analyst, 3 

F 
F1 help, 18 

for View menu, 117, 146 
Factor Loading diagnostic, 343 
factors 

applied to spectral measurement method, 276 
editing, 339 
for PLS methods, 218 
using Loading Spectra diagnostic to determine, 350 
using PRESS diagnostic to determine, 337 

Factors wizard, 24 
feasibility test, 185 

results, 187 
selecting standards, 186 

File menu, 87 
file name 

and method title, 88 
base, 91 
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changing for method, 90 
default for exported standards, 98 
entering method, 180 
entering spectral, 204 
for Multiple Quantify results, 108 
for spectral group, 132 
method, 89, 91 
sorting standards by, 132 
text file, 107 
TQ Analyst program, 10 

file names 
common for spectral files, 101, 134 
common spectral, 92, 105 
displaying spectral, 132 
entering for External Validation diagnostic, 328 
entering for Multiple Quantify command, 335 
for TQ Analyst spectra, 132 
in an input file, 105 
reporting, 104 
selecting multiple, 107 

file size 
minimizing, 92 

file type 
input file, 107 
spectral group, 107 

file types 
method files, 89 
Multiple Quantify, 105 
Open Standard, 134 

Final Format parameter, 120 
Find Residual Differences 

for Similarity Match, 51 
Find Similarities 

for Similarity Match, 51 
Find window, 17 
fit value, 297 

threshold for, 297 
Fit Value parameter 

and method file size, 92 
Fit Values check box, 298 
Fixed Location Height region type, 281 
floppy disk drive 

requirements for TQ Analyst, 9 
Force Through Zero parameter, 229 
forcing a correction curve through zero, 229 
frequency 

described, 28 
Full Spectrum Check 

and method file size, 92 
Full Spectrum Check check box, 297 

G 
gap derivative. See Norris derivative 
gases 

analyzing, 30 
collection parameters for, 202 
preparing standards for, 35 
setting pressure and temperature, 137 

General options, 12 
Gram-Schmidt analysis, 50 
grey parameters, 353 

H 
hard disk drive 

requirements for TQ Analyst, 9 
hardware requirements, 9 
help 

accessing with F1, 18 
buttons, 16 
context-sensitive, 18 
on-line, 13 
searching, 17 

Help menu, 13 
Help topics, 14 
Help window, 14 
hiding 

How To help windows, 22 
Spectra tab, 157 
uncertainty values, 295 

How To button, 21 
How To help 

operation of, 22 
turning off automatic display, 22 
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I 
ILS. See SMLR method 
importing 

concentration values for standards, 140, 206 
standards, 204 

independent variation 
for method standards, 199 

index 
performance, 78, 221 

Index Search window, 17 
indicator 

calibration, 78 
input file 

file type, 107 
for External Validation diagnostic, 330 
for Multiple Quantify command, 335 

interactions 
and CLS, 38 
and PLS, 43 
and Simple Beer's Law, 36 
and SMLR, 41 

intercept, 277 
applying to spectral measurement method, 276 
for Simple Beer's Law calibration curve, 223 

Intercept parameter, 223 
interferences 

and Simple Beer's Law, 36 
and SMLR, 41 

interfering peaks 
errors (classification), 265 
errors (quantitative), 227 
errors (spectral measurement), 292 

Internal Known pathlength type, 67 
Internal Reference pathlength type, 67 

algorithm, 68 
and Pathlength wizard, 68 
and Regions wizard, 68 
compared with Peak Ratio, 68, 357 
requirements for using, 67 
when to use, 67 

Internal Standard pathlength type, 69 

Interpolated Height At Exact Location region type, 282 
inverse least squares. See SMLR method 

K 
keyboard, 355 

requirements for TQ Analyst, 9 
K-matrix. See CLS method 
Known pathlength type, 65 

when to use, 65 

L 
labels 

for spectral measurements, 274 
Last Saved Date readout, 90 
least squares analysis. See CLS method or PLS method 
Leverage diagnostic, 347 
leverage values, 347 
library files, 91 

for method standards, 111 
light scattering correction. See MSC or SNV pathlength type 
limit 

for Distance Match, 52 
linear correction 

for spectral measurement methods, 58 
Linear Correction parameter, 276 
linear regression. See SMLR method 
linear removed baseline correction, 283 
linearity 

and CLS, 38 
and Simple Beer's Law, 36 
and SMLR, 40 
correcting, 227 

linearity correction 
and ratioed peaks, 276 
for spectral measurement methods, 276 

liquids 
analyzing, 30 
preparing standards for, 35 

list boxes, 83 
loading spectra 

displaying, 350 
Loading Spectra diagnostic, 350 
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Location At X% Of Peak Maximum region type, 282 
Location parameter, 283 
locking a method, 94 

M 
Mahalanobis distance, 55 

and method calibration, 261 
and Spectrum Outlier diagnostic, 316 
for Discriminant Analysis method, 54 

manual conventions, 6 
Match Type parameter, 51 
match value 

for Distance Match, 52 
for QC Compare search, 56 
for Search Standards, 57 
for Similarity Match, 51 
limit for Distance Match, 53 
reporting, 295 
TQ Analyst compared with OMNIC Search, 57 

Match Value Check check box, 298 
matrix 

and CLS, 38 
and PLS, 43 
and Simple Beer's Law, 34, 36 

maximizing the active window, 124 
Maximum Height In Range region type, 281 
mean spectrum 

and Spectrum Outlier diagnostic, 315 
and Statistical Spectra diagnostic, 321 
defined, 315 
for classification method standards, 321 
for quantitative method standards, 315 

measurement digits 
entering, 275 

measurement labels, 274 
abbreviations for, 275 
entering, 274 

measurement methods. See spectral measurement methods 
Measurement Only methods. See spectral measurement 

methods 
Measurement Region Spectrum Check 

and method file size, 92 

check box, 297 
measurement unit 

entering, 275 
reporting, 295 

measurements 
specifying for spectral measurement methods, 273 

Measurements tab, 274 
measuring 

distance from class average, 51 
gas phase components, 35 
liquids, 35 
one component, 198 
peak area, 31, 57 
peak height, 31, 57 
peak location, 58 
peak width, 57 
peak-to-peak noise, 58, 271 
RMS noise, 58, 271 
signal and noise, 279 
signal-to-noise ratio, 57 
solids, 35 
where a peak levels off, 57 

memory 
needed to run TQ Analyst, 9 

menu 
Diagnostics, 305 
Edit, 11, 142, 144, 207, 318 
File, 18, 87 
Help, 13 
View, 117 
Window, 90, 113 

menu bar, 77 
menu commands 

choosing, 77 
menus 

using keyboard to open, 18 
Merge Like Standards button, 152 
merging like standards, 152 
method 

copying, 91 
creating, 87 
creating a classification, 233 
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creating a quantitative, 173 
creating a spectral measurement, 267 
deleting password from, 96 
Discriminant Analysis, 47, 74 
library files, 91 
locking, 94 
minimum file size, 92 
opening an existing, 88 
performance index, 221 
printing, 100 
protecting, 94 
saving, 90 
saving and protecting, 300 
saving with a new name, 91 
testing, 299 
troubleshooting, 353 
unlocking, 96 
updating calibration data, 303 
when to save, 181 

Method Description parameter, 181 
method diagnostics. See diagnostics 
method file, 91 

creating, 180, 237, 269 
extensions, 91 
moving to another computer, 111 

method file name 
entering, 180 

method file types, 89 
method library files, 91 
method parameters, 81, 114 

default settings, 180 
displaying, 180 
mismatched, 102 
printing, 100 
protecting, 94 
saving, 92 

Method Title parameter, 181 
method window, 79, 114 

closing, 123 
creating, 123 

methods 
classification, 46, 49 

example, 14, 17 
measurement, 57 
qualitative, 46 
QuantIR, 89 
quantitative, 29 
Quick IR, 89 
tracking changes in, 304 

misclassified standards, 262 
MLR. See SMLR method 
monitor 

requirements for TQ Analyst, 9 
moving method files, 111 
MSC pathlength type, 70 

assumptions, 71 
displaying processed spectra, 159 
showing processed standards, 148 
used in classification methods, 244 
when to use, 64 

multiple linear regression. See SMLR method 
multiple processing operations 

viewing, 161 
Multiple Quantify command, 106, 334 

compatible file types, 105 
formatting input file, 335 

multiplicative factor 
applied to spectral measurement method, 277 

multiplicative signal correction. See MSC pathlength type 
multipoint baseline correction 

and sample spectra, 172 
compared with Baseline Type, 169 
piecewise linear, 168, 170 
spline, 170 
warning message, 172 

multivariate 
analysis, 32 
calibration models, 32 

N 
New Method command, 87 
noise, 179, 237 

measuring, 57, 58, 271 
nonlinearity 
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correcting, 227 
NonZero setting 

for Intercept parameter, 223 
normalizing spectra 

with SNV pathlength type, 73 
Norris derivative smoothing, 166 
notes used in this manual, 6 
number of standards 

for classification methods, 248 
for quantitative methods, 197 
for spectral measurement methods, 277 

O 
offset 

applied to spectral measurement method, 276 
offset baseline correction, 283 
offset value 

specifying, 277 
OMNIC 

matching collection parameters with, 353 
running a TQ Analyst method with, 108 

OMNIC command 
Quant Setup, 108 
Quantify, 109 

OMNIC Search 
match value, 57 

OMNIC spectra 
displaying, 92 

one-point baseline correction, 283 
compared with multipoint baseline correction, 169 

on-line help, 13 
Open Method command, 88 

compatible file types, 89 
Open Method dialog box, 109 
Open Spectrum command, 92 

compared with Open Standard, 92 
Open Standard button, 135 

mismatched parameters warning, 136 
Open Standard command. See Open Standard button 

compared with Open Spectrum, 133 
compatible file types, 134 

opening 

method, 88 
spectra, 92 
spectrum as a standard, 135 

operating system 
requirements for TQ Analyst, 9 

option buttons, 82 
options 

diagnostic, 12 
for viewing spectra, 117 
general, 12 
printing, 100 
setting, 11 
TQ Analyst, 11 

Options command, 11 
setting view options, 117 

order 
for correction curves, 229 

origin 
and Simple Beer's Law calibration curve, 223 

Other tab 
for classification methods, 256 
for Discriminant Analysis, 54 
for quantitative methods, 214 
for Similarity Match, 51 

outliers 
eliminating in quantitative methods, 220 
identifying in quantitative methods, 217 
testing for, 315 
using Cross Validation diagnostic to determine, 324 
using Factor Loading diagnostic to determine, 343 
using Leverage diagnostic to determine, 347 
using Principal Component Scores diagnostic to 

determine, 340 
overfit calibration model, 218 
overlapping peaks 

and CLS, 38 
and PLS, 43 
and Simple Beer's Law, 36 
and SMLR, 40 

P 
Pairwise Concentration diagnostic, 313 
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when to use, 150 
pairwise distance plot, 261 
palette, 121 
palette tool 

selecting, 122 
parameter 

Action, 296, 297 
Analysis Type, 181 
Baseline Type, 283 
Calculate Coefficients, 230 
Class, 252 
Data Format, 162 
Data Points, 166 
Developer's Name, 181 
Digits, 190, 275 
Final Format, 120 
Fit Value, 92 
Force Through Zero, 229 
Intercept, 223 
Linear Correction, 276 
Location, 283 
Match Type, 51 
method, 114 
Method Description, 181 
Method Title, 181 
Pathlength Type, 61, 183 
Polynomial Order, 166 
Region Type, 154 
Restrict Analysis to Y-axis Range, 154 
Segment Length, 167 
Show Processed Spectra in View Standards, 159 
Show Spectrum File Names, 132 
Show Spectrum Titles, 132 
Usage, 99, 208, 252 
Use Analysis Limits, 190 
Use Specified Background File, 144 

Parameter check, 296 
Parameter check box, 109 
parameters 

Background Handling, 143 
Bench, 109 
checking automatically, 296 

Collect, 109 
data collection, 201, 249, 278 
default settings, 180 
displaying help information for, 19 
displaying method, 180 
for collecting standards, 137 
for linearity correction, 229 
for multipoint baseline correction, 169 
for reporting sample results, 104, 294 
for smoothing, 164 
general, 11 
greyed, 353 
method, 80, 81 
mismatched, 102 
print, 99 
printing, 100 
resetting, 109 
unavailable, 353 
using consistent settings, 137 
warning message, 136 

partial least squares. See PLS method 
pass/fail indicator 

for Distance Match, 53 
reporting, 295 

password 
adding to a method, 94 
deleting, 96 

Password check box, 95, 300 
Paste command, 142, 207 
pathlength, 30 

accounting for differences, 60 
and classification methods, 242 
and Pure Component Spectra diagnostic, 318 
and quantitative methods, 60, 183 
and spectral measurement methods, 273 
assumptions, 31, 60 
constant, 64 
defined, 59 
known, 65 
predicted, 66 

Pathlength column, 220 
pathlength component, 184 
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pathlength correction 
and multivariate quantitative methods, 61 
internal known, 67 
internal reference, 67, 357 
internal standard, 69 
MSC, 70 
options for classification methods, 61 
options for quantitative methods, 60 
peak ratio, 69, 357 
selecting, 61 
SNV, 71 
sources of error (classification), 265 
sources of error (quantitative), 227 
sources of error (spectral measurement), 292 

pathlength peak 
and internal reference pathlength correction, 67 
and peak ratio pathlength correction, 69 

Pathlength Region table, 286 
pathlength spectrum, 318 
Pathlength tab, 184, 286 
Pathlength Type parameter, 183 

and Regions wizard, 210 
Constant, 64 
Internal Reference, 67 
Known, 65 
MSC, 64, 70 
options for classification methods, 62 
options for quantitative methods, 61 
Peak Ratio, 63, 69 
Predict, 66 
selecting, 61 
SNV, 64, 71 
switching, 63 

Pathlength wizard, 62, 183 
and internal reference pathlength correction, 68 
and peak ratio pathlength correction, 69 
and SNV pathlength correction, 74 
purpose, 23 

PCR, 44 
PCR method 

number of standards, 44 
PCR METHOD 

advantages, 45 
bias of calibration, 222 
calibration model, 44 
compared with PLS, 45 
conditions for use, 44 
correlation coefficient of calibration, 222 
disadvantages, 46 
reporting uncertainty values, 295 
root mean square error of calibration, 222 

peak area tool, 122 
Peak Height (Interpolated) region type, 282 
peak height tool, 122 
Peak Location (Interpolated) region type, 282 
peak locations 

finding, 57 
Peak Ratio pathlength type, 69, 212 

algorithm, 63, 70 
and Pathlength wizard, 69 
and Regions wizard, 69 
and spectral measurement methods, 273 
as a denominator peak, 58 
compared with Internal Reference, 357 
requirements for using, 69 
used in classification methods, 244 
used to define a denominator peak, 70, 286 
when to use, 63 

peak shift 
and Simple Beer's Law, 36 

peak width at half maximum 
measuring, 57 

Peak Width At Half Maximum region type, 282 
peaks 

component for SBL, 34 
overlapping with CLS, 38 
overlapping with PLS, 43 
overlapping with SBL, 36 
overlapping with SMLR, 40 

peak-to-peak noise 
measuring, 58, 271 

Peak-To-Peak Noise region type, 282 
percent difference values 

for quantitative methods, 218 
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percent spanned value 
defined, 150 

performance index, 78 
and analysis limits, 191 
for classification methods, 247, 264 
for Discriminant Analysis and Distance Match 

methods, 263 
for quantitative methods, 193, 224 
overall versus component, 221 

piecewise linear baseline correction, 168, 170 
plot 

% Difference, 219, 326 
Calculated versus Actual concentrations, 219, 326 
leverage versus studentized residual, 348 
pairwise distance, 261 
pathlength component, 220 

PLS factors 
evaluating error, 218 

PLS method, 42 
advantages, 43 
algorithm, 42 
bias of calibration, 222 
calibration model, 42 
calibration process, 219 
chemical interactions, 43 
compared with PCR, 45 
conditions for using, 42 
correlation coefficient of calibration, 222 
disadvantages, 44 
displaying loading spectra, 350 
number of standards, 42 
overfit calibration model, 218 
overlapping peaks, 43 
reporting uncertainty values, 295 
root mean square error of calibration, 222 
sample matrix, 43 
spectral baselines, 43 
typical samples, 43 
using Factor Loading diagnostic to determine outliers, 

343 
using Leverage diagnostic to determine outliers, 347 

using Loading Spectra diagnostic to determine 
variation, 350 

using PRESS diagnostic to determine factors, 337 
when to use, 43 

PLS1 algorithm, 42 
P-matrix. See SMLR method 
points 

for multipoint baseline correction, 169 
Polynomial Order parameter, 166 
Predict pathlength type, 66 

requirements for using, 66 
when to use, 67 

predicted pathlength, 66 
preparing standards, 200 
pre-processing. See processing spectral data 
PRESS diagnostic, 337 
pressure settings 

for gases, 137 
principal component analysis 

for Discriminant Analysis, 54 
principal component regression. See PCR 
Principal Component Scores diagnostic, 340 
principal component spectra 

displaying, 310 
Principal Component Spectra diagnostic, 310 
principal components 

calculating score values for, 340 
for classification methods, 263 
for individual standards, 340 
variation represented in, 308 

Principles of TQ Analyst, 27 
Print command, 100 
printer 

setting up, 99 
printer options, 100 
Printer Setup command, 99 
printing 

analysis results, 105 
custom information with spectra, 119 
method, 100 
Quantify dialog box, 110 

processed spectra 
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displaying, 158 
processing 

spectral data, 155 
processing information 

displaying, 118 
processing operations 

specifying multiple, 161 
viewing selected, 160 

Professional Edition of TQ Analyst, 2 
protecting a method from changes, 94, 300 
pure component spectra 

displaying, 317 
Pure Component Spectra diagnostic, 317 

Q 
QC Compare search method, 55 

algorithm, 55 
creating composite standards, 153 
match value, 56 
number of classes, 56 
number of standards, 56 
when to use, 55 

quadratic removed baseline correction, 283 
qualitative analysis, 29 
qualitative methods, 46 
Quant Setup command, 108 
quantify 

a sample from OMNIC, 108 
a spectrum from TQ Analyst, 101 
and produce residual spectrum, 331 
calibration standards for validation, 324 
input file, 107 
mismatched parameters warning, 354 
more than one sample, 105 
multiple spectra, 334 
sample from Thermo Scientific applications, 111 
validation spectra using External Validation diagnostic, 

328 
validation standard, 328 

Quantify button, 77, 102, 299 
compared with Multiple Quantify, 102 
mismatched parameters warning, 102 

Quantify dialog box 
printing, 110 

Quantify dialog boxes 
format, 275 

quantify results 
exporting, 105 
printing, 105 

QUANTIFY.TXT file, 335 
QUANTIFY.XLS file, 335 
quantifying 

correction standards, 217 
quantifying a sample 

from OMNIC, 108 
from Thermo Scientific applications, 111 
from TQ Analyst, 101 

QuantIR 
internal known pathlength corrections, 67 
internal standard pathlength corrections, 69 

QuantIR methods, 89 
quantitative analysis, 29 
quantitative method 

CLS, 37 
PCR, 44 
PLS, 42 
Simple Beer's Law, 34 
SMLR, 39 

quantitative methods 
acceptable signal-to-noise ratio, 179 
and sample pathlength, 60 
calibrating, 216 
choosing a sampling technique, 178 
collecting the standards, 192, 201 
creating a new method file, 180 
customizing, 213 
defining the problem, 177 
displaying principal component spectra, 310 
displaying pure component spectra, 317 
entering component names, 189 
how to create, 173 
importing calibration spectra, 204 
importing concentration values, 140, 206 
optimizing analysis regions, 212 
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optimizing collection parameters, 201 
Pathlength Type, 61 
performance index, 224 
preparing the standards, 200 
protecting from changes, 300 
recommended data format, 180 
running a test sample, 299 
saving, 216 
selecting a pathlength option, 183 
selecting analysis regions, 209 
selecting analysis type, 181, 210 
selecting calibration technique, 181 
selecting method type, 33 
selecting resolution, 179 
selecting standards by hand, 196 
selecting standards with the Evaluate Standards wizard, 

195 
selecting standards with the Suggest Standards wizard, 

194 
setting usage for method standards, 208 
sources of error, 226, 265 
specifying analysis limits, 190 
specifying components, 188 
standards defined, 192 
testing feasibility, 185 
testing for outlier standards, 315 
titling the method, 181 
troubleshooting, 353 
using Eigenanalysis diagnostic to determine variation, 

308 
using Pairwise Concentration diagnostic to evaluate 

distribution of standards, 313 
using Residual Spectra diagnostic to evaluate 

uncertainty, 331 
using Statistical Spectra diagnostic to determine 

variation, 320 
using the Evaluate Standards wizard to select standards, 

195 
using the Suggest Standards wizard to select standards, 

194 
using the wizard to select regions, 209 
validating, 224 

validating without validation standards, 324 
warnings reported but no sample results, 296, 297 
wizards, 174 

quantitative techniques 
theory of, 29 

Quick IR 
methods, 89 

quitting TQ Analyst, 10 

R 
ratioing peaks 

in SMLR methods, 212 
in spectral measurement methods, 285 

readout 
% Variability Described, 263 
for region tool, 123 
Last Saved Date, 90 
Revision, 90 

readouts, 82 
rearranging displayed spectra, 117, 146 
region 

adjusting displayed, 120 
changing display limits, 121 
changing displayed, 121 
displaying entire, 121 
for SNV pathlength correction, 72 
selecting for classification method, 253 
selecting for quantitative method, 209 
selecting for spectral measurement method, 279 
using Principal Component Scores diagnostic to select, 

340 
using Statistical Spectra diagnostic to select, 320 
using wizard to select, 209, 253 

Region Selection task window 
displaying, 212 
displaying pure component spectra in, 320 
for classification methods, 254 
for quantitative methods, 209 
for spectral measurement methods, 280 
printing, 100 

region tool, 122 
Region type 
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for derivative spectra, 164 
for spectral measurement methods, 280 
selecting (spectral measurement), 270 

Region Type parameter, 154 
regions. See region and analysis regions 
Regions tab, 279 
Regions wizard, 23, 209 

and internal reference pathlength correction, 68 
and peak ratio pathlength correction, 69 
and quantitative Analysis Type, 210 
and quantitative Pathlength Type, 210 
for classification methods, 253 

regression analysis, 39 
relative difference plot, 219 
removing 

password, 96 
report features, 295 
standards from a method, 144 

replacing a standard, 144 
report features 

adding and removing, 295 
Report tab, 294 

for classification methods, 255 
for quantitative methods, 214 
for spectral measurement methods, 288 

reporting 
concentration values and unit, 295 
method information, 295 
uncertainty values, 295 

requirements 
hardware and software, 9 

resetting collection parameters, 109 
Residual Spectra diagnostic, 331 
residual spectrum 

component, 332 
cumulative, 332 
displaying, 331 
for Distance Match, 52 
for Similarity Match, 50 

residual values, 347 
resizing 

active window, 125 

TQ Analyst window, 76 
resolution 

for classification methods, 237 
for quantitative methods, 179 
of collected standards, 137 

Restrict Analysis to Y-axis Range parameter, 154 
restricting the Y-axis range, 154 
result checks, 298 
result file 

default, 108 
results 

applying linearity corrections to, 276 
for classification methods, 103 
for quantitative methods, 103 
for spectral measurement methods, 104 
from feasibility test, 187 
reporting only warnings, 296, 297 

retrieving spectra from a disk, 92 
Revision readout, 90 

after updating calibration data, 304 
RMS noise 

measuring, 58, 271 
RMS Noise 

region type, 282 
root mean square error of calibration (RMSEC), 222 
running a method 

from OMNIC, 108 
from Thermo Scientific applications, 111 

S 
sample 

analyzing, 101 
analyzing from OMNIC, 108 
analyzing from Thermo Scientific applications, 111 

sample checking, 105 
and method file size, 92 
turning on and off, 295 

sample matrix 
and CLS, 38 
and PLS, 43 
and Simple Beer's Law, 36 
Simple Beer's Law, 34 
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sample pathlength. See pathlength 
sample reports 

customizing, 295 
sample results 

applying linearity correcting, 276 
copying to spreadsheet file, 335 
for classification methods, 103 
for quantitative methods, 103 
for spectral measurement methods, 104 
reporting only warnings, 296, 297 

sample single-beam spectrum, 142 
sample thickness. See pathlength 
samples 

analyzing more than one, 105 
representative for spectral measurement methods, 277 
typical for CLS, 38 
typical for PLS, 43 
typical for Simple Beer’s Law, 36 
typical for SMLR, 41 

sampling technique 
choosing for classification methods, 236 
choosing for quantitative methods, 178 
choosing for spectral measurement methods, 269 

Save Method As command, 91 
and passwords, 95 

Save Method command, 90 
Save Spectrum As command, 93 
saving 

a method with a new file name, 91 
and protecting a method, 300 
method, 90 
method with a minimum file size, 92 
spectrum in a spectral data file, 93 
standards in spectral files, 204, 251 
standards in TQ Analyst methods, 136 

Savitsky-Golay smoothing, 166 
compared with OMNIC smoothing, 166 

SBL. See Simple Beer's Law method 
scattering 

and MSC pathlength correction, 71 
and SNV pathlength correction, 72 

score values 

for Discriminant Analysis, 54 
using Principal Component Scores diagnostic to 

calculate, 340 
scores. See PC Scores 
scroll bar, 80 
scroll box, 80 
Search Standards method, 47, 56, 74 

algorithm, 56 
match value, 57 
number of classes, 56 
number of standards, 56 
when to use, 56 

searching 
on-line help, 17 

security system, 94 
Segment Length parameter, 167 
selecting 

displayed spectrum, 146 
points for baseline correction, 170 
window, 124 

selecting standards 
using Suggest Standards wizard, 148 
using the Evaluate Standards wizard, 149 

selection tool, 122 
setting up the printer, 99 
shifting peaks 

and Simple Beer's Law, 36 
shortcuts 

for starting TQ Analyst, 10 
Show Processed Spectra in View Standards parameter, 159 
Show Spectrum File Names parameter, 132 
Show Spectrum Titles parameter, 132 
showing 

How To help windows, 22 
processed spectra, 147 
Spectra tab, 157 
uncertainty values, 295 

signal-to-noise ratio 
for classification methods, 237 
for quantitative methods, 179 
of collected standards, 137 

SIMCA, 54 



 

Thermo Fisher Scientific TQ Analyst User’s Guide 413 

Similarity Match method, 50 
algorithm, 50 
Match Type, 51 
match value, 51 
when to use, 50 

Simple Beer’s Law method 
advantages of, 36 
calibration curve intercept, 223 
calibration model, 36 
chemical interactions, 36 
component peaks, 34 
conditions for using, 34 
disadvantages of, 37 
linearity, 36 
number of standards, 34 
overlapping peaks, 36 
requirements for standards, 36 
sample matrix, 34, 36 
slope of calibration curve, 222 
spectral baselines, 36 
typical samples for, 36 

Simple Beer's Law method, 34 
single-beam spectrum 

for sample and background, 142 
slope 

applying to spectral measurement method, 276 
for Simple Beer's Law calibration, 222 

SMLR method, 39 
advantages, 42 
chemical interactions, 41 
conditions for using, 40 
denominator peak, 39 
disadvantages, 42 
interferences, 41 
linearity, 40 
overfit model, 40 
overlapping peaks, 40 
recommended number of standards, 41 
selecting regions, 40 
setting up denominator peak, 212 
spectral baselines, 41 
typical samples, 41 

when to use, 41 
smoothing, 164 

algorithm, 164 
displaying smoothed spectra, 159 
for sample spectra, 167 
Norris derivative technique, 166 
Savitsky-Golay technique, 166 
showing smoothed spectrum, 167 
viewing smoothed spectra, 160 
warning message, 168 

SNV pathlength type, 71 
algorithm, 73 
and Pathlength wizard, 74 
and quadratic removed baseline correction, 72 
assumptions, 72 
compared with MSC, 74 
defining the region, 72 
displaying processed spectra, 159 
showing processed standards, 148 
used in classification methods, 244 
when to use, 64, 73 

soft independent modeling of class analogies (SIMCA), 54 
software 

version number, 14 
software requirements, 9 
solids 

analyzing, 30 
preparing standards for, 35 

Sort Standards button, 132 
sorting standards, 77, 132 
spectra 

adjusting displayed region, 120 
calculating derivatives, 161 
displaying baseline corrected, 171 
displaying file names, 132 
displaying processed version, 158 
dragging right/left, 121 
expanding/contracting, 120 
opening, 92 
printing custom information, 119 
quantifying multiple, 334 
rearranging displayed, 117, 146 



 

414 TQ Analyst User’s Guide Thermo Fisher Scientific 

rolling right/left, 121 
storing, 91 
testing for outliers, 315 
viewing selected corrections, 160 

Spectra tab, 156 
showing/hiding, 157 
View Standards button, 160 

spectral baselines 
and CLS, 38 
and PLS, 43 
and Simple Beer's Law, 36 
and SMLR, 41 

spectral cursor tool, 122 
spectral data 

exporting, 98 
spectral file 

naming, 204 
selecting multiple, 107 

spectral group 
file name, 132 
file type, 107 
saving, 93 

spectral measurement method 
Measurement Only method, 57 

spectral measurement methods, 57 
applying linear corrections, 58 
calibrating, 290 
calibration models, 59 
choosing a pathlength option, 273 
choosing a sampling technique, 269 
collecting representative samples, 277 
correcting a measured value, 276 
creating a new method file, 269 
customizing, 288 
defining the measurements, 273 
defining the problem, 268 
entering labels, 274 
how to create, 267 
measuring peak height or area, 58 
measuring peak width, 58 
measuring peak-to-peak noise, 58, 271 
measuring RMS noise, 58, 271 

number of measurements, 58 
optimizing collection parameters, 278 
protecting from changes, 300 
running a test sample, 299 
saving, 290 
selecting analysis regions, 279 
selecting measurement technique, 270 
selecting Region Type, 270, 280 
selecting representative samples, 277 
setting up a denominator peak, 285 
sources of error, 291 
titling the method, 270 
validating, 291 
when to use, 58 

spectral noise 
measuring, 57, 58, 271 

spectral processing. See processing spectral data 
spectral window, 86, 116 

axes, 119 
axis unit, 119 
closing, 124 
displaying, 124 
printing, 100 
selecting a displayed spectrum, 146 

spectrometer, 28 
spectroscopy, 28 
spectrum 

analyzing, 101 
analyzing from OMNIC, 108 
analyzing from Thermo Scientific applications, 111 
analyzing more than one, 105 
background, 140, 142, 203, 250 
collecting, 139, 202, 250, 279 
collecting for a standard, 136 
described, 28 
deselecting using Title box, 118 
displaying, 145 
displaying collection and processing information, 118 
displaying entire, 121 
opening as a standard, 133, 135 
pathlength, 318 
quantifying calibration for validation, 324 
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quantifying from OMNIC, 108 
quantifying from Thermo Scientific application, 111 
quantifying from TQ Analyst, 101 
quantifying validation, 328 
replacing, 144 
saving from task window, 94, 115 
saving in a spectral data file, 93 
selecting, 146 
selecting using Title box, 118 
single-beam, 142 

spectrum checks, 297 
Spectrum Outlier diagnostic, 315 
spectrum title, 118, 131 

editing, 118 
entering, 140 
for composite standard, 153 
for recommended standards, 149 

spline baseline correction, 170 
spreadsheet file 

copying data to, 97 
copying spectral and concentration data to, 98 
for defining method standards, 206 

standard 
adding, 139, 204, 251 
adding to a method, 133 
choosing actual class, 252 
collecting, 136, 139, 202, 250 
creating composite, 153 
deleting, 144 
displaying, 145 
opening, 135 
replacing, 144 

standard deviation 
for Distance Match, 52 

standard error of measurement 
reporting, 295 

Standard Error of Measurement Check, 298 
standard error of measurement sample checking 

and validation standards, 299 
standard normal variate. See SNV pathlength type 
standards 

and principal components, 340 

and signal-to-noise ratio, 137 
calibration, 192, 247 
collecting, 201 
collecting outside TQ Analyst, 204, 251 
collection and processing information for, 146 
collection parameters for, 137 
component concentrations for, 198 
copying concentration data for, 98 
defined for classification methods, 246 
defined for quantitative methods, 192 
for feasibility test, 186 
importing, 204 
importing concentration values for, 140, 206 
independent variation, 199 
independent variation for PCR, 45 
independent variation for PLS, 43 
merging, 152 
misclassified, 259, 262 
mismatched warning, 353 
preparing, 200 
pruning, 151 
quality for classification methods, 249 
quality for quantitative methods, 201 
quality of, 137 
quantity for classification methods, 248 
quantity for quantitative methods, 197 
quantity for spectral measurement methods, 277 
recommended for CLS, 37 
recommended for PCR, 44 
recommended for PLS, 42 
recommended for QC Compare search, 56 
recommended for Search Standards, 56 
recommended for Simple Beer’s Law, 34 
recommended for SMLR, 41 
requirements for, 36 
requirements for Simple Beer’s Law, 36 
resolution of, 137 
saving in spectral files, 204, 251 
saving in TQ Analyst methods, 136 
selecting for classification methods, 248 
selecting for quantitative methods, 193 
setting collection parameters for, 133 
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showing processed versions, 147 
signal-to-noise ratio, 137 
sorting, 132 
sources of error (classification), 265 
sources of error (quantitative), 226 
storing, 91 
testing for outliers, 315 
updating concentration values, 200 
using Evaluate Standards wizard to select, 149 
using Loading Spectra diagnostic to determine 

variation, 350 
using Pairwise Concentration diagnostic to evaluate 

distribution, 313 
using spreadsheet file to define, 206 
using Suggest Standards wizard to select, 148 
validation, 192, 247 
verifying, 198 
verifying independent variation in, 313 

standards library 
storing, 111 

Standards Selection diagnostic 
and Evaluate Standards wizard, 149, 196 

Standards tab, 130, 156 
Standards table, 130 

adding a standard, 133, 140 
format of, 132 
showing/hiding spectrum file names, 132 
showing/hiding spectrum titles, 132 
sorting entries, 132 
Usage column, 131 

Standards to Text File command, 98 
starting a wizard, 24 
starting TQ Analyst, 9 
Statistical Spectra diagnostic, 320 
stepwise multiple linear regression. See SMLR method 
stopping a wizard, 25 
storing 

methods, 91 
spectra, 91 
standards, 91 

studentized residual values, 347 
Suggest Analysis Type button, 241 

not available, 5 
purpose, 23 
results, 26 

Suggest Corrections button, 228 
Suggest Pathlength Type button, 62, 63 

purpose, 23 
results, 26 

Suggest Regions button, 209 
Suggest Standards button, 149 
Suggest Standards wizard, 23, 194 

requirements for analysis limits, 148 

T 
tab, 114 

Classes, 245 
Components, 189 
Description, 90 
General, 12 
Measurements, 274 
Other, 214, 256 
Pathlength, 184, 286 
Regions, 279 
Report, 214, 255, 288, 294 
Spectra, 156 
Standards, 130, 156 
TQ Analyst, 22 

table 
ANOVA, 187 
Baseline Points, 170 
Calibration Results for classification methods, 259 
Calibration Results for Cross Validation, 326 
Calibration Results for quantitative methods, 217 
Classes, 245 
Component Regions, 212 
Components, 189 
copying, 97, 98 
copying from a task window, 116 
Correction Curve Coefficients, 230 
Factors For Last Calibration, 339 
in task window, 115 
input for External Validation, 330 
Leverage diagnostic results, 348 
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loading values, 344 
Measurements, 274 
of standards, 130 
Pairwise Concentration, 314 
Pathlength Region, 253, 286 
PRESS diagnostic results, 338 
Regions, 211 
score values, 341 
Spectrum Outlier, 316 

tables, 83 
in task windows, 85 
selecting fields in, 84 

tabs, 80 
task window, 85, 115 

Calibration Results, 217, 259 
Corrections, 228 
Region Selection, 209, 280 

task windows 
closing, 123 
displaying, 123 
exporting diagnostic data from, 97 
printing, 100 
saving spectra from, 94, 115 

technical support, 7, 14 
techniques 

for choosing baseline points, 284 
temperature settings 

for gases, 137 
test sample, 299 
testing 

feasibility, 185 
for outliers, 315 
method, 299 

text boxes, 81 
Thermo Fisher Scientific 

technical support, 14 
Thermo Scientific application 

running a TQ Analyst method with, 111 
thickness. See pathlength 
threshold 

for Distance Match, 52 
Tile Windows command, 125 

tiling windows, 125 
title 

for recommended standards, 149 
method, 181 
of composite standard, 153 
spectrum, 131, 140 

Title box, 118 
tool 

selecting, 122 
tool palette, 121 
toolbar buttons 

Calibrate, 77, 304 
Explain, 19 
Quantify, 77, 102, 299 

totally absorbing bands 
excluding, 154 

tour of the software, 14 
TQ Analyst 

action buttons, 81 
choosing menu commands, 77 
customizing, 11 
example methods, 14 
EZ Edition, 3 
help topics for, 14 
menu bar, 77 
method parameters, 80, 81 
method window, 79 
options, 11 
principles of, 27 
Professional Edition, 2 
program icon, 10 
program name, 10 
quitting, 10 
scroll bar, 80 
selecting fields in a table, 84 
spectral window, 86 
starting, 9 
tab order, 80 
tables, 84 
tabs, 80 
task windows, 85 
tour, 14 
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version number, 14 
window, 76 

TQ Analyst spectra 
saving, 132 

TQ Analyst Tour 
installing without, 8 
viewing, 17 

TQ Analyst window 
resizing, 76 

training set. See calibration set 
transmittance, 28 
troubleshooting 

TQ Analyst methods, 353 
two-point baseline 

compared with multipoint baseline, 169 
two-point baseline correction, 283 
typical samples 

for CLS, 38 
for PLS, 43 
for Simple Beer's Law, 36 
for SMLR, 41 

U 
Uncertainty Value Check, 298 
Uncertainty Value Check check box, 298 
uncertainty values 

not displayed, 354 
reporting, 295 
using Residual Spectra diagnostic to evaluate, 331 

Undecided analysis type, 210 
unit 

absorbance, 72 
common X-axis, 119 
for method components, 189 
for reporting component concentration, 188 
for reporting pathlength, 81 
for reporting spectral measurement, 274 
for spectral measurements, 275 
for spectral window axes, 119 
Kubelka-Munk, 71 
log (1/R), 72 
mismatched, 296 

reporting, 295 
standard deviation for Distance Match, 52, 241 
Y-axis, 120 

unlocking a method, 96 
updating 

calibration data, 303 
usage 

for composite standard, 154 
for standards in classification methods, 252 
for standards in quantitative methods, 208 

Usage parameter 
for classification methods, 252 
for quantitative methods, 208 
Standards table, 131 

Use Analysis Limits parameter, 190 
Use Specified Background File parameter, 144 

V 
VALID.TXT file, 329 
VALID.XLS file, 329 
validating 

a classification method, 263 
a quantitative method, 224 
a spectral measurement method, 291 
using Cross Validation diagnostic, 226 
without validation standards, 324 

validation 
avoiding bias, 225 

validation data 
copying to spreadsheet file, 328 

validation spectra 
quantifying using External Validation diagnostic, 328 

validation standards 
and classification method performance, 247 
and performance index, 78 
and quantitative method performance, 193 
and uncertainty values, 295 
collecting, 201 
compared with calibration standards, 218 
exported values for, 99 
for classification method validation, 264 
for classification methods, 247, 248 
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for quantitative method validation, 225 
for quantitative methods, 192, 197 
requirements for, 36 
selecting, 131 
symbols displayed in plots, 220 
validating without, 324 

variability 
using Eigenanalysis diagnostic to determine, 309 

variance spectrum 
and Statistical Spectra diagnostic, 321 
for Discriminant Analysis, 54 

variation 
evaluating in method standards, 313 
using Loading Spectra diagnostic to determine, 350 
using Principal Component Scores diagnostic to 

determine, 340 
using Statistical Spectra diagnostic to determine, 320 

version number, 14 
View finder, 120 

changing displayed region, 121 
expanding/contracting display, 120 
region markers, 121 

View menu, 117, 146 
Display Setup command, 119 
displaying help information for, 117 

View options, 117 
View Standards button 

Spectra tab, 160 
Standards tab, 146 
updating the display, 146 

viewing 
selected processing operations, 160 

W 
warning message 

mismatched parameters, 102, 136, 137 
mismatched standards, 353 
on sample reports, 105 

warnings 
turning on and off, 295 

wavelength, 28 
wavelength distance. See Distance Match method 

wavenumbers, 28 
window 

active, 124 
Calibration Results task for classification methods, 259 
Calibration Results task for quantitative methods, 217 
closing, 127 
Collect Background, 124, 143 
Collect Sample, 124 
Collection and Processing Information, 119 
Corrections task, 228 
Cross Validation diagnostic task, 325 
Edit Factors, 218 
Eigenanalysis task, 309 
Excel application, 98, 107 
Explain Help, 19 
Factor Loading diagnostic task, 344 
Find, 17 
graphical, 211, 254, 285 
Help, 14 
How To help, 22 
Index Search, 17 
Leverage diagnostic task, 347 
maximizing, 124 
method, 79, 114 
PC Scores diagnostic task, 341 
PRESS diagnostic task, 338 
Region Selection task, 169, 209 
Region Selection task for classification methods, 254 
Region Selection task for spectral measurement 

methods, 280 
Residual Spectra task, 333 
resizing, 125 
selecting, 124 
spectral, 86, 116 
Spectrum Outlier diagnostic task, 316 
task, 85, 115 
TQ Analyst, 76 
wizard, 25 

Window menu, 113 
selecting methods from, 90 

Window options, 117 
windows 
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cascading, 126 
closing, 77 
diagnostic task, 305 
managing, 113 
rearranging, 125 
setting options for, 11 
tiling, 125 

Windows 
requirements for TQ Analyst, 9 
task bar, 10 

Windows help 
using, 16 

Within Class Variance 
for Discriminant Analysis, 54 

wizard, 22 
Analysis Type, 23, 241 
Assess Feasibility, 186 
Corrections, 24, 228 
Evaluate Standards, 149, 195 
Factors, 24 
Feasibility, 23 
Pathlength, 23, 62, 183 
recommendations from, 26 
Regions, 23, 209, 253 
starting, 24 
stopping, 25 

Suggest Standards, 23, 194 
wizards 

for classification methods, 234 
for quantitative methods, 174 

word processing file 
copying method data to, 97 
copying spectral and concentration data to, 98 

working curve, 31, 35 

X 
X-axis 

splitting, 119 

Y 
Y-axis range 

restricting, 154 
Y-axis unit 

setting, 120 

Z 
zero 

forcing a correction curve through, 229 
zero point 

adding to calibration curve, 224 
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